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About FlashPro

FlashPro is Microsemi's programming software tool for SmartFusion, IGLOO, ProASIC3, Fusion devices.
You will be able to navigate easily through the FlashPro software because of its similarities with other
Microsemi software tools. The FlashPro software includes the following features:

e Supports modification of I/O states during programming
e Supports automatic construction of chain from scan chain operation
e Supports importing non-Microsemi BSDL files for automatic chain construction
e Supports direct multiple Microsemi device chain programming and serialization
e Supports single device STAPL files generation
e Supports single device SVF files generation
e Supports single device IEEE 1532 files generation
e Supports Chain STAPL file generation
e Supports Chain SVF file generation
e Supports a single GUI to drive multiple FlashPro5/4/3/3X programmers for parallel programming
e Supports 1.2V programming for IGLOO devices
Note: Parallel programming via FlashPro (USB/LPT1) or FlashPro Lite programmers is not supported.
e Supports device serialization for parallel programming
e A redesigned GUI, which features a project manager to manage the programming files and data
e Enhanced In-System Programming (ISP) Support

An optional In-House Programming (IHP) service is available if you are purchasing Microsemi devices in
volume. Contact Microsemi for more information.

For step-by-step instructions on how to use these features, see the FlashPro Tutorial.

If you arrived here by pressing the F1 key in FlashPro, use the Search tool in help for more information on
specific content, or click the Help button embedded in any dialog box or GUI for context-specific help.

Installing FlashPro Express Software

See the FlashproExpress Installation Instructions on the Microsemi website for information on how to install
FlashproExpress software and relevant system requirements.

View the detailed Install Instructions and System Requirements at the Flashpro Express software page:
http://www.microsemi.com/products/fpga-soc/design-resources/programming/flashproexpress#overview

Programming Tool Model Overview

The FlashPro software is designed for use in the operation, user design, and production programming flows.

Design Debug

The figure below illustrates the programming design flow when an engineer is in debug mode. In the
programming design flow, the new Programming files (STAPL/ PDB) are generated for a design change and
are sent to the FlashPro software for testing and debugging the design.

Note: FlashPoint is integrated into Designer; therefore, the STAPL file is generated from Designer. FlashPro v6.2
and greater can be used to export STAPL files from PDB files created by FlashPoint (Designer).

FlashPro User's Guide 5
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Figure 1 - Programming Design Flow

Operation/Production Planning

The figure below shows an illustration of the operation flow. In this illustration, the production coordinator
generates the programming files (STAPL/PDB) with or without serialization and/or security settings (see
Programming application note for further information). The production coordinator loads the programming
file in the FlashPro software to set up the configurations for production programming, such as Serialization
options, Action selections, and Procedure selections, etc.

FlashPgint
[Designer) Single Device STAPL

FlashPro
STAPL / PDB File Software FlashPro3 ProASIC3/E

Programming
Configuration File Stations

ITAG

Figure 2 - Operation Flow

The production coordinator may want to generate different configuration files for each programming station
(depending on the logistics and serialization options). For example, if the Programming file contains 10,000
serial data and the production coordinator decides to split the serial data designation to one thousand for
each programming station, then ten configuration files will be generated (one for each of the ten
programming stations). However, if you are not using serialization, you only need one configuration file.

The production coordinator can test the configuration files with one or more FlashPro5/4/3/3X programmers
before sending it to the production programming floor. If PDB files are used in the production flow, warning
icons may appear on the FlashPro/FlashPoint GUI because the automatic audit cannot find the source file
on the production environment; the PDB file contains the valid programming data. If STAPL files are used,
loaded STAPL files will be audited on execution of an action to determine if the original STAPL file has been
modified. If it has not been modified, the action will continue to run. If it has been modified you will be
prompted to reload the modified STAPL file, or to continue running the current action. If you select to reload
the modified STAPL file, all previous programming settings will be refreshed and will need to be performed
again.
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Programming Tool User Model Overview - SmartFusion Only

Operation/Production Programming

The figure below shows an illustration of the production programming flow. The operator imports the
configuration file and begins programming the devices by clicking the Run button. The operator's interaction

with FlashPro should be limited.
At the end of a programming session, the serialization log file (if applicable) and the programming log file are
sent back to the production coordinator for record keeping.

:Ll
FlashPro » FlashPro3 JTAG ProASIC3/E
Software

Send to
Production Coordinator
for record keeping

Configuration File

Serialization Log Programming Log

~

Figure 3 - Production Programming Flow

A A J

Express Configuration Programming (IGLOO, ProASIC3 and Fusion devices only)

The figure below illustrates the Express Configuration Programming Flow. In this flow, you can program the
security setting into the IGLOO, ProASIC3 and Fusion family device directly from the FlashPro software.

Note: FlashPoint is integrated into the FlashPro v6.0 and later software.

ITAG

FlashPrao ProASIC3/E

Software

N FlashPro3

PDB Flle with
Security Settings

Figure 4 - Express Configuration Programming Flow

Programming Tool User Model Overview - SmartFusion Only

The FlashPro software is designed for use in the operation, user design, and production programming flows.

Design Debug
The figure below illustrates the programming design flow when an engineer is in debug mode. In the
programming design flow, the new files (FDB, UFC, EFC) are generated for a design change and are sent to
the FlashPro software for testing and debugging the design.

FlashPro User's Guide
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Figure 5 - SmartFusion Programming Design Debug Flow

Operation/Production Planning

The figure below shows an illustration of the operation flow. In this illustration, the production coordinator
generates the programming files (STAPL/PDB) with or without serialization and/or security settings (see
Programming application note for further information). The production coordinator loads the programming
file in the FlashPro software to set up the configurations for production programming, such as Serialization
options, Action selections, and Procedure selections, etc.
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Figure 6 - SmartFusion Operation Flow

The production coordinator may want to generate different configuration files for each programming station
(depending on the logistics and serialization options). For example, if the Programming file contains 10,000
serial data and the production coordinator decides to split the serial data designation to one thousand for
each programming station, then ten configuration files will be generated (one for each of the ten
programming stations). However, if you are not using serialization, you only need one configuration file.

The production coordinator can test the configuration files with one or more FlashPro5/4/3/3X programmers
before sending it to the production programming floor. If PDB files are used in the production flow, warning
icons may appear on the FlashPro/FlashPoint GUI because the automatic audit cannot find the source file
on the production environment; the PDB file contains the valid programming data. If STAPL files are used,
loaded STAPL files will be audited on execution of an action to determine if the original STAPL file has been
modified. If it has not been modified, the action will continue to run. If it has been modified you will be
prompted to reload the modified STAPL file, or to continue running the current action. If you select to reload
the modified STAPL file, all previous programming settings will be refreshed and will need to be performed
again.

Operation/Production Programming

The figure below shows an illustration of the production programming flow. The operator imports the
configuration file and begins programming the devices by clicking the Run button. The operator's interaction
with FlashPro should be limited.
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SmartFusion2 Programming
At the end of a programming session, the serialization log file (if applicable) and the programming log file are
sent back to the production coordinator for record keeping.

[

SmartFusion

JTAG

FlashPro »
Software

FlashPro4/3/3X

Configuration File

Send to
Production Coordinator
for record keeping

Y v

Serialization Log Programming Log

e 2F

Figure 7 - SmartFusion Production Programming Flow

Creating a New PDB for SmartFusion
The figure below illustrates the new SmartFusion programming flow. In this flow you can program the
security, FPGA Array, FlashROM and Embedded Flash Memory (NVM) for SmartFusion.

FlashPro JTAG ;
e are FlashPro 4/3/3X |____| SmartFusion

Security Only (no file)

FDB
EFC
UFC

l

FlashPro PDB

Figure 8 - Creating a New PDB for SmartFusion

SmartFusion2 Programming

SmartFusion2 programming is executed from within Libero SoC.
See the Libero SoC help for information on SmartFusion2 programming, including programming
authentication error codes and programming error codes.

FlashPro User's Guide
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Supported Families

Microsemi's Libero SoC software supports the following families of devices:

SmartFusion2
IGLOO2
RTG4
SmartFusion
IGLOO
ProASIC3
Fusion

When we specify a family name, we refer to the device family and all its derivatives, unless otherwise
specified. See the table below for a list of supported device families and their derivatives:

Table 1 - Product Families and Derivatives

Device Family Description
Family Derivatives
SmartFusion2 | N/A Address fundamental requirements for advanced
security, high reliability and low power in critical
industrial, military, aviation, communications and
medical applications.
IGLOO2 N/A Low-power mixed-signal programmable solution
RTG4 N/A Microsemi's new RTG4 family of radiation-tolerant

FPGAs

SmartFusion

SmartFusion SmartFusion intelligent mixed-signal FPGAs are the

only devices that integrate an FPGA, ARM Cortex-M3,
and programmable analog, offering full customization
and IP protection.

Fusion N/A Mixed-signal FPGA integrating ProASIC3 FPGA
fabric, programmable analog block, support for ARM®
Cortex M-M1 soft processors, and flash memory into a
monolithic device.
IGLOO IGLOO The ultra-low-power, programmable solution
IGLOOe Higher density IGLOO FPGAs with six PLLs and
additional 1/0 standards
IGLOO nano The industry’s lowest power, smallest size solution
IGLOO PLUS | The low-power FPGA with enhanced I/O capabilities
ProASIC3 ProASIC3 The low-power, low-cost, FPGA solution
ProASIC3E Higher density ProASIC3 FPGAs with six PLLs and
additional 1/O standards
10 FlashPro User's Guide
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Installing FlashPro Software and Hardware

ProASIC3/EL

Device Family Description

Family Derivatives
ProASIC3 Lowest cost solution with enhanced I/O capabilities
nano
ProASIC3L The FPGA that balances low power, performance,

and low cost

Automotive ProASIC3 FPGAs qualified for automotive
ProASIC3 applications
Military Military temperature ASPE600L, A3P1000, and

A3PE3000L

RT ProASIC3

Radiation-tolerant RT3PE600L and RT3PE3000L

Installing FlashPro Software and Hardware

See the FlashPro Installation Instructions on the Microsemi website for information on how to install
FlashPro software/hardware and relevant system requirements.

View the detailed Install Instructions and System Requirements at the FlashPro software page:
http://www.microsemi.com/products/fpga-soc/design-resources/programming/flashpro#overview

Starting FlashPro

You can start the FlashPro software from Programs > Microsemi FlashPro vx.x >

FlashPro. If you installed the program in a folder other than FlashPro, choose that folder from the
Programs menu.

The figure below shows the FlashPro GUI. From this GUI, you can create a new project by clicking the New

Project button or open an existing project by clicking the Open Project button.

You can also access the above features from the menu bar. You can access all the other features after you
open or create a new project.

FlashPro User's Guide
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FlashPro Interface

The main FlashPro interface consists of two views, one for Single Device Programming and the other for
Chain Programming (see figure below). The GUI consists of a Flow window, Device Configuration Window
(for single or chain programming), Log window and a Status bar. The Log window displays programming
information, error messages, and warning messages. The Status bar displays your programming mode

(chain programming or single device programming) and file status.

T FlashPro - [dddd] (=13

File Edit View Tools Programmers Configuration Customize Help

DEE ? | |@% i |[EE ®Aa & DHHs |5 2

New Project D _> Configure Device E%I _> " mb
OpenProect (" View Proganmers %l —‘

| Frogramirg T
i Modify. ..
'5 DATE_MODIFIED Thu Feb 03 L5:58:14 2011 ~ Mode: ( Basic (% Advanced
FI'B_FILE_NAME V:ikiran\programming designs)fsfide: Action
CREATOR Designer Version: 2.1.2.0
HMODIFIED [PRDGRAM |
"g DESICH dddd
CHECKSTH 7CZF
Procedures. .
3 ¥DB_VERSION 1.6 e
IDCODE 0353ALCF
_!'ll Software Version: 9.1.2.0

Driver : 3.0.0 build 1
progeammer '30964' : FlashProd
Creaced new project 'Viikiran)programning designs)fsf)designes) impliddddd fphldddd.peo’

DESIGN : dddd: CHECESUM : 7CZF; FPDB VERSION : 1.6
Checking for software updates...

PDE file 'Vi\kiran\programming designs\fsfi\designer’ impli’dddd.pdh' has been loaded successfully.

Rescanning for Programmers. ..
Al l,(‘_ElI'EfS A Warnings E Info ?

Ready :kiran\programming_designs!fsf|designerlimpl1\dddd.pdb  STNGLE

Figure 9 - FlashPro for Single Device File Programming

Note the different options in the Flow window for the Chain Programming GUI and the Single Device
Programming GUI. In addition to the different Flow window options, the Chain Programming GUI view

consists of the Chain Configuration window which displays the devices in your chain.
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Creating a New Project
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Figure 10 - FlashPro for Chain Programming

Creating a New Project

With the FlashPro software, you have the option of choosing either the Single STAPL file or Chain
programming mode. You make this choice through the New Project dialog box (see figure below). By
choosing the Chain Programming mode, you are enabling chain programming. The Single STAPL file
Programming mode functions with the same programming capabilities as the FlashPro software v4.2.

To create a new project:
1. Click the New Project button or from the File menu choose New Project.
2. From the New Project dialog box, type in the name of your project in the Project Name field.

New Project E

Project Name:
f projz]

Project Location:
I CiiDocuments and Settingsifarley Browse. .. |

Programming mode

& Single device
" Chain

OF I Cancel | Help |

Figure 11 - New Project Dialog Box

3. If necessary, change the default location of your project in the Project Location field.
4. Choose your Programming mode (Single device or Chain).
5. Click OK. The FlashPro GUI displays (see figure below).

FlashPro User's Guide 13
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Figure 12 - FlashPro GUI

Note: You can switch between the two programming modes from Tools > Mode. From there, you can choose
either Single Device Programming or Chain Programming.

Opening a Project
You can open a project from the File menu or by clicking on the Open Project button in the flow window.

To open a project:
1. From the File menu, choose Open Project. The Open Project dialog box appears.
2. Find your project file or type in your project file name in the File name field.
3. Click Open.

Saving a Project

Click the Save button on the toolbar, or from the File menu choose Save Project to save your project.

If you want to save your project under a different name/path, from the File menu choose Save Project As
and save your project with the new name.

Parallel Programming with FlashPro5/4/3/3X

Parallel programming enables you to program multiple Microsemi devices in parallel with multiple
programmers. In parallel programming, all targeted devices are programmed with the same programming
file (STAPL). The targeted device or chain configuration that is connected to each programmer must be
identical.

The FlashPro software together with the FlashPro5/4/3/3X programmers supports parallel programming via
a USB port. You can connect up to sixteen FlashPro5/4/3/3X's to a PC via a USB v1.1 or a USB v2.0 port.
FlashPro5/4/3/3X requires a self-powered hub.

Connecting FlashPro5/4/3/3X (a USB v2.0 enabled programmer) to USB v1.1 port increases device
programming time due to a slow data transfer rate on the USB v1.1 port in comparison to a USB v2.0 port.

Note: FlashPro (USB/LPT1) or FlashPro Lite programmers do not support parallel programming.
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Serialization with FlashPro

The following figure illustrates how you can connect a FlashPro5/4/3/3X programmer for parallel
programming.

2 FlashPro3 | ProASICIE
H r FlashPro3 3 ProASIC3/E
/ B »
H
u
H / E
u :
B r
H
u
g —r
> FlashPro3 »| ProASICAE
H
" > FlashPro3 ¥ ProASICE
B M/

Figure 13 - Connecting a FlashPro5/4/3/3X Programmer
An independent thread processes the STAPL file during parallel programming. In an Microsemi test, parallel
programming is approximately five times faster than programming 16 devices sequentially.

Note: Microsemi has tested Belkin PCI-USB cards and hubs. We have found that parallel programming works
best with the vendor's latest driver installed and with the matching hubs.

Serialization with FlashPro

You can use the FlashROM in the ProASIC3 device for serialization. For each target ProASIC3 device,
different FlashROM contents are generated.

Serial Programming enables you to program a sequence of ProASIC3 devices in serial with an identical
FPGA program and with different serialization data. Serialization data can consist of different FlashROM
content and/or AES key values. To learn how to activate the serialization feature, see Skip Serial Data or
Reuse Serial Data.

There are two different STAPL formats that support serial programming, multiple actions to multiple serial
data and single action to multiple FlashROM.

Multiple Actions to Multiple FlashROM Serial Data

This format supports a generic STAPL player because the STAPL player does not provide a mechanism for
Serial Programming. One programming action is created to target different serial data. See examples below:

- PROGRAM_1 programs the FPGA Array and the first serial data.

FlashPro User's Guide 15
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- PROGRAM_2 programs the FPGA Array and the second serial data.

Single Action to Multiple FlashROM Serial Data

This format is created when the target programmer is FlashPro, Sculptor II, or BP auto programmer, where
the newly innovated Microsemi Serial Programming mechanism is supported. One programming action will
program multiple serial data in serial.

FlashPro and SVF

SVF (Serial Vector Format) is an industry standard file format that is used to describe JTAG operations. Like
STAPL files, SVF files are used for describing the in-system programming algorithm for SmartFusion,
IGLOO, ProASIC3 and Fusion family devices. Unlike STAPL files, SVF files support only one ACTION or
programming flow per file, due to language limitations. In addition, the SVF specification does not support
message display and flow control, such as conditional statements or loops.

As a result, Microsemi tools (Designer and FlashPro software) generate a set of SVF files corresponding to
the equivalent STAPL ACTIONS that are applicable to the silicon features selected.

For example, for a typical STAPL file that has the following ACTIONS: ERASE, ERASE_ALL, PROGRAM,
PROGRAM_ARRAY, VERIFY, VERIFY_ARRAY, DEVICE_INFO, READ_IDCODE, and
VERIFY_DEVICE_INFO, a set of corresponding SVF files are generated and hamed: ERASE.sVf,
ERASE_ALL.svf, PROGRAM.svf, PROGRAM_ARRAY.sVf, etc. These files are generated in a folder,
<Programming File Name>_svf, created during generation. The diagram below demonstrates the
differences between the STAPL and SVF files that are created.

STAPLFILE SVE FOLDER
PROGRAM PROGRAM.svf
ERASE

ERASE.svf
VERIFY

VERIFY.suf
FROGRAM _ARRAY
ERASE_ARRAY FROGRAM_ARRAY.svf
VERIFY _ARRAY ERASE_ARRAY.swf
DEVICE_INFO

VERIFY_ARRAY.swf

Figure 14 - STAPL vs SVF files
NOTE: DEVICE_INFO.svf file is not generated because SVF files do not support messsage display or flow

control.
Table 2 - SVF Outline
SVF File Array | FROM NVM Security | Previously

(Flash | Settings | Programmed
Memory Device?
System
Builder)

ERASE X X YES or NO

ERASE_ALL X X X YES or NO

ERASE_ARRAY X YES or NO
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SVF File Array | FROM NVM Security | Previously

(Flash | Settings | Programmed

Memory Device?

System

Builder)
ERASE_FROM X YES or NO
ERASE_SECURITY X YES or NO
PROGRAM X X YES or NO
PROGRAM_ARRAY X YES or NO
PROGRAM_FROM X YES or NO
PROGRAM_NVM X YES or NO
PROGRAM_SECURITY X YES or NO
VERIFY X X X YES or NO
VERIFY_ARRAY X YES or NO
VERIFY_FROM X YES or NO
VERIFY_NVM X NO
ENC_DATA_AUTHENTICATION | X YES

STAPL Actions not Available with SVF
The following STAPL actions are not available with SVF: DEVICE_INFO, VERIFY_DEVICE_INFO,

READ_IDCODE

FlashPro and the 1532 File Format

1532 is an IEEE industry standard file format that is used to describe JTAG operations. Like STAPL files,
1532 files are used for describing the in-system programming algorithm for SmartFusion, IGLOO, ProASIC3
and Fusion family devices. 1532 programming file generation will generate two files (*.isc, *.bsd) within a

folder.

& Microsemi

FlashPro and the 1532 File Format

The folder will be created with the following name <Programming File Name>_1532. The *.bsd file contains
the IEEE 1532 programming algorithm. The *.isc file contains the programming data to be programmed into

the device.

IEEE 1532 programming files will only be exported in FlashPro for SmartFusion devices when an FDB has

been properly imported.

STAPL to 1532 Action Mapping
The IEEE 1532 standard requires using default ACTION names in order to function with 1532 compliant

players. The table below describes the STAPL to 1532 ACTION name mappings.

NOTE: 1532 ACTIONs can have a data member parameter to allow reuse of the same ACTION name for

different features.

FlashPro User's Guide
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Table 3 - STAPL to 1532 Action Name Mapping

STAPL Action

1532 Action
ERASE_FROM ERASE(FROM)
PROGRAM_FROM PROGRAM(FROM)
VERIFY_FROM VERIFY(FROM)
PROGRAM PROGRAM
PROGRAM_ARRAY PROGRAM(ARRAY)
ERASE_ARRAY ERASE(ARRAY)
ERASE ERASE
ERASE_ALL ERASE(ALLDATA)
VERIFY VERIFY
VERIFY_ARRAY VERIFY(ARRAY)
READ_IDCODE READ(IDCODE)
ENC_DATA_AUTHENTICATION VERIFY(ENCDATA)
PROGRAM_SECURITY PROGRAM(SECURITY)
DEVICE_INFO READ
VERIFY_NVM VERIFY_NVM

VERIFY_SECURITY

VERIFY(SECURITY)

PROGRAM_NVM

PROGRAM_NVM

STAPL Actions not Available with 1532

The following STAPL action is not available with 1532: VERIFY_DEVICE_INFO

18
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Introductory Programming Tutorials

Single STAPL/PDB File Basic Tutorial

This section provides step-by-step instructions to familiarize you with the basic features of the FlashPro
software, specifically how to program a device. For more detailed step-by-step instructions and help with
advanced features of the software, please see specific topics in the online help.

Note: This tutorial assumes that you have already installed the latest version of FlashPro software and have
started the program.
First, create a new project and name it Tutorial. If FlashPro is launched through the Libero SoC, a new
project will be created automatically and a PDB or FDB file loaded, if available.
To Create a Project:
1. Click the New Project button in FlashPro.
2. Inthe New Project dialog box, type Tutorial in the Project Name field.

Mew Project F?I

Project Mame:

Project Locakion:
| Brawse, .,

Programming mode

* Single device
" Chain

(] 4 | Zancel Help

Figure 15 - New Project Dialog Box

If necessary, change the default location of your project in the Project Location field.
Select the Single device Programming mode

5. Click OK. The FlashPro GUI displays (see figure below). The Programmer List Window updates with
your programmer information.
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T FlashPro - [dddd] * (=13

Fie Edit View Tools Programeners Configuration Customize Help

DM ¢ | on BE 4 S HdH |6 o

Mew Project D _> Configure Device &I _> e T
OpenPioiect (@ View Proganmers %l —‘

e

Frogrammer Programmer Poit Pr P
Name Type Status Enabled
]
E Refresh/Rescan for Programmess
x| Software Version: 9.1.2.0 -~
<l Ipriver : 3.0.0 build 1
programoer '30964" : FlashProd

Ready Wik anprogramining_dessgns\fsfidesignerlimplidddd pdb_ SINGLE

Created nevw project 'Vilkiran\programming_designshfsf)designer’ impll)dddd_fpddddd. pro®

PDE file 'Viikiran\programming designs\fsfidesigner)impll)dddd.pdb' has been loaded successfully.
DESIGN : dddd: CHECESUM : 7C2F; FPDE_VERSION : 1.6

Checking for software updates...

Rescanning for Programmers...

T\al £ Erors ) Wamings ), Info [

Figure 16 - FlashPro Main Window

Loading and Configuring a Programming File

Once you have created your project and connected your programmer, you are ready to load your PDB or
STAPL file.

To load a Programming file:
1. Click the Configure device button. The Single Device Configuration window displays in FlashPro .
2. Click the Browse button to find your Programming file.
3. From the Load Programming File dialog box, select your Programming file and click Open.

The Single Device Configuration Window updates to list your Programming file information and the actions
available with your Programming file in the Action list box (see figure below). Program is the default action
displayed in the Action list box.

Note: Microsemi recommends using the default settings.

x

Prograrnming File

dddd.pdb Browse...
Modify...

DATE_MODIFIED Thu Feb 03 15:58:14 20l P Mode: " Basic * Advanced
PDB_FILE_NAME Vilkiran\programming designs)fsfidesig
CREATOR Designer Version: 5.1.2.0 Achion
bretcH ada PROGAAM =
g CHECKSUM 7CZE
; PDB_VERSION 1.6 Procedures...
._g IDCODE 0353ALCE
% |IDMASK OFFFFFFF
% |FAMILY FUSION
3 DEVICE AFS1500 i
< »
b}
g Chain Parameter. ..
o

Figure 17 - Single Device Configuration Window

This tutorial gives instructions on how to program a device. For an explanation on the other actions
available, see Programming File Actions.

20
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Programming a Device
Now that you have loaded your PDB file, programming a device is the next step.

To program a device:
1. From the Action list, select Program (see figure below).

x  Programming File

dddd.pdb Browse...
Modify. ..

DATE_MODIFIED Thu Feb 03 15:58:14 2011 ~ Mode: " Basic * Advanced
FDE_FILE_NAME Vitkiran\programming desigms) fsfidesig

CREATOR Designer Version: 5.1.2.0 Action

MODIFIED

DESIGH dddd PROGRAM =~
CHECKSUM 7C2E

PDEB_VERSION 1.6 Procedures. .

IDCODE 0353A1CF
IDHASK OFFFFFFF
FANTLY FUSION
DEVICE AFS1500
<

Chain Parameter...

Single Device Configuration Wdindow
v
<

Figure 18 - Selecting Program from the Action List box
2. Click the Procedures button (see figure below).

Action

|PROGRAM =l

Figure 19 - Procedures Button

The Select Action And Procedures dialog box appears, showing the procedures for the Programming
action (see figure below). Microsemi recommends using the default settings.
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Select Action And Procedures @

Action:

v
Procedures I:
W_INITIALIZE

CHECK_AND_BACKUP_CALIE

W DO_ERASE

DO_PROGRAM

v DO_VERIFY_BOL

¥ DO_PROGRAM_RLOCK |
DO_VERIFY_PGM_RLOCK

W DO_PROGRAM_NVM_3 =

Restore Default Procedures
Help OK Cancel

Figure 20 - Select Action and Procedures Dialog Box
3. Click the Restore Default Procedures button.
4. In FlashPro click the Program button to program your device.

The Programmer List Window updates the Programmer Status column with Run Passed indicating that
you have successfully programmed the device (see figure below).

Note: The status indicator updates during programming to show the programming progress, then it will change to
a pass or fail result when the operation is complete.

Programmer Programmer Port Programmer Programmer
Hame Type o Status Enabled
1 /03375 FlazhFro3 ush03375 [USE 1.1)  RUM PASSED v

Figure 21 - Successfully Programmed Device
5. View the Log window and take note of the details about your programmed device.
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Single Microsemi Device with Serialization Tutorial

This tutorial provides step-by-step instructions on how to program a single Microsemi Device with
Serialization. Before you begin this tutorial, make sure you have already installed the FlashPro software and
that you are familiar with the basic features of using the FlashPro software.

First, create the file generator using FROM for device serialization. You must have access to the Libero IDE
v8.0 or later software to complete this step.
To Configure the FROM data for serialization:

1. Generate FROM via the Catalog.

2. From the Properties section in the FlashROM Settings dialog box, select Auto Inc or Read From
File region. For the Auto Inc region, specify the step value. You will not be able to modify this value in
the FlashPoint software.

Complete the normal design flow and finish place and route.
Select Program FlashROM .
Click Browse to find the UFC file.

N

Check the FPGA Array box and click Next. The FlashROM Settings window appears (as shown in the
figure below).

FlashROM Settings - Step 2 of 2 X
FlashROM regions: Region_7_10 LI
Program Properkies:
page Hame Region_7_10
I~ Start page 7
Start word 10
v Length 5
Content Static:
W State Fixed
I3 Type HE*
W alue 123123
I~
=2
v
=2
FlashROM STAPL File bype
’7 " Single STAPL fil for all devices " One STAPL fils per device
Mumnber of devices ko program: 100 Target Programmer... |
Help | Back I Texk I Finish | Cancel |

Figure 22 - FlashROM Settings- Step 2 of 2
7. Select the FROM page you want to program and data value for the configured regions.
Note: The generated STAPL file contains only the data that targets the selected FROM page.

8. Modify properties for the serialization by specifying the Start and Max values. For the Auto Inc region,
specify the Start and Max values. For the Read From File region, select the file name of the custom
serialization file.

9. Select the FlashROM programming file type you want to generate from the two options below:
e Choose single STAPL file for all devices: generates one programming file with all
FROM values.
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Choose one STAPL file per device: generates a separate programming file for each

FROM value.

10. Enter the number of devices you want to program and generate the required programming file.

11. Click the Finish button.

You have completed the steps to enable device serialization. Now you are ready to program a device using

Device Serialization in FlashPro.

To program a device using device serialization:
1. Click the New Project button in the FlashPro.
2. Inthe New Project dialog box, type Tutorial in the Project Name field.
3. Check the Single STAPL file option from the Programming Mode area.
4. If necessary, change the default location of your project in the Project Location field.
5. Click OK. The FlashPro GUI appears (see figure below).

Y FlashPro - [dddd] * EEX

File Edt “iew Tools Programmers Configuration Customize Help

DEdE ¢ | i BE 4 & £HDa |6 0

Configure Device E%I
View Programeners %l

= PROGRAM Tl

|

dddd.pdb Briwise. ..

i Modify. ..
B :
% |DATE_MODIFIED Thu Feb 03 15:58:14 2011 -~ Mode:  Basic ( Advanced

POB_FILE_NAME V:\kiran\prograsming designs)fsfide: Aciion

CREATOR Designer Version: 2.1.2.0

MODIFIED [PROGRAM -
"g DESIGH dddd

CHECKSUH 7C2F
g PDB_VERSION 1.6 ocadies

IDCODE 0353ALCE ~
x| Software Version: 9.1.2.0 ~
2l Ipriver : 3.0.0 build 1

programmer '30964' : FlashProd

Created nev project 'Vilkiran\programming designs\fsf\designech implltdddd f£p\dddd.pro’

PDE file 'Vi\kiran\programming designs)fsfidesigner’ impll)dddd.pdh' has been loaded successfully.
DESIGN : dddd: CHECESUNM : 7CIF; FDB_VERSION : 1.6

Checking for software updates...

Rescannlnq for Programmers. .. !
i Elrnrs ,\ ‘Warnings x Info ?

Wi {kiraniprogramming_designs!fsFidesignerlimpl1\dddd pdb  STNGLE

Figure 23 - FlashPro Main GUI
The Programmer List Window updates with your programmer information.

6. Click the Configure STAPL File button to load the STAPL file. The Single STAPL Configuration

Window appears in the FlashPro GUI.
Click the Browse button to find your STAPL file.

From the Load STAPL File dialog box, find your STAPL file and click Open. The Single STAPL
Configuration Window updates to list your STAPL file information and the actions available with your
STAPL file in the Action list box (see figure below).
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x | [~ Prograrmenang File

[ Serialization
rrim, pidb Browse..,
Modify. ..
[ATE_MODIFIED Sat Jan 29 19:32:14 2011 ~
PDB_FILE_NAME V:ikiram\programming designs\sf_ser)de Action
CREATOR FlashPro Versiomn: 5.1.2.0
MODIFIED FlashPro Version: 9.1.2.0 [pﬂuﬁw j
,g DESIGH
£ |CHECESUM 000
§ [pe_verstow 1.6 Proceduses...
3 | |IpCODE 05R13LCF
IDMASE ODFFFFFF
FAMILY PAISOCE M
£ >
§
o Chain Parameter. .. Inspect Device
$

Figure 24 - Single STAPL Configuration Window with STAPL File Uploaded

9. From the Single Device Configuration Window in FlashPro, check the Serialization box and click
the Select Serialization Indexes button.

The Serial Settings dialog box appears (see figure below).

Serial Settings [5_<|

[ e B I = p B ) B S R

[v Yiew unused data
[v Yiew used data
v ‘iew skipped data

Filker: | *

v Log serial data: |Regi|:|n_6_3 ﬂ

Help

o All

Hild»

o]

Cancel |

Figure 25 - Serial Settings Dialog Box

10. From the Serial Settings dialog box, click All to select all the serial data.

11. Click OK. The Serialization Indexes text box updates (see figure below).
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W Serialization
Senalization

Action; |F'F|E|I3F|,£'-.h-1 ﬂ Procedures...

| i Select Senalization Indexes.. |

Seral Indexes | State | Frogrammers |

druzed
Jnuzed
Jnuzed
Jnuzed
Jnuzed
Jnuzed
Jnuzed
Jnuzed
Jnuzed
1] Jruzed

P 5 R Y 3 S Y P R S

Mext Senalization Data: 1

Figure 26 - Single STAPL File Configuration Window- Serialization Indexes Update
12. Click the Program button to program your device using serialization.

Chain Programming Tutorial

This tutorial demonstrates how to directly program an APA300 device that is part of a heterogeneous JTAG
chain. The example in this tutorial uses one APA300 device and three non-Microsemi devices configured as
shown in the figure below.

Note: This tutorial is performed in Advanced Mode. You can change your display mode to Advanced Mode from
the Preferences dialog box.

DO Device & Device 3 Device 2 Devicel
o — [ 00 TOI TDO oI TDO oI TDO |

TMS ™S ™S ™S ™S
- ‘ ‘ - | APA300
TCK T Nor-Actel —| 1o Non_Actel — 1o Non-Actel ’,TCK

Figure 27 - APA Device Tutorial Example
First, create a new project.

To create a new project:
1. Click the New Project button in FlashPro.
2. Inthe New Project dialog box, type Tutorial in the Project Name field.
3. Select the Chain option in the Programming Mode.
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Chain Programming Tutorial

X

Mew Project

Project Mame:

| Tutoriall

Project Locakion:

| Cihackelpriy Tutorial Browse, .,

Prograrming mode

" Single device
{* hain

(0] 4 | Cancel Help

Figure 28 - New Project Dialog Box

4. If necessary, change the default location of your project in the Project Location field.
5. Click OK. The FlashPro GUI appears (see figure below).

A FlashPro - [Tutorial]

File Edit View Tools Programmers Configuration Customize Help

O = AL R R < Y EHE = @
Mew Project ﬁ i onfigure Chain
Open Project Dﬂ Wiew Programmers j
x
Programmer Programmer Progi Prog : ,
Mame Type Port Status Enabled Device / Action

i
a
[=4
=
b
£
5 Refresh/Rescan for Programmers
g
&
= Software Version: §.0.0.40
o] Created new project 'C:hActelprj\fpro tutorialbtutorial.pro’
Software Version: §.0.0.40
Created new project 'CitActelprilTutorial’Tutorial.pro'
All l/{' Errors }\' Warnings l}\‘Inl’o l/r
Ready Mo devices in chain |CHAIN

Figure 29 - FlashPro Main GUI
Note: The Programmer List Window updates with your programmer information.

6. From the Menu bar, click Programmers > Scan Chain (or select the programmer in the Programmer
List Window, right-click and choose Scan Chain).

Scan Chain shows how the devices are ordered in the chain in the Log window (see figure below). In this
example, APA300 is the first device and will be programmed first in the chain since it is connected directly to
TDO.
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x| programuer '3I0175' @ Soeakn Chain. ..

I programmer '30175' 1 Found 32 instruction register bits.
prograuer '30175' @ Checking IDCODE=s...
progratener '3I0175' @ Dewvice 1: 11A081CF Mfr: Ahctel Part: APLIO0O0
prograreer '30175' 1 Dewviee 2@ Unknown
programmer '30175' : Dewvice 3: Unknown
progratener '3I01TS' @ Dewvice 4@ Unknown
prograteer '30175' @ 3cakh Chain PASIED.

Figure 30 - Log Window Scan Chain Order
| Add Actel Device ﬂ or

7. From the Chain Configuration window, click either

fdd Morn-dctel Device
buttons to add devices to the chain. In this example, click the Add
Microsemi Device button because the APA300 is the first device in the chain.

The Add Microsemi Device dialog box displays (see figure below).

Add Actel Device [X]

Pragrammming File: | J

" Device

Device: | J

MNarne : |

Help Ik | Cancel

Figure 31 - Add Microsemi Device Dialog Box

Select the File radio button and click the Browse button to find your programming file.
Select the Device radio button, then choose the APA300 device from the Device drop-down.

10. Inthe STAPL File field, load the APA300.stp file by using the Browse button '™ to locate the file.
11. Inthe Name field, keep APA300 as the default name.
12.  The APA300 device is added to the Chain Configuration Window (see figure below).

x—i{TDI N TDO}—O...—.{TDI 2 TDOHTDI 1 TDO}—O

Iv Show Chain Editing

Device Hame File

= 4P

1 | &PA300 oo
[¥] | Device 2

300 O CManualstestidesignerimpl VPAZD0 stp E]I
2 | Mon Actel

Figure 32 - Chain Configuration Window: Device One

13. Click the Add Non-Microsemi Device button to add the non-Microsemi device. The Add Non-
Microsemi Device dialog box appears (see figure below). You can load the BSDL file or enter the IR
length and Max TCK Frequency of the device. In this tutorial, you will enter the IR length and Max TCK
frequency for this device.
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Add Mon-Actel Device

X

£ File
BSDL file: | [

(* Data

IR, length: z
Max TCK Freq.: |1 MHz

[arne: | Device 2

Help I | Cancel

Figure 33 - Add Non-Microsemi Device Window
For this device, enter 8 in the IR length field and keep the Max TCK freq default to 1IMHz.

Name the device, "Device 2" and click OK. The second device now appears in the Chain Configuration
Window (as shown in the figure below).

x—i{TDI N TDO}—O...—.{TDI 2 TDOHTDI 1 TDO}—O

Iv Show Chain Editing

14.
15.

File
8P 4500 O CManualstestidesignerimpl VPAZD0 stp E]I
Actel

Figure 34 - Chain Configuration Window: Device Two

16. Repeat step 15 for Device 3 and Device 4.

17. Check the Enable Device box for the APA300 device. After you add all the devices in the chain, the

Chain Configuration Window should look like the figure below.

x—i{TDI N TDO}—O...—.{TDI 2 TDOHTDI 1 TDO}—O

Iv Shaowe Chain Editing

Device Hame File
1 | APA3OO [l APA3OO O CManualstestidesignerimpl! WRAIN0 stp =]
2 | Mon Actel [ |Device 2
3 | Mon Actel [ |Device 3
4

Mon Actel (=]

Figure 35 - Chain Configuration Window: All Devices in the Chain

After you have added all of the devices to the chain in the correct order, click the Run button to
program the chain.

18.

19. When programming is complete, the results are listed in the Log window (see figure below).
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x| programewer '30175' @ Scan Chain. ..
L] programoer '30175' @ Jcan Chain PAISED.
programmer '30175' : device 'APAS00' : Executing action PROGRAM
programmer '30175' @ device 'APA300' : SERIAL# = OC1DFA7EEOGOS0
programmer '30175' @ device 'APA3IO0OO0' @ PROGRAMMING ARRAY
programeer '30175' @ dewice 'APASOD' : VERIFYING PROGRAMMED EITS. ..
programeer '30175' @ dewvice 'APAI00' : VERIFYING NON-PROGRAMMED BITS...
programoer '30175' @ device 'ALPAS00' @ Finished: Tue Jul 18 15:09:59 Z006 (Elapsed tiwe 00:03:00)
programoer '30175' @ device 'APASO0' @ Executing action PROGRAM PASSED.
programmer 30175 @ Chain progrssaning PASSED.
0O-o0-0-0-0-a0

Figure 36 - Programmer List Window: Programming Complete

SmartFusion Programming Tutorial

You can program your SmartFusion device without using the Libero SoC by using an EFC or UFC file from
standalone SmartDesign, or using an FDB file from standalone Designer.
To program a SmartFusion device without using the Libero SoC:

1. Start FlashPro and click New Project to create a new project. Specify your Project Name, Project
Location and Programming Mode.

Click Configure Device.

Single Mode: Click the Create button to create your new PDB programming file. The create PDB
dialog box appears (as shown in the figure below).

Create PDB g|

Device: | A2F200M3F =]

Package:

Mame: | smartfusion_0113

Location: | Ciactelpritsmartfusion_0113

[o]4 | Cancel |

Figure 37 - Create PDB Dialog Box

Chain Mode: Click Add Microsemi Device and choose a SmartFusion device from the drop-down menu.
Click the Create PDB button in the Chain Configuration Window. The Create PDB dialog box appears.

4. Specify your PDB parameters. Click OK to continue. The FlashPoint SmartFusion Programming File
dialog box appears.

5. Specify your security settings and select which silicon features you want to program. Click the Import
button for your EPGA Array, FlashROM and Embedded Flash Memory files to add them to your PDB
file.

You must have a FDB file to program your FPGA Array, a UFC file to program your FlashROM, and a
EFC file to program your Embedded Flash Memory.

Click the Modify buttons if you wish to modify your FlashROM or Embedded Flash Memory files
before you save your PDB file.

6. (Optional) Specify your I/O States During Programming.
7. Click Save PDB to save your new PDB file.

If you make changes to your Security, /0O States During Programming, EFC, UFC or FDB file, click Modify
in FlashPro to open and re-save your PDB with the updated files and settings.

See Reprogramming a Secured Device for information on programming a secured SmartFusion device.
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Modifying Memory Contents and Programming a Device Tutorial

This tutorial provides step-by-step instructions on how to load a Program Database (PDB) file, modify the
memory contents, and program the device.

Before you begin this tutorial, you should have a design with an EFMB client in it with a generated
programming file for this design. You will first create a new project and title it "tutorial.” If FlashPro is

launched through Libero SoC, a new project will automatically be created and a PDB file will be loaded, if
available.

Creating a new project

If you are familiar with this feature, follow the basic procedures for creating a new project. However, if you

would like step-by-step instructions, see the creating a new project section in the Single STAPL/PDB File
Basic Tutorial.

Loading and Configuring a PDB File
Once you have created your project and connected your programmer, you are ready to load your PDB file.
To load a PDB file:

1. Click the Configure Device button. The Single PDB Configuration window appears in FlashPro.
2. Click the Browse button to find your PDB file.
3. From the Load PDB File dialog box, find your PDB file and click Open.

Modify Embedded Flash Memory Block Content
Now, you are ready to modify the Embedded Flash Memory Block content.
To modify Embedded Flash Memory Block content:
1. Click the PDB Configuration button to open FlashPoint.

FlashPoint - Programming File Generator - Step 1 of 3

silicon feature(s) ko be programmed:
e [ Security settings
[ FPGA Array
W FlashRoM
Criginal FlashRoOM configuration File:

Embedded Flash Memary Blocks (EFME]:

Program ﬁl‘;ﬁt LE:;::;:;“ Onginal Configuration File
1 ~ firmwwareh MYk .. 1 F:\Flash_Memon_Block.efc Fadify...

[~ Programming presviously secured deviceds)

Modify I/O States During Programming. ..

Silicon signature {max length is & HEX chars):

Help Mext Finish Cancel

Figure 38 - Program File Generator
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Check the Program box.

3. Click the Modify button to import Embedded Flash Memory Block configuration and memory content
file. The Modify Embedded Flash Memory Block dialog box appears

Modify Embedded Flash Memory Block

Block name:

Block location:

Block content:

Block configuration File:

Select All Clients

Firmuware) NYM_INST

1

Duhprod80auditinvm_all_newirnvm_all_new.efc

Unselect All Clients

Impart Configuration File. ..

X

Help

Ok |

Start ) JTAG Protection
Program [Client Type | Client Name | Address |, LNt [ pieyent [ Prevent | Original Memory Content File

[hex] b Read Wirite
q Ird Analog Spste  ash MNia MN/& I i
2 ¥ CFl Data cfiData Mia N/& I i D:AprodB0auditsnym_simplehinput_m Import content..
3 [~ Data Storage ds 1} X8 I I Dr:\prodB0auditsnvem_simpletinput_m Import content..
4 [~ Initizlization  init1 a0 18 I I [:AprodB0auditsnym_simpleXinput_m Import content.
[ ¥ RAM Initizlizat ramirit 100 5128 I I

Cancel ‘

Figure 39 - Modify Embedded Flash Memory Block Content Dialog Box

4. Click the Import Configuration File button to import the Embedded Flash Memory Block configuration
and memory content from the EFC file. This will populate the client table below. All clients that belong
to this block will be selected by default.

5. Click the Import content button if you want to change the client memory content.
6. Click OK.
7. Click Finish.

Note: FlashPoint audits original configuration and memory content files and warns you if the files cannot be
located or if they have been updated. These files are not required as the last updated configuration and memory

content is stored in the PDB.

Ernhge—t=t—t 1

The original configuration file has changed.
Click on the Modify button to view the details,

~

al Configuration File

ctelpriFlashProtFusion Viewhsm | paodify,.

Figure 40 - Audit Warning

Proceed to program the device. For steps on how to program a device, see the Programming a device
section of the Single STAPL/PDB file basic tutorial.

Modifying FlashROM Contents and Programming a Device Tutorial

This tutorial provides step-by-step instructions on how to load a Program Database (PDB) file, modify the
memory contents, and program the device.

Before you begin this tutorial, you should have a design with an EFMB client in it with a generated
programming file for this design. You will first create a new project and title it "tutorial.” If FlashPro is
launched through the Libero SoC Project Manager, a new project will automatically be created and a PDB
file will be loaded, if available.

Creating a new project
If you are familiar with this feature, follow the basic procedures for creating a new project. However, if you
would like step-by-step instructions, see the creating a new project section in the Single STAPL/PDB File

Basic Tutorial.
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Modifying FlashROM Contents and Programming a Device Tutorial

Loading and Configuring a PDB File

Once you have created your project and connected your programmer, you are ready to load your PDB file.

To load a PDB file:
1. Click the Configure Device button. The Single Device Configuration Window displays in FlashPro
(see figure below).

x |~ Programming File
T conkinue,

Inad existing programming file Browse. ..
of create new POE file

e e

Sirgle Device Configuration Yiindow

Figure 41 - Single Device Configuration Window

2. Click the Browse button to find your PDB file. From the Load Programming File dialog box, find
your PDB file and click Open. .

Modify FlashROM Content
Now you are ready to modify the FlashROM content.
1. Click the PDB Configuration button. This opens FlashPoint.
2. Select FlashROM under Silicon feature(s) to be programmed (see figure below).

X

FlashPoint - Programming File Generator - Step 1 of 3

Silicon Featurels) to be programmed:
o Iv Security settings
v FPGA array
I¥ FlashRomM
Criginal FlashROM configuration File:

Embedded Flash Memory Blocks (EFMB):

Program :I;ﬁt LE(I:ztl:iI:Jn Original Configuration File
1 Ird firmwareh /N 1 F:AFlash_Memomy_Block. efc Modify...

[ Programming previously secured deviceds)

Modify I/ States During Programming. ..

Silicon signature (max length is 8 HEX chars):

Help et Finish Cancel

Figure 42 - FlashPoint Programming File Generator
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3. Click the Browse button to select the *.ufc FlashROM configuration file by and navigating to the
configuration file. This file is normally present in the SmartGen subfolder of the Libero SoC project, in a
folder with the FlashROM IP block's name.

Click Next.
Select the FlashROM pages you want to program (see figure below).

FlashROM Settings - Step 2 of 2

|FIashROM regions: Region_0_0 LI
Program Propertigs:
page Marmne Fegion 0 0
2 Start page 1]
Start word 1}
v Length 16
Content Static
g State Fized
v Tvpe HE¥
Walue F14FEFFAF240 341361
= SESERDO1104080
v
v
2

Help | Back I Textk I Finish Cancel

Figure 43 - FlashROM Settings Dialog Box

6. Click Finish.

Proceed to program the device. For steps on how to program a device, see the Programming a device
section of the Single STAPL/PDB file basic tutorial.

Programming Only Security Settings Tutorial

This tutorial provides step-by-step instructions on how to program only the security settings into a device.
No design or PDB file is needed to follow this tutorial.

First create a new project and name it tutorial. If FlashPro is launched from the Project Manager, a new
project will automatically be created and a PDB file will be loaded, if available. For this tutorial you always
need to create a new project.

Creating a New Project
If you are familiar with this feature, follow the basic procedures for creating a new project. However, if you
would like step-by-step instructions, see the creating a new project section in the Single STAPL/PDB file
basic tutorial.

Configuring the Security Settings

Once you have created your project and connected your programmer, you are ready to load your PDB file.
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Programming Only Security Settings Tutorial

To configure the security settings:
1. Click the Configure Device button. The Single Device Configuration window appears in FlashPro
(see figure below).

x|~ Programming file
To continue,

lnad existing programming file Browse...
or create new PDE file

EETE [Cisinnis |

Single Device Configuration Window

Figure 44 - Single Device Configuration Window
2. Click Create. This opens the Create PDB dialog box, as shown in the figure below.

Create PDB P§|

Device: | j
Package: | ﬂ

Mame: | |

Location: |

K | Zancel |

Figure 45 - Create PDB Dialog Box

3. Select the desired device and package (if available) from the drop down list, and specify the filename
and location. Click OK. FlashPoint opens. SmartFusion, IGLOO, ProASIC3 and Fusion family devices
support securing the device with a pass key as well as encrypting programming files using an AES
key. Flash devices can also be permanently locked, preventing reprogramming.

4. Check the Security Settings checkbox to secure the unsecured device.

Warning: Make a note of the security keys that you are using. Once a device is secured, it cannot be
reprogrammed without those keys.
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Security Settings - Step 2 of 2
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- |Jse the Pass Kev ko write or verify,

Medium

- Lock the FlashROM For both reading and writing wia the

ITAG interface,

- |Jse the Pass Key ko read or write,

= —  Mone b
Custom Level... Default Lewvel |
Pass Key (max length is 32 HEX chars):
& | Generate random key |

BES key (max length is 32 HEX chars):

Help Back | Finish | Cancel

Figure 46 - Security Settings Dialog Box

5. Click Finish.

Proceed to program the device. For steps on how to program a device, see the Programming a device
section of the Single STAPL/PDB file basic tutorial.

Automatic Chain Construction Tutorial

This tutorial demonstrates how to automatically scan a chain of devices and construct the chain within
FlashPro. Automatic chain construction saves the effort of manually adding each device to your chain.
The software also scans the chain before constructing it, which reduces the possibilities of having errors in
the chain. This feature is fully automated if your chain is composed of only Microsemi devices. If you have
non-Microsemi devices in your chain, you can still use the Auto Chain Construction feature. However, you
will be required to either manually add the BSDL file or enter the IR length and max TCK for each non-
Microsemi device. This tutorial goes through the flow for an Microsemi-only chain first, followed by
instructions on adding Non-Microsemi devices to the database.

Note: This tutorial requires that your chain is connected to the computer you are using, via an Microsemi

programmer, and that you have suitable programming files to program the devices in your chain.

To automatically scan a chain of devices and construct the chain:
1. Start a new project in FlashPro. Select Chain as the Programming Mode.
2. Click the Configure Chain button in FlashPro.

3. From the Configuration menu, choose Construct Chain Automatically; or click the Construct the
chain from a Scan Chain operation link in the Chain Configuration Window, see below.
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Automatic Chain Construction Tutorial

¥ FlashPro - [Tutorial] *

File Edit “ew Tools Programmers Bselie(fEl N Customize  Help

DEHE 2| %%

Add Actel Device...
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(Construck Chain Automatically...

Open Project Dﬁ' View Programmers %

Figure 47 - Construct Chain Automatically
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4. A popup appears asking you to select the programmer you would like to use from the ones attached to
your computer. Choose the appropriate programmer (as shown in the figure below) and click OK.

X

Scan Programmer(s)

The device chain will be automatically built to match the
phrysical chain of one ar more programmers,

Select the programmeris) wou wank to scan:

Frograrmmer(z]

30964

Select Al | Unselect Al

Help

Figure 48 - Select Programmer Popup

Zancel

Automatic chain construction starts. The Log window documents the detection and verification of all devices
in your chain. The devices are added to the chain in the Chain Configuration Window; see figure below for
an example.

Y FlashPro - [mm]*

Fle Edit Wiew Tooks Programmers Configuration Customize Help

DER ? |sa% o BE A @ @D o) o
Programmer Programmer Prog Prog - c
Illlm Type Port Status Enabled Device / Action
1 | 30964 FlashProd usb30964 (USB 20) SCAN CHAIN PASSED cd
Refresh/Rescan for Programmers .| RUN IE!!B |
x o
- Add Actel Device 174 |
—-|rn| N rnol—-no —-|r|)| 2 rnol—-lrnl 'I TDO}—- Create PDB... | Conifigure Device... | ﬂ ﬂ &
Add Non-fictel Devicel
¥ Show Chain Ediling Inspect Device |
- - IR Max TCK = Enable = Enable B Serial
Device MName File Length (MHz) Device | Seral Action
1| AIPILNWAGLL B AIPILNVAGLINGS

Data HIGH-Z
(=] 8 10 | mf
2 | AFSEO0 = | AFSEND a

r

Figure 49 - Scan Chain Configuration Passed
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In some cases, FlashPro is not able to uniquely identify the device due to shared IDCODEs, and lists all
possible devices (ex: AGL030V2/AGL030V5). Once a programming file is loaded for that device, the device
field only shows one device, since the programming file will only be targeted to one device.

Adding Non-Microsemi Devices to the Chain

FlashPro recognizes non-Microsemi devices in the chain, but it does not contain any device information,
such as IR length or Max TCK. The figure below lists Microsemi devices and non-Microsemi devices in the
chain.

indow

: Add Actel Device 14 |
_-|rn| N 1|)o|_- POy _-|1|)| 2 rnoI_-|r|;| 1 T00|—' Create PDB... | Configure Device... | il iJ il
Add Nan-dctel Devics
[¥ Show Chain Editing Inspect Device
- = IR Max TCK  Enable = Enable c Serial
Device Name File Length (MHz) Device | Serial Action Data HIGH-Z

1 ASPILINJ/AGLL B AZPILINVAGLINIZS = 8 10 r L

2 AFSEOD = | AFSE00 8

3 MonActel B devicel 2 1

4 MonActel | device2 2 1

5  MNonActel ™| deviced 2 1

Figure 50 - Non-Microsemi Devices in a Chain

You must import the BSDL file into Microsemi's non-Microsemi device database for FlashPro to recognize
your non-Microsemi device.

To import the device BSDL into the FlashPro non-Microsemi device database and run the scan
chain:

1. From the Tools menu, choose Import Settings for Non-Microsemi Devices. This opens the Import
Settings for Non-Microsemi Devices dialog box. This dialog box enables you to import and remove
BSDL files from the database and lists all the device information contained in the BSDL file.

2. Click the Import BSDL Files button and navigate to the folder that contains your BSDL files. Select
the file and click OK. Once the BSDL is imported into the database, the original BSDL file is no longer
audited by FlashPro. If changes are made to the original source BSDL file, it will not affect the BSDL
file that has been imported into the non-Microsemi device database.

Remove BSDL files from the database by selecting the file and clicking the Remove button.

3. Once you have the appropriate BSDL files loaded to the database, you can construct the chain. To do
so, from the Configuration menu, choose Construct Chain Automatically and select the appropriate
programmer from the dialog box. FlashPro runs a scan chain, detects the devices in the chain, and
associates them with the BSDL files in the database, as shown in the figure below.

-|1D| N'IDO}—vu.—+IDI 2 'IDOH'IDI 1 rno}—- CrestePDB.. | ConigweDevice. | 4| #| X| E |

Add Nonvhctel Device
¥ Showe Chain Editing ——J
5 - IR Max TCK = Enable Enable = Serial
orIce W A3 Length = [MHz) | Device Serial Aeuon Data HIGH:2

1 | Mon Actel ™ devicel 2 1

3 | Mon Actel ™ deviced 2 1

4 | AFSEOD = 4FS600 @ B8 10 L |

5 | AIPLN)AGLI B ASPILNVAGLINIZS =] 8 10 r r

Figure 51 - Non-Microsemi Devices in the Chain with Associated BSDL Files

It is possible to add multiple BSDL files to your Non-Microsemi device database that have the same
IDCODE. If the BSDL files list the same IR length but different TCK values, FlashPro automatically chooses
the file with the lowest TCK value by default and no action is required. If the IR lengths are different you
receive an error message asking you to resolve the conflict.

To resolve the issue, click the drop-down arrow adjacent to the device name. This opens the Non-Microsemi
Device Configuration dialog box (as shown in the figure below). From here you can choose the BSDL file
that you wish to use. Browse to the BSDL file or use the Data to input the IR length and Max TCK
Frequency. Once you select your data you can enter a new name or use the default.
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eNVM/EFMB Client JTAG Protection Use Flow
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" Data
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Help (4 | Cancel

Figure 52 - Non-Microsemi Device Configuration Dialog Box

For a tutorial on manually adding both Microsemi and non-Microsemi devices to your chain as well as
programming the chain, refer to the Chain Programming Tutorial.

See Also
Understanding the Chain Configuration Window
Import Settings for Non-Microsemi Devices

eNVM/EFMB Client JTAG Protection Use Flow

eNVM/EFMB client JTAG protection enables you to protect specific clients with a User Pass Key while
leaving others unprotected.

See the eNVM Client JTAG Protection Tutorial or EEFMB Client JTAG Protection Tutorial for step by step
instructions.
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Figure 53 - eNVM/EFMB Client JTAG Protection Tutorial Use Flow

eNVM Client JTAG Protection Tutorial - SmartFusion

This tutorial provides step-by-step instructions on how to enable JTAG protection for eNVM clients. The
protection can be read, write or both and it is protected with a User Pass Key (FlashLock).

The JTAG protection of eNVM clients enables you to protect specific clients with a User Pass Key while
leaving others unprotected.

One example use is IP customization. This enables an IP vendor to allow limited visibility to eNVM clients for
IP customers. The IP vendor can protect specific clients and leave other clients unprotected for modification
by IP customers. See the eNVM/EFMB Client JTAG Protection use flow diagram for a detailed example of a
typical use case.

Before you begin this tutorial, make sure you have already installed the FlashPro software and that you are
familiar with its basic features.

JTAG READ/WRITE protection is set when you create your original eNVM in Libero SoC. You cannot
change this setting in FlashPro/FlashPoint.
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eNVM Client JTAG Protection Tutorial - SmartFusion

Importing an EFC (Embedded Flash Configuration) File with Client JTAG protection in a
Previously Unsecured PDB

1. Create a client in eNVM configurator with JTAG read and write protect (as shown in the figure below).

If the MSS block is generated with an eNVM client with JTAG protection then FlashPro requires that
you specify a User Pass Key prior to programming or exporting programming files.

Add Data Storage Client @

0K

Cliertt name: |Legr_1
ety
Content:
o Iemory file: |E:\d&a\anDnn:$\Fmg|amnhg\eNVH JTAG P
Format: ActelBinay = Browse...
" Mo content [client iz 2 placeholder)
) [ Use absolute addressing
Start address: Ox (B0 _%l
Size of word: 8 | bits
Murnber of words: 3 [decimal]
JTAG Protection
¥ Prevent read W Prevent wite
Cancel

1

Figure 54 - Generating the EFC File with JTAG Protection

2. Import the EFC file with JTAG protection in FlashPoint. When the EFC file is imported the Security
Settings box is checked automatically, implying that you must set the User Pass Key (as shown in the

figure below).
The PDB file cannot be saved without specifying the pass key.
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Figure 55 - Importing the EFC File with JTAG Protection

3. Click Specify to open the Security Settings dialog box. Notice that Enable eNVM client JTAG
protection box is checked. This indicates that reading, writing, and verifying of other eNVM pages are
allowed but the reading and writing of specific eNVM clients are protected.

4. To enforce the eNVM client JTAG protection in the PDB file, enter a Pass Key or click Generate
random key (as shown in the figure below).
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eNVM Client JTAG Protection Tutorial - SmartFusion

Security Settings E|

Serurity level For this device:

" High Mo protection
" Medium - Allow writing and verifying of the FPGA Array,

- Allow reading, writing, and verifying of the FlashROM,
¥ Enstle ety client ITAG protection g ik
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Pass Key (max length is 32 HEX chars):
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AES Kev (max length is 32 HEX chars):

Help oK Cancel

Figure 56 - Setting Security

Custom Level Security Settings

If you select Custom Level security and decide to protect writing of the entire eNVM block, then the eNVM
client JTAG protection Write, if enabled, will be overridden by full block protection.

If the Read protection of the eNVM block is left open, then the eNVM client JTAG protection Read will be
enabled if a client has a read protection enabled.

If you choose to encrypt the entire eNVM block, then the eNVM client JTAG protection Write will be disabled
if enabled, due to enforced encryption. The eNVM client JTAG protection Write, if enabled, will be
overridden by full block protection.

To set Custom Level Security:

1. Click Custom Level to open the Custom Security Level dialog box (as shown in the figure below)
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Figure 57 - Setting Security for Unprotected eNVM Clients

2. Click the Set Security checkbox to secure Read, Write and Verify using Flash Lock. In this mode you

can unlock Read and Verify and only protect Write by FlashLock. The eNVM client JTAG read
protection will be enabled.

3. Click the Encrypt checkbox to secure Write using the AES Key. Read, Verify will be secured by

FlashLock in this mode. You must enter the AES key in addition to the Pass Key before saving the
PDB file.

Setting Standard Security Levels

There are two types of standard level security: High and Medium. If either of the two is selected the eNVM
client JTAG protection is overridden or disabled. You can enforce Read, Write and Verify protection of the

entire eNVM block with the Pass Key and/or AES key. JTAG protection of specific pages will not be
available.

Importing EFC (Embedded Flash Configuration) File with Client JTAG Protection in

P

reviously Secured PDB
The secure PDB file exported from FlashPro is called a secured PDB.

If you import an EFC file that has JTAG protection into a secured PDB file but does not have eNVM clients
with JTAG protection enabled then the FlashPro returns an EFC file has eNVM client JTAG protection
and cannot be loaded error, as shown in the figure below.
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EFMB Client JTAG Protection Tutorial - Fusion

EFC filz has eNYM client JTAG protection and cannot be loaded,
Security cannot be modified in a currently secured PDB.

Ok

Figure 58 - EFC File with JTAG Protection Cannot be Imported into a Secured PDB Error Message
You can import any EFC file that does not have JTAG protection.
You cannot import a new EFC with JTAG protection into a secured PDB that already has an EFC file

imported with eNVM client JTAG protection. You can update the memory content by importing MEM files for
the specific clients (as shown in the figure below).

‘-\ Currently loaded EFC has eMVM client JTAG protection and
! cannot be changed in a currently secured PDB.
You can update memory content by importing
mem File for each individual client.

Ok

Figure 59 - New EFC File Cannot Overwrite Existing eNVM Client JTAG Protection Error Message

EFMB Client JTAG Protection Tutorial - Fusion

This tutorial provides step-by-step instructions on how to enable JTAG protection for eNVM clients. The
protection can be read, write or both and it is protected with a User Pass Key (FlashLock).

The JTAG protection of EFMB clients enables you to protect specific clients with a User Pass Key while
leaving others unprotected.

One example use is IP customization. This enables an IP vendor to allow limited visibility to EFMB clients for
IP customers. The IP vendor can protect specific clients and leave other clients unprotected for modification
by IP customers. See the eNVM/EFMB Client JTAG Protection use flow diagram for a detailed example of a
typical use case.

Before you begin this tutorial, make sure you have already installed the FlashPro and/or Designer software
and that you are familiar with its basic features.

JTAG READ/WRITE protection is set when you create your original EFMB in Libero SoC. You cannot
change this setting in Designer/FlashPoint or FlashPro/FlashPoint.

EFMB Client JTAG Protection in Designer/FlashPoint

If the ADB file has an EFM (Embedded Flash Memory) block with page/client JTAG protection enabled, the
EFC file appears in the FlashPoint window when you click the Programming File button in Designer.

A message indicating JTAG protection is enabled appears in the Embedded Flash Memory Block (EFMB)
tooltip, as shown in the figure below.
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Figure 60 - EFMB Client JTAG Protection
To set EFMB Client JTAG Protection:

1. Check the Security Settings or Programming previously secured devices checkbox and click
Next. The Security Settings dialog box opens.

2. Specify the appropriate security settings.

If the EFM block is generated with an EFMB client with JTAG protection then FlashPro requires that
you specify a User Pass Key prior to programming or exporting programming files.

3. Import the EFC file with JTAG protection in the FlashPoint dialog box. When the EFC file is imported
the Security Settings box is checked automatically, implying that you must set the User Pass Key (as
shown in the figure below).

The PDB file cannot be saved without specifying the pass key.

46 FlashPro User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

& Microsemi

EFMB Client JTAG Protection Tutorial - Fusion

Silicon Feature(s) to be programmed:
e i Security settings
| Fras arran:
" Flashrom
Criginal FlashRom configuration file;

F:'l,Documents and|SettingsifarleyciDeskiopifarleyc_Actelpri_81imy FROM,uf Impart... |

0 Embedded Flash Memary Blocks (EFME):

Program ﬁl‘:;:; LE(I:Da(l:il:m Original Configuration File
1 @ ¥ MYk _block_04.. 1 D:AFusion_Mediatsmartgenirvm_jta... | Modify...

™| Programming previously. secured device(s)

o Specify IO States During Programming. ..

Silicon signature {max length is & HEX chars):

Help | Back | Text | Finish I Cancel |

Figure 61 - Importing the EFC File with JTAG Protection

4. Click Next to open the Security Settings dialog box. Notice that the Enable EFMB client JTAG
protection box is checked. This indicates that reading, writing, and verifying of other EFMB pages are
allowed but the reading and writing of specific EFMB clients are protected.

5. To enforce the EFMB client JTAG protection in the PDB file, enter a Pass Key or click Generate
random key (as shown in the figure below).

Security Settings - Step 2 of 2 [ %]

Security level For this device:

- - High

Mo prokection ;I
- Allovs writing and verifying of the FPGA Array.
Medium
- Allows reading, writing, and verifying of the FlashROM,
I - Allows reading, writing, and verifying of the EFME {EFME client
Mo JTAG protection is enabled),
€V Enable EFME client: ITAG pratection
EFME client JTAG protection is enabled.
=l
Custom Level.., Default Level |
Pass Key {max length is 32 HEX chars):
Z7BECACZESSADG201509F097 1B557F11 Generate random key |
AES key {max length is 32 HEX chars):
I Generate random key |

Help | Back | Finish | Cancel |

Figure 62 - Setting Security
Custom Level Security Settings

If you select Custom Level security and decide to protect writing of the entire EFMB, then the EFMB client
JTAG protection Write, if enabled, will be overridden by full block protection.
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If the Read protection of the EFMB is left open, then the EFMB client JTAG protection Read will be enabled
if a client has Read protection enabled.

If you choose to encrypt the entire EFMB, then the EFMB client JTAG protection Write will be disabled due
to enforced encryption. The EFMB client JTAG protection Write, if enabled, will be overridden by full block

protection.

To set Custom Level Security:
1. Click Custom Level to open the Custom Security Level dialog box (as shown in the figure below)

Custom Security Level E

Set Security Settings

Silicon Feature Security| Encrypt Fead | Verily | Wite
FPGA Array - I
FlashROM r r
N¥M_block_0/NVM_INST (# 1) O o

o Ta see EFME client ITAG protection information place your mouse cursor over each block

[ Permanently lock the security settings.

Help | OF I Cancel |

Figure 63 - Setting Security for Unprotected eNVM Clients
2. Click the Set Security checkbox to secure Read, Write and Verify using Flash Lock. In this mode you
can unlock Read and Verify and only protect Write by FlashLock. The EFMB client JTAG read
protection will be enabled.

3. Click the Encrypt checkbox to secure Write using the AES Key. Read, Verify will be secured by
FlashLock in this mode. You must enter the AES Key in addition to the Pass Key before saving the

PDB file.

Setting Standard Security Levels

There are two types of standard level security: High and Medium. If either of the two is selected the EFMB
client JTAG protection is overridden or disabled. You can enforce Read, Write and Verify protection of the
entire EFMB with the Pass Key and/or AES key. JTAG protection of specific pages will not be available.

EFMB client JTAG Protection via FlashPro/FlashPoint
If the PDB file was created with the EFMB client and JTAG protection is enabled you can click Modify in
FlashPro to change the settings.

Fusion Calibration Backup and Recovery Tutorial

This tutorial provides step-by-step instructions on how to backup and recover default calibration data on a
Fusion device. It assumes that you have created a new project, connected your programmer, and loaded a
Fusion PDB/STAPL file created in Designer v8.4 or above.

If you would like step-by-step instructions on how to create a new project, see the Creating a New Project
section in the FlashPro Single STAPL Basic Tutorial..

If you would like step-by-step instructions on loading a programming file, see the Loading and Configuring a
Programming File section in the FlashPro Single STAPL Basic Tutorial.

Note: This feature is only supported in STAPL and PDB programming files.
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Backing Up Default Fusion Calibration Data

A backup copy of the Fusion calibration data is created once after ANY programming ACTION, except
READ_IDCODE, is executed. The copy will be stored in the spare pages of eNVM. The FlashPro Log
window shows that a backup copy of the calibration data has been created (as shown in the figure below).

programwer '07553' : Jcan Chain...

programmer '07595' @ Scan Chain PASSED.

programoer '07893' : Executing action PROGRAM

programmer '07553' : Checking for Backup Calibration Data...
programmer '07525' : Beading Master Calibracion Data...
progremoer '07898' : Writing Calibration Backup Copy
programmer '07828' : Erase

programrer '073938' : Completed erase

progremoer '07898' : Progrewming FPGAL Array

Figure 64 - FlashPro Log Window

Recovering Default Fusion Calibration Data

1. Load the PDB/STAPL file created in Designer v8.4 or above.

2. In the FlashPro Configuration window, click Advanced and select RECOVER_CALIB (as shown in the
figure below).

Achan

Procedures...

Figure 65 - RECOVER_CALIB

3. Click Run to restore the original Fusion calibration data. The Log window shows the data is restored
(as shown in the figure below).

prograrmmer '07398' @ Scan Chain. ..

prograrmmer '073258' @ Scan Chain PASIED.

brogramemer '07395' @ Executing sction RECOVEER CALTE
programmer '073958' ¢ Checking for Backup Calibration Data...
programmer '07595' ¢ Beading Master Calibration Data...
programmer '07595' ¢ Writing Calibration Backup Copy
programmer '073958' ¢ Checking for Backup Calibration Data...
programmer '07595' ¢ Bestoring Master Calibration Data.

Figure 66 - Restoring Original Calibration Data
Note: The Calibration data can only be restored after a backup has been made.

Specify 1/0 States During Programming Tutorial

This tutorial explains how to modify the 1/O states during programming within FlashPro for used and unused
1/0s. It also explains how to modify the Boundary Scan Registers (BSRs) for each 1/O to allow for more
detailed customization of the /O states during programming. Finally, it shows how to save and load these
settings with a file.

Note: This tutorial requires a design with a valid *.pdb file associated with it. If you launch FlashPro from a
Libero SoC project, a FlashPro project is created automatically and the PDB file loaded. Otherwise, you can
start a new FlashPro project and load a PDB file; refer to Single STAPL/PDB file basic tutorial for more
information.
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You can also modify the individual Boundary Scan Registers; see the Modify Boundary Scan Registers
section for more information.

To modify the state of an 1/0 during programming:

1. Once your PDB is successfully loaded, from the Configuration menu, choose PDB Configuration.
This brings up FlashPoint . FlashPoint is the tool that allows you to modify the PDB programming file
from within FlashPro.

2. In FlashPoint, click the Specify I/O States During Programming button. The Specify I/0 States
During Programming dialog box appears (as shown below). This dialog box enables you to modify the

1/0 states during programming for all used and unused 1/Os.

Specify I/0 States During Programming
Load from File. .. | Save ko file... | [™ show BSR Details
Port Hame Macro Cell Pin Humber 1/0 State [Output Only) j
BIST ADLIB:INBUF T2 1
BvPA55_10 ADLIB:INBUF K1 1
CLE. ADLIB:INBUF B1 1
ENOUT ADLIB:INBUF J16 1
LED ADLIB:OUTBUF M3 a
MOMITOR[O] ADLIB:OUTBUF ES a
MOMNITOR[1] ADLIB:OUTBUF c7 d
MOMNITOR[2] ADLIB:OUTBUF k] d
MOMITOR[3] ADLIB:OUTBUF D7 d
MOMNITOR[4] ADLIB:OUTBUF A1 d
OEa ADLIB:INBUF E4 d
OEb ADLIB:INBUF F1 d
O5C_EN ADLIB:INBUF K3 d
PAD[10] ADLIB:BIBUF_LYCMOS33U ME d
PAD[11] ADLIB:BIBUF_LYCMOS33D R? d
PAD[12] ADLIB:BIBUF_LYCMOS33U D11 d
FAD[13] ADLIB:BIBUF_LVCMOS 33D ciz z
PAD[14] ADLIB:BIBUF_LYCMOS33U RE d LI
Help | OF I Cancel |

Figure 67 - 1/0 States During Programming Window

The default view displays a grid with 4 columns: Port Name, Macro Cell, Pin Number, and I/O State
(Output Only). Port Name lists the port associated with each of theses pins, if the pin is not used in the
design, the Port Name for this pin reads Unused. The Pin Number column contains a list of all the pins
for the package associated with the design open in FlashPro.The Macro Cell column contains the
Microsemi macro associated with each pin, as with Port Names, if the pin is not used, the Macro Cell
for this pin reads Unused. The I/O State column is the only column editable in FlashPro.

3. Select an I/O State from the drop-down menu for each 1/0 you want to modify.

Please refer to Specifying 1/0O States During Programming for information on sorting and selecting
multiple entries in the grid.

4. Click Save in the Specify I/O States During Programming window, then Finish in FlashPoint to return
to FlashPro. The PDB is updated with your new settings.

Congratulations, you have successfully modified the 1/O states that will be held during programming.

Modifying Boundary Scan Registers

Each 1/O in your device is comprised of an Input, Output and Output Enable Boundary Scan Register (BSR)
cell.

The BSR cells enable you to define 1/0O states during programming and control the individual states for each
Input, Output, and Output Enable register.
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Specify I/O States During Programming Tutorial

To modify the individual Boundary Scan Registers of an 1/0 in your device:

1. Select the Show BSR Details checkbox in the Specify I/O States During Programming window.
This replaces the 1/0 State (Output Only) column with a Boundary Scan Registers column that is split
into Input, Output Enable and Output.

2. Modify each of the registers for any I/O to set your custom options. See the Specifying I/O States
During Programming - I/O States and BSR Details help topic for an explanation of the individual BSR
settings.

3. (Optional) Uncheck the Show BSR Details checkbox to return to the default view.

Note: Updated 1/0s with non-default settings are displayed as User-Defined BSR in the default view.
Click OK and complete programming to save your updated settings to the ADB and programming files.

Saving and Loading I/O State Settings
Click Save to File to save your changes. This enables you to save your custom 1/O settings in an 10OS file.
Click Load from File to load a previously saved *.ios file.
You must click OK and complete programming to save your updated settings to the ADB and programming files.

See Also
Specifying 1/0 States During Programming
Specifying 1/0O States During Programming - 1/O States and BSR Details
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Advanced Tutorials

Multiple Device Chain Programming

This tutorial provides step-by-step instructions on how to program multiple Microsemi devices in a chain.
You should already be familiar with the basic features of the FlashPro software.

Note: This tutorial does not provide software installation instructions. Please have FlashPro already installed

before you begin.
In the figure below, there are three devices in a chain (two A3P250 and one A3PEG600). In this section, we

will program these three devices in the chain.

TDO
TOI T©I  TDO oI TDO
™S ™S ™S _ ]
TCK e | ITeK TCK
I A3P250 A3PEG00 ’7
‘ .

Figure 68 - APA Device Tutorial Example
First you need to create a project.

To create a new project:
1. Click the New Project button in FlashPro.
2. From the New Project dialog box, type “Tutorial” in the Project Name field.

3. Check the Chain box (see figure below).

Mew Project F§|

Project Mame:

| Tukorial

Project Location:

| D:\FlashProvS0yMult_Actel_Chain'  Browse...

Programming mode
" Single STAPL File
{* Chain

(4 | Cancel Help

Figure 69 - New Project Dialog Box
4. If necessary, change the default location of your project in the Project Location field.
5. Click OK. The FlashPro main window appears.
Note: The Programmer List window updates with your programmers information.

6. From the Programmers menu, choose Scan Chain (or select the programmer in the Programmer
List window, right-click, then choose Scan Chain) (see figure below).
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Multiple Device Chain Programming

Programmer Programmer 0 Pr
MName Type Status Enabled

Edi cell

st} eing

) SeF Test

8 scan Chain

* Remawe
Disable

Run Salected Programmers

Refresh/Rescan for Programmers PROGRAM E%

Figure 70 - Select Programmer Window

Scan Chain shows how the devices are ordered in the chain in the log window (see figure below). In this
case, A3P250 is the first device that will be programmed in the chain since it is connected directly to TDO.

x| prografener '01245' @ Found 24 instruction register bits.

z prografemer '01245' @ Checking IDCODEs. ..
prograweer '01245' @ Device 1: ZA4141CF Mfr: Actel Part: MVAIPZ50
programosr '01245' @ Dewviee 2: 123261CF Mfr: Actel Part: MVAIPEGOO
progragmner '01245' : Device 3: 2Z4141CF Mfr: Actel Part: A3P250
prograwmmer '01245' : Scan Chain PASIED.
<

| P\MII f{' Errars ;-\,' Warnings }\InFD ,f

Figure 71 - Scan Chain Order in the Log Window
7. Click the Configure Chain button. The Chain Configuration window displays (see figure below).

x R
A Actel Deviee 14
—-ITDI N rm}—..»—-[‘rm 2 'maHrm 1 rool—u | | 2] X
Add Nondctel Device
¥ Show Chain Editing
: " IR Max TCK  Enable  Enable = Serial
s L= 2 Length  [MHz)  Device Serial ) Data it

Construct the chain from a Scan Chain operation...

Figure 72 - Chain Configuration Window

8. Inthe Chain Configuration window, click the Add Device button to add devices to the chain. The
Add Microsemi Device dialog box appears (as shown in the figure below).

Add Actel Device X

" File

Programming file: | J

* Device

Device:

Mame: | A3PZS0

Help K, | Cancel

Figure 73 - Add Microsemi Device Dialog Box

9. Choose the "A3P250" device from the Device drop-down.
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10. Inthe STAPL file field, use the Browse button to locate the A3P250.stp file.

11. In the Name field, leave A3P250 as default. The A3P250 device is added into the Chain
Configuration window (see figure below).

x :
= = - Add Actel Device 4
—-Iml N 'll)o}—-ooo—ull’l)l 2 rml—-lml 1 100}—0 ModiyPDB.. |  ConfigueDevice.. [ & i il 5'
Add NonsActel Device
¥ Show Chain Editing Inspect Device
Devie Name File IR Max TCK  Enable  Enable Serial

Length  [MHz] | Device | Seiial Data HIGH-Z

Figure 74 - Device One Chain Configuration Window
12. Repeat the same process for A3PE600 and the other A3P250 respectively.
13. After you have finished adding all of the devices in the chain, the Chain Configuration window

updates.
L
: T ]
_.|'m| N 100]_.... _.I1|)| 2 'mol_.lrm 1 'mol_. Create FOB... | Configure Device. . | il ll £|
Add NorvActel Device
¥ Shows Chain Editing Inspect Device
- IR Max TCK = Enable = Enable - Serial
LD LE= = Length  [MHz) | Device Serial e Data sl
1 AIPIS0 ¥ a3F250 =] 8 10 ¥
AIPEEDD [G] 43PERO0 = 8 v
3 A3IPZS0 ¥ A3F250(2) = 8 10 =

Figure 75 - Chain Configuration Window: All Devices in the Chain

14. Once all the devices have been added to the chain in the correct order, click the Run button to
program the chain.

15.  When Programming is complete, the Programmer List window displays. See figure below.

Programmer Programmer Programmer Programmer
Hame Type Status Enabled

Device / Action

03178

i
]
£
=
=
£
E Refresh/Rescan for Programmers
g
&
x| programmer '03178' : device 'A3ZPEZS50' : Finished: Wed Jul 05 17:15:49 2006 (Elapsed time 00:01:23) ~
L] programmer '03175' @ device 'A3PZ250' : Executing action PROGRAM PAZZED.
programemer '03175' : Chain programening PASZIED.
o-o-0o-0-0-20
~
< *

Al A Errors A Warnings A Info

Figure 76 - Programmer List Window Done

Congratulations! You have just completed the FlashPro Multiple Microsemi Device Chain Programming
tutorial.

Multiple Device Serialization Chain Programming

This tutorial provides step-by-step instructions on how to program multiple Microsemi devices with
serialization. Before you begin this tutorial, you should already be familiar with the basic features of the
FlashPro software.

Note: This tutorial does not provide software installation instructions. Please have FlashPro already installed
before you begin.

In this tutorial you will program two devices in a chain (one device is A3P250 and the other is A3PE600).
The STAPL file for the first A3P250 device contains 10 serialization data. See figure below.
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TCK
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Multiple Device Serialization Chain Programming

DI TDO. DI TDO
TMS TS —
. | 1TCK TCK
I A3P250 A3PEGOO ’7
l |

Figure 77 - APA Device Tutorial Example

First you need to create a project.

To create a new project:
1. Click the New Project button in FlashPro.
2. From the New Project dialog box, type "Tutorial" in the Project Name field.
3. Check the Chain box (as shown in the figure below).

Mew Project [‘S_<|

Project Mame:

| Tukorial

Project Location:
| D:\FlashProvSOMult_Ackel_Chain,  Brawse...

Programming mode

" Single STAPL File
* Chain

(0] 4 | Cancel Help

Figure 78 - New Project Dialog Box

. If necessary, change the default location of your project in the Project Location field.
5. Click OK. The FlashPro main window appears and updates the Programmer List info with your
programmer information.

6. From the Programmers menu, choose Scan Chain (or select the programmer in the Programmer List
window, right-click, then choose Scan Chain) (as shown in the figure below).

Programmer Programmer Port F

Mame Status ' Enabled

30354

20 ping
) Self Test
%0 scan Chain

B Remove

ush30964 [USE 2.0)

Edit cell

Disable

Run Selected Programmers

Refresh/Rescan for Programmers PROGRAM %

Figure 79 - Scan Chain Selection

Scan Chain shows how the devices are ordered in the chain in the log window (see figure below). In this
case, A3P250 is the first device will be programmed in the chain since it is connected directly to TDO.
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| prograginer '03175' ¢ Found 24 instruction register hits.
H programmer '03175' : Checking IDCCODEsS...
programmer '03178' @ Dewvice 1: 24141CF Mfr: Actel Part: A3IPZE0
programmer '03178' @ Device 2: 123261CF Mfr: Actel Part: AZPE&OO
prograrmer '03178' @ Dewvice 3: 24141CF Mfr: Actel Part: A3IPZE0
prograginer '03175' ¢ 3can Chain PASIED.
<
| P".'"'“ r'(. Errars r)". \Warnings f7-.|Inl:|:| fn{

Figure 80 - Scan Chain Order in the Log Window
7. Click the Configure Chain button . The Chain Configuration window appears (see figure below).

: DI TOO— e#e —TD1 ™ DI 00 [—l Add Actel Device 4 I
_'lT N |_. _.| 2 °|_.| 1 }_‘ | _I _J _I Add Nom&ctel Device |

- . IR Max TCK = Enabl Enabl A Serial
Device Name File Length ﬁ:‘Hz] Dnvic: Sn:riaf Action Dealtla HIGH-Z

[¥ Show Chain Ediing

Construct the chain from a Scan Chain operation...

Figure 81 - Chain Configuration Window

8. Inthe Chain Configuration window, click the Add Device button to add devices to the chain. The
Add Microsemi Device dialog box appears.

9. Choose A3P250 device from the Device drop-down menu (as shown in the figure below).

Add Actel Device x|

" File

Programming file: | J

* Device

Device:

Mame: | A3PZS0

Help K, | Cancel

Figure 82 - Add Microsemi Device Dialog Box
10. Inthe STAPL file field, use the Browse button to locate the A3P250.stp file.
11. In the Name field, leave A3P250 as default.
12. Click OK. The A3P250 device is added into the Chain Configuration window.

13. Repeat steps 8 to 11 for A3PE600 and A3P250 respectively. After you are finished adding all devices
in the chain, the Chain Configuration window updates (as shown in the figure below).

L

L o1 N Toot— ese —101 P 00101 ] ™ eale igure Dievice. Add ctel Device 74
-'| N "I—' —-I 2 |—-| ‘|no|—. CosteP08. | ConigusDevics | & 4| El_unml

Add Norvfict
# Show Chan Ediling Irspect Denvice
: = IR Max TCK = Enable = Enable - Senal
Device Hame File Length MHz) Device  Serial Action Data HIGH-Z
1 A3FZS0 ™ #3P250 =2 3 10 ~
A3PEBO0 = =) [

3| AP0 [ A3P250 (2] 10 2

Figure 83 - Chain Configuration Window for all Devices
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& Microsemi

Multiple Programmer Multiple Device Chain Programming

From the Chain Configuration Window, check the Enable Serial box. This enables the Serial Data
option in the Chain Configuration window.

Click Select in the Serial Data column, the Serial Settings dialog box displays as shown in the figure

below.
3

Serial Settings

- All

W00 -~ O N = L

Hills

v ‘iew unused data
[+ Wiew used data
[v View skipped data

Filker: | *

v Log serial data: |Regin:nn_6_3

Help

[~
Cancel |

o]

Figure 84 - Serial Settings Dialog Box

From the Serial Settings dialog box, click the All button to select all the serial data.
Click OK.

Once all the devices have been added to the chain in the correct order and serialization has been
selected, click the Run button to program the chain.

When programming is complete, the Programmer List window appears and indicates that the devices
are ready for programming (as shown in the figure below).

Lw =

Programmer
Status:

Programmer
Enabled

Programmer Programmer

Hame Type [enid

Device [ Action

Figure 85 - Programmer List Window Done

Congratulations! You have just completed the FlashPro Multiple Device Serialization Chain Programming
tutorial.

Multiple Programmer Multiple Device Chain Programming

This tutorial demonstrates step-by-step instructions on how to parallel program two chains using two
programmers, each with two Microsemi SoC Devices (A3P250 and A3PE600). See the figure below for an
illustration.

TDO
TDI TDI DO TDI DO
TMS ———=— TS TS
TCK TCK TCK
A3ZP250 A3PEGDD

Figure 86 - APA Device Tutorial Example
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You should already be familiar with the basic features of the FlashPro software before you begin this tutorial.

Note: This tutorial does not provide software installation instructions. Please have FlashPro already installed
before you begin.

First you need to create a project.
1. Click the New Project button in FlashPro.
2. From the New Project dialog box, type “Tutorial” in the Project Name field.
3. Check the Chain box (see figure below).

Mew Project §|

Project Marme:

| Tutorial

Praoject Location:
| L1 FlashProvS0iMulk_Progr_Muolki_ Browse. .,

Prograrming mode

" Single STAPL file
(* Chain

O | Cancel Help

Figure 87 - New Project Dialog Box

4. If necessary, change the default location of your project in the Project Location field.

Click OK. The FlashPro main window appears and displays your updated programmer information (as
shown in the figure below).

Programmer Programmer Programmer Programmer S N
Hame Type e Status Enabled e T
1 03178 FlashPro3 ush03 75 v
2 245 FlazhPro3 uzh01245 cd

Figure 88 - FlashPro User Interface

6. From the Programmers menu, choose Scan Chain (or select the programmer in the Programmer
List window, right-click, then choose Scan Chain). The Select Programmer(s) dialog box displays
(see figure below).
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Multiple Programmer Multiple Device Chain Programming

Select programmer(s) P§|

Select the programmer(s) wou wank ko scan;

Frogrammer(zs]
03173
01245

Select Al | Unselect Al |

Ik | Cancel | Help |

Figure 89 - Select Programmer Window

The Programmer List window shows the Scan Chain Test was passed and how the devices are ordered in
the chain (see figure below).

Programmer Programmer Port Programmer Programmer Device / Action
Hame Type Status Enabled
£ 11 03178 FlazhPro3 uzh03178 SCAN CHAIN PASSED e
H : [ES 5
=
T
£
E Refresh/Rescan for Programmers
g
&
=] programmer '01245' : Scan Chain... ~
e A Tarning: programmer '01245' : Vpump has been selected on programmer AND an externally provided Vpump has also |

programemer '01245' : Found § instruction register hits.
programwer '01245' : Checking IDCODEs. ..

programeer '01245' @ Device 1: 123261CF Mfr: Actel Part: AIPEGOOD
programuer '01245' @ Scan Chain PASIED.

Al A Errors A Warnings A Info

Figure 90 - Scan Chain Order in the Log Window

7. Click the Configure Chain button . The Chain Configuration window appears (as shown in the figure
below).

=

101 [ To0l— s4e—fto1 P ol—lror T 1 | Add Actel Device J74
_+ N }_. 2 H 1 Wl_. l J'_I —I Add NonActel Device

: " IR Max TCK  Enable  Enable - Sernial
pecs s 3 Length = [MHz) = Device  Serial chon Data il

[¥ Shaw Chain Editing

Figure 91 - Chain Configuration Window

8. Inthe Chain Configuration window, click the Add Device button to add devices to the chain. The
Add Microsemi Device dialog box appears.

9. Choose A3PEG600 device from the Device drop-down menu (as shown in the figure below).
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Actel Device Configuration E|
« Fle:
Prograrming Files | W kiraniprogramming_designs), ...
" Device

Device: | J

Mame: | A3PEEOD

Help K, | Cancel

Figure 92 - Add Microsemi Device Dialog Box

10. Inthe STAPL file field, use the Browse button to locate the ASPE600.stp file.
11. In the Name field, leave ASPEG600 as default.

12. The A3PEG600 device is added into the Chain Configuration window (as shown in the figure below).

x

AIPEGOD

Add Actel Device 54
—clrbl N wol—cm—clml 2 onrDl 1 wol—. CrestePOB. | Corfigure Device . | il fl il
Add Hor-Actel Device
¥ Show Chain Editing Inspect Device |
- - IR Max TCK = Enable Enable - Senal
Device Mame File Length (MHz) Davics Sarial Action Data HIGH-Z

[ A3PEEN0

Figure 93 - Device One Chain Configuration Window

13. Repeat steps 8 to 11 for A3P250. After you are finished adding all devices in the chain, the Chain
Configuration window updates (as shown in the figure below).

=

Add Actel Device 14
-|n:| N Tm}—-.» o1 2 'monl 1 rpol—- | | +] _I _l
Add HonrActel Device
[¥ Show Chain Editing
- . IR Max TCK ~ Enable  Enable - Seral
pence) L= 3 Length | [MHz] = Device Serial LELD Data iz

Figure 94 - Chain Configuration Window for all Devices

14. Once all the devices have been added to the chain in the correct order and serialization has been
selected, click the Run button to program the chain.

15.  When programming is complete, the Programmer List Window appears (as shown in the figure

below).
x
Programmer Programmer Port Programmer Programmer Device / Action
Hame Type Status Enabled
1 03178 FlazhPro3 ush03175 RUN PASSED [ £,3P250FPROGRAM
o245 ushi01245 A |

Figure 95 - Programmer List Window Done

Congratulations! You have just completed the FlashPro Multiple Device Serialization Chain Programming
tutorial.
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Multiple Programmer and Multiple Device Serialization Chain Programming

Multiple Programmer and Multiple Device Serialization Chain
Programming

This tutorial demonstrates step-by-step instructions on how to parallel program two chains using two
programmers, each with two Microsemi SoC Devices (A3P250 with Serialization and A3SPE600). See the
figure below for an illustration.

TDO
TDI T TDO TDI TDO
TMS ———=— TS TS

TCK TCK TCK
A3P250 A3PEROD

Figure 96 - APA Device Tutorial Example

You should already be familiar with the basic features of the FlashPro software before you begin this tutorial.
The STAPL file for the A3P250 device contains 10 serialization data.

Note: This tutorial does not provide software installation instructions. Please have FlashPro already installed
before you begin.

First you need to create a project.
1. Click the New Project button in FlashPro.
2. From the New Project dialog box, type “Tutorial” in the Project Name field.
3. Check the Chain box (see figure below).

Mew Project P§|

Project Mame:

| Tutorial

Project Locakion:

| Ci:\FlashProyS0yrulk_Progr_fult_y Browse, .,

Prograrming mode

" Single STAPL file
{* Chain

(04 | Cancel Help

Figure 97 - New Project Dialog Box

4. If necessary, change the default location of your project in the Project Location field.

Click OK. The FlashPro main window and the Programmer List window displays your updated
programmer information.

6. From the Programmers menu, choose Scan Chain (or select the programmer in the Programmer
List window, right-click, then choose Scan Chain). The Select Programmer(s) dialog box appears
(as shown in the figure below).
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Figure 98 - Select Programmer Window

The Programmer List window shows the Scan Chain Test was passed and how the devices are ordered in

the chain (see figure below). In this example, A3PE600 will be programmed first in the chain since it is
connected directly to TDO.

Programmer Programmer Port Programmer Programmer Device / Action
Hame Type Status Enabled
1 03176 FlazhPro3 ush03176 SCAH CHAIN PASSED I
2 |01245 FlashPro3 ush1245 SCAH CHAIN PASSED cdl

Figure 99 - Scan Chain Order in the Log Window

7. Click the Configure Chain button . The Chain Configuration window appears (as shown in the figure

below).

i Add Actel Device 14 |
—-|Tn| N ‘lDOl—-m—'I'lDI 2 rnol—-lwl 1 TDO}—‘ | | _I _] _J SRR
[¥ Show Chain Ediing

Device Name File et B B e B B Action el HIGH Z

Construct the chain from a Scan Chain operation...

Figure 100 - Chain Configuration Window

8. Inthe Chain Configuration window, click the Add Microsemi Device button to add devices to the
chain. The Add Microsemi Device dialog box appears.

9. Choose A3PEG600 device from the Device drop-down menu (as shown in the figure below).
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Figure 101 - Add Microsemi Device Dialog Box

10. Inthe STAPL file field, use the Browse button to locate the A3PE600.stp file.

11. In the Name field, leave A3PEG600 as default. The ASPE600 device is added into the Chain
Configuration window.

12. Repeat the steps above to add the A3P250. After finished adding all devices in the chain, the Chain
Configuration window updates (see figure below).

) ) Add Actel Device 174
—-Irnl N 100|—~m—-|1|>| Z rnol—-|rn| 1 mo|—~ Create PDB... I CONIMUSW&--l il ﬂ ﬂ
Add Norvéctel Device
¥ Show Chain Editirg Inspect Device:
E IR Max TCK  Enable  Enable . Senal
Device Name File Length  [(MHz) = Device Serial Action Data HIGH-Z

B A3F250 2) 10 v

Figure 102 - Chain Configuration Window for all Devices
13. Inthe Chain Configuration Window, check the Enable Serial box.

14. Click Select in the Serial Data column. The Serial Settings dialog box appears (as shown in the
figure below).
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Figure 103 - Serial Settings Dialog Box

15. From the Serial Settings dialog box, click the All button to select all the serial data.
16. Click OK.

17. Once all the devices have been added to the chain in the correct order and serialization has been
selected, click the Runbutton to program the chain.

18.  When programming is complete, the Programmer List window updates (as shown in the figure

below).
x
Programmer Programmer Programmer Programmer e ] "
Hame Type (Pl Status Enabled W= 5 e
1 03178 FlazhPra3 uzh03178 I A3P2S0PROGRAM
2 245 FlashPro3 ush1245 ~ AZP2S0PROGRAM

Figure 104 - Programmer List Window Done

Congratulations! You have just completed the FlashPro Multiple Programmer and Multiple Device
Serialization Chain Programming tutorial.

Setting Disabled Microsemi SoC Devices to HIGH-Z

This tutorial explains how to set disabled Microsemi SoC SmartFusion, IGLOO, ProASIC3, Fusion devices
in a chain to HIGH-Z during chain programming.

Note: This tutorial requires a design with valid *.pdb/*.stp files for a chain of devices. If you launch FlashPro from
a Libero SoC project, a FlashPro project is created automatically and the PDB/STP file loaded. Otherwise, you
can start a new FlashPro project and load a PDB/STP file; refer to the Chain Programming Tutorial for more
information.

1. Once all your devices have been added to the chain, from the Chain Configuration window, choose
which devices you would like disabled during programming by de-selecting the appropriate checkbox
from the Enable Device column.

Now that you have disabled devices a checkbox appears in the HIGH-Z column of the Chain
Configuration window. If the HIGH-Z column is not shown in the Chain Configuration Grid, right-click
any column header and choose HIGH-Z.

2. Select the HIGH-Z checkbox to ensure your disabled devices enter HIGH-Z mode and remains in that
mode until chain programming is complete.
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Setting Disabled Microsemi SoC Devices to HIGH-Z

HIGHZ is not supported if enabled Microsemi devices are executing one of the following ACTIONS:
e PROGRAM_NVM_ACTIVE_ARRAY
e VERIFY_NVM_ACTIVE_ARRAY
e READ_IDCODE
Disabled devices 1/0s will not go to HIGHZ and the they will not tri-state. Any other ACTION will work as

expected
x - - Add Actel Device 74
—-|TI]I N Tnol—ono—-{ml 2 moH'ml 1 1Do|—- Creste FDB... | Configuie Device... | ﬂ ﬂ &
Add Non-Actel Device
¥ Show Chain Editing Inspect Device
IR Max TCK  Enable  Enable - Serial
File Length | [MHz) | Device | Seral Action Data HIGH-Z

2 | AGLEOVS (3] AGLEOOVS (2) 8 10 v

Figure 105 - HIGH-Z Option in FlashPro
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Programming Settings and Operations

Introduction

The FlashPro software enables you to connect multiple programmers to your computer. With each
programmer you select, you can connect the programmer, perform a self-test, customize, add, and remove
and analyze the JTAG chain.

Programmer Settings

The Programmer Settings dialog box includes setting options for FlashPro5/4/3/3X, FlashPro Lite and
FlashPro.
Note: You can set the TCK setting in the PDB/STAPL file by selecting the TCK frequency in the Programmer
Settings dialog box.

Limitation of the TCK frequency for the selected programmer:
e FlashPro supports 1-4 MHz
e FlashPro Lite is limited to 1, 2, or 4 MHz only.
e FlashPro5/4/3/3X supports 1-4 MHz.
Limitation of the TCK frequency for the target device:
e |GLOO, ProASIC3, and Fusion — 10MHz to 20MHz
e ProASICPLUS and ProASIC — 10 MHz.

During execution, the frequency set by the FREQUENCY statement in the PDB/STAPL file will override the
TCK frequency setting selected by you in the Programmer Settings dialog box unless the Force TCK
Frequency checkbox is selected.

To set your programmer settings:

1. From the Tools menu, choose Programmer Settings.The Programmer Settings dialog box appears
(as shown in the figure below).
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Figure 106 - Programmer Settings Dialog Box for FlashPro

2. Click a programmer tab and check the appropriate settings for your programmer.
3. Click OK.

FlashPro Programmer Settings

Choose your programmer settings for FlashPro (see above figure). If you choose to add the Force TCK
Frequency, select the appropriate MHz frequency. After you have made your selection(s), click OK.

Default Settings

e The Vpp, Vpn, Vdd(l), and Vddp options are checked (Vddp is set to 2.5V) to instruct the FlashPro
programmer(s) to supply Vpp, Vpn, Vdd(l) and Vddp.

e The Drive TRST option is unchecked to instruct the FlashPro programmer(s) NOT to drive the TRST
pin.

e The Force TCK Frequency option is unchecked to instruct FlashPro to use the TCK frequency
specified by the Frequency statement in the STAPL file(s).

FlashPro Lite Programmer Settings

If you choose to add the Force TCK Frequency, select the appropriate MHz frequency. After you have made
your selection(s), click OK.

Default Settings
e The Vpp and Vpn options are checked to instruct the FlashPro Lite programmer(s) to supply Vpp and
Vpn.

e The Drive TRST option is unchecked to instruct the FlashPro Lite programmer(s) NOT to drive the
TRST pin.
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e The Force TCK Frequency option is unchecked to instruct the FlashPro Lite to use the TCK frequency
specified by the Frequency statement in the STAPL file(s).

FlashPro5/4/3/3X Programmer Settings

For FlashPro5/4/3/3X, you have the option of choosing the Set Vpump setting or the Force TCK Frequency.
If you choose the Force TCK Frequency, select the appropriate MHz frequency. For FlashPro4/3X settings,
you have the option of switching the TCK mode between Free running clock and Discrete clocking. After you
have made your selections(s), click OK.

Default Settings
e The Vpump option is checked to instruct the FlashPro5/4/3/3X programmer(s) to supply Vpump to the
device.

e The Force TCK Frequency option is unchecked to instruct the FlashPro5/4/3/3X to use the TCK
frequency specified by the Frequency statement in the PDB/STAPL file(s).

e FlashPro5/4/3/3X default TCK mode setting is Free running clock

TCK Setting (ForceTCK Frequency)

If Force TCK Frequency is checked (in the Programmer Setting) then the selected TCK value is set for
the programmer and the Frequency statement in the PDB/STAPL file is ignored.

Note: FlashPro Lite RevA supports only 4MHz on TCK.

Default TCK frequency

When the PDB/STAPL file or Chain does not exist, the default TCK frequency is set to 4MHz. In the Single
Device File Programming mode, FlashPro will parse through the file and search for the "freq" keyword and
the "MAX_FREQ" Note field, which are expected in all Microsemi flash device files. The FlashPro software
uses the lesser value of the two as the default TCK frequency.

In Chain Programming mode, when more than one Microsemi flash device is targeted in the chain, the
FlashPro software passes through all of the files and searches for the "freq" keyword and the "MAX_FREQ"
Note field. The FlashPro software uses the lesser value of all the TCK frequency settings and the
"MAX_FREQ" Note field values.

Ping Programmers

To ping a programmer(s):
1. From the Programmers menu, choose Ping.
2. Select the programmers you want to connect from the Select Programmer(s) dialog box.
3. Click OK.

Note: You can click the Refresh/Rescan for Programmers button to quickly ping new programmers.

Performing a Self-Test

To perform a self-test:
1. From the Programmers menu, choose Self Test.
2. Select the programmer(s) you want to self-test from the Select Programmer(s) dialog box.
3. Click OK.

Note: You must connect the programmer to the self-test board that comes with your programmer before
performing a self-test.

You can also perform self-test by right-clicking on a specific programmer from the Programmer List
Window and selecting Self-Test.
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Scanning a Chain

Note: Self-test is not supported with FlashPro4 or FlashPro Lite programmers. These programmers are
rigorously tested at the factory during production.

Scanning a Chain

The scan chain operation scans and analyzes the JTAG chain connected to programmer(s) you have
selected.
To scan a chain:

1. From the Programmers menu, choose Scan Chain.

2. Select the programmers you want to scan from the Select Programmer(s) dialog box.

3. Click OK.
You can also perform Scan Chain by right-clicking on a specific programmer from the Programmer List
Window and selecting Scan Chain.
To scan and check a chain:

1. From the Tools menu, choose Modes > Chain Programming.

2. From the Chain Configuration window, select auto construct or add devices.
3. From the Programmers menu, choose Scan and Check Chain.
4

Select the programmers that you want to scan and check chain from the Select Programmer(s) dialog
box.

5. Click OK.

You can also perform Scan Chain and Scan and Check Chain by right-clicking a specific programmer from
the Programmer List Window and selecting Scan Chain or Scan and Check Chain.

Enabling and Disabling Programmers

Once your programmer is enabled you can connect the programmer, perform a self-test, scan the chain, or
remove it.
To enable a programmer:
1. From the View menu, choose Programmer Details Window.
2. Check the Enable programmer checkbox in the Programmer Details Window.
The Programmer Details window displays all the information about your programmer.

Note: You can also enable your programmer from the Programmer List window by checking the
checkbox in the Programmer Enabled column.

Disable your programmer by unchecking the Enable programmer checkbox from the Programmer Details
Window or by unchecking the checkbox in the Programmer Enabled column in the Programmer window.

Renaming a Programmer

Enter the new programmer name in the Programmer Details window to rename the programmer. By
default, the programmer name is the same as the programmer ID.

Removing a Programmer

To remove a programmer:
1. From the Programmers menu, choose Remove.
2. Select the programmers you want to remove from the Select Programmer(s) dialog box.
3. Click OK.
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Selecting Programmers

The Select Programmer(s) dialog box gives you the option of selecting all and unselecting all of the
programmers that you want to ping. See figure below.

Select programmer(s) [‘5—<|

Select the programmer(s) wau wank ko ping:

Programmer(z] |
01236

Select Al | Unselect Al |

QK | Cancel | Help |

Figure 107 - Selecting Programmer(s) Dialog Box
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Single Device Programming

Single Device Configuration

Single Device Programming

When devices are joined together in a JTAG chain, all of their Instruction Registers (IR) and Data Registers
(DR) are put in a long shift register from TDI to TDO. The IR length defers from device to device and the DR
length depends on the instruction that shifts into the instruction register.

When targeting Device 2 (see figure below), you need to know the IR length for Device 1 and Device 3.
Given this information, you can bypass both devices by shifting an all one pattern into their instruction
registers before and after the instruction targeted at Device 2. The number of bits you shift before Device 2's
instruction is the pre IR length, and the number of bits you need to add after Device 2's instruction is the post
IR length. In this case, the pre IR bits are shifted into

Device 1 and post IR bits are shifted into Device 3.

Device 3 Device 2 Device 1

el T R 1

TDI IR} IR R TDO

—-J
Targeting Device 2

When the bypass instruction is shifted into Device 1 and Device 3, the TDI and TDO of the two devices are
connected to the 1-bit bypass register at the Shift-DR state. To correctly shift the data in and data out of
Device 2's register, you need to shift one bit of data before and after Device 2's data.

The number of bits you need to shift into the data register for Device 1 is the pre-DR length and the number
of bits we need to shift into the data register for Device 3 is the post-DR length. With the IR and DR length
information, you can shift instructions and data into Device 2 with the correct registration.

Figure 108 -

To create the JTAG chain (shown in the above figure):
1. Connect the TCK and TMS from the programmer to all of the devices.
2. Connect the programmer’s TDI pin to the TDI pin of device 3.
3. For all devices in the chain, connect the TDO output of one device to the TDI input of the next device.
4. Connect the TDO output of the last device to the programmer’'s TDO input.
The order of devices in the chain is set by the connections of TDI to TDO.

The ChainBuilder software takes the order of the devices in a chain and their IR lengths and adds the pre-
IR, post-IR, pre-DR, and post-DR padding bits in the device you want to program, which properly aligns the
instructions and data within the IR and DR of the devices.

If you do not use the ChainBuilder software, the FlashPro software tries to find the pre-IR, post IR, pre-DR,
and post-DR values during the Analyze Chain operation.

For more information, see ProASIC programming and ProASICPLUS and ProASIC programming
introduction.

To find out how to set the IR length, see Chain Settings.

Loading a Programming File

You can either load a programming file from the Configuration menu or from the Single Device
Programming Window. The section below describes how to load a programming file from the Single
Device Programming Window.
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To Load a programming file from the Single Device Programming window:

1. From the View menu, choose Single Device Configuration to activate the Single Device
Configuration Window.
2. Click the Browse button in the Single Device Configuration Window (see figure below).

x | [~ Programming file
To continue,

lnad existing programming file Browse...
or create new PDE file

EETE [Cisinnis |

Single Device Configuration Window

Figure 109 - Signal Device Configuration Window
The Load Programming File dialog box appears.

3. Navigate to your programming file, select it, and click Open. The programming file is loaded and the
Single Device Configuration Window updates.

Select Target Device

The Select Target Device dialog box is located in the Configuration menu.

The Select Target Device dialog box enables you to select the target device you want to program. If you
are only programming one device in a chain, there is no need for you to make a selection. The Select
Target Device dialog box automatically displays your device (see figure below).

Select Target Device

Target device: |FY==ERREN

Help Ik | Cancel |

Figure 110 - Select Target Device (One Device in a Chain)

If you are programming more than one Flash device in a chain, you need to select the target device you
want to program. If you attempt to program your device without selecting a target device, a warning
message appears.

If the warning message appears, click OK and the Select Target Device dialog box appears. From the
Select Target Device dialog box, select the device you want to program (see figure below).

Select Target Device

Target device: |RFSE'I]1] @ j
il

Figure 111 - Select Target Device (Multiple Devices in a Chain)
Click the down arrow to display the list of devices in your chain. Then, make your selection and click OK.

Help
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Chain Settings

Note: When the FlashPro software does not detect your chain configuration, you must specify the Pre/Post IR
fields by entering these values in the Set Pre/Post IR Values dialog box (see figure below).

Set Pre/Post IR values x|

FlashPrao failed to determine the Pre and Post IR
values far the device AZPEEDO 1)

Pre IR: I 0
Piosk IR I 0

Ik Zancel | Help I

Figure 112 - Pre IR and Post IR Values for the Target Device
For more information, see Single STAPL file programming information.

Chain Settings

Click the Chain Parameter button in the Single Device Configuration window to set the chain settings
(see the Chain Settings dialog box below). See Single Device Programming Information for more
information about these STAPL settings.

Chain Parameter F§|

Pre IR: IEIi
Pre DR lﬂi
Post IR o
Post DR: o

Restore Defaults |

Help | Cancel |

Figure 113 - Chain Settings Dialog Box

Serial Settings

Click the Select Serialization Indexes/Select Serialization Actions button from the Single Device
Configuration Window. The Serial Settings dialog box appears (as shown in the figure below).

Note: Depending on the STAPL file format (Microsemi format or generic format) used, you will either see Indexes
columns or Actions columns in the Serial Settings dialog box.
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Figure 114 - Serial Settings Dialog Box

Click the red arrow buttons in the center of the dialog box to move from the Actions column to the Selected
Actions column. The indexes/actions available for selection are located on the left and the indexes/actions
you choose to select are located on the right column. Viewing options are available in the checkboxes under
the Actions column. If you check Log serial data, you can select the FlashROM region nhame where the
serial data will be stored.
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Chain Order

Chain Programming

Chain Order

The chain order is located in the Chain Configuration Window. The devices you add to the chain must be
in the correct order and must match the physical chain to be programmed. The TDO for the first device
connects to the programmer, and the last device's TDI connects to the programmer. The devices in the
chain go in order from a device's TDI into the next device's TDO, as shown in the figure below.

]—tTDI N TDOF— ##4 —TD1 2 TDOATD I '| TDO—

Figure 115 - Chain Order

Multiple Device Chain Programming

The FlashPro software enables direct chain programming without generating a chain STAPL file. Each
device will be programmed in sequential order starting from device 1 to device N. See example below. For
more information about chain order, see the Chain Order help topic.

TDI > Device N > Device N-1 >... > Device 2 > Device 1 > TDO

You have the advantage of using the Chain Builder GUI interface to construct the target physical chain.
Therefore, you do not need to calculate the PRE/POST IR/DR value of the target device. Instead, you must
provide either a valid BSDL file or the IR length and TCK Fmax values when you add a non-Microsemi
device to the chain.

You also have the advantage of automatically generating the chain from a scan chain operation. If you
connect the target chain to your Microsemi programmer, then you can automatically construct the chain.
Refer to the Automatic Chain Construction Tutorial for more information.

Note: Even though the FlashPro software enables direct chain programming without generating a Chain STAPL
file, this functionality is still available. For more information, see Export Chain STAPL file.

Device Programming Compatibility
The following is a list of flash devices that can be programmed together in a chain.

e SmartFusion, IGLOO, ProASIC3 and Fusion, excluding ProASIC3L, families can be programmed in
the same chain.

PLUS

e ProASIC™"® can only be programmed with other ProASIC™"® devices.

e ProASIC can only be programmed with other ProASIC devices.

Programmer Support

FlashPro5/4/3/3X supports only SmartFusion, IGLOO, ProASIC3 and Fusion family devices. The Vpump on
FlashPro5/4/3/3X is designed to support the programming of only one device. Please make sure that
Vpump, Vcc and Vjtag are provided on board for chain programming. Connect the Vpump to the header as
the FlashPro software will attempt to check for all external supplies, including Vpump, to ensure successful
programming. There is no limitation to the chain length; however, ensure that the JTAG signal integrity and
the timing are preserved.

FlashPro and FlashPro Lite support both ProASIC
both devices in the same chain.

PLUS and ProASIC devices. However you cannot program

Unless all supplies are provided on board, there is a limitation of programming eight ProASIC™"® or

ProASIC devices in a chain.

FlashPro User's Guide 75



NOTE: Links and cross-references in this PDF file may point to external files and generate an error

. . when clicked. View the online help included with software to enable all linked content.
& Microsemi

Multiple Device Serialization in a Chain

When you program multiple SmartFusion, IGLOO, ProASIC3 and Fusion family parts, you can use the
serialization functionality for more than one device. You must generate STAPL files with the correct
serialization data in them to use this functionality.

Each serialization enabled STAPL file may contain a different number of serialization data, but you may only
select the same number of serialization data to program in a single Serialization/Programming session.

See the example below for further explanation:

In this example, you have a chain of two devices (one device is an A3P250 and the other device is an
A3PEG600). The STAPL file for the A3P250 contains 10,000 serialization data and the STAPL file for the
A3PEG600 has 5,000 serialization data. In a single Serialization/Programming session, you are allowed to
select serialization data indexed from 1 to 1,000 for the ASPE600 device and serialization data indexed from
5,001 to 6000 for the A3P250 device. However, FlashPro errors out (at the beginning of a programming
operation) when the amount of the Serialization data you select is different from the devices.

Reuse Serial Data That Failed Programming

If any of the devices in the chain fail programming, the entire chain fails. All of the devices with serialization
enabled will fail as well. The serialization data will be reused or skipped based on your settings. See the
example below for more information:

You have a chain with three devices. Device 1 and Device 3 are serialization enabled. You have selected
Serialization Data 1 to 100 for Device 1 and 501 to 600 for Device 3, and you have set to reuse any unused
Serialization Data. Device 2 is targeted for programming without serialization. See the figure below for an
illustration.

Time ) 1 501 gj;?ui

10 Programmer | s I Devz ] Dewt | .
PASE PASE PASE
. 2 502

1 Programmer L s [ Devz - Devt | part
FAIL PASE PASE

Programmer * 2 20 J

t2 * Dev3 * Devi * Devl FAIL
MiA FAIL PASS
Programmer + 2 a

£ » Dev3 ™ Devl # Devl J PASS
PASE PASE PASE
Frogrammer + s 2l

t * Dev3 » Devl # Devl J PASS
PASE PASE PASE

At time t0, all devices in the chain passed programming so the Serialization Data indexes are advance to 2
and 502 for Device 3 and Device 1 respectively. At time t1 and t2, one of the devices failed programming so
the device indexes are reused for time t3.

Note that at time t2, when Device 2 failed to program; Device 3 will not be programmed.

Multiple Device Serialization and Parallel Programming

The FlashPro software enables parallel programming for ProASIC3, excluding ProASIC3L, family devices
using multiple FlashPro5/4/3/3X programmers. The following figure illustrates how the indexes are reused in
a parallel programming environment.
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Chain Configuration Window

: Chain
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At time t0, the chain failed to program so index 2 and 502 are reassigned to Device 3 and Device 1
respectively at time t1. The failed indexes are not assigned to the programmer that previously failed. It will
always be assigned to the devices in the first programmer in the Programmer List.

Chain Configuration Window

The Chain Configuration Window displays the chain order, the chain editing options, and the chain
configuration grid (see figure below). The Chain Configuration Grid enables you to view and set options for
each of your devices. Right-click a column heading in the grid and choose a menu option to show or hide a
specific column.

The Chain Configuration Grid enables you to view, sort and/or set the following options:
e Device - Device name

e Name - Editable field for a user-specified device name. If you have two or more identical devices in
your chain you can use this column to give them unique names.

e File - Path to programming file
¢ IR Length - Device instruction length.

e Max TCK (MHz) - Maximum clock frequency to program a specific device. FlashPro uses this
information to ensure that the programmer operates at a frequency lower than the slowest device in
the chain.

e Enable Device - Select to enable the device for programming
e Enable Serial- Select to enable serialization when you have loaded a serialization programming file
e Action - List of programming actions for your device.

e Procedures - Advanced option; enables you to customize the list of recommended and optional
procedures for the selected Action.

e Serial Data - Opens the Serial Settings dialog box; enables you to set your serialization data.
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e Serial Status - Displays serialization status; lists serialization index(es)/action(s) that have been used
and shows the next serialization data that will be programmed.

e HIGH-Z - Sets disabled Microsemi SoC SmartFusion, IGLOO, ProASIC3, Fusion devices in the chain

to HIGH-Z (tri-states all the 1/0s) during chain programming of enabled Microsemi devices in the daisy
chain.

The Show Chain Editing checkbox, when checked displays your chain editing options (Configure device,
Add Microsemi Device, Add Non-Microsemi Device, and organization buttons to move your device within the
grid).

Note: For information on how to Add Microsemi and Non-Microsemi devices, see Chain Editing.

Note: For information on how to use the Organize buttons (located next to the Add Microsemi and Add Non-
Microsemi buttons) in the Chain Configuration grid, see Using the Organize buttons in the Chain Programming
grid.
You can enable programming and serialization by checking the Enable Device checkbox and the Enable
Serial checkbox in the Chain Configuration grid.

Add Actel Device 14 |
—-|rn| N mol—- .o —-Iml 2 rool—olml 1 Too;—- | | _I _J _I
Add Nom&ctel Device
[¥ Show Chain Editing
Device Name File o] P S Fl el Feee) Action Senal HIGHZ

Construct the chain from a Scan Chain operation...

Figure 116 - Chain Configuration Window

Chain Editing Options

The FlashPro software enables you to automatically construct the chain by clicking the Construct the chain
from a Scan Chain operation link, or by selecting Construct Chain Automatically from the
Configuration menu.

FlashPro also enables you to manually edit your chain by adding Microsemi and Non-Microsemi devices.
You can add devices by clicking the Add Microsemi Device button and the Add Non-Microsemi Device
button, or you can select these options from the Configuration menu.

For more information about how to edit the chain, see Chain Editing.

Editing the Chain Configuration Grid

The Chain Configuration Grid enables you to select an Action for your device, Enable Serialization, and edit
the grid using the right-click menu.

To select an Action from the Configuration Grid:
1. Choose the device you would like to program and check the Enable Device checkbox.

2. In the Action column, click the down arrow to expose the drop down menu (see figure below).
3. Select your desired action.
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Action

FROGRAM =]
DEVICE_INFO
ERASE
ERASE_&LL
ERASE_ARRAY
ERASE_FROM
FROGRAM ARRA
PROGRAM_FROM
READ IDCODE
VERIFY
VERIFY_ARRAY
VERIFY_FROM

Figure 117 - Drop Down Menu for Select Action

& Microsemi
Editing the Chain Configuration Grid

Before you can enable serialization, you must check the Enable Device checkbox.

To enable Serialization:

1.

2.

5.

Check the Enable Serial checkbox. By enabling serialization, the action options change.

In the Action column, click the down arrow to expose the drop down menu (see figure below).

Action

PROGR.A

[
PROGRAM FROM |
VERIFY

VERIFY _FROM

Figure 118 - Drop Down Menu for Select Action

Select your desired action.

Serial

Data

Figure 119 - Serial Data Column

Click the Select button from the Serial Data column, which is next to the Action column (see above

figure). The Serial Settings dialog box displays.

Choose your serial settings from the Serial Settings dialog box.

See Serial Settings for more information about this topic.
Note: Uncheck the Enable Serial checkbox to disable serialization.

To edit the Chain Configuration Grid:
Select the device you would like to edit and right click anywhere in the row of the selected device.

1.
2.

Select and click an option from the right-click menu.

Note: The Device Configuration menu (see figure below) includes options for configuring your device.

Configure, .. Ckrl+F
IT Prograrm Ckrl+P
%% Seleck Action, . Chrl+Shift+a

Setializakion g

Load STAFL File... CErl+Shift+L

Figure 120 - Device Configuration Menu
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Chain Editing

The chain order is located in the Chain Configuration Window (see figure below). The devices you add to the
chain must be in the correct order and must match the physical chain to be programmed.

x

—-ITnl N mo}—-uo—‘irnl 2 'II)OH'IDI 'I 1|>o|—- Create PDB...
5 ""'9 Inspect Device |
Device Mame Epntie Enshle Action HIGH-Z
¥ ¥ FROGRAM |

1 [ PROGRAM

Figure 121 - Chain Configuration Window

Check the Show Chain Editing checkbox to display chain editing options (Add Microsemi Device, Add
Non-Microsemi Device). See figure below.

x

) _ Add Actel Device I
—o{ml N mo]—o "ee —-{101 2 rnonl 1 rnol—o Ciesle PDB.. | Coriigure Device.. | il ﬂ £|
Add Mon-Actel Device
¥ Show Chain Editing Inspect Device —I
" - IR Max TCK  Enable Enable o Serial
Device Name File Length (MHz) Device | Serial Action Data HIGH-Z
1 AFSE00 = APEEDD @ V) \kranhprogrammin(=)

8 10 i =
2 AFNOMIF & A0 © 'V \kiran'progiammin (=) ] -

PROGRAM  ~|
PROGRAM x

Figure 122 - Chain Configuration Window
You can edit the chain by adding Microsemi and Non-Microsemi Devices, for information refer to:
e Adding Microsemi Devices

e Adding Non-Microsemi Devices

e Adding Microsemi Devices from a STAPL File
e Automatic Chain Construction Tutorial

e Chain Programming Tutorial

Using the Organize Buttons in the Chain Programming Grid

The organize buttons enable you to select the order of the devices in your Chain Programming grid (see
figure below).

x

Add Actel Device 14
—o{ml N mo]—. "ee —o{wl 2 rnonl 1 rno|—~ Ciesle PDB.. | Coriigure Device.. | il ﬂ £|
Add Mon-actel Device
¥ Show Chain Edting Inspect Device
" - IR Max TCK  Enable Enable o Serial
Device Name File Length (MHz) Device | Serial Action Data HIGH-Z
| AIPEE00 © \V:\kiran\programmin ) g 10 = W |PROGRaM =] e
B A3P250 @ V' \kean'programmin =) 8 0 PROGRAM hd S ele

Figure 123 - Chain Configuration Window (Displaying Organize Buttons)

You can move devices up and down or delete devices within the grid. See the table below for a description
of each button.

Table 4 - Organize Buttons

Button Description

4 Moves your device up in the Chain Programming grid.

+ | Moves your device down in the Chain Programming grid.
Iz‘ Deletes your device from the Chain Programming grid.
80
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Cutting, Copying and Pasting Devices from the Chain

If you want to make changes to your chain, you must make these changes from the spreadsheet in the
Chain Programming grid.

To copy or cut a device from the chain programming grid:

1. Select the device you would like to edit and right click anywhere in the row of the selected device. The
right-click menu appears.

2. Select Copy or Cut from the right-click menu to copy your device.

To paste a device from the chain programming grid:
1. Right-click the location where you would like to Paste the device.
2. Select Paste from the right-click menu .

Removing Devices from the Chain

If you want to make changes to your chain, you must make these changes from the spreadsheet in the
Chain Programming grid.

To remove a device from the chain programming grid:

1. Select the device you would like to remove and right click anywhere in the row of the selected device.
The right-click menu appears.

2. ChooseRemove from the right-click menu to delete your device.

Moving Devices within the Chain

You can move devices within the chain by using the Organize buttons (located next to the Add Microsemi
and Add Non-Microsemi Device buttons) in the Chain Programming grid (as shown in the figure below).

+| 2| X|

Figure 124 - Organize Buttons

To move or delete a device within the chain:

1. Click a device to select it.

2. Click one of the Organize button arrows to move your device up or down the spreadsheet. Click the
delete button (red X) to remove a device.

For more information about the Organize buttons, see Using the Organize buttons in the Chain
Programming grid.

Skip Serial Data

If you are unable to perform the programming action on your device, if your device fails to program, and you
have selected the Skip Serial Data serialization setting, the software automatically uses the next serial data
when you program the next device. By default, the software is set to Skip Serial Data.

You can change the serialization setting by selecting Tools > Serialization or you can click the Skip serial
data icon or the Reuse serial data icon from the toolbar.

Reuse Serial Data

If your device fails to program, and you have selected the Reuse Serial Data serialization setting, the
software automatically reuses the current serial data when you program the next device.

Note: The FlashPro default setting is Skip Serial Data.
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You can change the serialization setting by selecting Tools > Serialization or you can click the Skip serial
data icon or the Reuse serial data icon from the toolbar.

Serialization with Parallel Programming

When programming the multiple ProASIC3 devices in parallel, while performing serialization at the same
time, each target device is assigned a Serial Index/Action for each programming run. Upon each successful
completion of each programming run, a new index is assigned to the each target device for the next
programming run. This process continues until the selected Serial Indices/Actions are exhausted.
Note: If programming failure is encountered, depending on the user setting, the failed serial data may be reused
or skipped in the next programming run.
If, in the last programming run, the remaining number selected Serial Indices/Actions is less than the number of
targeted ProASIC3 devices, the targeted devices without an assigned Serial Index/Action are skipped in the final
serial programming run.
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Adding a Microsemi Device

Chain Editing

Adding a Microsemi Device

To add an Microsemi device:

1. Click the Add Microsemi Device button from the Chain Programming grid. The Add Microsemi
Device dialog box appears (see figure below).

Add Actel Device x|

Prograrmming File: | J

" Device

Device: | J

MName : |

Help (0] 4 | Cancel

Figure 125 - Add Microsemi Device

Click the Device radio button and choose your device from the Device list drop-down menu.

3. Click the File radio button, then click the Browse button in the Programming file text box to find your
PDB/STAPL file. The Use File dialog box appears.

4. Find your PDB/STAPL file and click Open. Your PDB/STAPL file name appears in the Name text box.
You can change the name by clicking in the text box.

5. Click OK. Your device displays in the Chain Programming grid.
You can also add a Microsemi device from Configuration > Add Microsemi Device.

Adding a Microsemi Device from Files

To add a Microsemi device from a file:

1. From the Configuration menu, choose Add Microsemi Devices From Files. The Add Microsemi
Devices From Files dialog box appears.

2. Locate your file and click Open. Your device displays in the Chain Programming grid.

Adding a Non-Microsemi Device

When adding a non-Microsemi device, you must choose either a BSDL file or customize the Instruction
Register (IR) length and the Max TCK frequency of the device.

IR Length

The IR length specifies the number of IR bits in a specific device.
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Max TCK Frequency

Maximum clock frequency to program a specific device. FlashPro uses this information to ensure that the
programmer operates at a frequency lower than the slowest device in the chain.

BSDL File

Boundary Scan Description Language (BSDL) files describe the characteristics of a specific device. When
using a BSDL file, FlashPro extracts the IR length and TCK frequency for the specific device and uses the
information to build the FlashPro STAPL file. If you do not have a BSDL file for your specific device, you
must manually enter the IR length and Max TCK for your device. This information should be found in the
datasheet for the device.

To add a non Microsemi device using a BSDL file:

1. Click the Add Non-Microsemi Device button in the Chain Programming window. The Add Non-
Microsemi Device dialog box appears (see figure below).

Add Non-Actel Device X
" File
ESDL File: | J
{* Data

IR, length: 2
Max TCK Freq.: |1 MHz

Marne: | Device 2

Help K | Cancel

Figure 126 - Add Non-Microsemi Device Dialog Box

2. Type in the BSDL file or locate it by clicking the Browse button. If you click the Browse button to find
your BSDL file, the Use File dialog box displays.

3. Select your BSDL file from the Use File dialog box, and click Open.
4. Click OK, and your device appears in the Chain Programming grid.

When closing the Add Non-Microsemi Device window, if you specified a BSDL file, it is parsed and its IR
length and Max TCK frequency are retrieved.

Note: If you select a BSDL file, you cannot specify an IR length and Max TCK frequency.

To add a Non-Microsemi device using an IR length and a Max TCK frequency:
1. Click the Add Non-Microsemi Device button from the Chain Programming window.
2. Click the Data option from the Add Non-Microsemi Device dialog box.
3. Enter the IR length AND the Max TCK frequency in MHz.
4. Click OK.
If you decide to use custom data, you must specify both an IR length and Max TCK frequency.

Note: The IR length must be an integer greater than or equal to 2, and the Max TCK frequency must be a float
greater than or equal to 1.
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Adding a Non-Microsemi Device

Non-Microsemi Device Configuration Dialog Box
It is possible to add multiple BSDL files to your Non-Microsemi device database that have the same
IDCODE. If the BSDL files list the same IR length but different TCK values, FlashPro automatically chooses
the file with the lowest TCK value by default and no action is required. If the IR lengths are different you
receive an error message asking you to resolve the conflict.
To resolve the issue, click the drop-down arrow adjacent to the device name. This opens the Non-Microsemi
Device Configuration dialog box (as shown in the figure below). From here you can choose the device that
you wish to use. Select the device from the dropdown menu and enter a new name or use the default.

Mon-Actel Device Configuration

B3O File: | WY kiraniprogramming_designsisar_w ...

" Data

IR, length:
Max TCK Freq.: MHz

MName: | AFSE00FG256

Help (04 | Cancel

)

Figure 127 - Non-Microsemi Device Configuration Dialog Box
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Configuring a Programmer

Selecting an Action

The available actions are depend on what type of STAPL file you have loaded into the software.

To configure a programmer:

1. From the Configuration menu, choose Select Action. The Select Action and Procedures dialog
box appears (see figure below). You can change the procedures for each action; the procedures that
appear will vary depending on both your device and the action you have selected.

Select Action And Procedures E|
Action:
IDEVICE_INFO =]
Procedures |

VERIFY_IDCODE
READ_IMITIALIZE
CHECK_aAMD_BACKLP CaLlB
READ_IDCODE_OMLY
DO_DEVICE_IMFO
DO_QUERY_SECURITY
DO_E=IT

REEEEER

Restore Defaulk Procedures |

Help | Ik | Cancel |

Figure 128 - Select Action and Procedures Dialog Box

2. Click the checkboxes of the available procedures or click the Restore Default Procedures button in
the Select Action and Procedures dialog box.

3. Click OK.

Click the Restore Default Procedures to return to default settings.

For example, if you wish to disable the gathering of Check and Backup calibration data:
1. Inthe Action drop-down menu, choose DEVICE_INFO.

2. Click Procedures to open the Select Action and Procedures dialog box (as shown in the figure
above).

3. Click CHECK_AND_BACKUP_CALIB to clear the checkbox and disable it.
4. Click OK to continue.

Using Serialization

To use serialization:
1. Enable serialization by checking the Serialization checkbox.
2. Select an action in the Action text box.
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Modifying Programming Settings in FlashPro with a PDB File

3. Click the Select Serialization Indexes button. The Serial Settings dialog box displays (see figure
below).

Note: Depending on the STAPL file format (Microsemi format or generic format) used, you will either see
Indexes columns or Actions columns in the Serial Settings dialog box.

Serial Settings f'5_<|

- Al =y

W00 ] O N e LD P —

Hils

[v Yiew unused data
[ ‘iew used data
v View skipped data

Filker: | *

v Log serial data: |Regiu:un_6_3 j

Help Ok | Cancel |

Figure 129 - Serial Settings Dialog Box
Note: Depending on your STAPL file, you would click the Select Serialization Actions button (see figure below).

¥ seriskation
Seriakzation
SeralAcions | State | Programmers [
PROGRAM_1 Urnszed

PROGRAM_2 Urwised
PROGRAM_3 Unused
PROGRAM_4 Urissed
PROGRAM_S Urwsed

Next Seriakzation D atac PROGRAM_1

Figure 130 - Select Serialization Actions Button

Modifying Programming Settings in FlashPro with a PDB File

FlashPro enables you to modify programming settings within the software by using a PDB file. This feature
is available only for PDB files generated from Designer v8.1 or greater. This feature allows modification of
features being programmed, security settings, and memory content update for FlashROM and Embedded
Flash Memory Blocks (Fusion only). Please refer to Modifying Memory Contents and Programming a Device
Tutorial (EFMB) and Modifying FlashROM Contents and Programming a Device Tutorial for an example.
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Note: You cannot add or remove the FPGA feature from your PDB. If you would like to add or remove this
feature from your PDB, regenerate the PDB from Designer.

See Also
Configuring security, FlashROM and Embedded Flash Memory Block settings in FlashPro
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Configuring Security, FlashROM and Embedded Flash Memory Settings in FlashPro

Configuring Security

Configuring Security, FlashROM and Embedded Flash Memory
Settings in FlashPro

From the Configuration menu, choose Load Programming File (PDB).
Select the PDB file and click Open, this loads the programming file.

3. From the Configuration menu, choose PDB Configuration. The Programming File Generator
appears (see figure below).

-

FlashPoint - Programming File Generator - Step 1 of 2

Silicon Feature(s) to be programmed:
[ Security settings
I
[¥ FlashRomM
Criginal FlashROM configuration File:

P adbfrom, ufc Impart. ..

Embedded Flash Memory Blocks (EFME):

Program :I:;:; LEI!:Da[l:iI:Jn Onginal Configuration File
1 Ird nvm_inst i, i P:4adbhafz280hcalib. efc Modify,..

-

Modify 10 Skates During Programming. . .

Silicon signature {max length is 8 HEX chars):

Help Tk | Finish | Cancel

Figure 131 - Programming File Generator

4. Select the Silicon feature(s) you want to program:

e Security settings
e FlashROM
¢ Embedded Flash Memory Block

5. Check the Programming previously secured device(s) box if you are reprogramming a device that
has been secured.
Because the SmartFusion, IGLOO, ProASIC3 and Fusion families enable you to program the Security
Settings separately from the FPGA Array and/or FlashROM, you must indicate if the Security Settings
were previously programmed into the target device. This requirement also applies when you generate
programming files for reprogramming.

6. Enter the Silicon signature (0-8 HEX characters).

7. Click Next.
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Configuring Security Settings in FlashPro

To configure the security settings:

1. From the Configuration menu, choose Load Programming File (PDB).
2. Select the PDB file and click Open, this loads the programming file.

3. From the Configuration menu, choose PDB Configuration. The Programming File Generator
appears (as shown in the figure below).
FlashPoint - Programming File Generator - Step 1 of 3

Silicon feature(s) to be programmed:
0 v Security settings
I
W FlashRoM
Criginal FlashROM configuration File:

P:iadbifrom.ufc Import...

Embedded Flash Memory Elocks (EFMED;

Frogram pBJI;.[:I; LEII:';[GI;" Original Configuration File
1 Ird rvm_instdnvm .. 0 P adbhafzs 250 calib.efc Fadify...

-

Modify IjC States During Programming. ..

Silicon signature {ma: length is 8 HEX chars):

Help Tk | Finish | Cancel

Figure 132 - Programming File Generator

Check the Security Settings checkbox and click Next. This brings up the Security Settings dialog
box (shown below).

4.
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Configuring Security Settings in FlashPro

FlashPoint - Programming File Generator - Stepi1 of 3 @

Security level For this device:

-——I=  High Protect with 125-bit Advanced Encryption Standard (AES) key
and Pass Key i
§ - Jse AES kew bowrite or verify the FRPGA Array,
Medium
- Use AES kew bowrite or verify the FlashROM wia the JTAG -
intetface,
- - Mone

| £

Custom Level... Default Lewvel |

Pass Key {max length is 32 HEX chars):

Generate random key |

AES Key (max length is 32 HEX chars):

| Generate random key |

Help Back et | Finish | Cancel |

Figure 133 - Security Settings Dialog Box

5. Move the sliding bar to select the security level for FPGA, FlashROM, and EFMB (see table for a
description of the security levels).

Table 5 - Security Level Descriptions

Security | Security Option Description
Level
High Protect with a Access to the device is protected by an AES Key and
128-bit Advanced | the Pass Key. The Write and Verify operations of the
Encryption FPGA Array use a 128-bit AES encrypted bitstream.

Standard (AES) From the JTAG interface, the Write operation of the

key and a Pass FlashROM uses a 128-bit AES encrypted bitstream.
Key Read back of the FlashROM content via the JTAG
interface is protected by the Pass Key. Read back of the
FlashROM content is allowed from the FPGA Array.

Medium | Protect with Pass | The Write and Verify operations of the FPGA Array
Key require a Pass Key. From the JTAG interface, the Read
and Write operations on the FlashROM content require
a Pass Key. You can Verify the FlashROM content via
the JTAG interface without a Pass Key. Read back of
the FlashROM content is allowed from the FPGA Array.

None No Security The Write and Verify operations of the FPGA Array do
not require keys. The Read, Write, and Verify
operations of the FlashROM content also do not require
keys.

Note: When a device is programmed with a Pass key and AES key, only the Pass key is required for
reprogramming since re-entering the correct Pass key unlocks the bits that restrict programming to
require AES encryption and also unlocks the bits that prohibit reprogramming altogether (if locked);
thus both plaintext and encrypted programming are [re-] enabled.
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6. Enter the Pass Key and/ or the AES Key as appropriate. You can generate a random key by clicking

the Generate random key button.

The Pass Key protects all the Security Settings for the FPGA Array and/or FlashROM.

The AES Key decrypts FPGA Array and/or FlashROM programming file content. Use the AES Key if
you intend to program the device at an unsecured site or if you plan to update the design at a remote

site in the future.
7. Click Finish.

You can also customize the security levels by clicking the Custom Level button.

To change or disable your security keys you must run the ERASE_SECURITY action code. This erases your
security settings and enables you to generate the programming file with new keys and reprogram, or to
generate a programming file that has no security key.

Custom Security Settings

For advanced use, you can customize your security levels.

To set custom security levels:

1. Click the Custom Level button in the Setup Security page. The Custom Security dialog box appears
(see figure below).

Custom Security Level @

i Security Settings
Device Feature Seiﬁtlity Encrypt Road | "lu":l:lify | ?ﬁfrite
FPGA Amray ~ i GEE
FlashROM ~ v RS
firmwareh/NVH_INST (& 1) v "2 i | i

[~ Permanently lock the security settings.

Figure 134 - Custom Security Level

2. Select the FPGA Array Security, the FlashROM Security, and Embedded Flash Memaory block
levels.
The silicon features can have different Security Settings. See the tables below for a description of the
custom security option levels for FPGA Array, FlashROM, and Embedded Flash Memory block.

Table 6 - FPGA Array

Security Option Description

Lock for both writing and verifying Allows
writing/erasing
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Custom Security Settings

Security Option Description

_ set security Settings and verification
Device Feature Encrypt
VP [ pead | Venty | write | | Of (e FPGA

Security

Array via the
FPGA Array W r E E JTAG interface
only with a
valid Pass
Key.

Lock for writing Allows the

Set Security Seftings writing/erasing

Device Feature : E it
Security]| """ YP' [T Raa | werfy | wrte | | Of e FPGA

Array only with
FPGA Arrzy rd r (] 5 a valid Pass

Key.
Verification is
allowed
without a valid
Pass Key.

Use the AES Key for both writing and verifying Allows the
: set Security Settings writing/erasing
Device Feature Security Encrypt e | Verily | Write and verification
of the FPGA
FPGA Array | W | W | E E Array only with
a valid AES
Key via the
JTAG
interface. This
configures the
device to
accept an
encrypted
bitstream for
reprogramming
and verification
of the FPGA
Array. Use this
option if you
intend to
complete final
programming
at an
unsecured site
or if you plan
to update the
design at a
remote site in
the future.
Accessing the
device security
settings
requires a valid
Pass Key.

Allow write and verify Allows
writing/erasing
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Security Option

Description

5 ity Setti
Device Fzature SEt. Encrypt il nnbinke
Security Read | Verify | Wirite
FPGA Array | ™ #

and verification
of the FPGA
Array with
plain text
bitstream and
without
requiring a
Pass Key or an
AES Key. Use
this option
when you
develop your
product in-
house.

Note: The ProASIC3 family FPGA Array is always read protected regardless of the Pass Key or the AES Key

protection.

Table 7 - FlashROM

Security Option

Description

Lock for both reading and writing

Allows the writing/erasing and

_ set Security Settings reading of the FIashRQM via the
Device Feature S | Encrypt - - JTAG interface only with a valid
ecurity Read | Verify | Write PR
Pass Key. Verification is allowed
FlashROM W r ﬁ [ﬁ] E without a valid Pass Key.
Lock for writing Allows the writing/erasing of the
; g FlashROM via the JTAG
: Set Security Settings
Device Feature ShT Encrypt | Uw - | ?N i interface only with a valid Pass
Read 2L € || Key. Reading and verification is
FlashROM ~ r [ 3 | allowed without a valid Pass

Key.

Use the AES Key for writing

Device Feature

Set

Security Settings

Security £

Read | Verify | Write

FlashROM

= I

Allows the writing/erasing of the
FlashROM via the JTAG
interface only with a valid AES
Key. This configures the device
to accept an encrypted
bitstream for reprogramming of
the FlashROM. Use this option if
you complete final programming
at an unsecured site or if you
plan to update the design at a
remote site in the future.

Note: The
bitstream that is
read back from the
FlashROM is
always
unencrypted (plain
text).

Allow reading, writing, and verifying

Allows writing/erasing, reading
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Custom Security Settin

gs

Security Option

Description

Security Setti
Device Feature SEt. Encrypt S e
Security Read | Verify | Write
FlashROM | H

and verification of the
FlashROM content with a plain
text bitstream and without
requiring a valid Pass Key or a
AES Key.

n

Note: The FPGA Array can always read the FlashROM content regardless of these Security Settings.
Table 8 - Embedded Flash Memory Block

Security Option

Description

Device Feature

Lock for reading, verifying, and writing

Set
Security

firmwareVNVM_INST (#1)

| &

Em::r!.rptl

Security Settings

Allows the writing
| and reading of the

-

Read | Verify | Write |

i - I - N i

Embedded Flash
Memory Block via
the JTAG interface
only with a valid
Pass Key.
Verification
accomplished by
reading back and
compare.

Lock for writing

Allows the writing

Device Feature

Set
Security

Encrypt

Security Settings

of the Embedded

Read | Verify | Wirite

Flash Memory

firmwareWNVM_INST (# 1)

¥

C

[ = VR -

Block via the JTAG
interface only with
a valid Pass Key.
Reading and
verification is
allowed without a
valid Pass Key.

Use AES Key for writing

Allows the writing

Device Feature

Set
Security

Encrypt

Security Settings

of the Embedded

Read | Verify | Write

Flash Memory

firmwareVNVM_INST (# 1)

I

[ |

i - S

Block via the JTAG
interface only with
a valid AES Key.
This configures the
device to accept
an encrypted
bitstream for
reprogramming of
the Embedded
Flash Memory
Block. Use this
option if you
complete final
programming at an
unsecured site or if
you plan to update
the design at a
remote site in the
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Security Option Description

future. The
bitstream that is
read back from the
Embedded Flash
Memory Block is
always
unencrypted (plain
text), when a valid
pass key is
provided.

Allow reading, writing, and verifying Allows writing,
: Set Security Settings reading and
HeaLE Toalie Security b Read | Verify | Write verification of the
Embedded Flash
firmwareVNVM_INST (# 1) | r I Memory Block
content with a
plain text bitstream
and without
requiring a valid
Pass Key or an
AES Key.

3. To make the Security Settings permanent, select the Permanently lock the security settings check
box. This option prevents any future modifications of the Security Setting of the device. A Pass Key is
not required if you use this option.

Note: When you make the Security Settings permanent, you can never reprogram the Silicon Signature. If
you lock the write operation for the FPGA Array or the FlashROM, you can never reprogram the
FPGA Array or the FlashROM, respectively. If you use an AES key, this key cannot be changed once
you permanently lock the device.

4. To use the Permanent FlashLock™ feature (One-time programmable or OTP), select Lock for both
writing and verifying for FPGA Array, Lock for both reading and writing for FlashROM, Lock for
reading, writing, and verifying for each Embedded Flash Memory Block (for Fusion and
SmartFusion), if present, and select the Permanently lock the security settings checkbox as shown
in the figure below. This will make your device one-time programmable.
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Changing or Disabling Security Keys

F o " 5
Custom Security Level lﬁ

Silicon Feature Sas:‘}“y Encrypt Msm'"v;ﬂs‘:“mfme
FPGA Aray ] i) i 5
AashROM [ = (] i 7
eNVM (# 0) ] 5 7 T
eNVM ( 1) B i iy H

|| Enable M3 debugger
Permanently lock the security settings.

0 The following silicon features will not be reprogrammable:
- Security settings, AES key, and silicon signature

-FPGA Array

- FlashROM

-eNVM (3 0)

-elVM (£ 1)

Cxd (o

Custom Security Level- Permanent Lock

5. Click the OK button. The Security Settings page appears with the Custom security setting
information.

Changing or Disabling Security Keys
To change or disable your security keys you must run the ERASE_SECURITY action code.

ERASE_SECURITY erases your security settings and enables you to generate the programming file with
new keys and reprogram, or to generate a programming file that has no security key.

Your action codes vary according to device family:
e Programming File Actions - SmartFusion and Fusion Devices
e Programming Actions - IGLOO and ProASIC3 Devices

Configuring FlashROM Settings in FlashPro

To configure the FlashROM settings:
1. From the Configuration menu, choose Load Programming File (PDB).
2. Select the PDB file and click Open, this loads the programming file.

3. From the Configuration menu, choose PDB Configuration. The Programming File Generator
appears.

4. Check the FlashROM checkbox and click Browse to load a FlashROM configuration file. Click Next.
This brings up the FlashROM Settings dialog box (see figure below).
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FlashROM Settings - Step 2 of 2

|FIashROM reqions: Region_0_0 j
Program Properties:
page Name Region_ 00
v Start page I}
Start word 1]
e Length 18
Content Static
o State Fixed
= Type HEx
Walue F14F8FFAF340541851
v SERESDOT104080
2
v
v

Help | Back I Text I Finish Cancel

Figure 135 - FlashROM Settings Dialog Box

5. Select the FlashROM memory page that you want to program.

6. Enter the data value for the configured regions.

7. If you selected the region with a Read From File, specify the file location.

8. If you selected the Auto Increment region, specify the Start and Max values.

9. Enter the number of devices you want to program.
10. Click the Target Programmer button. The Select Programmer Type dialog box appears.
11. Click Finish. FlashPoint generates your programming file.

Note: You cannot change the FlashROM region configuration from FlashPoint. You can only change the
configuration from the FlashROM core generator.

Express Configuration

The express configuration feature in FlashPro allows you to set the security settings as well as FlashROM
content without a design. This allows the production flow to be executed in parallel to the design effort if
needed.

For example, you can pre-program the security settings with the High Security setting and serialize the
device using FlashROM without the FPGA design in a secured programming environment. The FPGA Array
and EFMB design can be programmed in unsecured programming environment using encrypted
programming file. Refer to Programming Only Security Settings Tutorial for more information.

Note: This feature is only available for SmartFusion, IGLOO, ProASIC3 and Fusion devices.
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Express Configuration

IGLOO and ProASIC3 Programming
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Programming File Actions for IGLOO and ProASIC3 Devices

IGLOO and ProASIC3 devices support the following features:
o FPGA Array
e FlashROM
e Security settings
You can program these features separately or together using different programming files or by using one
programming file.
Note: When we specify a family name, we refer to the device family and all its derivatives, unless otherwise
specified. See the Supported Families topic for a complete list of families and their derivatives.

The STAPL files for IGLOO and ProASIC3, excluding ProASIC3L, devices include actions targeted at one,
two, or all three of the IGLOO and ProASIC3 features (FPGA Array and FlashROM and Security Settings).
The combinations of the features you selected to target results in different actions that are available in the
STAPL file. See the following table for an illustration.

The table indicates that if you choose the feature FPGA Array, it will be affected by the PROGRAM file
action.

If you choose the feature Security, it will be unaffected by the PROGRAM action.
Table 9 - IGLOO and ProASIC3 Device Programming Actions

Features Selected

FPGA | FlashROM | Security | FPGA FPGA | FlashROM
Array Array and [ Array and
FlashROM | and Securi
Security ty

STAPL Actions Available (correspond with Features
Selected above)

PROGRAM X X X X X
VERIFY X X X X X
ERASE X X X X X
ERASE_ALL X X X X X X
DEVICE_INFO X X X X X X
READ_IDCODE X X X X X X
ERASE_FROM X X X

PROGRAM_FROM

ERASE_ARRAY X X X
VERIFY_ARRAY X X X
ENC_DATA_AUTHENTICATION | X X X
PROGRAM_SECURITY X X X
ERASE_SECURITY X X X
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Express Configuration

Note: The ENC_DATA_AUTHENTICATION Action is only available when you choose encrypted programming.

Programming Actions

See the table below for a list of all the actions for the programming file.

Table 10 - Programming File Actions

Action

Description

PROGRAM

Programs all selected family features: FPGA Array, targeted
FlashROM pages, security setting and silicon signature (if
provided).

VERIFY

Verifies all selected features: FPGA Array, targeted
FlashROM pages, security setting and silicon signature (if
provided).

ERASE

Erases all selected family features: FPGA Array, targeted
FlashROM pages, security setting and silicon signature (if
provided).

ERASE_ALL

Erases all features in the targeted device regardless of the
features selected to generate the STAPL file.

DEVICE_INFO

Displays the IDCODE, Silicon Signature, the design name,
the checksum, and device security settings and programming
environment information programmed into the device.

VERIFY_DEVICE_INFO

Verifies the IDCODE, silicone signature, design name,
checksum, device security settings and programming
information programmed into the device.

READ_IDCODE

Reads the device ID code from the device.

ERASE_FROM

Erases only the targeted FlashROM pages, not the entire
FlashROM.

PROGRAM_FROM

Programs only the targeted FlashROM pages.

VERIFY_FROM

Verfies the targeted FlashROM pages.

PROGRAM_ARRAY

Programs the FPGA Array and Silicon Signature (if
applicable) into the device.

VERIFY_ARRAY

Verifies the FPGA Array and Silicon Signature (if applicable)
into the device.

ERASE_ARRAY

Erases the FPGA Array and Silicon Signature (if provided).

PROGRAM_SECURITY

Programs only the Security Settings.

ERASE_SECURITY

Erases only the Security Settings.

Note: FIX_INT_ARRAYS - This function is only applicable to STAPL file only. Depending on the STAPL player
implementation, the indexing of an integer array may start from different direction. The STAPL standard did not
clearly specify how it should be implemented. The FIX_INT_ARRAYS function detects the indexing implemented
by the STAPL player and flips the content of the integer array if needed.
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UNLOCK_UKEY: This function unlocks a secured device if it is locked by FlashLock.

Options available in Programming Actions
The table below shows the available actions in the programming file.
Table 11 - Programming File Actions

Action Description

PROGRAM When you target the Security Setting, you have the option of not
erasing and programming the Security Setting by deselecting the
following 2 procedures before executing the action. -
SET_ERASE_SEC, - DO_PROGRAM_SECURITY. When you
perform encrypted programming, you have the option of skipping
the data authentication before programming by deselecting the
DO_ENC_AUTHENTICATION procedure before executing the
action.

ERASE When you target the Security Setting, you have the option of not
erasing the Security Setting by deselecting the
SET_ERASE_SEC procedures before executing the action.

PROGRAM_ARRAY | When you perform encrypted programming, you have the option
of skipping the data authentication before programming by
deselecting the DO_ENC_AUTHENTICATION procedure before
executing the action.

Note: The DO_ENC_AUTHENTICATION procedure prevents you from proceeding with encrypted programming
with incorrect data due to corruption or an operator error. If incorrect data is detected during encrypted
programming, the device will not be functional after programming.
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Programming File Actions - SmartFusion and Fusion

SmartFusion and Fusion (AFS) Programming

Programming File Actions - SmartFusion and Fusion

FlashPro enables you to program security settings, FPGA Array, eNVM and embedded flash memory blocks
(EFMB), and FlashROM features for AFS device support. You can program these features separately using
different programming files or you can combine them into one programming file.

Note: If you are programming SmartFusion devices you are using eNVM. If you are programming Fusion devices
you are using the Embedded Flash Memory Block (EFMB). When referring to these elements together we refer
to them as eNVM/EFMB.

The STAPL files for SmartFusion and Fusion devices include actions targeted at one, two, or all four of the
programming features: FPGA Array and FlashROM, Security Settings, and eNVM/EFMB. The combinations
of the features you selected to target, results in different actions that are available in the STAPL file. See the
following table for an illustration.

The table indicates that if you select ERASE_ALL that it will affect any Programming Feature (or
combination of features) marked with an X. According to the table, the only Programming Feature unaffected
by ERASE_ALL is the eNVM/EFMB.

Compare that to the ERASE command: ERASE does not have any effect on the following Programming
Features: Security; Embedded Flash Memory Block; Security AND eNVM/EFMB.

Table 12 - SmartFusion and Fusion Programming File Actions

Programming Features Selected

FP | Flash | Sec |eNVM/ FP |[Flash |Sec |FPGA |FPG |Flash |FPGA | FPG | Flash
GA | ROM |urity | Embedded | GA | ROM [urity | Array |A ROM | Array, |A ROM,
Arr Flash Arr | and and |[and Arra | and Flash [ Arra | Securi
ay Memory ay |[eNVM |eNV |Flash |y Securi | ROM |y, ty and
Block and |/ M/ ROM [and |ty and Sec |eNVM/
(EFMB) eN |[EFMB | EFM Sec eNVM | urity | EFMB

VM/ B urity / and

EF EFMB [ eNV

MB M/

EFM

B

STAPL Actions Available (correspond with Features Selected above)

PROGRAM X |x X X X X X X X X
VERIFY X |x X X X X X X X |X
ERASE X |x X X X X X X X |X
ERASE_ALL X |x X X X X X X X X X X
DEVICE_INFO X |x X X X X X X X X X X X
READ_IDCODE X |x X X X X X X X X X X X
ERASE_FROM X X X X X X
PROGRAM_ARRAY | X X X X X X
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Programming Features Selected

VERIFY_ARRAY X X X X X X
ENC_DATA_AUTHE |X X X X X X
NTIFICATION
PROGRAM_SECURI X X X X X X
TY
ERASE_SECURITY X X X X X X
VERIFY_SECURITY X X X X X X
PROGRAM_FP X X X X X X X
VERIFY_FP X X X X X X X
PROGRAM_NVM X X X X X X X
VERIFY_NVM X X X X X X X
PROGRAM_NVM_A X X X X
CTIVE_ARRAY
VERIFY_NVM_ACTI X X X X
VE_ARRAY
PROGRAM_NVM_A X X X X
CTIVE_RSTM3
RESET_CORTEXM3 X X X X X X X
(SmartFusion only)

Note: The ENC_DATA_AUTHENTICATION Action is only available when you choose encrypted programming.

Note: PROGRAM_NVM_ACTIVE_ARRAY and VERIFY_NVM_ACTIVE_ARRAY actions are not available when
the EFMB read/write/verify is locked with FlashLock.

STAPL Actions

See the table below for a list of all the actions for the STAPL file.
Table 13 - STAPL File Actions

Action Description

PROGRAM Programs all selected family features: FPGA
Array, targeted FlashROM pages, security setting
and silicon signature (if provided).

SmartFusion only: Resets the CORTEX M3.

VERIFY Verifies all selected family features: FPGA Array,
targeted FlashROM pages, security setting and
silicon signature (if provided).

ERASE Erases the selected family features.
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Programming File Actions - SmartFusion and Fusion

Action

Description

ERASE_ALL

Erases all features in the targeted family device
except Embedded Flash Memory Blocks,
regardless of the features selected to generate
the STAPL file.

DEVICE_INFO

Displays the IDCODE, Silicon Signature, the
design name, the checksum, and device security
settings and programming environment
information programmed into the device.

READ_IDCODE

Reads the device ID code from the device.

ERASE_FROM

Erases only the targeted FlashROM pages, not
the entire FlashROM.

PROGRAM_FROM

Programs only the targeted FlashROM pages.

PROGRAM_ARRAY

Programs the FPGA Array and Silicon Signature
(if applicable) into the device.

SmartFusion only: Resets the CORTEX M3.

VERIFY_ARRAY

Verifies the FPGA Array and Silicon Signature (if
applicable) into the device.

ERASE_ARRAY

Erases the FPGA Array and Silicon Signature (if
provided).

PROGRAM_SECURITY

Programs only the Security Settings.

ERASE_SECURITY

Erases only the Security Settings.

PROGRAM_NVM

Programs the targeted EFMBSs.

SmartFusion only: Resets the CORTEX M3.

VERIFY_NVM

Verifies the targeted EFMBSs.

PROGRAM_NVM_ACTIVE_ARRAY

Programs the targeted EFMBs while the FPGA
Array remains active.

VERIFY_NVM_ACTIVE_ARRAY

Verifies the targeted EFMBs while the FPGA
Array remains active.

PROGRAM_NVM_ACTIVE_RSTM3

SmartFusion only; programs the eNVM while the
core is active and then resets the CORTEX M3.

RESET_CORTEXMS3

SmartFusion only; resets the CORTEX M3.

Options available in STAPL Actions

The table below shows the available actions in the STAPL file.
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Table 14 - STAPL File Actions
Action Description
PROGRAM When you target the Security Setting, you have the option of not

erasing and programming the Security Setting by deselecting the
following two procedures before executing the action.

- SET_ERASE_SEC,

- DO_PROGRAM_SECURITY. When you perform encrypted
programming, you have the option of skipping the data
authentication before programming by deselecting the

DO_ENC_AUTHENTICATION procedure before executing the
action.

ERASE When you target the Security Setting, you have the option of not
erasing the Security Setting by deselecting the
SET_ERASE_SEC procedures before executing the action.

PROGRAM_ARRAY | When you perform encrypted programming, you have the option
of skipping the data authentication before programming by
deselecting the DO_ENC_AUTHENTICATION procedure before
executing the action.

Note: The DO_ENC_AUTHENTICATION procedure prevents you from proceeding with encrypted programming
with incorrect data due to corruption or an operator error. If incorrect data is detected during encrypted
programming, the device will not be functional after programming.
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Generate a Programming File in FlashPoint

Generating Programming Files

Generate a Programming File in FlashPoint

FlashPoint enables you to program security settings, FPGA Array, and FlashROM features for SmartFusion,
IGLOO, ProASIC3, Fusion family devices. You can program these features separately using different
programming files or you can combine them into one programming file. Each feature is listed as a silicon
feature in the GUI.

You can generate a programming file with one, two, or all of the silicon features from the Programming File
Generator first page.

To generate a programming file:
1. Select the Silicon feature(s) you want to program.

e Security settings
o FPGA Array

e FlashROM
FlashPoint - Programming File Generator - Step 1 of 2 [ %]

Silicon Featurels) to be programmed:
[ Security settings
¥ FRGa Array
[V FlashromM
Criginal FlashROM configuration file:

r?:'|,A3PEQUAL'|,A3P125_BI'|,smartgen'l,UFROMFIXZ'l,UFROMFIXZ.ch —— |

™ Programming previously secured device(s)

o Specify [j0 States During Programming. ..

Silicon signature {max length is 8 HEX chars):

Back | Mext | Finish | Cancel |

Figure 136 - Programming File Generator — Step 1 of 2

Note: When FlashPoint is invoked for the first time, after netlist files are imported and the design is in
post-layout state, the software retrieves the FlashROM and EFM blocks configuration files from
the imported netlists and imports the configuration files. Otherwise, you need to import
configuration files.

2. Click the Programming previously secured device(s) check box if you are reprogramming a device
that has been secured.

Because the SmartFusion, IGLOO, ProASIC3, Fusion families enable you to program the Security Settings
separately from the FPGA Array and/or FlashROM, you must indicate if the Security Settings were
previously programmed into the target device. This requirement also applies when you generate
programming files for reprogramming.

3. Enter the silicon signature (0-8 HEX characters). See Silicon Signature for more information.
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4. Depending upon the Silicon features you selected, click Next or Finish.

If you click Next, follow the instructions in the appropriate dialog box. If you click Finish, the Generate
Programming Files dialog box appears (as shown in the figure below). Use this dialog box box to specify
the programming file name, location, output format (STAPL file, SVF file, PDB file, DirectC DAT file, 1532
file), and, if necessary, limit the file size (as explained below).

Some testers may have memory size restrictions for a single SVF file. The SVF limit file option enables you

to limit the size of each SVF file by either file size or vectors.

The generated SVF files append an index to the file name indicating the sequence of files. The format is:
<SVF_filename>_XXXXX.svf

where XXXXX is the index of the SVF file. The first SVF file begins with <SVF_filename>_00000.svf and

increments by 1 until file generation is complete.

Maximum file size: Max file size limit for the SVF file; use this option to limit your SVF file size based on

number of kB.

Maximum number of vectors: Max vector limit for the SVF file; use this option to limit the size of your SVF
based on number of vectors.

Generate Programming Files E|
hame: Existing programming files in this location:
o | TOP HF.pdb
HF .stp
Location: TOP.pdb
| Piadblaspzs0 TOP.stp
[aToP 1532

BT o0 LA TOP_sv

0 Output Farmats:

[ JIEEE 1532 Files (*.bsd; *.isc)
[ |DirectC Filz (*.dat)
[wIProgramming Data File {*.pdb)
[WISTAPL File (*.stp)

[w]Serial Wector Files {*.swf)

[+ Limit file size

(% Maximum file size 9000 KE
" Maximum number of veckors ,7

Generate | Cancel |

Figure 137 - Generate Programming Files Dialog Box (Flashpoint)

Programming File Types

The table below summarizes the Microsemi SoC programming file types and programmers.

Unless otherwise noted, listing an individual device indicates the device family and all its derivatives. For
example, IGLOO indicates IGLOO, IGLOOe, IGLOO nano and IGLOO plus. See the Supported Families
topic for more information. See the list of programming file type descriptions below for more details.

Programming File Device Support Programmer
Type
PDB (*.pdb) See device FlashPro 4/3/3x
specifications
STAPL (*.stp) FlashPro 4/3/3x, FlashPro Lite, FlashPro,
Silicon Sculptor l1/11
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Programming File Types

Programming File Device Support Programmer
Type
SVF (*.svf) Third party programmer
IEEE 1532 (*.isc or Third party programmer
* bsd)

The following programming-related files are required if you use the related functional block elements in your
enabled devices. See the appropriate sections of the FlashPro help for more information on creating these
files.

File Type Device Support Function

FDB (*.fdb) | See device specifications | Contains your FPGA array data

UFC (*.ufc) Contains your FlashROM data

EFC (*.efc) Contains your Embedded Flash Memory file

PDB Files

A proprietary Microsemi programming data file.
STAPL Files

The Standard Test And Programming Language (STAPL) is designed to support the programming of
programmable devices and testing of electronic systems, using the IEEE Standard 1149.1: “Standard Test
Access Port and Boundary Scan Architecture” (commonly referred to as JTAG) interface. As a STAPL file is
executed, signals are produced on the IEEE 1149.1 interface, as described in the STAPL file. STAPL
operates on a single IEEE 1149.1 chain. STAPL supports the programming of any IEEE 1149.1-compliant
programmable device.

STAPL has support for programming and test systems with user interface features. A single STAPL file may
perform several different functions, such as programming, verifying, and erasing a programmable device.
Bitstream Files

Proprietary Microsemi programming data file.
SVF Files

Courtesy Serial Vector Format Specification from ASSET InterTech, 1999:

Serial Vector Format (SVF) is the media for exchanging descriptions of high-level IEEE 1149.1 bus
operations. In general, IEEE 1149.1 bus operations consist of scan operations and movements between
different stable states on the IEEE 1149.1 state diagram. SVF does not explicitly describe the state of the
IEEE 1149.1 bus at every Test Clock.

The SFV file is defined as an ASCII file that consists of a set of SVF statements. The maximum number of
characters on a line is 256, although one SVF statement can span more htan one line. Each statement
consists of a command and associated parameters. Each SVF statement is terminated by a semicolon. SVF
is not case sensitive.

IEEE 1532 Files

Courtesy ieee.org:

The IEEE 1532 files implement programming capabilities within programmable integrated circuit devices,
utilizing (and compatible with) the 1149.1 communication protocol. This standard allows the programming of
one or more compliant devices concurrently, while mounted on a board or embedded in a system, known as
In-System Configuration.
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Generate a Programming File for SmartFusion

You can configure and generate a new PDB file from FlashPoint.

If you are using Single Mode, click Create to add a new PDB, or click Modify to make changes to a loaded
PDB.

In Chain Mode, if you have not already done so, construct a chain and click Create PDB to create a new
PDB for programming, or click Modify PDB to make changes to a loaded PDB.

FlashPoint enables you to specify your security settings and silicon features when you generate your
programming file in SmartFusion. You can specify your FPGA Array, FlashROM, and Embedded Flash
Memory by importing FDB, UFC and EFC files, respectively (as shown in the figure below). If you have
imported a FlashROM and Embedded Flash Memory file you can click Modify to configure these feature
before saving your PDB file.

Click Specify 1/0 States During Programming to set custom 1/O states.
NOTE: You must import an FDB to populate Port Name and Macro Cell columns.

FlashPoint - A2F200M3F. pdb

£

Silicon Featureds) to be programmed:

I¥ Security settings Specify,..

ER ¥ Frca array

Cihactelpritsmartfusion_sample_fpro_files\SD.fdb Impott. ..

B W Flashrom
Cihactelpritsmartfusion_sample_fpro_files\MSs_IUFROM_0,ufc Import. .. | Modify, .. |

m Iv Embedded Flash Memary

/¢y SilActel_Project_Testings|SmartFusionicomponentiwork),.. \M55_ENYM_D.efc Impart... | Madify. .. |

o Specify [j0 States During Programming. ..

Silicon signature {max length is 8 HEX chars):

Help Save PDB | Cancel

Figure 138 - FlashPoint Programming Settings for SmartFusion

Creating a Programming Database (PDB) File in Designer

The programming database (PDB) file supports SmartFusion, IGLOO, ProASIC3 and Fusion devices only.
This allows reconfiguration of the security settings, FlashROM, FPGA Array, and Embedded Flash Memory
Blocks. You create the file in Designer using FlashPoint and you modify the file in FlashPro.

You must create programming files for SmartFusion in FlashPro; see the Generate a Programming File for
SmartFusion topic for more information.

1. From the Designer main window, click the Programming File button. This brings up FlashPoint (see
figure below).
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Programming Embedded Flash Memory Block

FlashPoint - Programming File Generator - Step 1 of 3 E|

Silicon Featurels) o be programmed:
o Iv Security settings
v FPGA Array
¥ FlashRoM
Original FlashROM configuration File:

Embedded Flash Memory Blocks (EFME):

Program :I:;:; LE:;?:EH Original Configuration File
1 Ird firraare AR 1 F:\Flazh_Meman_Block. efc Modify,..

[ Programming previously secured device(s)

Modify /0 States During Programming. ..

Silicon signature (max length is 8 HEX chars):

Help ext Finish Cancel

Figure 139 - FlashPoint Programming File Generator - PDB File

2. Select the silicon feature(s) to be programmed: Security Settings, FPGA array, FlashROM, and
Embedded Flash Memory Block. If you are programming a previously secured device, check the
Programming previously secured device(s) and enter the silicon signature.

3. Click Finish to create the PDB file.

See Also
Configuring security and FlashROM settings in FlashPro
Configuring security settings in FlashPro

Configuring FPGA array settings
Configuring FlashROM settings in FlashPro
Configuring Embedded Flash Memory Block settings in FlashPro

Programming Embedded Flash Memory Block

For more information about the Embedded Flash Memory Block, see the Flash Memory System Builder
online help.

To program the Embedded Flash Memory Block:
1. Check the Program box to enable Embedded Flash Memory Block modification.
2. Click the Modify button to import Embedded Flash Memory Block configuration and memory content.
The Modify Embedded Flash Memory Block dialog box appears.
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Modify Embedded Flash Memary Block X
EBlock name: Firrnarel il _TNST
Block location: 1
Elock configuration file: hprodaauditinym_all_newinem_all_new.efc Import Configuration File..,
Block content:
Select all Clients Unselect All Clients
JTAG Protection
] i Start Client . !
Program |Client Type | Client Hame | Address depthXwidth Pievent Prevent | Original Memory Content File
[hex) Read Write
q Icd Analog Syste  ash Meds MAA r i~
2 I CF| Data cfiDiata N N/& r i~ D\ prod@0auditsrvm_simplehinpul_m Import content
3 ~ Data Storage  ds 0 X8 I I D:\prodB0auditsnm_simpletinput_m Imnpoit cortent
4 Ird Initizlization  init1 an X8 I I D:AprodB0auditsnym_simplehinput_m Import content..
5 " RaM Initializat raminit 100 512¢9 I I
Help oK | Cancel ‘

Figure 140 - Modify Embedded Flash Memory Block Content Dialog Box

3. Click the Import Configuration File button (if available) to import the Embedded Flash Memory Block
configuration and memory content from the EFC file. This will populate the client table below. All
clients that belong to this block will be selected by default.

. Click the Import content button if you want to change the client memory content.
5. Click OK.

Note: FlashPoint audits original configuration and memory content files and warns you if the files
cannot be located or if they have been updated.

Programming the FPGA Array
The FPGA Array contains your design; in FlashPro for SmartFusion you must have an FDB file to program
your FPGA Array.
You can program the FPGA Array by selecting the silicon feature FPGA Array in the Generate
Programming File page and clicking OK.
In FlashPro, if you are using a PDB with an FPGA Array you cannot de-select it for programming unless you
are using SmartFusion.
See Generate a programming file for more information.

Programming the FlashROM

You can program selected memory pages and specify the region values of the FlashROM.

To program FlashROM:
1. Select FlashROM from the Generate Programming File page.

2. Enter the location of the FlashROM configuration file. The FlashROM Settings page appears (see
figure below).

Select the FlashROM memory page that you want to program.

Enter the data value for the configured regions.

If you selected the region with a Read From File, specify the file location.

If you selected the Auto Increment region, specify the Start and Max values.

Click Finish.

FlashPoint generates your programming file.

Note: You cannot change the FlashROM region configuration from FlashPoint. You can only change the
configuration from the FlashROM core generator.

N otk »
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Silicon Signature

Silicon Signature

With Libero SoC tools, you can use the silicon signature to identify and track Microsemi designs and
devices. When you generate a programming file, you can specify a unique silicon signature to program into
the device. This signature is stored in the design database and in the programming file, and programmed
into the device during programming.

The silicon signature is accessible through the USERCODE JTAG instruction.

Note: If you set the security level to high, medium, or custom, you must program the silicon signature along with
the Security Setting. If you have already programmed the Security Setting into the target device, you cannot
reprogram the silicon signature without reprogramming the Security Setting.

The previously programmed silicon signature will be erased if:
e You have already programmed the silicon signature and
e You are programming the security settings, but you do not have an entry in the silicon signature field

Programming Security Settings

FlashPoint allows you to set a security level of high, medium, or none (SmartFusion uses radio buttons and
the option Clear Security instead of None).

To program Security Settings on the device:
1. If you choose to program Security Settings on the device from the Generate Programming File page,
the wizard takes you to the Security Settings page.

Your Security Settings page depends on your family.

2. Set the security level for FPGA, FlashROM, and EFMB (see the table below for a description of the
security levels).

Table 15 - FPGA, FlashROM, and EFMB Security Settings

Security Security Option Description
Level
High Protect with a 128- Access to the device is protected by an AES Key
bit Advanced and the Pass Key.
Encryption Standard | The Write and Verify operations of the FPGA Array
(AES) key and a use a 128-bit AES encrypted bitstream.
Pass Key From the JTAG interface, the Write and Verify

operations of the FlashROM use a 128-bit AES
encrypted bitstream. Read back of the FlashROM
content via the JTAG interface is protected by the
Pass Key.

Read back of the FlashROM content is allowed from
the FPGA Array. The Read and Verify operations of
the EFMB module are protected by Pass Key from
the JTAG interface. The Write operations of the
EFMB module use a 128-bit AES encrypted
bitstream.

Medium [ Protect with Pass The Write and Verify operations of the FPGA Array
Key require a Pass Key.

From the JTAG interface, the Read and Write
operations on the FlashROM content require a Pass
Key. You can Verify the FlashROM content via the
JTAG interface without a Pass Key.

Read back of the FlashROM content is allowed from
the FPGA Array. The Read, Write, and Verify
operations of the EFMB module are protected by
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Security Security Option Description
Level
Pass Key from the JTAG interface.
None No security The Write and Verify operations of the FPGA Array

do not require keys. The Read, Write, and Verify
operations of the FlashROM content also do not
require keys. The Read, Write, and Verify operations
of the EFMB module content do not require keys.

This option is available for SmartFusion; to choose it,
de-select the Security Settings checkbox.

Note: When a Device is programmed with a Pass key and AES key, only the Pass key is required for
reprogramming since re-entering the correct Pass key unlocks the bits that restrict programming to
require AES encryption and also unlocks the bits that prohibit reprogramming altogether (if locked);
thus both plaintext and encrypted programming are [re-] enabled.

3. Enable eNVM client JTAG protection - Enables eNVM client JTAG
protection in the event you have not set Medium or High security. Enables you
to protect specific clients with a user pass key and then leave others
unprotected. This can be advantageous if you want to protect your IP, but give
another user access to the rest of the eNVM for storage. You can also set
custom security levels for your eNVM.

NOTE: EFMB (Fusion) is called eNVM for SmartFusion devices.

4. Enter the Pass Key and/ or the AES Key as appropriate. You can generate a
random key by clicking the Generate random key button.

The Pass Key protects all the Security Settings for the FPGA Array, FlashROM, and/or EFMB.

The AES Key decrypts the FPGA Array, FlashROM, and/or EFMB programming file content. Use the AES
Key if you intend to program the device at an unsecured site or if you plan to update the design at a remote
site in the future.

You can also customize the security levels by clicking the Custom Level button. For more information, see
the Custom Security Levels section.

To change or disable your security keys you must run the ERASE_SECURITY action code. This erases your
security settings and enables you to generate the programming file with new keys and reprogram, or to
generate a programming file that has no security key.

Custom Security Levels
For advanced use, you can customize your security levels.

To set custom security levels:

1. Click the Custom Level button in the Security Settings page. The Custom Security Level dialog
box appears.

2. Select the FPGA Array Security and the FlashROM Security levels. For SmartFusion and Fusion
devices, you can also choose the Embedded Flash Memory Block level of security. The FPGA Array
and the FlashROM can have different Security Settings. See the tables below for a description of the
custom security option levels for FPGA Array and FlashROM.

Table 16 - FPGA Array

Security Option Description

Lock for both writing and verifying Allows
writing/erasing
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Custom Security Levels

Security Option Description

_ set security Settings and verification
Device Feature Encrypt
VP [ pead | Venty | write | | Of (e FPGA

Security

Array via the
FPGA Array W r E E JTAG interface
only with a
valid Pass
Key.

Lock for writing Allows the

Set Security Seftings writing/erasing

Device Feature : E it
Security]| """ YP' [T Raa | werfy | wrte | | Of e FPGA

Array only with
FPGA Arrzy rd r (] 5 a valid Pass

Key.
Verification is
allowed
without a valid
Pass Key.

Use the AES Key for both writing and verifying Allows the
: set Security Settings writing/erasing
Device Feature Security Encrypt e | Verily | Write and verification
of the FPGA
FPGA Array | W | W | E E Array only with
a valid AES
Key via the
JTAG
interface. This
configures the
device to
accept an
encrypted
bitstream for
reprogramming
and verification
of the FPGA
Array. Use this
option if you
intend to
complete final
programming
at an
unsecured site
or if you plan
to update the
design at a
remote site in
the future.
Accessing the
device security
settings
requires a valid
Pass Key.

Allow write and verify Allows
writing/erasing
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Security Option Description

; gat Security Settings and verification
Device Faature Encrypt
e | werify | write of the FPGA

Security A ith

rray wi
FPGA Array | r [ plainytext
bitstream and
without
requiring a
Pass Key or an
AES Key. Use
this option
when you
develop your
product in-
house.

Note: The ProASIC3 family FPGA Array is always read protected regardless of the Pass Key or the AES Key
protection.

Table 17 - FlashROM

Security Option Description

Lock for both reading and writing Allows the
: Set Security Settings writing/erasing and
Device Feature Security Encrypt e | Verity | Nt reading of thg
FlashROM via the
FlashROM 4 r A (] 8 | JTAG interface
only with a valid
Pass Key.
Verification is
allowed without a
valid Pass Key.

Lock for writing Allows the
: 3 writing/erasing of

Device Feature Seaurity| ENCTYPt———VSETROS i FlashROM via

Read | Verify | Wirite || 0 11aG interface
FlashROM ~ r | @ ] 3 | only with a valid
Pass Key. Reading
and verification is
allowed without a
valid Pass Key.

Use the AES Key for both writing and verifying Allows the
Device Feature ol Encrypt st e s Wm’:‘ng/?rasw;ghand
security] """ ["Reaq [ verity | wnite | | /MU0 O e
— ashROM via the
FlashROM ~ ¥ B JTAG interface
only with a valid
AES Key. This
configures the
device to accept
an encrypted
bitstream for
reprogramming
and verification of
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Custom Security Levels

Security Option Description

the FlashROM.
Use this option if
you complete final
programming at an
unsecured site or if
you plan to update
the design at a
remote site in the
future.

Note: The
bitstream that is
read back from the
FlashROM is
always
unencrypted (plain
text).

Allow reading, writing, and verifying Allows
; set Security Settings writing/erasing,
Device Feature Security Encrypt Road | Verty | Write rea_d_ing_and
verification of the
FlashROM | r i FlashROM content
with a plain text
bitstream and
without requiring a
valid Pass Key or
an AES Key.

The FPGA Array can always read the FlashROM content regardless of these Security Settings.
Table 18 - Embedded Flash Memory Block

Security Option Description
Lock for reading, verifying, and writing Allows the writing
: set | Security Settings | |and reading of the
Device Feature . | Encrypt
Security | Read | Verify | write | smbeo'd%‘? F'ssh
emory Block via
firmwarelNVM_INST (# 1) | #= r 5 5 B3 | e JTAG interface

only with a valid
Pass Key.
Verification
accomplished by
reading back and
compare.

Lock for writing Allows the writing
. Set Security Settings of the Embedded
Device Feature : Encrypt
Security Read | Verify | Write g'lasﬂ 'V,'eThor%TAG
ock via the
firmwareVNVR_INST (£ 1) ¥ r [E] [Ei] i interface only with
a valid Pass Key.
Reading and
verification is
allowed without a
valid Pass Key.
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Security Option Description
Use AES Key for writing Allows the writing
: Set Security Settings of the Embedded
Device Feature : Encrypt
security " '"'| Read | Verify | Wirite | | F/@sh Memory

firmwareUNVIM_INST (# 1) ¥ [~ A B H i?wlt%??a\éf SnyJV;ﬁ]G
a valid AES Key.
This configures the
device to accept
an encrypted
bitstream for
reprogramming of
the Embedded
Flash Block. Use
this option if you
complete final
programming at an
unsecured site or if
you plan to update
the design at a
remote site in the
future. The
bitstream that is
read back from the
Embedded Flash
Memory Block is
always
unencrypted (plain
text), when a valid
pass key is
provided.

Allow reading, writing, and verifying Allows writing,
: Set Security Settings reading and
fadeetia doc il Security ekl Read | Verify | Write verification of the
Embedded Flash
firmwareVHVRIM_INST (# 1) | r i Memory Block
content with a
plain text bitstream
and without
requiring a valid
Pass Key or an
AES Key.

3. To make the Security Settings permanent, select Permanently lock the security settings check box.
This option prevents any future modifications of the Security Setting of the device. A Pass Key is not
required if you use this option.

Note: When you make the Security Settings permanent, you can never reprogram the Silicon Signature. If
you Lock the write operation for the FPGA Array or the FlashROM, you can never reprogram the
FPGA Array or the FlashROM, respectively. If you use an AES key, this key cannot be changed once
you permanently lock the device.

4. (SmartFusion Only) Enable M3 Debugger option enables access to the M3 debugger even if security is
enforced. Select the Enable M3 debugger checkbox if you want to access the M3 debugger after
programming.
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Custom Security Levels

To use the Permanent FlashLock™ feature (One-time programmable or OTP), select Lock for both
writing and verifying for FPGA Array, Lock for both reading and writing for FlashROM, Lock for
reading, writing, and verifying each Embedded Flash Memory Block (for Fusion and SmartFusion),
if present, and select the Permanently lock the security settings checkbox as shown in the figure
below. This will make your device one-time programmable.

F " N
Custom Secunty Level lﬁ

Silicon Feature Sei"‘;ﬂy Encrypt Mse”‘“v;ﬂ_s‘:m"gfme
FPGA Array ] i) i 5
AashROM [ = (i) =
eNVM (# 0) ] ﬁ m ﬁ
eNVM (# 1) B 7 i &

|| Enable M3 debugger
Permanently lock the security settings.

0 The following silicon features will not be reprogrammable:
- Security settings, AES key, and silicon signature

-FPGA Array

- FlashROM

- eMNVM (3 0)

- eNVM (# 1)

e

Figure 141 - Custom Security Level

6. Click the OK button. The Security Settings page appears with the Custom security settings
information as shown in the figure below.
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Security Settings - Step 2 of 2

%]

Security level For this device:

i SREUTE) SRR Security settings For FPGA Array:

- |lse AES kew ko write or verify the FPGA Array,

Security settings For FlashROmM:
- Use AES kew ko write the FlashROM via the JTAG interface.

Custom Level... | Default Lewvel |

Pass Kew (max length is 32 HEX chars):

| DE67BEOFI6ASDTESAE] 7FAED4AG4EB1 659 Generate random key |

BES key (max length is 32 HEX chars):

| &A7EESEECCBOATF47FE00FEZ77DOTTE Generate randam key

Help Back Finish Cancel

Figure 142 - Security Settings

Reprogramming a Secured Device

You must know the previous Security Settings of the device before you can reprogram a device with
Security Settings.

Programming a Secured SmartFusion Device
After you create a PDB you may wish to export a programming file for a secured device. To do so:
1. Create a PDB file (as explained above) with security set to High or Medium. Save the PDB file.

2. From the File menu, choose Export Single Programming File. The Export Programming Files dialog
box appears.

3. Click the Export programming file(s) for currently secured device checkbox. This exports
programming files for devices that already have security settings programmed.

Choose your outputs and enter your output file Name and Location.

5. Click Export to create the file(s). Your updated secured programming files are in the directory you
specified.

Custom Serialization Data for FlashROM Region

FlashPoint enables you to specify a custom serialization file as a source to provide content for programming
into a Read from file FlashROM region. You can use this feature for serializing the target device with a
custom serialization scheme.

To specify a FlashROM region:

1. From the Properties section in the FlashROM Settings page, select the file name of the custom
serialization file (see figure below). For more information on custom serialization files, see Custom
Serialization Data File Format.
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Custom Serialization Data File Format

Figure 143 - FlashROM Settings

Custom Serialization Data File Format

FlashPoint supports custom serialization data files that specify the data in binary, HEX, decimal, or ASCII

text. The custom serialization data files may contain multiple data with the Line Feed (LF) character as the
delimiter. You can create a file by entering serialization data into any type of text editor. Depending on the
serialization data format (hex, ASCII, binary, decimal), input the serialization data according to the size of

the region you specified in the FlashROM settings page.

Semantics

Each custom serialization file has only one type of data format (binary, decimal, Hex or ASCII text). For
example, if a file contains two different data formats (i.e. binary and decimal) it is considered an invalid file.

The length of each data file must be shorter or equal to the selected region length. If the data is shorter then
the selected region length, the most significant bits shall be padded with 0’s. If the specified region length is
longer then the selected region length, it is considered an invalid file.
The digit / character length is as follows:
-Binary digit: 1 bit
-Decimal digit: 4 bits
-Hex digit: 4 bits
-ASCI1 Character: 8 bits

Note the standard example below:
If you wanted to use, for example, device serialization for three devices with serialization data 123, 321, and
456, you would create file name from_read.txt. Each line in from_read.txt corresponds to the serialization
data that will be programmed on each device. For example, the first line corresponds to the first device to be
programmed, the second line corresponds to the second device to be programmed, and so on.

Hex serialization data file example
The following example is a Hex serialization data file for a 40-bit region. Enter the serialization data below
into file created by any text editor:
123AEd210
AeB1
0001242E

Note: If you enter an invalid Hex digit such as 235SedF1, an error occurs. An error will also occur if you enter
data that is out of range, i.e. 4300124EFE.

The following is an example of programming "AeB1" into Region_7_1 located on page 7, from Word 5 to
Word 1 in the FlashROM settings page. See Custom serialization data for FlashROM region for more
information.

Table 15 | ... Word 5 | Word 4 | Word 3 | Word 2 | Word 1 | Word O

Page 7 | ... o | ... | 00 00 00 AE B1
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Binary serialization data file example

The following example is a binary serialization data file for a 16-bit region:
1100110011010001

100110011010011

11001100110101111 (This is an error: data out of range)
1001100110110111

1001100110110112 (This is an error: invalid binary digit)

Decimal serialization data file example

The following example is a decimal serialization data file for a 16-bit region:
65534

65535

65536 (This is an error: data out of range)

6553A (This is an error: invalid decimal digit)

Text serialization data file example

The following example is a text serialization data file for a 32-bit region:
AESB

A e

ASE3 23 (This is an error: data out of range)

65A~

1234

AEbF

Syntax
Indentations in the syntax below indicate a wrapped line. If a line wraps and is not indented, then it should
appear on one line; you may need to expand your help window to view the syntax correctly.
Custom serialization data file =
<hex region data list> | <decimal region data list> |
<binary region data list> | <ascii text data list>
Hex region data list = <hex data> <new line> { < hex data> <new line> }
Decimal region data list = <decimal data> <new line> {<decimal data><new line> }
Binary region data list = <binary data> <new line> { <binary data> <new line> }
ASCII text region data list = < ascii text data> <new line> { < ascii text data> <new
line> }
hex data = <hex digit> {<hex digit>}
decimal data = < decimal digit> {< decimal digit>}
binary data = < binary digit> {< binary digit>}
ASCIl text data = <ascii character> {< ascii character >}
new line = LF
binary digit = “0”]“1”
decimal digit = “07|“1”]“27|“3”|“4”|“57|“6”|“7*|“8"] “9~
hex digit = <07 <17 <27 <37 <4 |57 |67 |77 1“8 <97 | “A"|“B*|“C”|“D" | “E’| “F" |
ca’] *b” | <c’| <d” | “e’| “F
ascii character = characters from SP(0x20) to“~”(OX7E).

File Format Limitations

The read from file data size cannot exceed the size of the region. The maximum size supported for each
format is described below:

HEX - limited to the size of the FlashROM page. Maximum size of 128-bits
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DEC - 32-bit unsigned numbers. Maximum decimal value is: 4294967295
BIN - limited to the size of the FlashROM page. Maximum size of 128-bits
TEXT - limited to the size of the FlashROM page. Maximum size of 128-bits

Specifying 1/0O States During Programming

You can modify the 1/O states during programming in FlashPro. In FlashPro, this feature is supported for
PDB files generated from Designer v8.5 or greater.

Note: PDB files generated from Designer v8.1 to Designer v8.4 (including all service packs) have limited display
of Pin Numbers only.

1. Load a PDB from the FlashPro GUI. You must have a PDB loaded to modify the I/O states during
programming.

2. From the FlashPro GUI, click PDB Configuration. A FlashPoint — Programming File Generator
window appears.

3. Click the Specify I/0 States During Programming button to display the Specify I/0O States During
Programming dialog box.

4. Sort the pins as desired by clicking any of the column headers to sort the entries by that header.
Select the I/Os you wish to modify (as shown in the figure below).

5. Set the I/0O Output State. You can set Basic I/O settings if you want to use the default I/O settings for
your pins, or use Custom I/O settings to customize the settings for each pin. See the Specifyin
States During Programming - I/O States and BSR Details help topic for more information on setting
your 1/O state and the corresponding pin values. Basic I/O state settings are:

e 1-1/0 is set to drive out logic High
e 0-1/Ois set to drive out logic Low

e Last Known State: I/O is set to the last value that was driven out prior to entering the programming mode, and

then held at that value during programming

e 7 - Tri-State: I/O is tristated
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Specify I/0 States During Programming
Load from File. .. Save ko file... [™ show BSR Details
Port Hame Macro Cell Pin Humber 1/0 State [Output Only) j
BIST ADLIB:INBUF T2 1
BvPA55_10 ADLIB:INBUF K1 1
CLE. ADLIB:INBUF B1 1
ENOUT ADLIB:INBUF J16 1
LED ADLIB:OUTBUF M3 a
MOMITOR[O] ADLIB:OUTBUF ES a
MOMNITOR[1] ADLIB:OUTBUF c7 d
MOMNITOR[2] ADLIB:OUTBUF k] d
MOMITOR[3] ADLIB:OUTBUF D7 d
MOMNITOR[4] ADLIB:OUTBUF A1 d
OEa ADLIB:INBUF E4 d
OEb ADLIB:INBUF F1 d
O5C_EN ADLIB:INBUF K3 d
PAD[10] ADLIB:BIBUF_LYCMOS33U ME d
PAD[11] ADLIB:BIBUF_LYCMOS33D R? d
PAD[12] ADLIB:BIBUF_LYCMOS33U D11 d
PAD[13] ADLIB:BIBUF_LYCMOS33D c12 d
PAD[14] ADLIB:BIBUF_LYCMOS33U RE d LI
Help | OF I Cancel |

Figure 144 - 1/O States During Programming Window
6. Click OK to return to the FlashPoint — Programming File Generator window.

Note: 1/O States During programming are saved to the ADB and resulting programming files after
completing programming file generation.

Custom 1/O Settings and Boundary Scan Registers

Each 1/O in your device is comprised of an Input, Output and Output Enable Boundary Scan Register (BSR)
cell..

The BSR cells enable you to define 1/O states during programming and control the individual states for each
Input, Output, and Output Enable register.

The Specify I/O States During Programming dialog box enables access to each of these BSR cells for
control over the individual states. You can use the 1/0 State (Output Only) settings to set a specific output
state and ignore the other values for the individual BSR elements, or you can click the Show BSR Details
checkbox for control over the settings for each Input, Output Enable, and Output as you exit programming.

Specifying 1/0O States During Programming - I/O States and BSR
Details

The I/O States During Programming dialog box enables you to set custom I/O states prior to programming.

I/O State (Output Only)
Sets your I/O states during programming to one of the values shown in the list below.
e 1 —1/Os are set to drive out logic High
e 0-1/Os are set to drive out logic Low

e Last Known State: I/Os are set to the last value that was driven out prior to entering the programming
mode, and then held at that value during programming

e Z-Tri-State: I/Os are tristated
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When you set your 1/O state, the Boundary Scan Register cells are set according to the table below. Use the
Show BSR Details option to set custom states for each cell.

Table 19 - Default I/O Output Settings

Output State Settings
Input Control (Output Output
Enable)
Z (Tri-State) 1 0 0
0 (Low) 1 1 0
1 (High) 0 1 1
Last_Known_State | Last_Known_State | Last_Known_State Last_Known_State
Table Key:

e 1 — High: I/Os are set to drive out logic High
e 0-Low: I/Os are set to drive out logic Low

e Last Known_State - I/Os are set to the last value that was driven out prior to entering the
programming mode, and then held at that value during programming

Boundary Scan Registers - Enabled with Show BSR Details

Sets your I/O state to a specific output value during programming AND enables you to customize the values
for the Boundary Scan Register (Input, Output Enable, and Output). You can change any Don't Care value in
Boundary Scan Register States without changing the Output State of the pin (as shown in the table below).

For example, if you want to Tri-State a pin during programming, set Output Enable to 0; the Don't Care
indicates that the other two values are immaterial.

If you want a pin to drive a logic High and have a logic 1 stored in the Input Boundary scan cell during
programming, you may set all the values to 1.

Table 20 - BSR Details 1/0 Output Settings

Output State Settings
Input Output Enable Output
Z (Tri-State) Don't Care 0 Don't Care
0 (Low) Don't Care 1 0
1 (High) Don't Care 1 1
Last Known State Last State Last State Last State
Table Key:

e 1 — High: I/Os are set to drive out logic High
e 0-Low: I/Os are set to drive out logic Low
e Don't Care — Don'’t Care values have no impact on the other settings.

e Last Known_State — Sampled value: I/Os are set to the last value that was driven out prior to entering
the programming mode, and then held at that value during programming

The figure below shows an example of Boundary Scan Register settings.
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Specify I/0 States During Programming
Load from File. .. Save ko file... ¥ show BSR Details

_ Boundary Scan Registers -

Port HName Macro Cell Pin Number Input %l:.lapl;‘::g Dutput j
BIST ADLIB:INBUF T2 a 1 1
BvPA55_10 ADLIB:INBUF K1 a 1 1
CLE. ADLIB:INBUF B1 a 1 1
ENOUT ADLIB:INBUF J16 a 1 1
LED ADLIB:OUTBUF M3 1 1 a
MOMITOR[O] ADLIB:OUTBUF ES 1 1 a
MOMNITOR[1] ADLIB:OUTBUF c7 1 a a
MOMNITOR[2] ADLIB:OUTBUF k] 1 a a
MOMITOR[3] ADLIB:OUTBUF D7 1 a a
MOMNITOR[4] ADLIB:OUTBUF A1 1 a a
OEa ADLIB:INBUF E4 1 a a
OEb ADLIB:INBUF F1 1 a a
O5C_EN ADLIB:INBUF K3 1 a a
PAD[10] ADLIB:BIBUF_LYCMOS33U ME 1 a a
PAD[11] ADLIB:BIBUF_LYCMOS33D R? 1 a a
PAD[12] ADLIB:BIBUF_LYCMOS33U D11 1 a a
PAD[13] ADLIB:BIBUF_LYCMOS33D c12 1 a a

PAD[14] ADLIB:BIBUF_LYCMOS33U RE 1 a a LI

Help | OF I Cancel |

Figure 145 - Boundary Scan Registers

Specify 1/0 States During Programming Dialog Box

The I/O States During Programming dialog box enables you to specify custom settings for 1/0Os in your
programming file. This is useful if you want to set an 1/O to drive out specific logic, or if you want to use a
custom 1/O state to manage settings for each Input, Output Enable, and Output associated with an 1/O.

Load from file

Load from file enables you to load an I/O Settings (*.ios) file. You can use the 10S file to import saved
custom settings for all your I/Os. The exported |I0OS file have the following format:

e Used I/Os have an entry in the 10S file with the following format:

set_prog_io_state -portName {<design_port_name>} -input <value> -outputEnable <value> -
output <value>

e Unused I/Os have an entry in the IOS file with the following format:

set_prog_io_state -pinNumber {<device_pinNumber>} -input <value> -outputEnable <value> -
output <value>

Where <value> is:
e 1-1/Ois set to drive out logic High
e 0-1/Ois set to drive out logic Low

e Last Known_State: I/O is set to the last value that was driven out prior to entering the programming
mode, and then held at that value during programming

e 7 - Tri-State: I/O is tristated

Save to file

Saves your I/O Settings File (*.ios) for future use. This is useful if you set custom states for your 1/Os and
want to use them again later in conjunction with a PDC file.

126 FlashPro User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content. C . .
> Microsemi.

Generate a DAT file

Port Name

Lists the names of all the ports in your design.
Macro Cell

Lists the 1/O type, such as INBUF, OUTBUF, PLLs, etc.
Pin Number

The package pin associate with the 1/0.

I/O State (Output Only)

Your custom I/O State set during programming. This heading changes to Boundary Scan Register if you
select the BSR Details checkbox; see the Specifying I/O States During Programming - I/O States and BSR

Details help topic for more information on the BSR Details option.

Specify I/0 States During Programming
Load from File. .. | Save ko file... | [™ show BSR Details
Port Hame Macro Cell Pin Humber 1/0 State [Output Only) —
BIST ADLIB:INBUF T2 1 —
BvPA55_10 ADLIB:INBUF K1 1
CLE. ADLIB:INBUF B1 1
ENOUT ADLIB:INBUF J16 1
LED ADLIB:OUTBUF M3 a
MOMITOR[O] ADLIB:OUTBUF ES a
MOMNITOR[1] ADLIB:OUTBUF c7 d
MOMNITOR[2] ADLIB:OUTBUF k] d
MOMITOR[3] ADLIB:OUTBUF D7 d
MOMNITOR[4] ADLIB:OUTBUF A1 d
OEa ADLIB:IMBUF E4 z
OEb ADLIB:INBUF F1 d
O5C_EN ADLIB:INBUF K3 d
PAD[10] ADLIB:BIBUF_LYCMOS33U ME d
PAD[11] ADLIB:BIBUF_LYCMOS33D R? d
PAD[12] ADLIB:BIBUF_LYCMOS33U D11 d
PAD[13] ADLIB:BIBUF_LYCMOS33D c12 d
PAD[14] ADLIB:BIBUF_LYCMOS33U RE d LI
Help | OF I Cancel |

Figure 146 - 1/O States During Programming Dialog Box

Generate a DAT file

DAT files are generated via the Generate Programming Files dialog box.
To access the Generate Programming Files dialog box from Libero SoC and generate a DAT file:

1. In the Design Flow window, expand Implement Design, right-click Generate Programming Data and
choose Open Interactively. This opens Designer.

Click Programming File to start FlashPoint.

Set your feature and I/O options if necessary. Click Finish. This opens the Generate Programming File
dialog box, as shown in the figure below.
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Generate Programming Files E]

Mame: Existing programming files in this location:
| DAT_progl| | sD1.pdb
S01.skp
Location:

| Ci\Documents and SettingsiFarleyciDeskioplactel_projy |

Browse...

Oukput formats:

[C]IEEE 1532 Files (*.bsd; *.isc)
[#]DirectC File {*.dat)
[¥]Pragramming Data File (*.pdb)
[]STARL File (* stp)

[C]5erial ector Files (*.5vf)

[ Generate ] [ Cancel ]

Figure 147 - Generate Programing Files Dialog Box - DirectC File (*.dat)
4. Set your output file Name and Location.
5. Set your Output Formats to DirectC file (*.dat) and Programming Data File (*.pdb).
6. Click Generate to create your file.

Parallel Port Cable Information
The FlashPro software supports the generic Parallel Port Cable.
To connect to the Parallel Port Cable:

1. From the Parallel Port Cable text box, select the Parallel Port Buffer Cable (as shown in the figure
below).

2. Select the parallel port that is connected to the cable from the Parallel Port text box.

Connect Parallel Port Cable

Parallel port cable:  |[2E0EE N el o 10 = = =

Parallel port: LPT1 ﬂ

Iv Crive TRST pin

Help (o] 4 | Cancel

Figure 148 - Connect Parallel Port Cable

3. Click OK.
The Para2Buff programmer is added to the programmer list.
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Importing and Exporting Files

Importing Configuration Files

To import a configuration file:
1. From the File menu, choose Import Configuration File . The Import Configuration File dialog box
appears.

2. Navigate to your file and click Open.

Exporting Configuration Files

To export a configuration file:

1. From the File menu, choose Export and then choose Export Configuration File. The Export
Configuration File dialog box appears.

2. Navigate to your file and click Save.

Export Programming Files (SmartFusion Only)

Export Programming Files enables you to export DirectC DAT, PDB and STP programming files. Exporting
programming files is supported in both Chain and Single mode; to export programming files in Chain mode
you must select one SmartFusion device in your chain.

To export a programming file:
1. From the FlashPro File menu choose Export > Single Programming File. The Export Programming
Files dialog box appears.
2. Specify the Output format, Name and Location and click Export to create the files.
Export programming files for currently secured device enables you to generate PDB files for devices
that have already been programmed with security settings. It generates encrypted data for encrypted
features.

Target Programming Solution and STAPL file type options are available only if you have serialization.

Target Programming Solution

e Select Microsemi IHP (In House Programming) when generating STAPL or SVF files for Microsemi
IHP.

e Select Silicon Sculptor Il, BP Auto Programmer, or FlashPro5/4/3 when generating programming files
for those programmers.

e Select Generic STAPL Player when generating STAPL files for generic STAPL players.
STAPL File Type Options

e Single STAPL file for all devices: Generates one programming file with all the generated increment
values or with values in the custom serialization file.

e One STAPL file per device: Generates one programming file for each generated increment value or
for each value in the custom serialization file.
Limit file size
Some testers may have memory size restrictions for a single SVF file. The SVF limit file option enables you
to limit the size of each SVF file by either file size or vectors.
The generated SVF files append an index to the file name indicating the sequence of files. The format is:
<SVF_filename>_XXXXX.svf
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where XXXXX is the index of the SVF file. The first SVF file begins with <SVF_filename>_00000.svf and
increments by 1 until file generation is complete.

Maximum file size: Max file size limit for the SVF file; use this option to limit your SVF file size based on
number of kB.

Maximum number of vectors: Max vector limit for the SVF file; use this option to limit the size of your SVF
based on number of vectors.

When serialization is available, choose the appropriate Target Programming Solution and STAPL File Type
(if necessary) for your programming chain.

Export Programming Files &l

Loaded PDE file: D:\templ TOP . pdb
i I
0 Cukput Formats: Mame:
[WIIEEE 1532 Files (*.bsd; *.isc) & |'|'Op
[wiDirectC File {*.dat)
[CJProgramming Data File {*.pdh) Location:

[WISTAPL File (*.5kp) | Diikemp
[wiSerial Vector Files (*.svf)

Browse...

0 Existing prograrnming files in this location:
r oo |
~
i
-~
~
v Limit file size
(% Maximum File size | 9000] kB
™ Maximum number of wectars ,7

Help Export | Close

Figure 149 - Export Programming Files Dialog Box

Exporting a Chain STAPL File

To export a chain STAPL file:

1. From the File menu, select Export and then choose Export Chain STAPL File. The Export Chain
STAPL File dialog box appears.

2. Name your file and click Save.

Note: Chain STAPL file export is supported if all selected SmartFusion, IGLOO, ProASIC3 and Fusion
devices have STAPL or PDB files loaded.

Exporting a Chain SVF File

To export a chain SVF file:

1. From the File menu, choose Export and then choose Export Chain SVF File. The Export Chain SVF
File dialog box appears.

2. Name your file and click Save.

Note: Chain SVF file export is supported if all selected devices have STAPL or PDB files loaded.
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Exporting Single Device STAPL Files

To export a single STAPL file in single mode:

This option is available only for single programming mode projects with a PDB file loaded (refer to Single
STAPL file basic tutorial for more information).

1. From the File menu, choose Export > Export Single Device STAPL File. The Export Single Device
STAPL File dialog box appears.

2. Name your file and click Save.

To export a single device STAPL file in chain mode:

This option is available only for chain programming mode projects with a PDB file loaded (refer to Chain
programming tutorial for more information). Exporting a single device STAPL file is only supported for one
device in the chain.

1. Select only one device from the chain, and from the File menu, select Export and then choose Export
Single Device STAPL File. The Export Single Device STAPL File dialog box appears.

2. Name your file and click Save.
Or

1. Right-click a device in the Chain Configuration Window, and then choose Export Single Device
STAPL File. The Export Single Device STAPL File dialog box appears.

2. Name your file and click Save.

Exporting Single Device SVF Files
The following steps describe how to export SVF files.
To export single device SVF files in single mode:

This option is available only for single programming mode projects with a PDB file loaded (refer to Single
STAPL file basic tutorial for more information).

1. From the File menu, select Export and then choose Export Single Device SVF File. The Export
Single Device SVF File dialog box appears.

2. Name your file and click Save.

Note: Multiple SVF files will be generated from a single PDB. Each file corresponds to a PDB action, and will be
saved in the <SVF_filename> folder as <SVF_filename>_<action name>.SVF.

To export single device SVF files in chain mode:

This option is available only for chain programming mode projects with a PDB file loaded (refer to _Chain
programming tutorial for more information).

1. Select only one device from the chain, and from the File menu, choose Export and then choose
Export Single Device SVF File. The Export Single Device SVF File dialog box appears.

2. Name your file and click Save.
Or

1. Right-click a device in the Chain Configuration Window, and then choose Export Single Device SVF
File. The Export Single Device SVF File dialog box appears.

2. Name your file and click Save.

Note: Multiple SVF files will be generated from a single PDB. Each file corresponds to a PDB action, and will be
saved in the <SVF_filename> folder as <SVF_filename>_<action name>.SVF.

Exporting Single Device 1532 Files

IEEE 1532 programming files will only be exported in FlashPro for SmartFusion devices when an FDB has
been properly imported.
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To export single device 1532 files in single mode:

This option is available only for single programming mode projects with a PDB file loaded (refer to Single
STAPL file basic tutorial for more information).

1. From the File menu, choose Export Single Device 1532 File. The Export Single Device 1532 File
dialog box appears.

2. Name your file and click Save.

Note: Two files will be generated from a single PDB and will be saved in the <1532_filename>_1532
folder as

Note: IEEE 1532 BSDL file - <1532_filename>.bsd
Note: IEEE 1532 Data file - <1532_filename>.isc

To export single device 1532 files in chain mode:

This option is available only for chain programming mode projects with a PDB file loaded (refer to Chain
programming tutorial for more information). Exporting a single device STAPL file is only supported for one
device in the chain.

1. Select only one device from the chain, and from the File menu, choose Export and then choose
Export Single Device 1532 File. The Export Single Device 1532 File dialog box appears.

2. Name your file and click Save.
Or

1. Right-click a device in the Chain Configuration Window, and then choose Export Single Device 1532
File. The Export Single Device 1532 File dialog box appears.

2. Name your file and click Save.

Note: Two files will be generated from a single PDB and will be saved in the <1532_filename>_1532
folder as

Note: IEEE 1532 BSDL file - <1532_filename>.bsd
Note: IEEE 1532 Data file - <1532_filename>.isc

Opening an Existing FlashPro Project on a Different Machine

Opening a FlashPro project created on a different PC than it was created on causes tool problems. The
project cannot be opened and the PDB file cannot be imported. You must export the configuration file from
the original machine and import it on the new machine in order to preserve your project.

To move a FlashPro project and open it on a different machine:

1. Export configuration files on the machine where you created the original project. The configuration
files contain all FlashPro settings, including loaded programming files.

2. Send the configuration files to the new desktop
3. Open FlashPro on the new desktop and create a new FlashPro project.
4. Import the configuration file.
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Using Hot Keys

General Hot Keys

You can use hot keys for a lot of the features of the FlashPro software. See the table below for a list of

general hot keys.

Table 21 - FlashPro Software General Hot Keys

Feature Hot Key
New Project Ctrl+N
Open Project Ctrl+O
Save Project Ctrl+S
Import Configuration File Ctrl+l
Refresh Views F5
Refresh/Rescan for Programmers Ctrl+F5

See Also
Single STAPL programming hot keys

Chain programming hot keys

Single Device Programming Hot Keys

See the table below for the hot keys for single device programming.

Table 22 - Single Device Programming Hot Keys

Feature Hot Key
Load a STAPL file Ctrl + Shift + L
Select Action and Procedures Ctrl + Shift + A
Enable Serialization Ctrl + Shift + S
Select Serialization Data Ctrl + Shift + R
View Serialization Status Ctrl + Shift + U
View Chain Parameter (Pre/Post IR/DR) Ctrl + Shift + H
Configure Target Device Ctrl + Shift + D

Run

Ctrl + Return
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Chain Programming Hot Keys

See the table below for the hot keys for chain programming.
Table 23 - Chain Programming Hot Keys

Feature Hot Key

Add Microsemi Device Ctrl + Shift + T
Add non Microsemi Device Ctrl + Shift + N
Remove Device Ctrl + R
Configure Device Ctrl + F

Load STAPL File Ctrl + Shift + L
Load BSDL File Ctrl + Shift + B
Enable Device Ctrl + E

Select Action and Procedures Ctrl + Shift + A
Enable Serialization Ctrl + Shift + S
Select Serialization Data Ctrl + Shift + R
View Serialization Data Ctrl + Shift + u
Copy Device Ctrl + Shift + C
Cut Device Ctrl + Shift + X
Paste Device Ctrl + Shift + V
Move Device Down Ctrl+ D

Move Device Up Ctrl + U

Run Ctrl + Return

Batch Mode

Batch mode programming can be achieved by executing FlashPro TCL scripts from the command line.

The example below executes The FlashPro TCL script batch.tcl from the command line:
<location of Microsemi software>/bin/flashpro.exe script:batch.tcl
Batch.tcl contains the following script:

new_project -name {newproject} -location {./newproject} -mode {single}
set_programming_file -file {./design.stp}

set_programming_action -action {PROGRAM}

run_selected_actions

close_project
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About TCL Commands - FlashPro Tcl Command Reference

A Tcl (Tool Command Language) file contains scripts for simple or complex tasks. You can run scripts from
the Windows command line or store and run a series of Tcl commands in a *.tcl batch file. The Tcl
commands supported by FlashPro are listed in the table below.

Note: Tcl commands are case sensitive. However, their arguments are not.

Command Action
add_actel device Adds an Actel device to the chain
add_non_actel_device Adds a non-Actel device in the chain
add_non_actel device to_database Imports settings via a BSDL file that adds

non-Actel or non-Microsemi devices to the
device database

check_flash_memory Performs diagnostics of the page status and
data information

close_project Closes the FlashPro project
compare_analog_config Compares the content of the analog block

configurations in your design against the
actual values in the device

compare_flashrom_client Compares the content of the FlashROM
configurations in your design against the
actual values in the selected device

compare_memory_client Compares the memory client in a specific
device and block

configure_flashpro prg Changes FlashPro programmer settings
configure_flashpro3 prg Changes FlashPro 3 programmer settings
configure_flashpro4 prg Changes FlashPro 4 programmer settings
configure flashpro5 prg Changes FlashPro 5 programmer settings
configure_flashproLite prg Changes FlashPro Lite programmer settings
connect_cable Connects a parallel cable to a port
construct_chain_automatically Automatically starts chain construction for the

specified programmer

copy device Copies a device in the chain to the clipboard

cut_device Removes one or more devices from the chain

dump_tcl_support Unloads the list of supported FlashPro Tcl
commands

enable_device Enables or disables a device in the chain

enable_prg Enables or disables one or more
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Command

Action

programmers

enable_prg_type

Enables or disables all programmers of a
specified programmer type

enable_procedure

Enables/disables an optional procedure for an
action

enable_serialization

Enables/disables serialization for a device

export_config

Exports a configuration file

export_script

Exports the history in a Tcl script

export_secured pdb

Exports a single device secured PDB from
the loaded PDB

export_single 1532

Exports a single device 1532 file

export_single_dat

Exports a single device DirectC data file

export_single_stapl

Exports a single device STAPL file

export_single svf

Exports a single device SVF file

export_stapl Exports the ChainBuilder STAPL file in chain
programming mode

import_config Imports a configuration file

new_project Creates a new FlashPro project or convert an
old ChainBuilder project into a new FlashPro
project

open_project Opens a FlashPro project

paste_device

Pastes the devices that are on the clipboard
in the chain

ing_pr

Pings one or more programmers

read_analog_block _config

Reads analog block configuration information

read device status

Compares the memory client in a specific
device and block

read_flash_memory

Reads information from the eNVM modules

read_flashrom

Reads the content of the FlashROM

read id code

Reads IDCode from the device without
masking any IDCode fields

recover_flash_memory

Removes ECC2 errors due to memory
corruption by reprogramming specified flash
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About TCL Commands - FlashPro Tcl Command Reference

Command

Action

memory (NVM) pages

refresh_prg_list

Refreshes the programmer list

remove_device

Removes the device from the chain

remove _non_actel device to database

Removes settings for non-Microsemi or non-
Actel device from the device database

remove_pr

Removes the programmer from the
programmer list

run_selected actions

Runs the selected action on the specified
programmer and returns the exit code from
the action

sample analog channel

Samples the configured analog channel with
the ADC parameters you provided

save_log

Saves the log file

save_project

Saves the FlashPro project

save_project_as

Saves the FlashPro project under a new
project name

scan_chain_prg

Runs scan chain on a programmer

select from region_name

Enables you to select the serialization region
you want to add to the log file

select libero design _device

Selects the Libero design device to resolve
when there are two or more identical Libero
design devices in the configured JTAG chain.
This TCL command is for Libero usage only.

select_serial _range

Selects the serialization data

select target device

Sets the target device for programming in
Single Device Programming mode

self_test prg Runs Self-Test on a programmer
set_bsdl_file Sets a BSDL file to a non-Actel device in the

chain

set_chain_param

Sets the chain parameters in single
programming mode

set_debug device

Identifies the device you intend to debug

set_debug programmer

Identifies the programmer you want to use for
debugging (if you have more than one)

set_device to highz

Sets a disabled Microsemi or Actel device in
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Command

Action

Chain programming mode to HIGH-Z

set_device ir

Sets the IR length of a non-Actel device in the
chain

set_device_name

Changes the user name of a device in the
chain

set_device order

Sets the order of the devices in the chain to
the order specified

set _device tck

Sets the maximum TCK frequency of a non-
Actel device in the chain

set_device_type

Changes the family of an Actel device in the
chain

set_main_log_file

Sets the FlashPro log file

set prg_name

Changes the user name of a programmer

set_programming_action

Selects the action for a device

set_programming_file

Sets the programming file for a device

set_programming_mode

Sets the programming mode

set_serialization log_file

Sets the log file to be used for serialization

set_serialization_mode

Sets the serialization mode

update programming_file

Updates the programming file with the
selected parameters

Running Tcl Scripts from within FlashPro

Instead of running scripts from the command line, you can use FlashPro's Run Script dialog box to run a

script.

To execute a Tcl script file within FlashPro:

1. From the File menu, choose Run Script to display the Execute Script dialog box.
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Running Tcl Scripts from the Command Line

Execute Script §|

Script File: ||

Browse

Argurnentz; |

Fiun Cancel | Help |

Figure 150 - Execute Script Dialog Box

2. Click Browse to display the Open dialog box, in which you can navigate to the folder containing the
script file to open. When you click Open, FlashPro enters the full path and script filename into the
Execute Script dialog box for you.

3. Inthe Arguments box, enter the arguments to pass to your Tcl script. Separate each argument by a
space character. For information about accessing arguments passed to a Tcl script, see

4. Click Run.

Running Tcl Scripts from the Command Line
You can run Tcl scripts from your Windows command line.

To execute a Tcl script file in the FlashPro software from a shell command line:
1. Atthe prompt, type the path to the Microsemi software followed by the word "SCRIPT" and a colon,
and then the name of the script file as follows:
<location of Microsemi software>/bin/flashpro.exe SCRIPT:<filename>
The example below executes in batch mode the script foo.tcl:
<location of Microsemi software>/bin/flashpro.exe script:foo.tcl
The example below executes in batch mode the script foo.tcl and exports the log in the file foo.txt:
<location of Microsemi software>/bin/flashpro.exe script:foo.tcl logfile:foo.txt
The example below executes in batch mode the script foo.tcl, creates a console where the log is
displayed briefly, and exports the log in the file foo.txt:

<location of Microsemi software>/bin/flashpro.exe script:foo.tcl console_mode:brief
logfile:foo.txt

If you leave console_mode unspecified or set it to 'hide' FlashPro executes without a console window. If
you want to leave the console window open you can run the script with the console_mode parameter set
to 'show’, as in the following example:
<location of Microsemi software>/bin/flashpro.exe script:foo.tcl console_mode:show
logfile:foo.txt
2. If you want to pass arguments to the Tcl script from the command line, then use the "SCRIPT_ARGS"
variable as follows:

<location of Microsemi software>/bin/flashpro.exe SCRIPT:<filename> SCRIPT_ARGS: " paraml
param2 param3"

Arguments passed to a Tcl script can be accessed through the Tcl variables argc and argv. The example
below demonstrates how a Tcl script accesses these arguments:
puts "Script name: $argv0"
puts "Number of arguments: $argc"
set i 0
foreach arg $argv {
puts "Arg $i : $arg"
incr i
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Note: Script names can contain spaces if the script name is protected with double quotes:
flashpro.exe script:"flashpro tcl/foo 1.tcl"

Exporting Tcl Scripts from within FlashPro

To export a set of Tcl commands from the FlashPro history:
1. From the File menu, choose Export > Export Script.
2. Enter the filename and click Save. The Script Export Options dialog is appears (see image below).

Script Export Options §|

[ include commands from cument project only

Filenarne farmatting

* Relative filenames [default]

" Qualified flenarmes (full path; including directan name)

Help k. | Cancel

Figure 151 - Script Export Options Dialog Box

3. Check the Include commands from current project only to export commands of the current project
only. You can specify the filename formatting by selecting Relative filenames (relative to the current
directory) or Qualified filenames(absolute path, including the directory name).

4. Click OK.

add_actel device

Adds an Actel device to the chain. Either the file or device parameter must be specified. Chain
programming mode must have been set.

add_actel_device [-File {filename}] [-device {device}] -name {name} [-ukey {ukey value}]

Arguments
Where:
-file{filename}
Specifies a programming filename.
—-device{device}
Specifies the Actel device family(such as AFS600).
-name{name}
Specifies the device user name.
-ukey{ukey value}
Optional (SmartFusion only) - Specifies the ukey value.
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add_non_actel_device

Supported Families
Al

Exceptions
None

Example
add_actel_device —file {e:/design/stp/TOP.stp} —name {MyDevicel}
add_actel_device —device {A3P250} —name {MyDevice2}

add_non_actel device

Adds a non-Actel device in the chain. Either the file, or (-tck And -ir) parameters must be specified. The
Chain programming mode must have been set.

add_non_actel_device [-File {file}] [-ir {ir}] [-tck {tck}] [-name {name}]

Arguments
-file {filename}
Specifies a BSDL file.
-ir {ir}
Specifies the IR length.
-tck {tck}
Specifies the maximum TCK frequency (in MHz).

-name {name}

Specifies the device user name.

Supported Families
All

Exceptions

None

Examples
add_non_actel_device —file {e:/design/bsdl/DeviceX.bsdl } —name {MyDevice3}
add_non_actel_device —ir 8 — tck 5 —name {MyDevice4}

add_non_actel device to_database

Imports settings via a BSDL file that adds non-Actel or non-Microsemi devices to the device database so
that they are recognized during scan chain and auto-construction operations.

add_non_actel_device_to_database [-file {bsdl_filename}]

Arguments
-File {bsdl_filename}
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Specifies the path to the BSDL file and the BSDL filename add to the database.

Supported Families
All non-Microsemi and non-Actel families

Exceptions
N/A

Examples
The following example uses a BSDL file to add a non-Microsemi (1502AS J44) device to the device
database:
add_non_actel_device_to_database —file {c:/bsdl/atmel/1502AS_J44_bsd}
The following example uses a BSDL file to add a non-Microsemi (80200) device to the device database:
add_non_actel_device_to_database —file {c:/bsdl/intel/80200_v1.0.bsd}

check flash_memory

The command performs diagnostics of the page status and data information as follows:
e Page Status — includes ECC2 check of the page status information, write count
e Page Data - ECC2 check

check_flash_memory

[-name {device name}]

[-block {integer_value}]
[-client {client_name}]
[-startpage {integer_value}]
[-endpage {integer_value}]
[-access {all | status | data}]
[-show {summary | pages}]
[-file {filename}]

At a minimum you must specify -client <name> OR
-startpage <page_number> -endpage <page_number> -block <number>

Arguments
-name {device_name}

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.

-block {integer_value}

(Optional argument; you must set -client or —startpage, —endpage and —block before use.) Specifies
location of block for memory check.

-client {client_name}

Name of client for memory check.

-startpage {integer_value}

Startpage for page range; value must be an integer. You must specify a —endpage and —block along with
this argument.

-endpage {integer_value}

Endpage for page range; value must be an integer. You must specify a —startpage and -block along with
this argument.

-access {all | status | data}
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close_project

(Optional argument; you must set -client or —startpage, —endpage and —block before use.) Specifies what
NVM information to check: page status, data or both.

Value Description

all Shows the number of pages with corruption status, data corruption and
out-of-range write count (default)

status | Shows the number of pages with corruption status and the number of
pages with out-of-range write count

data | Shows only the number of pages with data corruption

-show {summary | pages}

(Optional argument; you must set -client or —startpage, —endpage and —block before use.) Specifies
output level, as explained in the table below.

Value Description

summary Displays the summary for all checked pages (default)

pages Displays the check results for each checked page

-file {filename}

(Optional argument; you must set -client or —startpage, —endpage and —block before use.) Name of output
file for memory check.

Supported Families
SmartFusion, Fusion

Exceptions
None

Example

The following command checks the page status for block 0 from starpage 0 to endpage 2:
check_flash_memory -startpage 0O -endpage 2 -block 0

The following command checks the memory status for the client 'DS8bit' and saves it to the file
‘checkFlashMemory.log":

check_flash_memory -client {DS8bit} -file {checkFlashMemory.log}

close_project

Closes the FlashPro or FlashPro Express project.

close_project

Arguments
None

Supported Families
All
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Exceptions
None
Example

close_project

compare_analog_config

Compares the content of the analog block configurations in your design against the actual values in the
device. In a typical SoC project, this directory is located at
<project_root>/smartgen/<analog_block_core_name>.

compare_analog_config
[-name *device_name™] -mem_file_dir "mem_file_directory"
[-File "filename™]

Arguments
-name {device_name}

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.

-mem_file_dir {mem_file_directory}
Location of memory file.

-file {filename}

Output filename.

Supported Families
Fusion

Exceptions
None

Example
The following command reads the analog block configuration in the directory F:/tmp/Analog_Block and
saves the data in the logfile compare_analogReport.log:

compare_analog_config -mem_file_dir {F:/tmp/Analog_Block} -file
{compare_analogReport.log}

The following command reads the analog block configuration information in the device 'AFS600' in the
directory F:/tmp/Analog_Block and saves the data in the log file compare_analogReport.log:

compare_analog_config —name {AFS600} -mem_file_dir {F:/tmp/Analog_Block} -file
{compare_analogReport.log}

compare_flashrom_client

Compares the content of the FlashROM configurations in your design against the actual values in the
selected device.

compare_flashrom_client [-name {device_name}] [-File {filename}]

Arguments
-name {device_name}
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compare_memory_client

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.

-file {filename}
Optional file name for FlashROM compare log.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example
The following command saves the FlashROM data to the file ‘FlashRomCompReport.log'":
compare_flashrom_client -file {FlashRomCompReport.log}

The following command compares the data in the device 'A3P250' and saves the data in the logdfile
'FlashRomCompReport.log'":

compare_flashrom_client —name {A3P250} -file {FlashRomCompReport.log}

compare_memory_client

Compares the memory client in a specific device and block.

compare_memory_client [-name {device name}] [-block integer_value] -client {client_name}
[-File {filename}]

Arguments
-name { device_name}

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.

-block {integer_value}

(Optional argument; you must set -client.) Specifies location of block for memory compare.
-client {client_name}

Name of client for memory compare.

-file {filename}

Optional file name.

Supported Families
SmartFusion and Fusion

Exceptions
None

Example
The following command compares the memory in the client 'DS32' on the device 'AFS600'.
compare_memory_client -client DS32 -name AFS600
The following command compares the data at block 'O’ to the client 'DS8bit'":
compare_memory_client -block 0 -client {DS8bit}

The following command compares the memory in the device 'AFS600' at block '0' to the memory client
'DS8hit":
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compare_memory_client —name {AFS600} -block 0 -client {DS8bit}

The following command compares the memory at block '1' to the memory client 'DS8bit' and saves the
information in a log file to F:/tmp/NVMCompReport.log:

compare_memory_client -block 1 -client {DS8bit} -file {F:/tmp/NVMCompReport.log}

configure_flashpro_prg

Changes FlashPro programmer settings.

configure_flashpro_prg [-vpp {ON]JOFF}] [-vpn {ON]JOFF}] [-vddl {ON]JOFF}] [-force_vddp
{ON]OFF}] [-vddp {2.5]3-3}] [-drive_trst {ON|OFF}] [-force_freq {ON|OFF}] [-freq {freq}l

Arguments

-vpp {ON|OFF}

Enables FlashPro programmer to drive VPP. Set to ON to drive VPP.
-vpn {ON]OFF}

Enables FlashPro programmer to drive VPN; set to ON to drive VPN.
-vddl {ON]JOFF}

Enables FlashPro programmer to drive VDDL; set to ON to drive VDDL.
-force_vddp {ON|OFF}

Enables FlashPro programmer to drive VDDP; set to ON to drive VDDP.
-vddp {2.5]3.3}

Sets VDDP to 2.5 or 3.3 volts.

-drive_trst {ON]|OFF}

Enables FlashPro programmer to drive TRST; set to ON to drive TRST.
-force_freq {ON]|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.

-freq {freq}
Specifies the TCK frequency in MHz.

Supported Families

Exceptions

Example

ProASICPYS proASIC

None

The following example enables the FlashPro programmer to drive the VPP, VPN, VDDL, VDDP, sets the
drive voltage to 3.3v, disables the driver for TRST, and does not force the programmer to use the TCK
frequency specified in the software.

configure_flashpro_prg —vpp {ON} —vpn {ON} —vddl {ON} —force_vddp {ON} —vddp {3.3} —
drive_trst {OFF} —force_freq {OFF}

configure_flashpro3_prg

Changes FlashPro3 programmer settings.

configure_flashpro3 prg [-vpump {ON]OFF}] [-clk _mode {discrete_clk|free_running_clk}] [-
force_freq {ON|OFF}] [-freq {freq}]
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configure_flashpro4_prg

Arguments
-vpump {ON|OFF}
Enables FlashPro programmer to drive VPUMP. Set to ON to drive VPUMP.
-clk_mode {discrete_clk]|free_running_clk}
Specifies free running or discrete TCK.
-force_freq {ON|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.

-freq {freq}
Specifies the TCK frequency in MHz.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example

The following example sets the VPUMP option to ON, TCK to free running, and uses the TCK frequency
specified in the programmer file (force_freq is set to OFF):

configure_flashpro3_prg -vpump {ON} -clk_mode {free_running_clk} -force_freq {OFF} -freq
{4}
The following example sets VPUMP to ON, TCK to discrete, forces the FlashPro software to use the TCK
frequency specified in the software (-force_freq is set to ON) at a frequency of 2 MHz.

configure_flashpro3_prg -vpump {ON} -clk_mode {discrete_clk} -force_freq {ON} -freq {2}

configure_flashpro4 prg

Changes FlashPro4 programmer settings.

configure_flashpro4_prg [-vpump {ON]JOFF}] [-clk_mode {discrete_clk]free_running_clk}] [-
force_freq {ON|OFF}] [-freq {freq}]

Arguments
-vpump {ON|OFF}
Enables FlashPro4 programmer to drive VPUMP. Set to ON to drive VPUMP.
-clk_mode {discrete_clk]|free_running_clk}
Specifies free running or discrete TCK.
-force_freq {ON]|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.

-freq {freq}
Specifies the TCK frequency in MHz.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None
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Example

The following example sets the VPUMP option to ON and uses a free running TCK at a frequency of 4 MHz
(force_freq is set to OFF).

configure_flashpro4_prg -vpump {ON} -clk_mode {free_running_clk} -force_freq {OFF} -freq
{4}
The following example sets the VPUMP option to ON, uses a discrete TCK and sets force_freq to ON at 2
MHz.

configure_flashpro4_prg -vpump {ON} -clk_mode {discrete_clk} -force_freq {ON} -freq {2}

configure_flashpro5_ prg

Tcl command; changes FlashPro5 programmer settings.

configure_flashpro5 prg [-vpump {ON]OFF}] [-clk _mode {free_ running_clk}]
[-programming_method {jtag | spi_slave}] [-force_freq {ONJOFF}] [-freq {freq}l

Arguments
-vpump {ON]OFF}
Enables FlashPro5 programmer to drive VPUMP. Set to ON to drive VPUMP.
-clk_mode {free_running_clk}
Specifies free running TCK.
-programming_method {jtag | spi_slave}
Specifies the programming method to use. spi_slave works only with SF2 and IGLOO2. Default is jtag.
-force_freq {ON]|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.

-freq {freq}
Specifies the TCK frequency in MHz.

Supported Families
RT ProASIC3, SmartFusion, IGLOO, ProASIC3, Fusion, SmartFusion2, IGLOO2, RTG4

Exceptions
None

Example

The following example sets the VPUMP option to ON and uses a free running TCK at a frequency of 4 MHz
(force_freq is set to OFF).

configure_flashpro5 prg -vpump {ON} -clk_mode {free_running_clk} -force_freq
{OFF} -freq {4}

The following example sets the VPUMP option to ON, uses a free running TCK and sets force_freq to ON at
2 MHz.

configure_flashpro5 prg -vpump {ON} -clk _mode {free_running_clk} -force_freq
{ON} -freq {2}

configure_flashproLite prg

Changes FlashPro Lite programmer settings.
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connect_cable

configure_flashproLite prg [-vpp {ONJOFF}] [-vpn {ON]OFF}] [-drive_trst {ON|OFF}] [-
force_freq {ON|OFF}] [-freq {freq}]

Arguments

-vpp {ON]OFF}

Enables FlashPro programmer to drive VPP. Set to ON to drive VPP.
-vpn {ON]OFF}

Enables FlashPro programmer to drive VPN; set to ON to drive VPN.
-drive_trst {ON]|OFF}

Enables FlashPro programmer to drive TRST; set to ON to drive TRST.
-force_freq {ON]|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.

-freq {freq}
Specifies the TCK frequency in MHz.

Supported Families

Exceptions

Example

ProASICELS

None

The following example sets the programmer to drive the VPP, drive VPN, drive the TRST and uses the
frequency set by the programmer file (sets force_freq to OFF):

configure_flashprolite_prg —vpp {ON} —vpn {ON} —drive_trst {ON} —force_freq {OFF}

connect_cable

Connects a parallel cable to a port.

connect_cable -cable_name {cable_name} -port_name {port_name} [-drive_trst {ON]|OFF}]

Arguments

-cable_name {cable_name}

Identifies the name of the parallel port cable you wish to connect.
-port_name {port_name}

Specifies the parallel port where the parallel programmer is connected.
-drive_trst {ON]|OFF}

Enables the parallel port cable to drive TRST.

Supported Families

Exceptions

All

None
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Example

The following example connects the cable named Parallel_Port_Buffer_Cable to the port LPT1 and
enables drive TRST:

connect_cable -cable_name {Parallel_Port_ Buffer_Cable} -port_name {Lptl} -drive_trst

{ON}

construct_chain_automatically

Automatically starts chain construction for the specified programmer.

construct_chain_automatically[(-name {name})+]

Arguments
-name {name}
Specifies the programmer(s) name(s).

Supported Families
Al

Exceptions
N/A

Example
Example for one programmer:
construct_chain_automatically -name {21428}
Example for two programmers:
construct_chain_automatically -name {21428} —name {00579}

copy_device

Copies a device in the chain to the clipboard. Chain programming mode must be set. See the paste_device
command for more information.

copy_device (-name {name})*

Arguments
-name {name}
Specifies the device name. Repeat this argument to copy multiple devices.

Supported Families
Al

Exceptions

None

Example
The example copies the device 'mydevicel' to the same location with a new name 'mydevice2'.
copy_device —name {MyDevicel} —name {MyDevice2}

150 FlashPro User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content. . .
p & Microsemi

cut_device

cut_device

Removes one or more devices from the chain. It places the removed device in the clipboard. Chain
programming mode must be set to use this command. See the paste_device command for more
information.

cut_device (-name {name})*

Arguments
-name {name}
Specifies the device name. You can repeat this argument for multiple devices.

Supported Families
Al

Exceptions
None

Example

The following example removes the devices 'mydevicel' and 'mydevice2' from the chain.
cut_device —name {MyDevicel} —name {MyDevice2}

dump_tcl support

Unloads the list of supported FlashPro or FlashPro Express Tcl commands.

dump_tcl_support -file {file}

Arguments
-file {file}

Supported Families
Al

Exceptions
None

Example

The following example dumps your Tcl commands into the file 'tcldump.tcl'
dump_tcl_support -file {tcldump.tcl}

enable device

Enables or disables a device in the chain (if the device is disabled, it is bypassed). Chain programming
mode must be set. The device must be a Microsemi device.

enable_device -name {name} -enable {TRUE|FALSE}

Arguments
-name {name}
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Specifies your device name
-enable {TRUE|FALSE}

Specifies whether the device is to be enabled or disabled. If you specify multiple devices, this argument
applies to all specified devices. (TRUE = enable. FALSE = disable)

Supported Families

All
Exceptions
None
Example
The following example disables the device 'mydevicel' in the chain.
enable_device —name {MyDevicel} —enable {FALSE}
enable prg

Enables or disables one or more programmers.

enable_prg (-name {name})* -enable {TRUE|FALSE}

Arguments
-name {name}*
Specifies the programmer name. You can repeat this argument for multiple programmers.
-enable {TRUE|FALSE}

Specifies whether the programmer is to be enabled or disabled. If you specify multiple programmers, this
argument applies to all of them (TRUE = enable. FALSE = disable).

Supported Families
All

Exceptions
None

Example

The following example enables the programmers 'FP300085' and 'FP300086'".
enable_prg —name {FP300085} —name {FP300086} —enable {TRUE}

enable prg_type

Enables or disables all programmers of a specified programmer type.

enable_prg_type -prg_type {prg_type} -enable { TRUE | FALSE }

Arguments
-prgType { FP | FPLite | FP3 | PP }
Specifies the programmer type to be enabled/disabled (FP—FlashPro type programmers, FPLite—FlashPro
Lite type programers, FP3—FlashPro3 type programmers, PP—Parallel port cable type programmers).
-enable {TRUE|FALSE}
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enable_procedure

Specifies whether the programmers are to be enabled or disabled (TRUE—enable, FALSE—disable).

Supported Families
Al

Exceptions
None

Example
The following example enables the FlashPro3 programmer.
enable_prog_type —prg_type{FP3} —enable{TRUE}

enable procedure

To enable/disable an optional procedure of an action. The device name parameter must be specified only
in chain programming mode. A programming file must have been loaded.

enable_procedure [-name {name}] -action {action} -procedure {procedure} -enable
{TRUE | FALSE}

Arguments
-name {name}
-action {action}
-procedure {procedure}
-enable {TRUE|FALSE}

Supported Families
Al

Exceptions
None

Example
In single programming mode:
enable_procedure —action {PROGRAM} —procedure {DO_ERASE} —enable {TRUE}

In chain programming mode:

enable_serialization —name {MyDevice2} —action {PROGRAM} —procedure {DO_ERASE} —enable
{FALSE}

enable_serialization

This Tcl command enables or disables serialization programming.

enable_serialization —name {device_name} -enable {true|false}

Arguments
-name
Specifies the device name.
-enable
Enables (true) or disables (false) serialization programming.
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Exceptions
Must be a Microsemi Device

Supported Families
See the_Tcl Commands and Supported Families table for the list of families that support this command.

Example
enable_serialization -name M2S/M2GLOSO{T|S|TS} -enable true

export_chain_stapl
Exports the ChainBuilder STAPL file in chain programming mode.

export_chain_stapl -file {file}

Arguments
-file {file}
Specifies the file to be exported.

Supported Families
Al

Exceptions
None

Example
The following example exports the STAPL file 'tcl_testing_chain.stp":
-export_chain_stapl -file {./tcl_testing_chain.stp}

export_config

Exports a configuration file.

export_config -file {file}

Arguments
—file {File}
Specifies the file to export.

Supported Families
All

Exceptions
None

Example
The following example exports the configuration file 'myconfigl’
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export_secured_pdb
export_config -file {myconfigl}

export_secured_pdb

Exports a single device secured PDB from the loaded PDB.

export_secured_pdb -file {file} [-name {name}]

Arguments
—file {File}
Specifies the file to export.
-name {name}
Specifies the name of the device in chain mode to export a single device currently secured PDB.

Supported Families
SmartFusion, Fusion

Exceptions
‘-secured' is only supported for SmartFusion devices.

Example
In single mode, the following command exports the secured PDB 'my_design.pdb':
export_secured_pdb -file {D:/TOP/my_design.pdb}

In chain mode, the following example exports the secured PDB 'my_design.pdb' from the A2F200M3F
device in the chain:

export_secured_pdb -name {A2F200M3F} -file {./my _design.pdb}

export_script
Exports the history in a Tcl script.

export_script -file {file} -relative_path {TRUE|FALSE}

Arguments
—file {File}
Specifies the file to export.
-relative_path {TRUE|FALSE}
Specifies whether the file path must be exported as a relative path or an absolute path.

Supported Families
Al

Exceptions
None

Example
The following example exports your Tcl history to the file 'history.tcl' with absolute pathnames.
export_script —file {./history.tcl} —relative_path {FALSE}
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export_single 1532
Exports a single device IEEE 1532 file.
export_single_1532 -file {file} [-name {name}] [-pdb {pdb_file}] [-secured]

Arguments
—file {File}
Specifies the file to export.
-name {name}
Specifies the name of the device in chain mode to export single device IEEE 1532 programming file.
-pdb {pdb_File}

Specifies the PDB to use for exporting a IEEE 1532 programming file. By default, the loaded PDB is used
for exporting a IEEE 1532 programming file.

-secured
Exports a IEEE 1532 programming file for a secured device.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
"-secured' is only supported for SmartFusion devices.

Example
Single Mode, exports the secured IEEE 1532 files 'my_design.isc' and 'my_design.bsd' into folder
'D:/TOP/my_design_1532" using the PDB 'my_design.pdb":
export_single_ 1532 -file {D:/TOP/my_design_1532) -pdb {D:/TOP/my_design.pdb} -secured

Chain Mode example exports secured IEEE 1532 files 'my_design.isc' and 'my_design.bsd' into folder
'D:/TOP/my_design_1532' from a device in the chain named 'A2F200M3F' using the PDB 'my_design.pdb":

export_single_ 1532 -name {A2F200M3F} -file {./my_design_1532} -pdb {./my_design.pdb} -
secured

export_single dat
Exports a single device DirectC data file.

export_single_dat -file {file} [-name {name}] [-pdb {pdb_Ffile}] [-secured]

Arguments
—file {File}
Specifies the name of the file you are exporting.
-name {name}
Specifies the name of the device in chain mode to export a single device DirectC data file.
-pdb {pdb_File}
Specifies the PDB to use for exporting a DirectC data file. By default, the loaded PDB will be used for
exporting a DirectC data file.
-secured
Use this argument to export a secured DirectC data file.
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export_single_stapl

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
‘-secured' is only supported for SmartFusion devices.

Example
Single Mode, exports a secured DirectC DAT file 'my_design.dat' using the PDB file 'my_design.pdb':
export_single_dat -file {D:/TOP/my_design.dat} -pdb {D:/TOP/my_design.pdb} -secured

Chain Mode, exports a secured DirectC DAT file 'my_design.dat' from a device in the chain named
'A2F200M3F', using the PDB 'my_design.pdb":

export single_dat -name {A2F200M3F} -file {./my_design.dat} -pdb {./my_design.pdb} -
secured

export_single stapl
Exports a single device STAPL file or single device chain STAPL file.
export_single_stapl -file {file} [-name {name}] [-pdb {pdb_file}] [-secured] [-chain]

Arguments
—file {File}
Specifies the file to export.
-name {name}

Specifies the name of the device in chain mode to export a single device STAPL or single device chain
STAPL file.

-pdb {pdb_File}

Specifies the PDB to use for exporting a STAPL file. By default, the loaded PDB is used for exporting a
STAPL file.

-secured

Exports a secured STAPL file.

-chain

Indicates that you want to export a single device chain STAPL file.

Note: This parameter is only supported for SmartFusion2, IGLOO2, and RTG4 families.

Supported Families
SmartFusion2, IGLOO2, RTG4, SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example

Single Mode example exports the secured file ‘'my_design.stp' using the PDB 'my_design.pdb'":
export_single_stapl -file {D:/TOP/my_design.stp} -pdb {D:/TOP/my_design.pdb} -secured
Chain Mode example exports secured STAPL file 'my_design.stp' from device 'A2F200M3F' using the PDB

'my_design.pdb":

export single_stapl -name {A2F200M3F} -file {./my_design.stp} -pdb {./my_design.pdb} -
secured

FlashPro User's Guide 157



NOTE: Links and cross-references in this PDF file may point to external files and generate an error

. . when clicked. View the online help included with software to enable all linked content.
& Microsemi

export_single svf

Exports a single device SVF programming file.

export_single_svf -file {file} [-name {name}] [-pdb {pdb_Ffile}] [-secured]

Arguments

—file {File}

Specifies the file to export.

-name {name}

Specifies the name of the device in chain mode to export a single device SVF programming file.

-pdb {pdb_File}

Specifies the PDB to use for exporting a SVF programming file. By default, the loaded PDB is used for
exporting a SVF programming file.

-secured

Exports a SVF programming file for a secured device.

Supported Families

Exceptions

Example

SmartFusion, IGLOO, ProASIC3 and Fusion

‘-secured' is only supported for SmartFusion devices.

Single Mode, exports the secured SVF files for each programming ACTION with the following format

'my_design_ACTION.svf' into folder 'D:/TOP/my_design_SVF' using the PDB 'my_design.pdb":
export_single_ SVF -file {D:/TOP/my_design_SVF) -pdb {D:/TOP/my_design.pdb} -secured

Chain Mode example exports secured SVF files for each programming ACTION with the following format

'my_design_ACTION.svf' into folder 'D:/TOP/my_design_SVF' from a device in the chain named
'‘A2F200M3F' using the PDB 'my_design.pdb':

export_single_SVF -name {A2F200M3F} -file {./my_design_SVF} -pdb {./my_design.pdb} -
secured

export_spi_directory

Tcl command; exports the SPI directory that contains address and design version information for the
Golden and Update SPI images.

export_spi_directory [-golden_ver {decimal}] [-golden_addr {hex}] [-update_ver {decimal}]
[-update_addr {hex}] -file {file}

Arguments

-golden_ver {decimal}

Specifies Golden SPI Image design version where decimal is a decimal value and less than 65536
(exclusive).

-golden_addr {hex}
Specifies Golden SPI Image address where hex is 32-bit hexadecimal value with prefix Ox/0X.
-update_ver {decimal}

Specifies Update SPI Image design version where decimal is a decimal value and less than 65536
(exclusive).

-update_addr {hex}
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export_spi_directory

Specifies Update SPI Image address where hex is a 32-hit hexadecimal value with prefix Ox/0X.
—file {File}
Mandatory argument; specifies the file export location.

Supported Families
SmartFusion2, IGLOO2

Examples

Both golden* options go together. The same is true for both update* options.; the file argument is required:

export_spi_directory -golden_ver {23} -golden_addr {0x40001234} -file
{D:\flashpro_files\m2s090t_spi_1\designer\m2s090t_spi_1 MSS\export\m2s090t_spi_1 MSS1.spi
Dir}

export_spi_directory -update_ver {8} -update_addr {0x2000abcd} -file
{D:\flashpro_files\m2s090t_spi_1\designer\m2s090t_spi_1_ MSS\export\m2s090t_spi_1_ MSS2.spi
Dir}

export_spi_directory -golden_ver {23} -golden_addr {0x40001234} -update_ver {8} -
update_addr {0x2000abcd} -file

{D:\flashpro_files\m2s090t_spi_1\designer\m2s090t_spi_1_MSS\export\m2s090t_spi_1_ MSS3.spi
Dir}
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import_config
Imports a configuration file.

import_config -file {file}

Arguments
-File {file}
Specifies the file to import.

Supported Families
All

Exceptions
None

Example
The following example imports the configuration file 'my_configl.ufc"
import_config -file {my_configl.ufc"}

new_project

Creates a new FlashPro project or convert an old ChainBuilder project into a new FlashPro project (the
mode parameter must be 'chain’ in this case).

new_project -name {name} -location {location} -mode {single]chain} [-convert_chb
{convert_chb}]

Arguments
-name {name}
Specifies the project name.
-location {location}
Specifies the project location.
-mode {single]chain}
Specifies programming mode; either single or chain.
-convert_chb {convert_chb}
An optional argument that specifies the ChainBuilder project to be converted.

Supported Families
All

Exceptions
None

Example

Create a new FlashPro single device project named 'FPPrjl' in a directory with the name 'FPProjectl":
new_project -name {FPPrjl} -location {./FPProjectl} -mode {single}
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open_project

Create a new FlashPro project named 'FPPrjChb' in the directory 'ChbProjectl’; converts the ChainBuilder
project 'prjl.chb’ project to FlashPro.

new_project -name {FPPrjChb} -location {./ChbProjectl} -mode {chain} -convert_chb
{./chb_prj/prjl.chb}

open_project
Opens a FlashPro or FlashPro Express project.

open_project -project {project}

Arguments
-project {project}
Specifies the location and name of the project you wish to open.

Supported Families
Al

Exceptions
None

Example

Opens the 'FPPrjl.pro' project from the FPProjectl directory
open_project -project {./FPProjectl/FPPrjl.pro}

paste device

Pastes the devices that are on the clipboard in the chain, immediately above the position_name device,
if this parameter is specified. Otherwise it places the devices at the end of the chain. The chain
programming mode must be enabled.

paste_device [-position_name {position_name}]

Arguments
-position_name {position_name}
Optional argument that specifies the name of a device in the chain.

Supported Families
Al

Exceptions
None

Examples

The following example pastes the devices on the clipboard immediately above the device 'mydevice3' in
the chain.

paste_device —position_name {MyDevice3}
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ping_prg

Pings one or more programmers.

ping_prg (-name {name})*

Arguments
-name {name}
Specifies the programmer to be pinged. Repeat this argument for multiple programmers.

Supported Families
All

Exceptions
None

Example
The following example pings the programmers 'FP300085' and 'FP30086'.
ping_prg —name {FP300085} —name {FP300086}

read_analog_block config

Reads each channel configuration on your analog system, enabling you to identify iffhow each channel is
configured.

read_analog_block_config [-name {device_name}] [-file {filename}]

Arguments
-name {device_name}

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.

-file {filename}
(Optional) Identifies the name of the file to which read results will be saved.

Supported Families
Fusion

Exceptions
None

Example

The following command reads the analog block configuration information in the device 'AFS600'":
read_analog_block_config —name {AFS600}

read_device_status

Displays the Device Information report; the Device Information report is a complete summary of your device
state, analog block test values, user information, factory serial number and security information..

read_device_status [-name {device_name}] [-File {filename}]

162 FlashPro User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

& Microsemi

read_flash_memory

Arguments
-name device_nhame

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.

-file {filename}
(Optional) Identifies the name of the file to which read results will be saved.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example

The following reads device info from the '"AFS600' device.
read_device_status -name AFS600

read_flash_memory

The command reads information from the NVM modules. There are two types of information that can be
read:

e Page Status — includes ECC2 status, write count, access protection

e Page Data

read_flash_memory

[-name {device name}]

[-block {integer_value}]
[-client {client_name}]
[-startpage {integer_value}]
[-endpage {integer_value}]
[-access {all | status | data}]
[-file {filename}]

At a minimum you must specify -client <name> OR
-startpage <page_number> -endpage <page_number> -block <number>

Arguments
-name {device_name}

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.

-block {integer_value}

(Optional argument; you must set -client or —startpage and —endpage before use.) Specifies location of
block for memory read.

-client {client_name}

Name of client for memory read.

-startpage {integer_value}

Startpage for page range; value must be an integer. You must specify a —endpage and -block along with
this argument.

-endpage {integer_value}

Endpage for page range; value must be an integer. You must specify a —startpage and -block along with
this argument.
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-access {all | status | data}

(Optional argument; you must set -client or —startpage, —endpage and —block before use.) Specifies what
eNVM information to check: page status, data or both.

Value Description

all Shows the number of pages with corruption status, data corruption and
out-of-range write count (default)

status | Shows the number of pages with corruption status and the number of
pages with out-of-range write count

data | Shows only the number of pages with data corruption

-file {filename}

(Optional argument; you must set -client or —startpage, —endpage and —block before use.) Name of output
file for memory read.

Supported Families
SmartFusion, Fusion

Exceptions
None

Example

The following command reads the flash memory for the client ‘DS8bit' and reports the data in a logfile
‘readFlashMemoryReport.log'":

read_flash_memory -client {DS8bit} -file {readFlashMemoryReport.log}
read_flash_memory —startpage O —endpage 2 —block 0 —access {data}

read_flashrom

Reads the content of the FlashROM from the selected device.

read_flashrom [-name {device_name}] [-mapping {logical | physical}] [-file {filename}]

Arguments
-name device_nhame

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.

-mapping {logical | physical}
(Optional) Specifies how the data read from the UFROM is mapped. Values are explained in the table

below.
Value Description
logical Logical mapping (default)
physical Physical mapping

-file {filename}
(Optional) Identifies the name of the file to which read results will be saved.
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read_id_code

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example

The following reads the FROM content on the device 'AFS600' and sets to physical mapping:
read_flashrom -name {AFS600} -mapping {physical}

read_id_code

The command reads IDCode from the device without masking any IDCode fields. This is the raw IDcode
from the silicon.

Note: Being able to read the IDCode is an indication that the JTAG interface is working correctly.

read_id_code [-name {device_name}]

Arguments
-name device_name

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example

The following command reads the IDCODE from the device 'AFS600':
read_id_code —name {AFS600}

recover_flash_memory

The command removes ECC2 errors due to memory corruption by reprogramming specified flash memory
(NVM) pages and initializing all pages to zeros. The recovery affects data blocks and auxiliary blocks.

The write counters of the corrupted pages might not be accurate due to corruption. The recovery operation
will not change state of the page write counters.

Use the check_flash_memory command to detect flash memory errors.

recover_flash_memory

[-name {device name}]
[-block {integer_value}]
[-client {client_name}]
[-startpage {integer_value}]
[-endpage {integer_value}]

At a minimum you must specify -client <name> OR
-startpage <page_number> -endpage <page_number> -block <number>
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Arguments
-name {device_name}

Optional user-defined device name. The device name is not required if there is only one device in the
current configuration, or a device has already been selected using the set_debug_device command.

-block {integer_value}

(Optional argument; you must set -client or —startpage and —endpage before use.) Specifies location of
block for memory recovery.

-client {client_name}

Name of client for memory recovery.

-startpage {integer_value}

Startpage for page range; value must be an integer.You must specify a —endpage and -block along with
this argument.

-endpage {integer_value}

Endpage for page range; value must be an integer. You must specify a —startpage and -block along with
this argument.

Supported Families
SmartFusion, Fusion

Exceptions
None

Example
The following command recovers flash memory data in the client ‘DS8bit":
recover_flash_memory -client {DS8bit}
The following command recovers flash memory from block 0, startpage 0, and endpage 3:
recover_flash_memory -block O -startpage O -endpage 3

refresh_prg_list

Refreshes the programmer list. This is most often used to have FlashPro or FlashPro Express detect a
programmer that you have just connected.

refresh_prg_list

Arguments
None

Supported Families
Al

Exceptions
None

Example
refresh_prg_list
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remove_device

Removes the device from the chain. Chain programming mode must be set.

remove_device (-name {name})*

Arguments
-name {name}

Specifies the device name. You can repeat this argument for multiple devices.

Supported Families
All

Exceptions
None

Example
Remove a device 'A3P250' from the chain:
remove_device (-name {A3P250})*

& Microsemi

refresh_prg_list
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remove_non_actel device from_database

Removes settings for non-Microsemi or non-Actel device from the device database.

remove_non_actel_device_from database [-name {device_name}]

Arguments
-name {device_name}

Specifies the non-Actel or non-Microsemi device name to be removed from the database. You can repeat
this argument for multiple devices.

Supported Families
Non-Microsemi and non-Actel devices

Exceptions
None

Example
The following example removes the F1502AS_J44 device from the database:
remove_non_actel_device_from_database —name {F1502AS_J44}
The following example removes the SA2_PROCESSOR device from the database:
remove_non_actel_device_from_database —name {SA2_PROCESSOR}

remove_prg

Removes the programmer from the programmer list.

remove_prg (-name {name})*

Arguments
-name {name}*
Specifies the programmer to be removed. You can repeat this argument for multiple programmers.

Supported Families
Al

Exceptions
None

Example
The following example removes the programmer '03178' from the programmer list:
remove_prg (name {03178})*

run_selected_actions

Runs the selected action on the specified programmer and returns the exit code from the action. If no
programmer name is specified, the action is run on all connected programmers. Only one exit code is
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sample_analog_channel

returned, so return code cannot be used when action is run on more than one programmer. A
programming file must be loaded.

run_selected_actions [(-name {name})*]

Arguments

-name {name}

Optional argument that specifies the programmer name. You can repeat this argument for multiple

programmers.

Supported Families

All

Exceptions

None

Example

The following example runs the selected actionS on the programmers 'FP30085' and 'FP30086'".

run_selected_actions —name {FP300085} —name {FP300086%}

Example using return code:

if {[catch {run_selected_actions} return_val]} {puts "Error running Action"} else {puts
"exit code $return_val"}

Example returning exit code to the command line (returns exit 99 on script failure, otherwise returns exit
code from selected action):

if {[catch {run_selected_actions} return_val]}{exit 99} else {exit $return_val}

sample_analog_channel

Performs analog-to-digital conversion of a selected analog channel. This command is used when debugging
the Analog Subsystem and is performed on the pre-configured analog channel with user-supplied ADC

conversion parameters. The command also performs digital filtering using a single-pole low-pass filter if you
opt to use it.

sample_analog_channel [(-name {name})*]

[-resolution {8 | 10 | 12}]

[-clock periods {int_value}]
[-clock _divider {int_value}]

[-num_samples { int_value}]

[-filtering_factor {real_value}]
[-initial_value {int_value}]

[-show_details {yes | no}l

[-file {filename}]

Arguments

-name { name}

Specifies the analog channel to be sampled. Channel name is a combination of the channel type followed

by the channel index. Valid channel names are listed in the table below.

Family

Valid Channel Name

Fusion

AvV<n>, AT<n>, AC<n>
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Family Valid Channel Name
SmartFusion AV<n>, AT<n>, AC<n>, ADC<n>

The maximum number of channels depends on particular device type; refer to the Analog Block
specification in the device handbook.

-resolution {8 | 10 | 12}

ADC conversion resolution. Specifies bit size of the conversion results. Selection of certain resolutions
may affect timing parameter valid ranges. See your device handbook for details.

-clock_periods {int_value }

Parameter specifying sampling time: Sampling_time = clock_periods * adc_clock_period.
-clock_divider {int_value }

Specifies clock prescaling factor.

-num_samples { int_value }

Optional argument that specifies the number of samples to be performed by the ADC. Default number of
samples is 1. Selecting multiple vs single sample will change appearance of the generated report. For the

single sample a single result is shown and if “show_details” is set to “yes” then detailed status of the ADC
register is also shown.

If multiple samples are requested then the results are printed in a table. If the digital filtering is enabled the
table also includes filtered results.

-filtering_factor {real_value}

Optional argument that specifies the filtering factor if multiple samples requested. The default value of 1.0
disables digital filtering.

—-initial_value {int_value}
Optional argument that specifies the initial value for the digital averaging filter. The value is specified in

ADC register counts. Default value is set to 0. Specifying this parameter improves filtering process during
initial samples.

-show_details {yes | no}

Optional argument that specifies the level of the report output. Detailed output includes initial user-
supplied conversion parameters. For the single-sampling case final output also includes detailed content
of ADC register after sampling.

-file {filename}
Optional argument. Specifies name of output file for conversion results.

Supported Families
SmartFusion and Fusion

Exceptions
None

Example

The following example performs single sample analog-to-digital conversion for channel AVO:
sample_analog_channel —channel AVO —resolution 8 —clock_periods 4 —clock_divider 4
Example with multiple sampling and digital signal filtering for AVO:

sample_analog_channel —channel AVO —resolution 10 —clock_periods 4 —clock _divider 4 —
num_samples 10 —filtering_factor 2.5

save log

Saves the log file.
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save_log -file {file}

Arguments
-file {file}
Specifies the log filename.

Supported Families
Al

Exceptions
None

Example

The following example saves the log file with the name 'my_logfilel.log":
save_log -file {my_logfilel.log}

save_project
Saves the FlashPro or FlashPro Express project.

save_project

Arguments
None

Supported Families
All

Exceptions
None

Example
save_project

save project_as

Saves the FlashPro project under a new project name.

save_project_as -name {name} -location {location}

Arguments
-name {name}
Specifies the project name.
-location {location}
Specifies the project location.
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Supported Families
Al

Exceptions
None

Example

The following example saves the FlashPro project 'FPPrj2' to the directory 'FPProject2":
save_project_as -name {FPPrj2} -location {./FPProject2}

scan_chain_prg

In single mode, this command runs scan chain on a programmer.

In chain mode, this command runs scan and check chain on a programmer if devices have been added in
the grid.

scan_chain_prg [(-name {name})+]

Arguments
-name {name}
Specifies the programmer name.

Supported Families
All

Exceptions
None

Example

The following example runs scan chain on a single programmer (single mode) named '21428":
scan_chain_prg -name {21428}

select_from_region_name

Enables you to select the serialization region you want to add to the log file.

select_from_region_name —enable {1]0} —-region_name {name}

Arguments
-enable {1]0}
Enable serialization region logging. '1' enables serialization region logging; '0' disables it.
-region_name {name}
The name of the target serialization/client within FlashRom you wish to log.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion
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Exceptions
None

Example

The following example enables select_from_region_name and adds the serialization region 'afs090_b' to the
log file:
select_from_region_name -enable {1} -region_name {afs090_b}

select_libero _design_device

FlashPro-specifc Tcl command. This command selects the Libero design device for the Programming
Connectivity and Interface tool within Libero. This command is needed when the tool cannot automatically
resolve the Libero design device when there are two or more identical devices that match the Libero
design device in the configured JTAG chain.

Syntax

select_libero_design_device -name {device_name}

Arguments
-name {device_name}
Specifies a user-assigned unique device name in the JTAG chain.

Supported Families
SmartFusion2, IGLOO2

Exceptions
None
Example
select_libero_design_device —name {M2S050TS (2)}
select_libero_design_device —name {my_design_device}
Note

This Tcl command is typically used in a Flashpro Tcl command script file that is passed to the Libero
run_tool command.
run_tool —name {CONFIGURE_CHAIN} -script {<flashPro_cmd>.tcl}

select_serial_range

This Tcl command selects the range of indexes to program.

select_serial_range -name device_name -from_data start_index_to_program -to_data
end_index_to_program

Arguments
-name
Specifies the device name.
-from_data
Specifies the start index to program.
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-to_data
Specifies the end index.

Supported Families
See the_Tcl Commands and Supported Families table for the list of families that support this command.

Exceptions
Must be a Microsemi Device

Example
select_serial_range -name M2S/M2GLO50{T|S|TS} -from _data 3 -to_data 5

select_target_device

Enables you to set a target device for programming in Single Device Programming mode. The command
is identical to the Select Target Device dialog box in FlashPro.

Select_target_device -name {device_name}

Arguments
-name {device_name}
Specifies the name of the target device.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Examples

The following example targets the A3P(L) / AGL1000 device for programming:
select_target_device —name {A3P(L)/AGL1000 (1)}

self test prg

Runs Self-Test on a programmer.

self_test_prg (-name {name})*

Arguments
-name {name}
Specifies the programmer name. You can repeat this argument for multiple programmers.

Supported Families
Al
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Exceptions
None

Example

The following examples runs the self test on the programmer '30175":
self_test_prg (-name {30175})*

set_bsdl_file

Sets a BSDL file to a non-Microsemi device in the chain. Chain programming mode must have been set.
The device must be a non-Microsemi device.

set_bsdl_file -name {name} -file {file}

Arguments
name {name}
Specifies the device name.
—file {File}
Specifies the BSDL file.

Supported Families
Any non-Microsemi device supported by FlashPro.

Exceptions
None

Example
The following example sets the BSDL file /design/bsdl/NewBSDL2.bsdl to the device 'MyDevice3":
set_bsdl_file —name {MyDevice3} —file {e:/design/bsdl/NewBSDL2._bsdl}

set_chain_param

Sets the chain parameters in single programming mode. Single programming mode must be set .

set_chain_param [-pre_ir {pre_ir}] [-pre_dr {pre_dr}] [-post_ir {post_ir}] [-post _dr
{post_dr}]

Arguments
-pre_ir {pre_ir}
Specifies the pre IR length.
-pre_dr {pre_dr}
Specifies the pre DR length.
-post_ir {post_ir}
Specifies the post IR length.
-post_dr {post_dr}
Specifies post DR length.

Supported Families
Al
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Exceptions
None
Example

The following example sets the chain parameters for pre IR length to 2, pre DR length to 3, post IR length
to 4, and post DR length to 5:

set_chain_param —pre_ir {2} —pre_dr {3} —post_ir {4} —post dr {5}

set_debug_device

Identifies the device you intend to debug.

set_debug_device -name {device_name}

Arguments
name {device_name}
Device name. The device name is not required if there is only one device in the current configuration.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example

The following example identifies the device 'A3P250' for debugging:
set_debug_device —name {A3P250}

set _debug_programmer

Identifies the programmer you want to use for debugging (if you have more than one). The name of the
programmer is the serial number on the bar code label on the FlashPro programmer.

set_debug_programmer -name {programmer_name}

Arguments
-name {programmer_name}
Programmer name is the serial number on the bar code label of the FlashPro programmer.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example

The following example selects the programmer 10841
set_debug_programmer -name {10841}
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set _device_ir

Sets the IR length of a non-Microsemi device in the chain. Chain programming mode must be set. The
device must be a non-Microsemi device.

set_device_ir -name {name} -ir {ir}

Arguments
-name {name}
Specifies the device name.
—ir {ir}
Specifies the IR length.

Supported Families
Any non-Microsemi device supported by FlashPro.

Exceptions
None

Example

The following example sets the IR length to '2' for the non-Microsemi device 'MyDevice4'":
set_device_ir —name {MyDeviced} —ir {2}

set_device _name

Changes the user name of a device in the chain. Chain programming mode must be set .

set_device _name -name {name} -new_name {new_name}

Arguments
-name {name}
Identifies the old device name.
-new_name {new_name}
Specifies the new device name.

Supported Families
All

Exceptions
None

Example

The following example changes the user name of the device from 'MyDevice4' to 'MyDevice5'":
set_device_name —name {MyDeviced4} —new_name {MyDevice5}

set _device order

Sets the order of the devices in the chain to the order specified. Chain programming mode must have
been set. Unspecified devices will be at the end of the chain.
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set_device_order (-name {name})*

Arguments
-name {name}

Specifies the device name. To specify a new order you must repeat this argument and specify each
device name in the order desired.

Supported Families
All

Exceptions
None

Example

The following example sets the device order for ‘MyDevicel', 'MyDevice?2', ‘MyDevice3', and '‘MyDevice4'.
‘MyDevice?2' is unspecified so it moves to the end of the chain.

set_device_order —name {MyDevice3} —name {MyDevicel} —name {MyDeviced}
the new order is:
MyDevice3 MyDevicel MyDevice4 MyDevice2

set _device_tck

Sets the maximum TCK frequency of a non-Microsemi device in the chain. Chain programming mode
must be set. The device must be a non-Microsemi device.

set_device_tck -name {name} -tck {tck}

Arguments
-name {name}
Specifies the device name.
—tck {tck}
Specifies the maximum TCK frequency (in MHz).

Supported Families
Any non-Microsemi device supported by FlashPro.

Exceptions
None

Example

The following example sets the maximum TCK frequency of the non-Microsemi device 'MyDevice4':
set_device_tck —name {MyDevice4} —tck {2.25}%}

set _device to_highz
Sets a disabled Microsemi or Microsemi device in Chain programming mode to HIGH-Z. This Tcl
command is related to the Set Device to HIGH-Z GUI command.
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set_device_to_highz -name {device_name} —-highz {1]0}

Arguments
-name {device_name}
Target device name in chain mode.
-highz {1]0}
Sets disabled device to HIGH-Z. '1' sets the device to HIGH-Z, '0' removes the setting.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example
The following example sets the AFS090 device to HIGH-Z:
set_device_to_highz —name {AFS090} —-highz 1
The following example removes the HIGH-Z setting from the AFS1500 device:
set_device_to_highz —name {AFS1500} —highz O

set _device_type
Changes the family of a Microsemi device in the chain. The device must be a Microsemi device. The
device parameter below is now optional.

set_device_type -name {name} -type {type}

Arguments
-name {name}
Identifies the name of the device you want to change.
-type {type}
Specifies the device family.

Supported Families
Any Microsemi device supported by FlashPro.

Exceptions
None

Example

The following example sets the device 'MyDevice2' to the type ASPEG00.
set_device_type —name {MyDevice2} —type {A3PE600}

set_main_log_file
Sets the FlashPro log file.
set_main_log_file -file {file}
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Arguments
-file {file}
Specifies the log file.

Supported Families
Al

Exceptions
None

Example

The following example sets the FlashPro log file to 'log1000.txt'.
set_main_log_file —file {e:/10g/10g1000.txt}

set_prg_name

Changes the user name of a programmer.

set_prg_name -name {name} -new_name {new_name}

Arguments
-name {name}
Identifies the old programmer name.
-new_name {new_name}
Specifies the new programmer name.

Supported Families
All devices supported by FlashPro.

Exceptions
None

Example

The following example changes the name of the programmer 'FP300086' to 'FP3Prg2":
set_prg_name —name {FP300086} —new_name {FP3Prg2}

set_programming_action

Selects the action for a device. The device name parameter must be specified only in chain programming
mode. A programming file must be loaded. The device must be a Microsemidevice.

set_programming_action [-name {name}] -action {action}

Arguments
-name {name}
Specifies the device name.
-action {action}
Specifies the action.
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Supported Families
SmartFusion, IGLOO, ProASIC3, Fusion

Exceptions
Must be a Microsemi device

Example
The following example sets the programming action in single programming mode:
set_programming_action —action {PROGRAM}
And in chain programming mode:
set_programming_action —name {MyDevicel} —action {ERASE}

set_programming_file
Sets the programming file for a device. Either the file orthe no_file flag must be specified. A
programming file must be loaded. The device must be a Microsemi device .

set_programming_Ffile [-name {name}] [-file {file}] [-no_Ffile { }]

Arguments
-name {name}
Specifies the device name. This argument must be specified only in chain programming mode.
—file {File}
Specifies the programming file.
-no_File
Specifies to unload the current programming file.

Supported Families
SmartFusion, IGLOO, ProASIC3, Fusion

Exceptions
Must be a Microsemi device.

Examples
In single programming mode:
set_programming_file —file {e:/design/pdb/TopA3P250.pdb}

In chain programming mode:
set_programming_file —name {MyDevice2} —File {e:/design/pdb/TopA3P250.pdb}
set_programming_file —name {MyDevicel} —no_Tfile

set_programming_mode

Sets the programming mode.

set_programming_mode -mode {single]chain}

Arguments
-mode {single]chain}
Specifies the mode, either single programming or chain programming.
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All devices supported by FlashPro.

Exceptions
None

Example

The following example sets the programming mode to 'single":
set_programming_mode -mode {single}

set_serialization_log_file

This Tcl command sets the path and name of the serialization log file.

set_serialization_log_file -fil

Arguments
-file
Specifies the serialization

Supported Families
See the_Tcl Commands and

e {log_file path}

log file path and name

Supported Families table for the list of families that support this command.

Exceptions
Must be a Microsemi Device

Example

set_serialization_log_file -file {C:/local_z_folder/work/my_serial_log}

set_serialization_mode

Sets the serialization mode.

set_serialization_mode -mode {s

Arguments
-mode {skip]reuse}

Supported Families

kip|reuse}

All devices supported by FlashPro.

Exceptions
None
Example
The following example sets the serialization mode to 'skip':
set_serialization_mode -mode {skip}
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Updates the programming file with the selected parameters.

update_programming_file

[(-name {name})*]

-feature {value}

-signature {value}

-from_content {name}

-from_config_file {name}
-number_of_devices {value}
-from_program_pages {value}
-custom_security {value}
-security_permanent {value}
-fpa_security_level {value}
-from_security_level {value}
-efm_block_security{location:X;security_level: value}
-pass_key {value} -aes key {value}
-efm_content {location:X;source: value}
-efm_block {location:X;config_file: value}
-efm_client {location:X;client:value; mem file: value}
-tie_off_arch {value}

-set_io_state {value}

-pdb_file {name}

-enable_m3debugger {value}

& Microsemi

update_programming_file

Arguments
-name {name}
Specifies the device name. This argument must be specified only in chain programming mode.
-feature {value}
Select the silicon feature(s) you want to program. Possible values for this option are listed in the table
below, or the instance-specific program options available only for specific families (as shown in the table
below). Microsemi recommends that you specify your program parameters for each Embedded Flash
Memory Block (EFMB) instance, from 0-3. The instance specific program options replace [-feature
{value}].
value Family

{setup_security:on/off} SmartFusion

{prog_fpga:on/off}

SmartFusion

{prog_from:on/off}

SmartFusion

{prog_nvm:on/off}

SmartFusion

{setup_security}

Fusion

{prog_from}

Fusion

{all}

IGLOO; ProASIC3

To program the Embedded Flash Memory Block, use the following EFM arguments: -efm_block, -

efm_client, and -efm_block_security.
-signature {value}
Optional argument that identifies and tracks Microsemi designs and devices.
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-from_content {name}

Optional argument that identifies the source file for the FlashROM content. The file type is UFC or PDB
(default). This argument only applies when programming the FlashROM (prog_from option).

-from_config_file {name}

Optional argument that specifies the location of the FlashROM configuration file. This argument only
applies when programming the FlashROM (prog_from option) and the from_content is set to UFC.

-number_of_devices{value}

Optional argument that specifies the number of devices to be programmed. This argument only applies
when FlashROM has serialization regions. This argument only applies when programming the
FlashROM (prog_from option).

-from_program_pages {value}

Optional argument that identifies the program pages in FlashPoint. This argument only applies when
programming the FlashROM (prog_from option).

-custom_security {value}

Optional argument that specifies the security level. This argument only applies when programming the

security settings (setup_security) or programming previously secured devices. The following table shows
the acceptable values for this argument:

Value Description

Yes

Custom security level

No

Standard security level

-security_permanent {value}

Optional argument that specifies whether the security settings for this file are permanent or not. This
argument only applies when programming the security settings (setup_security) or programming
previously secured devices. The following table shows the acceptable values for this argument:

Value Description

Yes

Permanently disables future modification of security settings

No

Enables future modifications of security settings

-fpga_security_level {value}

Optional argument that specifies the security level for the FPGA Array. This argument only applies when
programming the security settings (setup_security) or programming previously secured devices. Possible
values:

Value Description

write_verify_protect | The security level is medium (standard) and the FPGA Array

cannot be written or verified without a Pass Key

write_protect The security level is write protected. The FPGA Array cannot be
written without a Pass Key, but it is open for verification (custom
FPGA)

encrypted The security level is high (standard) and uses a 128-bit AES
encryption

none The FPGA Array can be written and verified without a Pass Key
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-from_security_level {value}

Optional argument that specifies the security level for the FlashROM. This argument only applies when
programming the security settings (setup_security) or programming previously secured devices. Possible
values:

Value Description

write_verify_protect | The security level is medium (standard) and the FlashROM cannot
be read, written or verified without a Pass Key

write_protect The security level is write protected. The FlashROM cannot be
written without a Pass Key, but it is open for reading and
verification (custom FlashROM)

encrypted The security level is high (standard) and uses a 128-bit AES
encryption
none The FlashROM can be written and verified without a Pass Key

-efm_block_security{location:X;security_level: value}

This option is available only for SmartFusion and Fusion; this argument only applies when
programming the security settings (setup_security) or programming previously secured devices.

X' identifies an Embedded Flash Memory Block instance from 0-3.
Possible values for security_level:

Value Description

clients_jtag_protect | Enables eNVM client JTAG protection; a pass key is required for
this option.

write_verify_protect | The security level is medium (standard) and the Embedded Flash
Memory Block cannot be read, written or verified without a Pass
Key

write_protect The security level is write protected. The Embedded Flash
Memory Block cannot be written without a Pass Key, but it is open
for reading (custom FB)

encrypted The security level is high (standard) and uses a 128-bit AES
encryption
none The Embedded Flash Memory Block can be written and read

without a Pass Key

-pass_key {value}

Protects all the security settings for FPGA Array, FlashROM, and Embedded Flash Memory Block. The
maximum length of this value is 32 characters. You must use hexadecimal characters for the pass key
value.

-aes_key {value}

Decrypts FPGA Array and/or FlashROM and Embedded Flash Memory Block programming file content.
Max length is 32 HEX characters.

-efm_content {location:X;source: value}

This option is available only for SmartFusion and Fusion; X identifies an Embedded Flash Memory Block
from 0-3. Option identifies the source file for the Embedded Flash Memory Block configuration content,
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either an EFC or PDB file. If you specify EFC as your source, you need to specify the -efm_block
parameter. Possible values:

Value Description

PDB | Embedded Flash Memory Block configuration and content is taken from your
PDB

EFC | FlashPoint uses the Embedded Flash Memory Block configuration and content
from the EFC file specified in -efm_block parameter

-efm_block {location:X;config_file: value}

This option is available only for SmartFusion and Fusion; X identifies an Embedded Flash Memory Block
(EFMB) from 0-3.

Config_file specifies the location of the EFMB configuration file (must be an EFC file with full pathname).
-efm_client {location:X;client:value; mem _file: value}

This option is available only for SmartFusion and Fusion; X identifies an EFMB from 0-3.

You must specify the client name and its memory content file for each client of EFMB you wish to
program.

Mem_file specifies the file with the memory content for the client. If you want to program a client with a
PDB or EFC file memory content (as defined by the -efm_content argument), the mem_file path should be
empty (see example 3); but if a mem_file path is specified, the memory content from this file will overwrite
the client content in PDB or EFC (as defined by the -efm_content argument).

-tie_off_arch {value}
This optional argument is used only for IT6X6M2 and M7IT6X6M2 devices. Possible values:

Value Description

pull-down | Pull-down resistor: reduced quiescent power consumption

pull-up Pull-up resistor: compatible behavior for migrated ProASIC™"® designs

-set_io_state {value}

Sets the I/O state during programming by port name or pin number.

To set the I/0 by port name, use -set_io_state {portName:<port name>; state:<state>}.
To set the I/O by pin humber, use -set_io_state {pinNumber:<pin number>; state:<state>}.
To set all I/Os to the specified state, use -set_io_state {all; state:<state>}.

Possible state values:

Value Description
Tri-State Sets the 1/O state to tristate
Last Known State Sets the I/O state to last known state
High Sets the I/O state to high
Low Sets the 1/O state to low

-pdb_file {name}

Optional PDB filename; if not specified the default is ‘expresspdbX'.
-enable_m3debugger {yes | no}

SmartFusion only; .enables the M3 debugger.
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update_programming_file

Supported Families
All devices supported by FlashPro.

Exceptions
None

Example

Fusion example 1:
update_programming_file \
-feature {setup_security} \
-feature {prog_from} \
-from_content {ufc} \
-from_config_file {D:/from_ah.ufc} \
-number_of_devices {1} \
-from_program_pages {1 2 3456 7 } \
-custom_security {no} \
-security_permanent {no} \
-fpga_security_level {write_verify protect} \
-from_security_level {write_verify protect} \
-efm_block_security {location:1;security_level:write_verify protect} \
-efm_content {location:1;source:efc} \
-efm_block {location:1;config_file:{D:\ nvm_all_new.efc}} \
-efm_client {location:1;client:asb;mem_file:{}} \
-efm_client {location:1;client:cfiData;mem_file:{D:\cfid.mem}} \
-efm_client {location:1;client:ds;mem_file:{D:\ds.hex}} \
-efm_client {location:1;client:initl;mem_Ffile:{D:\initl.hex}} \
-efm_client {location:1;client:raminit;mem_Ffile:{}}
Update loaded PDB file: use ufc file for FlashROM configuration and content; use efc file for block 1
configuration; efc memory content will be overwritten by memory content from specified mem files for
each client.
Fusion example 2:
update_programming_file \
-feature {prog_from} \
-from_content {pdb} \
-from_program_pages {1} \
-efm_content {location:1;source:pdb} \
-efm_client {location:1;client:cfiData;mem_Ffile:{D:\cfid.mem}}
Update loaded PDB file: use pdb data for FlashROM; program only page 1; use pdb data for block 1;
program only client cfiData; overwrite memory content for this client with memory content from the
specified file.
Fusion example 3:
update_programming_file \
-efm_content {location:1;source:pdb} \
-efm_client {location:1;client:cfiData;mem_Ffile:{D:\cfid.mem}} \
-efm_client {location:1;client:initl;mem_file:{}}
Update loaded PDB file: use pdb data for block 1; program client cfiData using memory content from the
specified file; program client initl using memory content from pdb (no mem_file path is specified) .
SmartFusion example:
update_programming_file \
update_programming_file \
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-feature {setup_security:on} \

-feature {prog_fpga:off} \

-feature {prog_from:off} \

-feature {prog_nvm:on} \

-custom_security {no} \

-security_permanent {no} \

-fpga_security_level {none} \

-from_security_level {none} \

-efm_block_security {location:0;security_level:clients_jtag protect} \
-efm_block_security {location:1;security_level:clients_jtag_protect} \
-pass_key {73F09973E792ECIF462AE5A446FB6C77} \

-efm_content {location:0;source:pdb} \

-efm_block

{location:0;config_Ffile:{./eNVM_client_JTAG_protection_A2F500/allClients_Read ON_Write_O
N.efc}}

\
-pdb_file {./fpro_jtag/fpro_jtag_30.pdb} \
-enable_m3debugger {no}
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& Microsemi
Loopback Test

Troubleshooting

Loopback Test

The console software supports all JTAG functions and a diagnostic loopback test. Note that loopback is not

supported on all boards.

To perform the diagnostic test

1. Connect the loopback test board to the FlashPro.
Connect the FlashPro to the parallel/USB port of the PC.

2
3. Power-on the FlashPro.
4. From the Start menu, choose Programs > Microsemi FlashPro > Diagnotics. This opens the

diagnostics console program.

5. Connect to the FlashPro by entering openport Iptl or openport usb. The parallel port number depends
on the port used to connect the FlashPro.

6. Enter test. The unit runs into self-test mode. Do not interrupt the unit during self-test mode.

Note: To see a complete list of all functions, enter help. To get a more detail description of each function,

enter help <command>.

Exit Codes (SmartFusion2, IGLOOZ2, and RTG4)

Table 24 - Exit Codes (SmartFusion2, IGLOO2, and RTG4)

Error | Exit Exit Message Possible Cause Possible Solution
Code |Code
0 Passed (no error) - -
0x8001 | -24 Failure to read DSN Device is in System TRSTB should be driven High or
Controller Suspend disable "System Controller Suspend
Mode Mode"
Check board
connections
0x8002 |5 Failure to configure device Unstable voltage level | Monitor related power supplies that
programming at 1.2/1.0 VCC Signal integrity issues | cause the issue during programming;
voltage on JTAG pins check for transients outside of
Microsemi specifications. See your
device datasheet for more information
on transient specifications.
Monitor JTAG supply pins during
programming; measure JTAG signals
for noise or reflection.
0x8032 |5 Device is busy Unstable VDDIx voltage | Monitor related power supplies that
level cause the issue during programming;
check for transients outside of
Microsemi specifications. See your
device datasheet for more information
on transient specifications.
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0x8003 |5 Failed to enter programming Unstable voltage level | Monitor related power supplies that
mode Signal integrity issues | cause the issue during programming;
on JTAG pins check for transients outside of

Microsemi specifications. See your
device datasheet for more information
on transient specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals
for noise or reflection.

0x8004 | 6 Failed to verify IDCODE Incorrect programming | Choose the correct programming file

file and select the correct device in the
chain.

Incorrect device in

chain Measure JTAG pins and noise for
reflection. If TRST is left floating then

Signal integrity issues add pull-up to pin.

on JTAG pins

Reduce the length of Ground

connection.
0x8005 |10 Failed to program eNVM Unstable voltage level. | Monitor related power supplies that
Signal integrity issues cause the issue during programming;
on JTAG pins. check for transients outside of
Microsemi specifications. See your
device datasheet for more information
on transient specifications.
Monitor JTAG supply pins during
programming; measure JTAG signals
for noise or reflection.
0x8006 |10 Failed to program eNVM Unstable voltage level. | Monitor related power supplies that
Signal integrity issues | cause the issue during programming;
on JTAG pins. check for transients outside of
Microsemi specifications. See your
device datasheet for more information
on transient specifications.
Monitor JTAG supply pins during
programming; measure JTAG signals
for noise or reflection.
0x8007 |11 Failed to verify FPGA Array Device is programmed | Verify the device is programmed with
with a different design. | the correct data/design
Unstable voltage level. | Monitor related power supplies that
Signal integrity issues cause the issue during programming;
on JTAG pins. check for transients outside of
Microsemi specifications. See your
device datasheet for more information
on transient specifications.
Monitor JTAG supply pins during
programming; measure JTAG signals
for noise or reflection.
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Error | Exit Exit Message Possible Cause Possible Solution
Code |Code
0x8008 |11 Failed to verify eNVM Device is programmed | Verify the device is programmed with
with a different design. | the correct data/design
Unstable voltage level. | Monitor related power supplies that
Signal integrity issues cause the issue during programming;
on JTAG pins. check for transients outside of
Microsemi specifications. See your
device datasheet for more information
on transient specifications.
Monitor JTAG supply pins during
programming; measure JTAG signals
for noise or reflection.
0x8009 |11 Failed to verify eNVM Device is programmed [ Verify the device is programmed with
with a different design. | the correct data/design
Unstable voltage level. | Monitor related power supplies that
Signal integrity issues | cause the issue during programming;
on JTAG pins. check for transients outside of
Microsemi specifications. See your
device datasheet for more information
on transient specifications.
Monitor JTAG supply pins during
programming; measure JTAG signals
for noise or reflection.
0x8010 | -35 Failed to unlock User Pass Key | Pass key in file does Provide a programming file with a pass
1 not match device key that matches pass key
programmed into the device
0x8011 [-35 Failed to unlock User Pass Key | Pass key in file does Provide a programming file with a pass
2 not match device key that matches pass key
programmed into the device
0x8012 [ -35 Failed to unlock debug pass key | Pass key in file does Provide a programming file with a pass
not match device key that matches pass key
programmed into the device
0x8013 | -18 Digest request from SPI/JJTAG Digest request from Provide a programming file with a pass
is protected by user pass key 1 | SPI/JTAG is protected [ key that matches pass key
by user pass key 1. programmed into the device
Lock bit has been
configured in the Debug
Policy within SPM
(Security Policy
Manager)
0x8014 [-19 Failed to verify digest Unstable voltage level | Monitor related power supplies that
cause the issue during programming;
check for transients outside of
Microsemi specifications. See your
device datasheet for more information
on transient specifications.
Signal integrity issues Monitor JTAG supply pins during

FlashPro User's Guide

191



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

& Microsemi

Error
Code

Exit
Code

Exit Message

Possible Cause

Possible Solution

on JTAG pins

programming; measure JTAG signals
for noise or reflection

0x8015

FPGA Fabric digest verification:

FAIL

Programming bitstream
components do not
match components
programmed

FPGA Fabric is either
erased or the data has
been corrupted or
tampered with

Use the same programming file that
was used to program the device.

0x8016

eNVM_0 digest verification:

FAIL

Programming bitstream
components do not
match components
programmed

eNVM_0 data has been
corrupted or tampered
with

Use the same programming file that
was used to program the device

0x8017

eNVM_1 digest verification:

FAIL

Programming bitstream
components do not
match components
programmed

eNVM_1 data has been
corrupted or tampered
with

Use the same programming file that
was used to program the device

0x8018

User security policies segment

digest verification: FAIL

Programming bitstream
components do not
match components
programmed

User security policy
segment data has been
corrupted or tampered
with

Use the same programming file that
was used to program the device.

0x8019

User key set 1 segment digest

verification: FAIL

Programming bitstream
components do not
match components
programmed

User key set 1 segment
data has been
corrupted or tampered
with

Use the same programming file that
was used to program the device.

O0x801A

User key set 2 segment digest

verification: FAIL

Programming bitstream
components do not
match components
programmed

User key set 2 segment
data has been

Use the same programming file that
was used to program the device.
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Error
Code

Exit
Code

Exit Message

Possible Cause

Possible Solution

corrupted or tampered
with

0x801B

Factory row and factory key
segment digest verification:
FAIL

Programming bitstream
components do not
match components
programmed

Factory row and factory
key segment data has
been corrupted or
tampered with

Use the same programming file that
was used to program the device.

0x801C

Fabric configuration segment
digest verification: FAIL

Programming bitstream
components do not
match components
programmed.

Fabric configuration
segment data has been
corrupted or tampered
with

Use the same programming file that
was used to program the device.

0x801D

Device security prevented
operation

The device is protected
with user pass key 1
and the bitstream file
does not contain user
pass key 1.

User pass key 1 in the

bitstream file does not
match the device.

Run DEVICE_INFO to view security
features that are protected.

Provide a bitstream file with a user
pass key 1 that matches the user pass
key 1 programmed into the device.

0x801E

Device security prevented
operation

The device is protected
with user pass key 1
and the bitstream file
does not contain user
pass key 1.

User pass key 1 in the

bitstream file does not
match the device.

Run DEVICE_INFO to view security
features that are protected.

Provide a bitstream file with a user
pass key 1 that matches the user pass
key 1 programmed into the device.

0x801F

Authentication Error

Invalid/Corrupted programming
file

Bitstream file has been
corrupted

Bitstream was
incorrected generated

Regenerate bitstream file

0x8020

Authentication Error

Invalid/Corrupted programming
file

Bitstream file has been
corrupted

Bitstream was
incorrected generated

Regenerate bitstream file

0x8021

Authentication Error

Invalid/Corrupted encryption key

File contains an
encrypted key that does

Provide a programming file with an
encryption key that matches that on the
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Error | Exit Exit Message Possible Cause Possible Solution
Code |Code
not match the device device
File contains user First program security with master
encryption key, but programming file, then program with
device has not been user encryption 1/2 field update
programmed with the programming files
user encryption key You must first ERASE security with the
Device has user master security file, then you can
encryption key 1/2 reprogram new security settings
enforced and you are
attempting to reprogram
security settings
0x8022 | -23 Authentication Error File contains an Provide a programming file with an
Invalid/Corrupted encryption key | €ncrypted key that does | encryption key that matches that on the
not match the device device
File contains user First program security with master
encryption key, but programming file, then program with
device has not been user encryption 1/2 field update
programmed with the programming files
user encryption key You must first ERASE security with the
Device has user master security file, then you can
encryption key 1/2 reprogram new security settings
enforced and you are
attempting to reprogram
security settings
0x8023 [ -24 Authentication | Design version is not Generate a programming file with a
Error higher than the back- design version higher than the back
Back level not | level programmed level version
satisfied device
0x8024 [ -24 Authentication | Design version is not Generate a programming file with a
Error higher than the back- design version higher than the back
Back level not | level programmed level version
satisfied device
0x8025 | -25 Authentication Error DSN specified in Use the correct programming file with a
DSN binding mismatch programming file does | DSN that matches the DSN of the
not match the device target device being programmed
being programmed
0x8026 |-25 Authentication Error DSN specified in Use the correct programming file with a
DSN binding mismatch programming file does | DSN that matches the DSN of the
not match the device target device being programmed
being programmed
0x8027 | -26 Authentication Error Device does not Generate a programming file with the
Insufficient device capabilities support the capabilities | correct capabilities for the target device
specified in
programming file
0x8028 | -26 Authentication Error Device does not Generate a programming file with the
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Error | Exit Exit Message Possible Cause Possible Solution
Code |Code
Insufficient device capabilities support the capabilities | correct capabilities for the target device
specified in
programming file
0x8029 | -27 Authentication Error Incorrect programming | Choose the correct programming file
Incorrect DEVICEID file and select the correct device in chain
Incorrect device in Measure JTAG pins and noise or
chain reflection. If TRST is left floating, then
Signal integrity issues | @dd pull-up to pin
on JTAG pins Reduce the length of ground
connection
0x802A | -27 AuthenticationError Incorrect programming | Choose the correct programming file
Incorrect DEVICEID file and select the correct device in chain
Incorrect device in Measure JTAG pins and noise or
chain reflection
Signal integrity issues | If TRST is left floating, then add pull-up
on JTAG pins to pin Reduce the length of ground
connection
0x802B | -28 Authentication Error Old programming file Generate programming file with latest
Unsupported bitstream protocol version of Libero SoC
version
0x802C | -28 Authentication Error Old programming file Generate programming file with latest
Unsupported bitstream protocol version of Libero SoC
version
0x802F | -30 JTAG interface is protected by Invalid or no UPK1 is User needs to provide correct UPK1 to
UPK1 provided unlock device.
0x8030 | -31 Authentication Error M2S090 Rev. A or User can program a valid application
Invalid or inaccessible Device M2S150 Rev. A: Either [ code. This can be done with
Certificate certificate is corrupted | SoftConsole.
ortheuserhasnt | FAR RESET_N should be tied to HIGH
provided the application
code in the eNVM or
provided invalid
application code
FAB_RESET_N is tied
to ground
0x8031 [-31 Authentication Error M2S090 Rev. A or User can program a valid application
Invalid or inaccessible Device M2S150 Rev. A: Either | code. This can be done with
Certificate certificate is corrupted | SoftConsole
ortheuserhasnt | A RESET_N should be tied to HIGH
provided the application
code in the eNVM or
provided invalid
application code
FAB_RESET N is tied
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Error | Exit Exit Message Possible Cause Possible Solution
Code | Code

to ground

SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for
Software v8.6 and Above

The table below lists exit codes for SmartFusion, IGLOO, ProASIC3 and Fusion devices in software v8.6
and ABOVE only. See the Device Exit Codes for pre-v8.6 Software help topic for exit codes for older
versions.
Note: Exit codes with positive integers are reserved for current and future standard EXIT codes of the STAPL
standard. Exit codes with negative integers are reserved for vendor-specific EXIT codes.
Table 25 - Exit Codes for SmartFusion, IGLOO, ProASIC3 and Fusion Family Devices in Software
v8.6 and Above

ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message

0 Passed
(no error)
1 A physical | Physical chain configuration has

chain does | been altered. Something has
not match | become disconnected in the
the chain.

expected The specific IR length of non-
set up from | Microsemi devices may be
the STAPL | incorrect.

file. The order of the specified chain
Also may be incorrect.
known as
Checking
Chain
Error.
0x8052 5 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
enter the issue during programming; check for
programmin | Unstable VCC transients outside of Microsemi
g mode. specifications. See your device datasheet
Signal integrity issues on JTAG for more information on transient
pins. specifications.
Device is in FlashFreeze mode Monitor VITAG during programming;
(ProASICL or IGLOO devices) measure JTAG signals for noise or

reflection.
Older software or programming
file used. Disble the FlashFreeze pin (ProASICL or
IGLOO devices)

Generate STAPL file with the latest
version of Designer/FlashPro.
Use latest version of FlashPro software.

0x801D 6 Failed to Incorrect programming file Choose the correct programming file and
0x8053 verify select the correct device in chain.
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SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for Software v8.6 and Above

ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message
IDCODE Incorrect device in chain
Measure JTAG pins and noise or
Signal integrity issues on JTAG reflection. If TRST is left floating then add
pins pull-up to pin.

Reduce the length of ground connection.
0x8005 6 Failed to Programming file generated with | Generate STAPL file with the latest
0x8009 verify AES an older version of software version of Designer/FlashPro. Use latest
0x800B Sec. version of FlashPro software.

Try again at a slower TCK.

Contact Microsemi Technical Support.
0x8008 6 Failed to File is not for M7, but target Check that the target device is M7

verify device is M7 enabled.
IDCODE.

Signal integrity issues on JTAG Make sure that the programming file you
Targetisan | pins. generated is for an M7-enabled device.
M7 device

Measure JTAG pins, noise and reflection.
0x800A 6 Failed to Files not for M1, but target device | Check that the target device is M1

verify is M1. enabled.
IDCODE

Signal integrity issues on JTAG Make sure the programming file
Targetis an | pins generated is for an M1-enabled device.
M1 device

Monitor VITAG during programming;

measure JTAG signals for noise or

reflection.
0x800C 6 Failed to File is not for target device. Check the target device; make sure the
verify programming file generated is matches
IDCODE. Signal integrity issues on JTAG the target device.
pins
Core Monitor VITAG during programming;
enabled measure JTAG signals for noise or
device reflection.
detected
0x800D 6 Failed to File is for M7 but target device is | Check that the target device is not M7
verify not M7. enabled.
IDCODE.
Signal integrity issues on JTAG Make sure that the programming file
The target is | pins. generated is for non-M7 enabled device.
not M7
device Monitor VITAG during programming;
measure JTAG signals for noise or
reflection.
0x800E 6 Failed to File is for M1, but target device is | Check that the target device is not M1
verify not M1. enabled.
IDCODE.
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ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message
Signal integrity issues on JTAG Make sure that the generated
Target is not | pins programming file is for non-M1 enabled
an M1 device.
device
Monitor VITAG during programming;
measure JTAG signals for noise or
reflection.
0x8006 6 Failed to File is not for P1, but target device | Check that the target device is P1
verify is a P1 device. enabled.
IDCODE.
Signal integrity issues on JTAG Make sure programming file generated is
Target is not | pins for M1 enabled device.
a P1 device
Monitor VITAG during programming;
measure JTAG signals for noise or
reflection.
Ox801E 6 A3PE600 Contact Microsemi Technical Support
Engineering
Sample
Device
Detected.
This device
is supported
with pre-v8.3
SP1 STAPL
files only
0x8057 8 Failed Erase | Unstable VPUMP voltage level. Monitor related power supplies that cause
Operation. the issue during programming; check for
Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) | for more information on transient
specifications.
Unstable VCC_ROSC voltage
level (SmartFusion only) Monitor VITAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins.
0x8058 10 Failed to Monitor related power supplies that cause
program Unstable VPUMP voltage level. the issue during programming; check for
FPGA array transients outside of Microsemi
at row <row | Unstable VCC specifications. See your device datasheet
number>. for more information on transient
Unstable VCC_OSC (Fusion only) | specifications.
Unstable VCC_ROSC voltage Monitor VITAG during programming;
level (SmartFusion only) measure JTAG signals for noise or
reflection.
Signal integrity issues on JTAG
pins.
0x805D 10 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
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SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for Software v8.6 and Above

ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message
Ox805E enable the issue during programming; check for
0x807B FPGA Array. | Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) | for more information on transient
specifications.
Unstable VCC_ROSC voltage
level (SmartFusion only) Monitor VITAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins.
0x80 |10 Failed to Monitor related power supplies that cause
95 disable Unstable VPUMP voltage level. the issue during programming; check for
0x80 FPGA Array. transients outside of Microsemi
96 Unstable VCC specifications. See your device datasheet
0x80 . for more ipformation on transient
97 Unstable VCC_OSC (Fusion only) | specifications.
Unstable VCC_ROSC voltage Monitor VITAG during programming;
level (SmartFusion only) measure JTAG signals for noise or
reflection.
Signal integrity issues on JTAG
pins.
0x8061 10 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
0x8062 program the issue during programming; check for
FlashROM. | Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) | for more information on transient
specifications.
Unstable VCC_ROSC voltage
level (SmartFusion only) Monitor VITAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins.
0x801B 10 Error Unstable VCC_NVM/VCC_0OSC Monitor related power supplies that cause
0x801C programmin | voltage level (Fusion only) the issue during programming; check for
0x806C g Embedded transients outside of Microsemi
0x806D Flash Unstable specifications. See your device datasheet
0x806E Memory VCC_ENVM/VCC_RCOSC for more information on transient
Block voltage level (SmartFusion only) | specifications.
(EFMB)
Signal integrity issues on JTAG Monitor VITAG during programming;
pins measure JTAG signals for noise or
reflection.
NVM corruption is possible when
writing from your design; check Reset signal is not properly tied off in
the NVM status for confirmation. | your design.

Inspect device using Device Debug.
0x807D 10 Error Unstable VCC Monitor related power supplies that cause
Ox807E programmin the issue during programming; check for

g system init [ Unstable VCC_OSC (Fusion only) | transients outside of Microsemi
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& Microsemi P
ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message

and boot specifications. See your device datasheet

clients Unstable VCC_ROSC voltage for more information on transient
level (SmartFusion only) specifications.
Signal integrity issues on JTAG Monitor VITAG during programming;
pins measure JTAG signals for noise or

reflection.

Inspect device using Device Debug.
0x8069 10 Error Programming file generated with | Generate STAPL file with the latest
0x806A programmin | an older version of software version of Designer/FlashPro; use the
0x806B g Embedded latest version of FlashPro software

Flash

Memory Try again at a slower TCK

Block

(EMFB) Inspect device using Device Debug.

Contact Microsemi Technical Support
Ox808E 10 Error Try reprogramming
0x808F programmin
0x8090 g Embedded Contact Microsemi Technical Support
0x8091 Flash

Memory
Block
(EFMB)
0x807F 10 Error Programming file generated with | Generate STAPL file with the latest
0x8080 programmin | an older version of software version of Designer/FlashPro; use the
g system init latest version of FlashPro software
and boot
clients Try again at a slower TCK

Inspect device using Device Debug.

Contact Microsemi Technical Support
0x8059 11 Verify 0 Unstable VPUMP voltage level. Monitor related power supplies that cause
0x805B failed at row the issue during programming; check for

<row Unstable VCC transients outside of Microsemi

number> specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) | for more information on transient

Verify 1 specifications.

failed at row | Unstable VCC_ROSC voltage

<row level (SmartFusion only) Monitor VITAG during programming;

number>. measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins.

0x8060 11 Device is programmed with a Run VERIFY_DEVICE_INFO to verify the

Failed to different design. device is programmed with the correct

verify data/design.

FlashROM Unstable VPUMP voltage level.

at row Monitor related power supplies that cause
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SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for Software v8.6 and Above

ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message
<FlashROM | Unstable VCC the issue during programming; check for
row transients outside of Microsemi
number>. Unstable VCC_OSC (Fusion only) | specifications. See your device datasheet
for more information on transient
Unstable VCC_ROSC voltage specifications.
level (SmartFusion only)
Monitor VITAG during programming;
Signal integrity issues on JTAG measure JTAG signals for noise or
pins. reflection.
0x8075 11 Failed to Device is programmed with a Verify the device is programmed with the
0x8076 verify different design. correct data/design.
0x8077 Embedded
Flash Unstable VCC Monitor related power supplies that cause
Memory the issue during programming; check for
Block Unstable VCC_NVM/VCC_OSC transients outside of Microsemi
(EFMB) (Fusion only) specifications. See your device datasheet
for more information on transient
Unstable specifications.
VCC_ENVM/VCC_ROSC voltage
level (SmartFusion only) Measure JTAG pins, and noise or
reflection.
Signal integrity issues on JTAG
pins. Run DEVICE_INFO to confirm if the
target EFMB block is locked with
The EFMB data was modified in FlashLock (pass key). If the target EFMB
your FPGA design after block is locked, then you must unlock it
programming. This could have by erasing the security and then
occurred during standalone verify. | reprogramming with the desired security
settings. After unlocking the target EFMB
The target EFMB is locked with block attempt to rerun the target ACTION.
FlashLock when running ACTION
PROGRAM_NVM_ACTIVE_ARR | Inspect device using Device Debug.
AY or
VERIFY_NVM_ACTIVE_ARRAY.
0x8085 11 Failed to Device is programmed with a Verify the device is programmed with the
0x8086 verify system | different design. correct data/design.
init and boot
clients Unstable VCC Monitor related power supplies that cause
the issue during programming; check for
Unstable VCC_NVM/VCC_OSC transients outside of Microsemi
(Fusion only) specifications. See your device datasheet
for more information on transient
Unstable specifications.
VCC_ENVM/VCC_ROSC voltage
level (SmartFusion only) Measure JTAG pins, and noise or
reflection.
Signal integrity issues on JTAG
pins. Run DEVICE_INFO to confirm if the
target EFMB block is locked with
The EFMB data was modified in FlashLock (pass key). If the target EFMB
your FPGA design after block is locked, then you must unlock it
programming. This could have by erasing the security and then
occurred during standalone verify. | reprogramming with the desired security
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ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message
settings. After unlocking the target EFMB
The target EFMB is locked with block attempt to rerun the target ACTION.
FlashLock when running ACTION
PROGRAM_NVM_ACTIVE_ARR | Inspect device using Device Debug.
AY or
VERIFY_NVM_ACTIVE_ARRAY.
0x8072 11 Failed to Programming file generated with | Generate STAPL file with the latest
0x8073 verify an older version of software version of Designer/FlashPro; use the
0x8074 Embedded latest version of FlashPro software
Flash
Memory Try again at a slower TCK
Block
(EFMB) Inspect device using Device Debug.
Contact Microsemi Technical Support
0x8083 11 Failed to Programming file generated with | Generate STAPL file with the latest
0x8084 verify system | an older version of software version of Designer/FlashPro; use the
init and boot latest version of FlashPro software
clients
Try again at a slower TCK
Inspect device using Device Debug.
Contact Microsemi Technical Support
0x8014 11 Failed to Unstable VCC Monitor related power supplies that cause
0x8015 verify the issue during programming; check for
calibration Unstable VCC_NVM/VCC_OSC transients outside of Microsemi
data (Fusion only) specifications. See your device datasheet
for more information on transient
Unstable specifications.
VCC_ENVM/VCC_ROSC voltage
level (SmartFusion only) Monitor VITAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins
Try reprogramming.
Workaround: Disable optional procedure
CHECK_AND_BACKUP_CALIB
0x805A 11 Verify 0 Device is programmed with a Run VERIFY_DEVICE_INFO to verify the
0x805C failed at row | different design device is programmed with the correct
<row data/design.
number> . Unstable VPUMP voltage level.
Monitor related power supplies that cause
Verify 1 Unstable VCC the issue during programming; check for
failed at row transients outside of Microsemi
<row Unstable VCC_OSC (Fusion only) | specifications. See your device datasheet
number> for more information on transient
Unstable VCC_ROSC voltage specifications.
level (SmartFusion only)
Monitor VITAG during programming;
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SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for Software v8.6 and Above

ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message
Signal integrity issues on JTAG measure JTAG signals for noise or
pins reflection.
0x8063 14 Failed to Signal integrity issues on JTAG Monitor related power supplies that cause
program pins. the issue during programming; check for
Silicon transients outside of Microsemi
Signature. specifications. See your device datasheet
Failed to for more information on transient
program specifications.
security lock
settings. Monitor VITAG during programming;
measure JTAG signals for noise or
reflection.
0x8068 -18 | Failed to Incorrect AES key. Generate a programming file with the
authenticate correct AES key.
the Signal integrity issues on JTAG
encrypted pins. Monitor VITAG during programming;
data. measure JTAG signals for noise or
reflection.
0x805F -20 | Failed to Programming file generated with | Generate STAPL file with the latest
verify an older version of software version of Designer/FlashPro; use the
FlashROM latest version of FlashPro software.
at row Device is programmed with a
<FlashROM | different design. Program with the correct data/design.
row
number>. Unstable VPUMP voltage level. Monitor related power supplies that cause
the issue during programming; check for
Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) | for more information on transient
specifications.
Unstable VCC_ROSC voltage
level (SmartFusion only) Measure JTAG pins and noise or
reflection.
Signal integrity issues on JTAG
pins.
0x8065 -22 | Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
program the issue during programming; check for
pass key. Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) | for more information on transient
specifications.
Unstable VCC_ROSC voltage
level (SmartFusion only) Monitor VITAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins.
0x8066 -23 | Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
program the issue during programming; check for
AES key. Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
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ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message
Unstable VCC_OSC (Fusion only) | for more information on transient
specifications.
Unstable VCC_ROSC voltage
level (SmartFusion only) Measure JTAG pins and noise or
reflection.
Signal integrity issues on JTAG
pins.
0x8055 -24 | Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
0x8056 program the issue during programming; check for
UROW. Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) | for more information on transient
specifications.
Unstable VCC_ROSC voltage
level (SmartFusion only) Monitor VITAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins.
Make sure you mounted 0.01uF and
0.33uF caps on Vpump (close to the pin).
0x802A -27 | FlashROM File contains no passkey and Provide a programming file with a
Write/Erase | device is secured with a passkey. | passkey that matches the passkey
is protected programmed into the device.
by the Passkey in the file does not
passkey. match device.
A valid
passkey
needs to be
provided.
0x8025 -28 | FPGA Array | File contains no passkey and Provide a programming file with a
Write/Erase | device is secured with a passkey. | passkey that matches the passkey
is protected Passkey in the file does not programmed into the device.
by the match device.
passkey.
A valid pass
key needs to
be provided.
0x802B -29 | FlashROM File contains no passkey and Provide a programming file with a pass
0x802D Read is device is secured with a passkey. [ key that matches the passkey
protected by [ Passkey in the file does not match | programmed into the device
passkey. device.
A valid
passkey
needs to be
provided.
0x8024 -30 | FPGA Array | File contains no passkey and Provide a programming file with a
0x8026 verification is | device is secured with a passkey. | passkey that matches the passkey
protected by | Passkey in the file does not programmed into the device.
a passkey. match device.
A valid
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& Microsemi

SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for Software v8.6 and Above

ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message
passkey
needs to be
provided.
-31 | Failed to AES key in the file does not Provide a programming file with an AES
0x804B verify AES match the device. key that matches the AES key
0x8001 key. programmed into the device.
0x8007 Unstable VCC
Monitor related power supplies that cause
Unstable VCC_OSC (Fusion only) | the issue during programming; check for
transients outside of Microsemi
Unstable VCC_ROSC voltage specifications. See your device datasheet
level (SmartFusion only) for more information on transient
specifications.
Unstable JTAG/VPUMP voltage
level. Monitor VITAG during programming;
measure JTAG signals for noise or
reflection.
0x8000 -31 | Failed to Programming file generated with | Generate STAPL file with the latest
verify AES an older version of software version of Designer/FlashPro; use the
key. latest version of FlashPro software.
Try again at a slower TCK
Contact Microsemi Technical Support
0x8020 -33 | FPGA Array | File contains unencrypted array Provide a programming file with an
0x8022 encryption is | data, but device contains AES encrypted FPGA Array data.
0x8028 enforced. A | key.
programmin
g file with
encrypted
FPGA array
data needs
to be
provided.
0x802C -34 FlashROM | File contains unencrypted Provide a programming file with an
0x802F encryption is | FlashROM data, but the device encrypted FlashROM data.
enforced. A | contains an AES key.
programmin
g file with
encrypted
FlashROM
data needs
to be
provided.
Ox801F -35 | Failed to Pass key in file does not match Provide a programming file with a pass
0x804A match pass | pass key in device. key that matches the pass key
key. programmed into the device.
0x802E -36 | FlashROM File contains encrypted Regenerate security programming file
0x8030 Encryption is | FlashROM, but device encryption [ with proper AES key.

FlashPro User's Guide

205


http://www.actel.com/techdocs/ds/default.aspx

NOTE: Links and cross-references in this PDF file may point to external files and generate an error

@M- Sefnf when clicked. View the online help included with software to enable all linked content.
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Code | Message
not enforced. | is not enforced for FlashROM
Program device security.
Cannot
guarantee Retry programming FlashROM with
valid AES encrypted programming file.
key present
in target
device.
Unable to
proceed with
Encrypted
FlashROM
programmin
g.
0x8021 -37 | FPGA Array | File contains encrypted FPGA Regenerate security programming file
0x8023 Encryption is | Array, but the device encryption is | with proper AES key.
0x8027 not enforced. | not enforced for FPGA Array.
0x8029 Program device security.
Cannot
guarantee Retry programming FPGA Array with
valid AES encrypted programming file.
key present
in target
device.
Unable to
proceed with
Encrypted
FPGA Array
verification.
0x8067 -38 | Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
program the issue during programming; check for
pass key. Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) | for more information on transient
specifications.
Unstable VCC_ROSC voltage
level (SmartFusion only) Measure JTAG pins and noise or
reflection.
Signal integrity issues on JTAG
pins.
Bad device.
0x806F -39 | ERROR: 2 Unstable VCC_NVM/VCC_OSC Monitor related power supplies that cause
0x8070 or more voltage (Fusion only) the issue during programming; check for
0x8071 errors found transients outside of Microsemi
0x8081 on this page [ Unstable specifications. See your device datasheet
0x8082 VCC_ENVM/VCC_ROSC for more information on transient
0x8089 (SmartFusion only) specifications.
NVM reset signal is floating in Bias NVM reset to a logic state in user
user design design.
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SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for Software v8.6 and Above

ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message
2 or more ECC errors found when | Try reprogramming.
reading the eNVM
0x8010 -39 | ERROR: 2 2 or more ECC errors found when | The master calibration data has been
or more reading the master calibration corrupted. Try restoring master
errors found | data calibration from backup, if it exists, by
on this page. running RECOVER_CALIB.
Workaround: Disable optional procedure
CHECK_AND BACKUP_CALIB
0x8013 -39 | ERROR: 2 2 or more ECC errors found when | Rerun action to attempt to write backup
or more verifying the backup calibration calibration again.
errors found
on this page. Workaround: Disable optional procedure
CHECK_AND_ BACKUP_CALIB
0x8078 -40 | Embedded Data in the file is encrypted with a | Verify the programming file is generated
0x8079 Flash different AES key than the device. | from the latest version of
0x807A Memory Designer/FlashPro.
0x8087 Block MAC
0x8088 Failure.
0x8002 -42 | Failed to File security settings do not match | Provide a programming file with security
0x8003 verify device. setting that match the security settings
security programmed into the device.
settings.
0x8093 -42 | Failed to Device eNVM/EFMB client JTAG | Verify the device is programmed with the
verify protection settings are not correct eNVM/EFMB client JTAG
eNVM/EFMB | programmed or are programmed | protection settings
client JTAG | with different settings
protection
settings
0x8004 -43 | Failed to File checksum and design name | Verify the device is programmed with the
verify design | do not match the device. correct data and design.
information.
0x8049 -44 | Failed to The AES key in the file does not Provide a programming file with an AES
verify AES match the AES key in the device. | key that matches the AES key
key. File does not contain an AES key | programmed into the device.
and the device is secured with an
AES key.
0x8054 -45 | Device Programming file was generated | Generate STAPL file with the latest
package with an older version of software | version of Designer/FlashPro; use the
does not latest version of FlashPro software.
match the
programmin
g file.
0x8033 -46 | Embedded File contains no pass key or Provide a programming file with the
0x8038 Flash incorrect pass key but EFMB read | correct pass key.
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ERROR_CODE

Exit
Code

Exit
Message

Possible Cause

Possible Solution

0x803D
0x8042
0x8045
0x8046
0x8047
0x8048

Memory
Block X
Read is
protected by
pass key. A
valid pass
key needs to
be provided.

is secured with a pass key.

0x8034
0x8039
0x803E
0x8043

Embedded
Flash
Memory
Block
(EFMB)
block X
Read is not
protected by
pass key.

EFMB
content is
not secure
after
encrypted
programmin
g.

Unable to
proceed with
encrypted
NVM
programmin
g.

File contains encrypted EFMB for
block X but the device encryption
is not enforced for EFMB block X.

Regenerate security programming file
with the proper AES key.

Program device security. Retry
programming with EFMB block X with
encrypted programming file.

0x8032
0x8037
0x803C
0x8041

Embedded
Flash
Memory
Block
(EFMB)
block X
encryption is
enforced. A
programmin
g file with
encrypted
EFMB data
needs to be
provided.

The programming EFMB data is
not encrypted, but the device
contains an AES key with
encryption enforced.

Provide a programming file with
encrypted EFMB data.

0x8031
0x8036
0x803B
0x8040

Embedded
Flash
Memory
Block
(EFMB)
block X

File contains no pass key or
incorrect pass key, but device is
secured with a pass key.

Provide a programming file with a
passkey that matches the passkey
programmed into the device.
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SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for Software v8.6 and Above

ERROR_CODE

Exit
Code

Exit
Message

Possible Cause

Possible Solution

Write is
protected by
pass key.

A valid pass
key needs to
be provided.

0x8035
0x803A
0x803F
0x8044

Embedded
Flash
Memory
Block
(EFMB)
block X
Encryption is
not enforced.

Cannot
guarantee
valid AES
key present
in target
device.

Unable to
proceed with
Encrypted
EFMB
programmin
g.

File contains encrypted EFMB for
block X, but the device encryption
is not enforced for EFMB block X.

Regenerate security programming file
with proper AES key.

Program device security. Retry
programming EFMB block X with
encrypted programming file.

Ox801A

-50

No backup
calibration
data found
or backup
calibration
data has
been
corrupted

No backup calibration copy has
been made or the backup copy
has been corrupted

If master copy is still intact, rerun Action
to create backup calibration copy.

Workaround: Disable optional procedure
CHECK_AND_BACKUP_CALIB

8x804E

-51

Failed to
access
Embedded
Flash
Memory.
(AFS600

only)

This version of the silicon does
not support programming of the
Embedded Flash Memory Block
while the FPGA Array is active.

If programming the EFMB while the
FPGA is active is not required, then use
actions PROGRAM_NVM or
VERIFY_NVM. Otherwise, use latest
revision of silicon.

0x804F

-52

Failed to
access
Embedded
Flash
Memory.
(AFS1500
only)

This version of the silicon does
not support programming of the
Embedded Flash Memory Block
while the FPGA Array is active.

If programming the EFMB while the
FPGA is active is not required, then use
actions PROGRAM_NVM or
VERIFY_NVM. Otherwise, use latest
revision of silicon.
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Code | Message
0x8050 -53 | Failed to This version of the silicon does If programming the EFMB while the
access not support programming block 3 | FPGA is active is not required, then use
Embedded of the EFMBs while the FPGA actions PROGRAM_NVM or
Flash Array is active. VERIFY_NVM. Otherwise, use EFMB
Memory. blocks 0, 1, or 2, but do not use block 3.
(AFS1500
only)
0x8051 -54 | Failed to FPGA Array is accessing the If programming the EFMB while the
access target EFMB block while FPGA is active is not required, then use
Embedded attempting programming. actions PROGRAM_NVM or
Flash VERIFY_NVM. Otherwise, check the
Memory. NVM reset signal is stuck in FPGA design or use a different EFMB
design. block that is not being accessed. Check if
target EFMB block logic is tied to reset.
Unstable VCC
Monitor related power supplies that cause
MSS Clock is disabled during the issue during programming; check for
programming. transients outside of Microsemi
specifications. See your device datasheet
MSS Clock is not properly routed | for more information on transient
to the correct pin. specifications.
Verify that the NVM reset signal in the
design is not stuck.
Verify the MSS clock is enabled during
programming.
If the MSS clock is defined as an external
1/0, then verify that it is properly routed to
the correct pin.
0x808A -55 | Failed to Programming file generated with | Generate STAPL file with the latest
0x8094 read an older version of software version of Designer/FlashPro; use the
Embedded latest version of FlashPro software
Flash
Memory Try again at a slower TCK
Block
(EFMB) Inspect device using Device Debug
Contact Microsemi Technical Support
0x808B -55 | Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
read the issue during programming; check for
Embedded Unstable VCC transients outside of Microsemi
Flash specifications. See your device datasheet
Memory Unstable VCC_OSC (Fusion only) | for more information on transient
Block specifications.
(EFMB) Unstable VCC_ROSC voltage
level (SmartFusion only) Monitor VITAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins
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& Microsemi

SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for pre-v8.6 Software

ERROR_CODE Exit Exit Possible Cause Possible Solution
Code | Message
0x808C -55 | Failed to Internal errror Contact Microsemi Technical Support
read
Embedded
Flash
Memory
Block
(EFMB)
0x8011 -56 | Failed to Try reprogramming.
read
calibration Workaround: Disable optional procedure
data CHECK_AND_BACKUP_CALIB
0x8012 -56 | Failed to Unstable VCC Monitor related power
read supplies that cause the
calibration Unstable VCC_NVM/VCC_OSC issue during
data (Fusion only) programming; check for
transients outside of
Unstable Microsemi
VCC_ENVM/VCC_ROSC voltage specifications. See
level (SmartFusion only) your device datasheet
for more information on
Signal integrity issues on JTAG transient specifications.
pins
Measure
JTAG voltages, noise,
and reflection.
Try reprogramming.
Workaround: Disable
optional backup
procedure
CHECK_BACKUP_CA
LIB
0x808D -57 | eNVM/EFMB | File contains no Pass Key and Provide a programming file with a Pass
0x8092 is protected [ device is secured with a Pass Key | Key that matches the Pass Key
by a Pass programmed into the device
Key; you Pass Key in the file does not
must provide [ match device
a valid Pass
Key

SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for
pre-v8.6 Software

The table below lists exit codes for SmartFusion, IGLOO, ProASIC3 and Fusion devices in pre-v8.6 software
only. This includes v8.5 SP2, v8.5 SP1, v8.5, etc. See the Device Exit Codes for Software v8.6 and Above
help topic for exit codes for older versions.

Note: Exit codes with positive integers are reserved for current and future standard EXIT codes of the STAPL
standard. Exit codes with negative integers are reserved for vendor-specific EXIT codes.
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Software

Exit Exit Message
Code

Possible Cause

Possible Solution

0 Passed (no error).

1 A physical chain
does not match the
expected set up
from the STAPL
file.

Also known as
Checking Chain

Physical chain configuration has
been altered. Something has
become disconnected in the chain.
The specific IR length of non-
Microsemi devices may be
incorrect.

The order of the specified chain

Error. may be incorrect.

5 Failed to enter Monitor VPUMP voltage
programming Unstable VPUMP voltage level. during programming
mode.

Signal integrity issues on JTAG Measure JTAG

pins. voltages, noise, and
reflection.

Older software or programming file

used. Generate STAPL file
with the latest version of
Designer/FlashPro.
Use latest version of
FlashPro software.

6 Failed to verify Measure JTAG pins,
IDCODE. Signal integrity issues on JTAG noise and reflection.

pins.

8 Failed Erase Signal integrity issues on JTAG Monitor VPUMP voltage
Operation. pins. during programming.

Measure JTAG
voltages, noise, and
reflection.

10 Failed to program
FPGA array at row

Signal integrity issues on JTAG
pins.

Monitor VPUMP voltage
during programming.

", rowNumber,"." Measure JTAG
voltages, noise, or
reflection.

10 Failed to enable Signal integrity issues on JTAG Monitor VPUMP voltage

FPGA Array. pins. during programming.

Measure JTAG
voltages, noise, or
reflection.

10 Failed to program
FlashROM.

Signal integrity issues on JTAG
pins.

Monitor VPUMP voltage
during programming.
Measure JTAG
voltages, noise, and
reflection.

Table 26 - Exit Codes for SmartFusion, IGLOO, ProASIC3 and Fusion Family Devices in pre-v8.6
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SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for pre-v8.6 Software

Exit Exit Message
Code

Possible Cause

Possible Solution

11 Verify O failed at
row",rowNumber,"."
Verify 1 failed at
row",rowNumber,"."
Failed to verify
FlashROM at
row",from
rowNumber-1.

Device is programmed with a
different design.

Signal integrity issues on JTAG
pins.

Run
VERIFY_DEVICE_INFO
to verify the device is
programmed with the
correct data/design.
Monitor VPUMP voltage
during programming.
Measure JTAG
voltages, noise and
reflection .

14 Failed to program
Silicon Signature.
Failed to program
security lock
settings.

Signal integrity issues on JTAG
pins.

Monitor VPUMP voltage
during programming.
Measure JTAG
voltages, noise, and
reflection.

-18 Failed to
authenticate the
encrypted data.

Incorrect AES key.

Signal integrity issues on JTAG
pins.

Generate a
programming file with
the correct AES key.

Measure JTAG
voltages, noise and
reflection

-20 Failed to verify
FlashROM at row
FRomRowNumber-
1.

Device is programmed with a
different design.

Signal integrity issues on JTAG
pins.

Program with the
correct data/design.

Monitor VPUMP level
during programming.
Measure JTAG pins and
noise or reflection.

-22 Failed to program
pass key.

Unstable VPUMP voltage level.

Signal integrity issues on JTAG
pins.

Monitor VPUMP voltage
during programming.

Measure JTAG
voltages, noise, and
reflection.

-23 Failed to program
AES key.

Unstable VPUMP voltage level.

Signal integrity issues on JTAG
pins.

Monitor VPUMP
voltage during
programming.

Measure JTAG pins
and noise or reflection.

-24 Failed to program
UROW.

Unstable VPUMP voltage level.

Signal integrity issues on JTAG
pins.

Monitor VPUMP voltage
during programming.

Measure JTAG
voltages, noise, and
reflection.

Make sure you mounted
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Exit Exit Message
Code

Possible Cause

Possible Solution

0.01iF and 0.33iF caps
on Vpump (close to the

pin).

-25 Failed to enter
programming mode

Signal integrity issues on JTAG
pins.

Measure JTAG
voltages, noise, and
reflection.

-26 Failed to enter
programming mode

Signal integrity issues on JTAG
pins.

Measure JTAG
voltages, noise, and
reflection.

-27 FlashROM
Write/Erase is
protected by the
passkey.

A valid passkey
needs to be
provided.

File contains no passkey and device
is secured with a passkey.

Passkey in the file does not match
device.

Provide a programming
file with a passkey that
matches the passkey
programmed into the
device.

-28 FPGA Array
Write/Erase is
protected by the
passkey.

A valid pass key
needs to be
provided.

File contains no passkey and device
is secured with a passkey.

Passkey in the file does not match
device.

Provide a programming
file with a passkey that
matches the passkey
programmed into the
device.

-29 FlashROM Read is
protected by
passkey.

A valid passkey
needs to be
provided.

File contains no passkey and device
is secured with a passkey.

Passkey in the file does not match
device.

Provide a programming
file with a pass key that
matches the passkey
programmed into the
device

-30 FPGA Array
verification is
protected by a
passkey.

A valid passkey
needs to be
provided.

File contains no passkey and device
is secured with a passkey.

Passkey in the file does not match
device.

Provide a programming
file with a passkey that
matches the passkey
programmed into the
device.

-31 Failed to verify
AES key.

AES key in the file does not match
the device.

Unstable JTAG/VPUMP voltage
level.

Provide a programming
file with an AES key that
matches the AES key
programmed into the
device.

Monitor
VPUMP/VVJITAG voltage
during programming.

Measure JTAG
voltages, noise, and
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SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for pre-v8.6 Software

Exit Exit Message Possible Cause Possible Solution
Code
reflection.
-32 Failed to verify File is not for M7, but target device | Check that the target
IDCODE. is an M7. device is M7 enabled.
Target is an M7 Make sure
device Signal integrity issues on JTAG programming file
pins. generated is for M7
enabled device.
Measure JTAG pins ,
noise, and reflection.
-32 Failed to verify File is not for M1, but target device | Check that the target
IDCODE. is an M1 device. device is M1 enabled.
Target is an M1 Make sure programming
device Signal integrity issues on JTAG file generated is for M1
pins. enabled device.
Measure JTAG pins,
noise, and reflection.
-32 Failed to verify File is not for target device. Check the target device.
IDCODE. Make sure programming
Core enabled Signal integrity issues on JTAG pins | file generated for target
device detected device.
Measure JTAG
voltages, noise, and
reflection.
-32 Failed to verify File is for M7, but target device is Check that the target
IDCODE. not M7. device is not M7
The target is not enabled.
an M7 device Signal integrity issues on JTAG Make sure programming
pins. file generated is for non
M7 enabled device.
Measure JTAG
voltages, noise, and
reflection.
-32 Failed to verify File is for M1, but target device is Check that the target
IDCODE. not an M1 device. device is not M1
The target is not an enabled.
M1 device Signal integrity issues on JTAG Make sure
pins. programming file
generated is for non M1
enabled device.
Measure JTAG
voltages, noise and
reflection.
-33 FPGA Array File contains unencrypted array Provide a programming
encryption is data, but device contains AES key. | file with an encrypted
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Exit Exit Message
Code

Possible Cause

Possible Solution

enforced. A
programming file
with encrypted
FPGA array data
needs to be
provided.

FPGA Array data.

-34 FlashROM
encryption is
enforced. A
programming file
with encrypted
FlashROM data
needs to be
provided.

File contains unencrypted
FlashROM data, but the device
contains an AES key.

Provide a programming
file with an encrypted
FlashROM data.

-35 Failed to match
pass key.

Pass key in file does not match
pass key in device.

Provide a programming
file with a pass key that
matches the pass key
programmed into the
device.

-36 FlashROM
Encryption is not
enforced.

Cannot guarantee
valid AES key
present in target
device.

Unable to proceed
with Encrypted
FlashROM
programming.

File contains encrypted FlashROM,
but device encryption is not
enforced for FlashROM

Regenerate security
programming file with
proper AES key.

Program device
security.

Retry programming
FlashROM with
encrypted programming
file.

-37 FPGA Array
Encryption is not
enforced.

Cannot guarantee
valid AES key
present in target
device.

Unable to proceed
with Encrypted
FPGA Array
verification.

File contains encrypted FPGA
Array, but the device encryption is
not enforced for FPGA Array.

Regenerate security
programming file with
proper AES key.

Program device
security.

Retry programming
FPGA Array with
encrypted programming
file.

-38 Failed to program
pass key.

Unstable VPUMP voltage level.

Signal integrity issues on JTAG
pins.
Bad device.

Monitor VPUMP voltage
during programming.

Measure JTAG pins
and noise or reflection.
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SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for pre-v8.6 Software

Exit
Code

Exit Message

Possible Cause

Possible Solution

Failed to verify
Embedded Flash
Memory Block
(EFMB).

Device is programmed with a
different design.

Signal integrity issues on JTAG
pins.

The EFMB data was modified
through user FPGA design after
programming; this could occur
during standalone verify.

The target EFMB block is locked
with FlashLock when running
ACTION
PROGRAM_NVM_ACTIVE_ARRAY
or VERIFY_NVM_ACTIVE_ARRAY.

Verify the device is
programmed with the
correct data/design.

Monitor VPUMP
voltage during
programming.

Measure JTAG pins
and noise or reflection.

Run DEVICE_INFO to
confirm if the target
EFMB block is locked
with FlashLock (pass
key). If the target EFMB
block is locked, then
you must unlock it by
erasing the security and
then reprogramming
with the desired security
settings. After unlocking
the target EFMB block
attempt to rerun the
target ACTION.

Embedded Flash
Memory Block
MAC Failure.

Data in the file is encrypted with a
different AES key than the device.

Verify the programming
file is generated from
the latest version of
Designer/FlashPro.

Error programming
Embedded Flash
Memory Block.
(EFMB)

Signal integrity issues on JTAG
pins.

Measure JTAG pins and
noise or reflection.

Failed to verify
security settings.

File security settings do not match
device.

Provide a programming
file with security setting
that match the security
settings programmed
into the device.

Failed to verify
design information.

File checksum and design name do
not match the device.

Verify the device is
programmed with the
correct data and design.

Failed to verify
AES key.

The AES key in the file does not
match the AES key in the device.
File does not contain an AES key
and the device is secured with an
AES key.

Provide a programming
file with an AES key that
matches the AES key
programmed into the
device.

Device package
does not match the
programming file.
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Exit Exit Message
Code

Possible Cause

Possible Solution

-46 Embedded Flash
Memory Block X
Read is protected
by pass key. A
valid pass key
needs to be
provided.

File contains no pass key or
incorrect pass key but EFMB read is
secured with a pass key.

Provide a programming
file with the correct pass
key.

-47 Embedded Flash
Memory Block,
block X encryption
is enforced. A
programming file
with encrypted
EFMB data needs
to be provided.

The programming EFMB data is not
encrypted, but the device contains
an AES key with encryption
enforced.

Provide a programming
file with encrypted
EFMB data.

-48 Embedded Flash
Memory Block
(EFMB) block X
Write is protected
by pass key.

A valid pass key
needs to be
provided.

File contains no pass key or
incorrect pass key, but device is
secured with a pass key.

Provide a programming
file with a passkey that
matches the passkey
programmed into the
device.

-49 Embedded Flash
Memory Block
(EFMB) block X
Encryption is not
enforced.

Cannot guarantee
valid AES key
present in target
device.

Unable to proceed
with Encrypted
EFMB
programming.

File contains encrypted EFMB for
block X, but the device encryption is
not enforced for EFMB block X.

Regenerate security
programming file with
proper AES key.

Program device
security. Retry
programming EFMB
block X with encrypted
programming file.

-51 Failed to access
Embedded Flash
Memory.
(AFS600 only)

This version of the silicon does not
support programming of the
Embedded Flash Memory Block
while the FPGA Array is active.

If programming the
EFMB while the FPGA
is active is not required,
then use actions
PROGRAM_NVM or
VERIFY_NVM.
Otherwise, use latest
revision of silicon.

-52 Failed to access
Embedded Flash

This version of the silicon does not
support programming of the

If programming the
EFMB while the FPGA
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ProASICPLUS and ProASIC Exit Codes

Exit Exit Message
Code

Possible Cause

Possible Solution

Memory.
(AFS1500 only)

Embedded Flash Memory Block
while the FPGA Array is active.

is active is not required,
then use actions
PROGRAM_NVM or
VERIFY_NVM.
Otherwise, use latest
revision of silicon.

-53 Failed to access
Embedded Flash
Memory.
(AFS1500 only)

This version of the silicon does not
support programming block 3 of the
EFMBs while the FPGA Array is
active.

If programming the
EFMB while the FPGA
is active is not required,
then use actions
PROGRAM_NVM or
VERIFY_NVM.
Otherwise, use EFMB
blocks O, 1, or 2, but do
not use block 3.

-54 Failed to access
Embedded Flash
Memory.

FPGA Array is accessing the target
EFMB block while attempting
programming.

NVM reset signal is stuck in design.

If programming the
EFMB while the FPGA
is active is not required,
then use actions
PROGRAM_NVM or
VERIFY_NVM.
Otherwise, check the
FPGA design or use a
different EFMB block
that is not being
accessed. Check if
target EFMB block logic
is tied to reset.

Verify that the NVM
reset signal in the
design is not stuck.

ProASICP"Y® and ProASIC Exit Codes

The table below lists the exit codes for ProASIC

PLUS

and ProASIC family devices.

Table 27 - ProASIC ™“® and ProASIC Family Devices Exit Codes

Exit Code

Exit Message

Possible Cause

Possible Solution

This message
means passed.
This does not
indicate an error.

A physical chain
does not match the
expected set up
from the STAPL
file.

Physical chain
configuration has been
altered. Something has
become disconnected in
the chain.
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Exit Code Exit Message Possible Cause Possible Solution
Also known as The specific IR length of
Checking Chain non-Microsemi devices
Error. may be incorrect.
The order of the
specified chain may be
incorrect.
2 There is a reading | The device either does Check the device ID.
device ID failure. not have a valid device
ID or the data cannot be
read correctly.
3 This occurs when | Connect was set up for a | Set up for a
using ProASIC™""® | ProASIC device and the | ProASIC™"® device.
devices. device is actually
ProASIC™S,
5 Programming set | The A500K device Power the VDDL
up problem. Also senses the VDDL power | down during
known as Entering | supply as being on. programming. Check
ISP Failure. the device has the
correct voltages on
VDDP, VDDL, VPP,
and VPN.
6 The IDCODE of The device targeted in Choose the correct

the target device the STAPL file does not | STAPL file and select
does not match the | match the device being the correct device.

expected value in | programmed. Measure JTAG pins
the STAPL file. User selected wrong and noise or
This is a JEDEC device. reflection. TRST
standard message. | Device TRST pin is should be floating or
grounded. tied high.
Noise or reflections on Cut down the extra
one or more of the JTAG | length of ground
pins caused by the IR connection.
Bits reading it back
incorrectly.
7 Unknown This occurs with current | Re-generate STAPL

algorithm: alg=x, STAPL files when the file from Designer 6.1
prev=x Invalid data | revision written into the SP1.

read from device factory row is not rev 1 Replace A500K ES
for ProASICPLUS or rev | parts with

2 for ProASIC devices. commercial parts.
The STAPL files from last | Double check VPP
year may "exit 7" with and VPN

newer devices or the connections.

older revision may cause | Make sure VPP and
this failure if the STAPL | VPN have correct

file used is from latest bypass caps.
version. Make sure that your
It can occur if you are power supply can
using Engineering deliver the correct

Sample parts that are no | current during
longer supported, such programming.
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ProASICPLUS and ProASIC Exit Codes

Exit Code

Exit Message

Possible Cause

Possible Solution

as ProASIC Engineering
Sample parts.

This error can also occur
if the programmer has
trouble reading the
factory row due to signal
noise, crosstalk, or
reflections on the JTAG
signal and clock lines.

It can occur if you
program an -F
ProASICPLUS device
with an old STAPL file.
This error occurs if you
connected VPP and VPN
the wrong way.

It occurs if there are no
bypass Caps on VPP
VPN, which damaged the
device.

This error may occur if
your power supply
cannot source the correct
current for programming.

FPGA failed during
the erase
operation.

The device is secured,
and the corresponding
STAPL file is not loaded.
The device has been
permanently secured and
cannot be unlocked.

Load the correct
STAPL file.

11

FPGA failed verify

The device is secured
and the corresponding
STAPL file is not loaded.
You used the Libero IDE
software v2.3 or earlier or
the Designer R1-2003
software or earlier to
generate the STAPL file.
VPN caps were soldered
in the wrong polarity.

Load the correct
STAPL file.

Use later software
versions —at least
Libero v2.3 SP1 and
Designer R1-2003
SP1.

Double-check the
VPN bypass caps
polarity.

12

Security is
enabled.

The device is secured
and the wrong
key/STAPL file was
entered.

The device is damaged.
The verification was
interrupted and therefore
fails, causing the
software to think the
device is secure.
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Exit Code Exit Message Possible Cause Possible Solution
14 Program security
failure.
15 This is a factory During program, erase,
Calibration Data or verify, you must read
CRC error. back Calibration Data
from the FPGA. The data
contains a CRC. You use
the CRC to ensure the
data is not
corrupted/wrong.
Device is damaged.
Noise on the FTAL
signals causes the
programmer to read back
wrong data.
17 The device has The device is secured Load the correct

been secured.
Write-security is

and the wrong key or
STAPL file was entered.

STAPL file.

enabled. The device is damaged.
-54 Failed to access Analog power supplies Connect the analog
Embedded Flash (Vccl5A, Vee33A, power supplies
Memory GNDAQ and GNDA) are | (Vccl5A, Vce33A,
not connected. GNDAQ and GNDA)
-80 Error code results | An internal calibration Check voltages on

from STAPL files
for A500K devices.

(based on DDP and
VPP) failed.

the device pins.
Check voltages on
the VDDP and VPP
pins.

-90 Unexpected RCK | Noise on the RCK signal. | Disconnect the RCK
detected. You connected a CLK and make sure TCK

source to the RCK signal. | has a clean signal.
The polarized bypass Separate FlashPros
capacitors on VPP or away from each other
VPN are reversed-biased | while they are
and are affecting the programming Internal
programmer’s VPP or ISP.
VPN output voltage. This | Connect programmer
causes programming to | as an Admin in
fail. Several FlashPros FlashPro.
are programming at the
same time and are too
close to each other.
Programmer not properly
installed by Admin.

-91 Calibration data Device is damaged. Replace the device.

parity error.

Null

Several FlashPros are
programming at the
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ProASICPLUS and ProASIC Exit Codes

Exit Code

Exit Message

Possible Cause

Possible Solution

same time and are too
close to each other.
FlashPro connects to PC
parallel port through a
dongle key.

Data length mismatch
when performing
DRSCAN on STAPL file.

Cable to target is
not connected

properly.

When the Analyze
command is executed,
the FlashPro looks for
target devices. If the
cable connection is
wrong, FlashPro
assumes that nothing is
connected at all.

Confirm the
connection between
the header to the
device. If the board
supplies the power to
the device, make
sure the voltage level
is correct.

Chain integrity test
failed: xx

The connection between
the FlashPro
programmer and the
device is broken.

The programmer cable
might not be securely
inserted into the header.
The header is not
connected to the JTAG
pins of the FPGA
correctly.

The configuration setting
(ProASIC/ProASICPLUS)
does not match the
target device.

Noise or reflections on
the JTAG pins has
caused communication
between the programmer
and the device to fail.

A dongle is plugged in
between the PC parallel
port and the FlashPro
parallel port cable.

Secure the
connections.

Check the JTAG pins
for signal activity.
Check for broken
TDO, TMS, and TCK
pins.

After checking all
type of connections if
the failure exists, you
may need to replace
the first device (the
devices closest to the
TDO of the
programming header)
in the chain.

Remove the dongle.

Could not connect
to programmer on
port Ip1 or parallel
port device does
not support IEEE-
1284 negotiation
protocol

The remote device does
not respond to the
negotiation protocol, for a
variety of reasons.

Make sure the port is
connected.

Make sure the
connected device is a
FlashPro/Lite
programmer.

Turn the programmer
on.

Check parallel port
setting in BIOS.
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Exit Code Exit Message Possible Cause Possible Solution

Make sure that there
are no dongles in
between the parallel
port and the FlashPro
connection.

Try another parallel
cable, the parallel
cable might be
defective.

Check to see if the
programmer is
damaged.

Make sure the
FlashPro Lite has
power. The FlashPro
Lite is powered from
the target board
through the Vdd pin
of the programming
header.

Make sure the Vvdd
pin is connected and
the target board is
powered up.

Secure the
connection between
the cable connector
and the programming
header.

Before you program
any devices, you
should run the self-
diagnostic test. The
diagnostic software
can be found on the
Microsemi web site. If
the test fails, please
contact Microsemi
Customer Technical
Support at
tech@Microsemi.com
for credit and
replacement.

Note: The Self-test is
only available for
FlashPro, not
FlashPro Lite.

External voltage The voltage supply for Set appropriate
detected on the FPGA is driven by options in the
<Supply> another source (board, Connect menu.
external power-supply),
but the user forgot to turn
off the supply in the
Connect menu.
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ProASICPLUS and ProASIC Exit Codes

Exit Code

Exit Message

Possible Cause

Possible Solution

VDPP
Disconnected.

There is no Vddp voltage
supply to the FPGA.

You accidentally turned
off the Vddp supply in the
Connect menu.

The Vddp supply on the
board is not functioning.

Check the Vddp
supply on the board
for appropriate
voltages and correct
the Connect menu.

More than one unidentified device.

If you want to
perform an
operation on the
ProASIC device,
the rest of the
devices in the
chain must be in
bypass mode.

To put devices in
bypass mode,
select
Configuration >
Chain Parameter
(or click the Chain
Parameter button
in the Single
STAPL
Configuration
window), then set
the Pre IR, Pre DR,
Post IR or Post
DR.

STAPL settings of Pre
IR, Pre DR, Post IR, and
Post DR do not match
the chain configuration.
One or more of the
devices in the chain is
damaged and the ID
CODE cannot be read
back.

Make sure you have
set Pre IR, Pre DR,
Post IR, and Post DR
to match the chain
configuration. If you
are still experiencing
the failure, it is likely
that the device's ID
CODE cannot be
read and you need to
replace the device.

Cannot find the
programmer with
ID xxx

The programmer is
removed from the PC.

Delete programmer
(or reconnect
programmer) and
select the Refresh
Programmer button.
See Connecting
Programmers for
more information.

Fatal Error: Please
check programmer
set up.

Software cannot resolve
the error encountered in
the programmer.

Save the project file,
restart the software,
and power cycle the
programmer.

External voltage
Xxx mV is detected
on XXxX.

You have specified the
programmer to drive the
XXX but external xxx is
detected.

Deselect the xxx in
the programmer
setting.

Executing action
xxx failed.

The STAPL runtime
failed.
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Exit Code

Exit Message

Possible Cause

Possible Solution

Executing action
xxx with serial
index/action xx
failed.

The STAPL runtime
failed.

No Vpump voltage
source is detected.

Select the Vpump in
the Programmer
setting. Make sure
the external Vpump

is properly turned on.

Vpump short

Use a different

detected. programmer. If the
problem persists,
check the board
layout.

xxx Mhz TCK Check FlashPro Lite

frequency in this
STAPL file is not
supported by the
FlashPro Lite
detected. It
supports only 4
MHz TCK
frequency.

version being used.
Use FlashPro Lite
Rev C or modify the

STAPL file to 4 MHz.

xxx Mhz TCK
frequency in this
STAPL file is not
supported by the
FlashPro Lite
RevC detected. It
supports only 1, 2
or 4 Mhz TCK
frequency.

Modify STAPL file to
1, 2, or 4 MHz.

Cannot find the
serial Index/Action
xxx in STAPL file.

Mismatch between
STAPL file and the
Index/Action selection.

Make sure the
STAPL file was not

overwritten. Save the

project with updated
serial/action
selection.

Duplicated serial
Index/Action xxx
was removed.

Mismatch between
STAPL file and the
Index/Action selection.

Make sure the
STAPL file was not

overwritten. Save the

project with updated
serial/action
selection.

Using local backup
COpY XXX

Cannot find original copy.

Check for available
space on the disk.
Check that write
permissions are
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ProASICPLUS and ProASIC Exit Codes

Exit Code

Exit Message

Possible Cause

Possible Solution

enabled.

FlashPro cannot
rename the
programmer/device
with an existing
name.

Name is already in use.

Create a new name.

FlashPro cannot
rename the
programmer/device
with an invalid
character.

Invalid character used in
programmer/device
name.

Do not use invalid
characters.

Automatic check
for updates.

FlashPro can check
the Microsemi
website to find if an
updated version of
the software is
available. If you
would like to have
FlashPro
automatically check
for software updates,
choose Preferences
from the File menu.
From the Updates
tab, you can choose
your automatic
software update
settings. You can
also select Software
Updates from the
Help menu for
updates to the
FlashPro software.

FlashPro parse
error.

FlashPro software failed
to parse the file.

FlashPro does not
support STAPL
files for xxx.

STAPL file not allowed.

Use a STAPL file for
your device that is
supported by
FlashPro.
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Electrical Parameters

DC Characteristics for FlashPro5/4/3/3X

Note: The target board must provide the VCC, VCCI, VPUMP, and VJTAG during programming. However, if
there is only one ProASIC3 device on the target board, the FlashPro5/4/3/3X can provide the VPUMP power
supply via the USB port.

The VJTAG signal is driven from the target/DUT board. The VJTAG pin is sensed by the FP4 to configure the
internal input and output buffers to the same 10 Voltage levels. The VITAG pin is only an input pin to the
programmer.

Table 28 - DC Characteristic for FlashPro5/4/3/3X

Description Symbol Min Max Unit
Input low voltage, TDO VIL -0.5 0.35*VJTAG |V
Input high voltage, TDO VIH 0.65*VJTAG | 3.6 \%
Input current, TDO lIL, IIH | -20 +20 mA
Input capacitance, TDO 40 pF
Output voltage, VPUMP, VPP +3.0 +3.6 \Y
operating
Output current, VPUMP IPP 250 mA
VJITAG = 1.5V
Output low voltage, TCK, TMS, |VOL 0.0 0.2 \%
TDI, 100uA load
Output low voltage, TCK, TMS, | VOL 0.0 0.30*VJTAG |V
TDI, 4mA load
Output high voltage, TCK, TMS, |V VJIJTAG-0.2 [VJITAG \Y
TDI, 100uA load
Output high voltage, TCK, TMS, | VOH 0.70*VJITAG | VITAG \%
TDI, 4mA load
Output current, TCK, TMS, TDI | IOL, -4 +4 mA

IOH

VJITAG = 1.8V
Output low voltage, TCK, TMS, | VOL 0.0 0.2 \Y
TDI, 100pA load
Output low voltage, TCK, TMS, | VOL 0.0 0.3 \%
TDI, 6mA load
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DC Characteristics for FlashPro Lite

Description Symbol Min Max Unit

Output high voltage, TCK, TMS, | VOH VITAG-0.2 | VIJTAG \Y

TDI, 100pA load

Output high voltage, TCK, TMS, | VOH 1.25 VITAG \%

TDI, 6mA load

Output current, TCK, TMS, TDI | IOL, -6 +6 mA
IOH

VITAG = 2.5V

Output low voltage, TCK, TMS, | VOL 0.0 0.2 \%

TDI, 100pA load

Output low voltage, TCK, TMS, | VOL 0.0 0.6 \Y

TDI, 8mA load

Output high voltage, TCK, TMS, | VOH VJIJTAG-0.2 | VJITAG \%

TDI, 100pA load

Output high voltage, TCK, TMS, | VOH 1.8 VITAG \Y

TDI, 8mA load

Output current, TCK, TMS, TDI | IOL, -8 +8 mA
IOH

VITAG = 3.3V

Output low voltage, TCK, TMS, | VOL 0.0 0.2 \%

TDI, 100uA load

Output low voltage, TCK, TMS, | VOL 0.6 \%

TDI, 8mA load

Output high voltage, TCK, TMS, | VOH VITAG-0.2 | VIJTAG \Y

TDI, 100uA load

Output high voltage, TCK, TMS, | VOH 2.4 VITAG \%

TDI, 8mA load

Output current, TCK, TMS, TDI | IOL, -8 +8 mA
IOH

DC Characteristics for FlashPro Lite

Table 29 - DC Characteristic for FlashPro Lite

Description Symbol Min Max | Unit
Input low voltage, TDO VIL -0.5 0.7 \%
Input high voltage, TDO VIH 1.7 5.0 \%
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Description Symbol Min Max | Unit
Input current, TDO 1L, 1IH -10 +10 UA
Input capacitance, TDO 40 pF
Input voltage, VDD, operating (see note) +2.3 [+3.5 \%
Input voltage, VDD, power off -1.0 +1.0 \%
Input current, VDD VDD 500 mA
Output voltage, VPP, operating VPP +15.9 | +16.5 |V
Output voltage, VPN, operating VPN -13.8 | -134 | V
Output current, IPP IPP 0 35 mA
Output current, IPN IPN 0 -15 mA
Output low voltage, TCK, TMS, TDI, 100uA load VOL 0.0 0.2 \%
Output low voltage, TCK, TMS, TDI, 1mA load VOL 0.0 0.5 \Y
Output low voltage, TCK, TMS, TDI, 2mA load VOL 0.0 0.8 \Y
Output high voltage, TCK, TMS, TDI, 100uA load VOH 2.1 25 \%
Output high voltage, TCK, TMS, TDI, 1mA load VOH 1.9 2.5 \Y
Output high voltage, TCK, TMS, TDI, 2mA load VOH 1.6 2.5 \Y
Output current, TCK, TMS, TDI, nTRST IOL, IOH | -2 +2 mA

Note: Up to 3.5 V can be supplied to the FlashPro Lite on the VDD pin. However, if the VDD supply for the
FlashPro is also connected to the APA VDD supply, the voltage for the VDD pin cannot exceed 2.7 V.

DC Characteristics for FlashPro

Table 30 - DC Characteristic for FlashPro

Description Symbol Min Max Unit
Input low voltage, TDO VIL -0.5 0.30* \%
VDDP
Input high voltage, TDO VIH 0.70 * 55 \%
VDDP
Input current, TDO IIL, 1IH -10 +10 UA
Input voltage, VDDP, VDDL 0 5.25 \Y
Input voltage, VPP 0 21.0 \%
Input voltage, VPN -21.0 \%

230

FlashPro User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error

when clicked. View the online help included with software to enable all linked content.

Description Symbol Min Max Unit
Input current, VDDP, VDDL, VPN, VP IVCC 5.0 mA
Output voltage range, VDDP VDDP 15 3.3 \%
Output voltage range, VPP VPP 15.0 18.0 \%
Output voltage range, VPN VPN -16.0 -12.0 \%
Output voltage resolution / Acccuracy 100/450 |mV
Output current, IDDP IDDP -135" +135 mA
Output current, IDDL IDDL -135t +135 mA
Output current, IPP IPP -2701% +270 mA
Output current, IPN IPN -270 +270" mA
Output low voltage, TCK, TMS, TDI, OUTO, | VOL 0.0 0.4 \%
NTRST
Output high voltage, TCK, TMS, TDI, OUTO, | VOH 0.85* +0.3 \Y
NTRST VDDP VDDP
Output current, TCK, TMS, TDI, OUTO, 0L, -12 +12 mA
NTRST IOH

Note (1): When power supply mode is set to ABI_GROUND.

* - If you want to power-up the device from the board power supply, clear the checkboxes for VDDL and VDDP.
VPP and VPN are required during programming only and are supplied by the FlashPro programmer.

(2) Microsemi does not have operating temperature information for the FlashPro programmer. FlashPro is
intended to be used as lab or production equipment and not tested at extreme temperatures. All devices in the
unit are commercial temp. FlashPro4 went through a burn-in cycle operating at 100C for 250 hours during quality
testing. This involved repeatedly powering the programmers and then programming after the burn in; they are not
actively programming during the burn in.

& Microsemi

DC Characteristics for FlashPro
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Electrical Specifications

FlashPro5

The FlashPro5 is a JTAG and a SPI based programmer for flash based Microsemi devices.

The FlashPro5 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector
on the FlashPro5 unit is a 2x5, RA male Header connector, which is manufactured by AMP and has a
manufacturer’s part number of 103310-1. This is a standard 2x5, 0.1 pitch connector which is keyed. Use
the 10 pin right-angle header, AMP P/N 103310-1 (DigiKey P/N A26285-ND) for FlashPro4 and use the 10
pin straight header, AMP P/N 103308-1 (DigiKey P/N A26267-ND) for the straight version.

The signals on the pins of the FlashPro5 10-pin connector are shown in the figure below.

- TCK/SCK | 1 7 lgND  -—
——=TOQ 500 | 3 4 |PROG_MODE ———
-I—T.\-'IS'SS#[ 5 6 |lVITAG =———
- Voume |7 8 |nTRST ——
OIS0 |9 10 |GND  -—

Figure 152 - FlashPro5 10-Pin Connector

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The table below shows a description of the signals.
Table 31 - FlashPro5 Signal Description

Signal Description
VPUMP 3.3V Programming voltage
GND Signal reference
TCK/SCK JTAG clock; SPI clock
TDI/SDI JTAG data input to device; SPI MOSI

TDO/SDO JTAG data output from device; SPI MOSI

TMS/SS# JTAG mode select; SPI Chip Select
NTRST Programmable output pin may be set to off, toggle, low, or high level
VITAG Reference voltage from the target board

PROG_MODE | IGLOO v2 family - Used for switching from VCC 1.2V to 1.5V during
programming

232 FlashPro User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content. . .
p & Microsemi

FlashPro4

Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied
to ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset
state by default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even
will not suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-
down resistor on TRST on your board, then enabling the “Drive TRST” flag will be required to force the
JTAG state-machine out of reset to permit programming to take place. With most boards, there is no need to
select this flag.

FlashPro4

The FlashPro4 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector
on the FlashPro4 unit is a 2x5, RA male Header connector, which is manufactured by AMP and has a
manufacturer’s part number of 103310-1. This is a standard 2x5, 0.1 pitch connector which is keyed. Use
the 10 pin right-angle header, AMP P/N 103310-1 (DigiKey P/N A26285-ND) for FlashPro4 and use the 10
pin straight header, AMP P/N 103308-1 (DigiKey P/N A26267-ND) for the straight version..

The signals on the pins of the FlashPro4 10-pin connector are shown in the figure below (extracted from
FlashPro4 product specification):

-~ TCK|1 2 |GND ~—
— TD0O |32 4 |PROG_MODE ——
 — TMS|:5 6 |VITAG =—
— Voume |7 g8 |nTRST —=
-« TDI|9 10 |GND —8m

Figure 153 - FlashPro4 10-Pin Connector

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The table below shows a description of the signals.
Table 32 - FlashPro4 Signal Description

Signal Description
VPUMP 3.3V Programming voltage
GND Signal reference
TCK JTAG clock
TDI JTAG data input to device
TDO JTAG data output from device
T™MS JTAG mode select
NnTRST Programmable output pin may be set to off, toggle, low, or high level
VITAG Reference voltage from the target board
PROG_MODE | IGLOO v2.family - Used for switching from VCC 1.2V to 1.5V during
programming
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Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied
to ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset
state by default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even
will not suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-
down resistor on TRST on your board, then enabling the “Drive TRST” flag will be required to force the
JTAG state-machine out of reset to permit programming to take place. With most boards, there is no need to
select this flag.

FlashPro3

The FlashPro3 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector
on the FlashPro3 unit is a 2x5, RA male Header connector, which is manufactured by AMP and has a
manufacturer’s part number of 103310-1. This is a standard 2x5, 0.1 pitch connector which is keyed. Use
the 10 pin right-angle header, AMP P/N 103310-1 (DigiKey P/N A26285-ND) for FlashPro5/4/3/3X and use
the 10 pin straight header, AMP P/N 103308-1 (DigiKey P/N A26267-ND) for the straight version.

The signals on the pins of the FlashPro3 10-pin connector are shown in the figure below (extracted from
FlashPro3 product specification):

-~ TCK|1 2 |GND  ~——
—  TD0|3 4 |N/C

*—TMSEE 6 |VITAG =—
I T 8 |nTRST ——
- TDI|9 10 |GND —8m

Figure 154 - FlashPro3 10-Pin Connector

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer itself.
Arrows show current flow towards or from the rectangular programmer.

The table below shows a description of the signals.
Table 33 - FlashPro3 Signal Description

Signal Description
VPUMP | 3.3V Programming voltage
GND Signal reference
TCK JTAG clock
TDI JTAG data input to device
TDO JTAG data output from device
T™MS JTAG mode select
nTRST | Programmable output pin may be set to off, toggle, low, or high level
VJIJTAG [ Reference voltage from the target board
N/C Programmer does not connect to this pin
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FlashPro Lite

Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied
to ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset
state by default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even
will not suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-
down resistor on TRST on your board, then enabling the “Drive TRST” flag will be required to force the

JTAG state-machine out of reset to permit programming to take place. With most boards, there is no need to
select this flag.

FlashPro Lite

For FlashPro Lite, the existing 26-pin connector is shown in the figure below.

N/C|1 2 |IN/C

N/C|3 4 IN/C
N/C|5 6 |Ver R
-~ GND|7 8 |Ven —
-— GNDl9g 10 |[SENSE -—
-— GND| 11 12 |TCK —
N/C| 13 14 [TDI —
N/C L15 16 |TDO -
-— GNDI17 18 |TMS B
-— GND[19 20 |OUTO/RCK ——
N/C |21 22 InTRST —
N/C |23 24 Voo S —
N/C |25 26 1Vop —

Figure 155 - 26-pin Connector for FlashPro Lite

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer itself.
Arrows show current flow towards or from the rectangular programmer.

The appropriate SAMTEC micro connector target cable for this is:
Samtec FFSD-13-D-12.00-01-N.

The 12 inch cable is specified. This is likely to be more than enough to connect to the board and reducing
the inductance will help compared with 18 inches, which is supplied by the default with FlashPro Lite.

See the table below for a description of the signals.
Table 34 - FlashPro Lite Signal Description

Signal Description
VDDP VDD supply for logic I/O pads
VDDL VDD supply for core
VPP Positive programming supply (+16.5V)
VPN Negative programming supply(-13.8V)
GND Signal reference
SENSE Input from target board to programmer to indicate connection to ground
TCK JTAG clock
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Signal Description

TDI JTAG data input to device

TDO JTAG data output from device

TMS JTAG mode select

NTRST Programmable output pin may be set to off, toggle, low, or high level

RCK/OUTO | Programmable output pin may be set to off, toggle, low, or high level

N/C Programmer does not connect to this pin

Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied
to ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset
state by default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even
will not suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-
down resistor on TRST on your board, then enabling the "Drive TRST" flag will be required to force the
JTAG state-machine out of reset to permit programming to take place. With most boards, there is no need to
select this flag.

FlashPro

For FlashPro, you can use the same 26-pin target cable you used for FlashPro Lite, but the connections are
shown in the figure below.

-—  2.5\/3.3V|1 2 |Vooe S
-— 2.5V/3.3V]|3 4 Voor -
-~  2.5V/3.3V|5 6 |Vee —_—
- GND|7 8 [Ven —
- GND]g 10 |SENSE -—
- GND| 11 12 |TCK -

N/C| 13 14 | TDI -

N/CL.15 16 |TDO I
-~ GND17 18 |TMS -
- GND |19 20 |RCK/OUTO —*
— 2.5V |21 22 InTRST -
-— 2.5V |23 24 [Voou —
- 2.5V |25 26 | VbooL —

Figure 156 - 26-pin connections for FlashPro

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer itself.
Arrows show current flow towards or from the rectangular programmer.

The table below shows the signal pin descriptions for FlashPro.
Table 35 - FlashPro Signal Description

Signal Description

VDDP VDD supply for logic I/O pads

VDDL VDD supply for core
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Signal Description
VPP Positive programming supply (+16.5 V)
VPN Negative programming supply (-13.8 V)
GND Signal reference
SENSE Input from target board to programmer to indicate connection to
ground
TCK JTAG clock
TDI JTAG data input to device
TDO JTAG data output from device
T™MS JTAG mode select
NnTRST Programmable output pin may be set to off, toggle, low, or high
level
RCK/OUTO Programmable output pin may be set to off, toggle, low, or high
level
2.5V, 2.5V/3.3V, Programmer does not connect to these pins
N/C

& Microsemi
FlashPro 5/4/3/3X Characteristics

Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied
to ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset
state by default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even
will not suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-
down resistor on TRST on your board, then enabling the "Drive TRST" flag will be required to force the
JTAG state-machine out of reset to permit programming to take place. With most boards, there is no need to

select this flag.

FlashPro 5/4/3/3X Characteristics

Table 36 - JTAG Switching Characteristics for FlashPro5/4/3/3X

Description Symbol Min | Max | Unit
Output delay from TCK to TDI, TMS TTCKTDI -2 2 ns
TDO setup time before TCK rising, VJITAG=3.3 TTDOTCK |12 ns
TDO setup time before TCK rising, VJITAG=1.5 TTDOTCK |14.5 ns
TDO hold time after TCK rising TTCKTDO |0 ns
TCK period TTCK 41.7 | 10667 |ns
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FlashPro and FlashPro Lite Characteristics

The table below shows the JTAG switching characteristics for FlashPro and FlashPro Lite measured at the
programmer end of the JTAG cable.

Table 37 - JTAG Switching Characteristics for FlashPro and FlashPro Lite

Description Symbol Min [ Max [ Unit
Output delay from TCK falling to TDI, | TTCKTDI 2 |2 ns
T™MS
TDO setup time before TCK rising TTDOTCK 5.0 ns
TDO hold time after TCK rising TTCKTDO | 0 ns
TCK period TTCK 40 (10240 |ns

lllustration of the JTAG Switching Characteristics

The figure below is an illustration of the JTAG switching characteristics.

X

TCK

TMS, TDI

N/
- [Tk B

Trexto —m=

TTDSTCHAP‘

TrckToo—m
Figure 157 - JTAG Switching Characteristics

Device Debug

Device Debug / SmartDebug enables you to use JTAG to interrogate and view embedded silicon features

and device status (FlashROM, Security Settings, Embedded Flash Memory (NVM) and Analog System).

It provides tools to help troubleshoot some of the common issues related to the Embedded Flash Memory

and Analog System.

Device Debug supports IGLOO, ProASIC3, SmartFusion and Fusion devices. SmartDebug supports

SmartFusion2 and ProASIC3 devices.

The user support is separated into two sections:

e Using Device Debug to Find Solutions to Common Issues - Contains common issues and

troubleshooting instructions that will enable you to solve your problems as quickly as possible.

e Frequently Asked Questions - Answers to the most frequently asked questions about the tools and
silicon features related to your solution.
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Getting Started with Device Debug

If you are unfamiliar with Device Debug, you may find it helpful to review the Getting Started with Device
Debug topic. You can view descriptions of the Device Debug interface in the Reference section of the help.

Getting Started with Device Debug
This topic introduces the basic elements and features of Device Debug. If you are already familiar with the
user interface then proceed to Solutions to Common Problems or Frequently Asked Questions sections.

Device Debug (SmartDebug for some families) enables you to use JTAG to interrogate and view embedded
silicon features and device status (FlashROM, Security Settings, Embedded Flash Memory (NVM) and
Analog System). Device Debug is available as a part of the FlashPro programming tool.

See the Using Device Debug topic for an overview of the use flow.
You can use the debugger to:

e Get device status and view diagnostics

o Use the FlashROM debug GUI to read out and compare content

e Use the Embedded Flash Memory Debug GUI to read out and compare your content with your original
files

e Use the Analog System Debug to read out and compare your analog block configuration with your
original file

Using Device Debug

The most common flow for Device Debug is:

1. Start FlashPro. If necessary, create a new project.

2. Set up your FlashPro Project with or without a PDB file. If you are in single-device mode you will need
a PDB file. You can create a PDB file in both Single Device and Chain mode.

With a PDB, you will get additional information such as FlashROM and Embedded Flash Memory
partitions when debugging the silicon features. Best practice is to use a PDB with a valid-use design to
start a debug session.

Select the target device from your chain and click Inspect Device.
Click Device Status to get device status and check for issues

5. Examine individual silicon features (FlashROM, Embedded Flash Memory Block and Analog System)
on the device.
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Solutions to Common Issues Using Device
Debug

Embedded Flash Memory (NVM) - Failure when
Programming/Verifying
If the Embedded Flash Memory failed verification when executing the PROGRAM_NVM, VERIFY_NVM or

PROGRAM_NVM_ACTIVE_ARRAY action, the failing page may be corrupted. To confirm and address this
issue:

1. Inthe Inspect Device window click View Flash Memory Content.

2. Select the Flash Memory block and client (or page range) to retrieve from the device.
3. Click Read from Device; the retrieved data appears in the lower part of the window.
4. Click View Detailed Status to check the NVM Status.

Note: You can use the check_flash_memory and read_flash_memory Tcl commands to perform
diagnostics similar to the commands outlined above.

5. Ifthe NVM is corrupted you must reset the affected NVM pages.

To reset the affected NVM pages, either re-program the pages with your original data or ‘zero-out’ the
pages by using the Tcl command recover_flash_memory.

If the Embedded Flash Memory failed verification when executing a VERIFY_NVM or
VERIFY_NVM_ACTIVE_ARRAY action, the failure may be due to the change of content in your design. To
confirm this, repeat steps 1-3 above.

NOTE: NVM corruption is still possible when writing from user design. Check NVM status for confirmation.

Analog System Not Working as Expected

If the Analog System is not working correctly, it may be due the following:
1. System supply issue. To troubleshoot:

e Physically verify that all the supplies are properly connected to the device and they are at the proper
level. Then confirm by running the Device Status.

e Physically verify that the relevant channels are correctly connected to the device.
2. Analog system is not properly configured. You can confirm this by examining the Analog System.

ADC Not Sampling the Correct Value

If the ADC is sampling all zero values then the wrong analog pin may be connected to the system, or the
analog pin is disconnected. If that is not the case and the ADC is not sampling the correct value, it may be
due to the following:

1. System supply issues - Run the device status to confirm.

2. Analog system is not configured at all - To confirm, read out the ACM configuration and verify if the
ACM content is all zero.

3. Analog system is not configured correctly - To confirm, read out the ACM configuration and verify that
the configuration is as expected .

Once analog block configuration has been confirmed, you can use the sample_analog_channel Tcl
command for debug sampling of the analog channel with user-supplied sampling parameters.
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ADC Not Sampling the Correct Value

If you have access to your Analog System Builder settings project (<Libero IDE
project>/Smartgen/AnalogBlock), you may use the compare function provided by the tool.
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Frequently Asked Questions

How do |

How do |

How do |

unlock the device security so | can debug?

You must provide the PDB file with a User Pass Key in order to unlock the device and continue debugging.

If you do not have a PDB with User Pass Key, you can create a PDB file in FlashPro (if you know the Pass
Key value).

export a report?

You can export three reports from the Device Debug GUI: Device Status, Client Detailed Status from the
NVM, or the Compare Client Content report from the NVM. Each of those reports can be saved and printed.
If using a Tcl command, you can use the —File <filename> option for the following commands:
read_flash_memory

check flash_memory

compare_memory client

read_device_status

read_flashrom
read_analog_block config
sample_analog_channel
compare_flashrom_client
compare_analog_config

For example, you can use the following command to export the content of the client 'datastorel’ in NVM
block 0 to the report file datastorel_content.txt:
read_flash_memory —client “datastorel” —file {C:\temp\datastorel_content.txt}

generate diagnostic reports for my target device?

A set of diagnostic reports can be generated for your target device depending on which silicon feature you
are debugging. A set of Tcl commands are available to export those reports. The following is a summary of
those Tcl commands based on the silicon features.

When using the —file parameter, ensure that you use a different file nhame for each command so you do not
overwrite the report content. If you do not specify the —file option in the Tcl, the output results will be directed
to the FlashPro log window.

For the overall device:

read device status

read_id_code

For FlashROM:

compare_flashrom_client
read_flashrom

For Embedded Flash Memory (NVM):

compare_memory client
check flash_memory
read_flash_memory

For Analog Block:

read_analog block config
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Where can | find files to compare my contents/settings?

compare_analog_config
sample_analog_channel

To execute the Tcl command, from the File menu choose Run Script.

Where can | find files to compare my contents/settings?

FlashROM

You can compare the FlashROM content in the device with the data in the PDB file. You can find the PDB in
the <Libero IDE project>/Designer/Impl directory.

Embedded Flash Memory (NVM)

You can compare the Embedded Flash Memory content in the device with the data in the PDB file. You can
find the PDB in the <Libero IDE project>/Designer/Impl directory.

Analog System

You can compare the Analog System configuration in the device with the data in the loaded PDB file or in
the Analog System folder. Go to:

e Fusion devices - <Libero IDE project>/Smartgen/AnalogBlock
¢ SmartFusion devices - <Libero IDE Project>/component/<SmartDesign Project>/MSS_ACE_0
The tool automatically identifies the necessary files in the selected folder for comparison.

What is a UFC file? What is an EFC file?

UFC is the User FlashROM Configuration file, generated by the FlashROM configurator; it contains the
partition information set by the user. It also contains the user-selected data for region types with static data.

However, for AUTO_INC and READ_FROM_FILE, regions the UFC file contains only:
e Start value, end value, and step size for AUTO_INC regions, and
e File directory for READ_FROM_FILE regions

EFC is the Embedded Flash Configuration file, generated by the Flash Memory Builder in the Project
Manager Catalog; it contains the partition information and data set by the user.

Both UFC and EFC information is embedded in the PDB when you generate the PDB file.

Is my FPGA fabric enabled?

When your FPGA fabric is programmed, you will see the following statement under Device State in the
Device Status report:

FPGA Array Status: Programmed and Enabled
If the FPGA fabric is not programmed, the Device State shows:
FPGA Array Status: Not Enabled
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Embedded Flash Memory (NVM) Frequently
Asked Questions

Is my Embedded Flash Memory (NVM) programmed?

To figure out if your NVM is programmed, read out and view the NVM content or perform verification with the
PDB file.

To examine the NVM content, see the FlashROM Memory Content Dialog Box.
To verify the NVM with the PDB select the VERIFY or VERIFY_NVM action in FlashPro.

How do | display Embedded Flash Memory (NVM) content in the

Client partition?
You must load your PDB into your FlashPro project in order to view the Embedded Flash Memory content in
the Client partition. To view NVM content in the client partition:

Load your PDB into your FlashPro project.

Click Inspect Device.

Click View Flash Memory Content.

Choose a block from the drop-down menu.

Select a client.

Click Read from Device. The Embedded Flash Memory content from the device appears in the Flash
Memory dialog box.

S i

See the Flash Memory Dialog Box topic for more description on viewing the NVM content.

How do | know if | have Embedded Flash Memory (NVM)
corruption?

When Embedded Flash Memory is corrupted, checking Embedded Flash Memory may return with any or all
of the following page status:

e ECCI1/ECC2 failure
e Page write count exceeds the 10-year retention threshold

e Page write count is invalid
e Page protection is set illegally (set when it should not be)
See the How do | interpret data in the Flash Memory (NVM) Status Report? topic for details.

If your Embedded Flash Memory is corrupted, you can recover by reprogramming with original design data.
Alternatively, you can ‘zero-out’ the pages by using the Tcl command recover_flash_memory.

Why does Embedded Flash Memory (NVM) corruption happen?

Embedded Flash Memory corruption occurs when Embedded Flash Memory programming is interrupted due
to:

e Supply brownout; monitor power supplies for brownout conditions. For SmartFusion monitor the
VCC_ENVM/VCC_ROSC voltage levels; for Fusion, monitor VCC_NVM/VCC_OSC.

e Reset signal is not properly tied off in your design. Check the Embedded Memory reset signal.
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How do | recover from Embedded Flash Memory corruption?

How do | recover from Embedded Flash Memory corruption?

Reprogram with original design data or ‘zero-out’ the pages by using the Tcl command
recover_flash_memory.

What is a JTAG IR-Capture value?

JTAG IR-Capture value contains private and public device status values. The public status value in the value
read is ISC_DONE, which indicates if the FPGA Array is programmed and enabled.

The ISC_DONE signal is implemented as part of IEEE 1532 specification.

What does the ECC1/ECC2 error mean?

ECC is the Error Correction Code embedded in each Flash Memory page.
ECC1 - One bit error and correctable.
ECC2 — Two or more errors found, and not correctable.

How can | tell if my FlashROM is programmed?

To verify that your FlashROM is programmed, read out and view the FlashROM content or perform
verification with the PDB file by selecting the VERIFY or VERIFY _FROM action in FlashPro.

Can | compare serialization data?

To compare the serialization data, you can read out the FlashROM content and visually check data in the
serialization region. Note that a serialization region can be an AUTO_INC or READ_FROM_FILE region.
For serialization data in the AUTO_INC region, check to make sure that the data is within the specified
range for that region.

For READ_FROM_FILE region, you can search for a match in the source data file.

Can | tell what security options are programmed in my device?

To determine the programmed security settings, run the Device Status option from the Inspect Device dialog
and examine the Security Section in the report.

This section lists the security status of the FlashROM, FPGA Array and Flash Memory blocks.

Is my analog system configured?

To determine if the analog block is configured, run the Device Status option from the Inspect Device dialog
and examine the Analog Block Section in the report. For example, the excerpt from the Device Status report
below shows that the analog block status is operational:

Analog Block:
OABTR Register (HEX): 0dbe37b
3.3V (vdd33): PASS
1.5V (vdd15): PASS
Bandgap: PASS
-3.3V (vddn33): PASS
ADC Reference: PASS
FPGA_Good: PASS
Status: Analog Block is operational

If you read out an all zero value when examining the Analog System Configuration, then it is possible that
the Analog System is not configured.
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You need to compare your analog system configuration with the design configuration from the Analog
System Builder

The -3.3V (vddn33) voltage is optional.

How do | interpret data in the Device Status report?

The Device Status Report generated from the FlashPro Device Debug Feature contains the following
sections:

e IDCode (see below)

e User Information

e Device State

e Analog Block (SmartFusion and Fusion only)
e Factory Data

e Security Settings

IDCode
The IDCode section shows the raw IDCode read from the device. For example, in the Device Status report
for an AFS600 device, you will find the following statement:
IDCode (HEX): 233261cf
The IDCode is compliant to IEEE 1149.1. The following table lists the IDCode bit assignments:
Table 38 - IDCode Bit Assignments
Bit Field (little Example Bit Value for Description
endian) AFS600 (HEX)
Bit [31-28] (4 bits) |2 Silicon Revision
Bit [27-12] (16 3326 Device ID
bits)
Bit [11-0] (12 bits) | 1cf IEEE 1149.1 Manufacturer ID for
Microsemi

Device Status Report: User Info

The User Information section reports the information read from the User ROW (UROW) of IGLOO,
ProASIC3, SmartFusion and Fusion devices. The User Row includes user design information as well as
troubleshooting information, including:

e Design name (10 characters max)

e Design check sum (16-bit CRC)

e Last programming setup used to program/erase any of the silicon features.

e FPGA Array / Fabric programming cycle count

For example:

User Information:

UROW data (HEX): 603a04e0alc2860e59384af926fe389f
Programming Method: STAPL

Programmer: FlashPro3

Programmer Software: FlashPro vX.X

Design Name: ABCBASICTO

Design Check Sum: 603A
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Algorithm Version: 19
Array Prog. Cycle Count: 19

Table 39 - Device Status Report User Info Description

Category

Field

Description

User Row Data

(Example)
UROW data (HEX):
603a04e0a1c2860e59384af926fe389f

Raw data from User Row
(UROW)

Programming
Troubleshooting

(Example)
Programming Method: STAPL

Known programming setup
used. This includes:

Design Name: ABCASICTO
Design Check Sum: 603A

Info Programmer: FlashPro3 Programming method/file,
Programmer Software: FlashPro v8.6 | programmer and software. It
Algorithm Version: 19 also includes programming
Algorithm version used.
Design Info (Example) Design name (limited to 10

characters) and check sum.

Design check sumis a 16-
bit CRC calculated from the
fabric (FPGA Array)
datastream generated for
programming. If encrypted
datastream is generated
selected, the encrypted
datastream is used for
calculating the check sum.

Device Status Report: Device State

The device state section contains:.

e IR-Capture register value, and
e The FPGA status

& Microsemi

Device Status Report: Device State

The IR-Capture is the value captured by the IEEE1149.1 instruction register when going through the IR-
Capture state of the IEEE 1149.1 state machine. It contains information reflecting some of the states of the

devices that is useful for troubleshooting.

One of the hits in the value captured is the ISC_DONE value, specified by IEEE 1532 standard. When the
value is ‘1’ it means that the FPGA array/fabric is programmed and enabled. This is available for IGLOO,
ProASIC3, SmartFusion and Fusion devices.

For example:
Device State:
IRCapture Register (HEX): 55

FPGA Array Status: Programmed and enabled

For a blank device:

Device State:

IRCapture Register (HEX): 51
FPGA Array Status: Not enabled
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Device Status Report: Analog Block

The Analog block of the SmartFusion and Fusion devices monitors some of the key power supplies needed
by the device to function. These power supply status is captured in the OABTR test register in the Analog
block.

For example, if you run Device Status when the Fabric and Analog configuration is programmed and
powered up successfully the report indicates:

Analog Block:

OABTR Register (HEX): 0dbe3bb

3.3V (vdd33): PASS

1.5V (vdd15): PASS

Bandgap: PASS

-3.3V (vddn33): PASS

ADC Reference: PASS

FPGA_Good: PASS

Status: Analog Block is operational

Table 40 - Device Status Report - Analog Block Description

Analog Block Status Description
OABTR Register RAW data captured from the device
3.3V (vdd33) Vcc33a supply status
1.5V (vdd15) Vcenvm supply status
Bandgap Internal bandgap supply status
ADC Reference ADC reference voltage status
-3.3V (vddn33) Vddn33 supply status (optional voltage)
FPGA Good FPGA array or Fabric status

If the Fusion device is erased, the report indicates:
Analog Block:
OABTR Register (HEX): 188e3ba
3.3V (vdd33): PASS
1.5V (vdd15): PASS
Bandgap: PASS
-3.3V (vddn33): FAIL
ADC Reference: FAIL
FPGA_Good: FAIL
Status: Analog Block is non-operational
Analog Block is not programmed

Device Status Report: Factory Data

The Factory Data section lists the Factory Serial Number (FSN).
Each of the IGLOO, ProASIC3, SmartFusion and Fusion devices has a unique 48-bit FSN.
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Device Status Report: Security

The security section shows the security options for the FPGA Array, FlashROM and Flash Memory (NVM)

block that you programmed into the device.
For example, using a Fusion AFS600 device:
Security:
Security Register (HEX): 0000000088c01b
FlashROM
Write/Erase protection: Off
Read protection: OFf
Encrypted programming: Off
FPGA Array
Write/Erase protection: Off
Verify protection: Off
Encrypted programming: OFF
FlashMemory Block O
Write protection: On
Read protection: On
Encrypted programming: OFf
FlashMemory Block 1
Write protection: On
Read protection: On
Encrypted programming: OFF

Table 41 - Device Status Report - Security Description

Security Description
Status Info
Security Raw data captured from the device's security status register

Register (HEX)

Write/Erase Write protection is applicable to FlashROM, FPGA Array (Fabric)and

Protection Flash Memory (NVM) blocks. When On, the Silicon feature is
write/erase protected by user passkey.

Read Read protection is applicable to FlashROM and Flash Memory (NVM)

Protection blocks. When On, the Silicon feature is read protected by user
passkey.

Verify Verify Protection is only applicable to FPGA Array (Fabric) only. When

Protection On, the FPGA Array require user passkey for verification.
Reading back from the FPGA Array (Fabric) is not supported.
Verification is accomplished by sending in the expected data for
verification.

Encrypted Encrypted Programming is supported for FlashROM, FPGA Array

Programming

(Fabric) and Flash Memory (NVM) blocks. When On, the silicon
feature is enable for encrypted programmed. This allows field design
update with encrypted datastream so the user design is protected.

& Microsemi

Device Status Report: Security
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Encrypted Programming
To allow encrypted programming of the features, the target feature cannot be Write/Erase protected by user
passkey.

The security settings of each silicon feature when they are enabled for encrypted programming are listed
below.

FPGA Array (Fabric)
Write/Erase protection: Off
Verify protection: OFf
Encrypted programming: On
Set automatically by Designer or FlashPro when you select to enable encrypted programming of the FPGA

Array (Fabric). This setting allows the FPGA Array (Fabric) to be programmed and verified with an encrypted
datastream.

FlashROM

Write/Erase protection: Off

Read protection: On

Encrypted programming: On
Set automatically by Designer or FlashPro when you select to enable encrypted programming of the
FlashROM. This setting allows the FlashROM to be programmed and verified with an encrypted datastream.
FlashROM always allows verification. If encrypted programming is set, verification has to be performed with
encrypted datastream.

Designer and FlashPro automatically set the FlashROM to be read protected by user passkey when
encrypted programming is enabled. This protects the content from being read out of the JTAG port after
encrypted programming.

Flash Memory (NVM) Block
Write/Erase protection: Off
Read protection: On
Encrypted programming: On
The above setting is set automatically set by Designer or FlashPro when you select to enable encrypted
programming of the Flash Memory (NVM) block. This setting allows the Flash Memory (NVM) block to be
programmed with an encrypted datastream.

The Flash Memory (NVM) block does not support verification with encrypted datastream.
Designer and FlashPro automatically set the Flash Memory (NVM) block to be read protected by user

passkey when encrypted programming is enabled. This protects the content from being read out of the
JTAG port after encrypted programming.

How do | interpret data in the Flash Memory (NVM) Status Report?

The Embedded Flash Memory (NVM) Status Report generated from the FlashPro Device Debug Feature
consists of the page status of each NVM page. For example:

Flash Memory Content [ Page 34 to 34 ]

FlashMemory Page #34:

Status Register(HEX): 00090000

Status ECC2 check: Pass

Data ECC2 Check: Pass

Write Count: Pass (2304 writes)

Total number of pages with status ECC2 errors: 0

Total number of pages with data ECC2 errors: O

Total number of pages with write count out of range: O

FlashMemory Check PASSED for [ Page 34 to 34 ]

The "check_flash_memory® command succeeded.

250 FlashPro User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content. . .
p & Microsemi

Probe Insertion (Post-Layout) - SmartFusion2, IGLOO2, and RTG4

The Execute Script command succeeded.

Table 42 - Embedded Flash Memory Status Report Description

Flash Description
Memory
Status Info

Status Raw page status register captured from device
Register
(HEX)

Status Check for ECC2 issue in the page status
ECC2
Check

Data ECC2 | Check for ECC2 issue in the page data
Check

Write Count | Check if the page-write count is within the expected range.
The expected write count is greater than or equal to:

6,384 - SmartFusion devices
2,288 - Fusion devices

Note: Write count, if corrupted, cannot be reset to a valid value within the
customer flow;invalid write count will not prevent device from being
programmed with the FlashPro tool.

The write count on all good eNVM pages is set to be 2288 instead of 0 in
the manufacturing flow. The starting count of the eNVM is 2288. Each
time the page is programmed or erased the count increments by one.
There is a Threshold that is set to 12288, which equals to 3 * 4096.

Since the threshold can only be set in multiples of 4096 (2”12), to set a
10,000 limit, the Threshold is set to 12288 and the start count is set to
2288; and thus the eNVM has a 10k write cycle limit. After the write count
exceeds the threshold, the STATUS bit goes to 11 when attempting to
erase/program the page.

Probe Insertion (Post-Layout) - SmartFusion2, IGLOO2, and RTG4

Introduction

Probe insertion is a post-layout debug process that enables internal nets in the FPGA design to be routed to
unused I/Os, as shown. Nets are selected and assigned to probes using the Probe Insertion window in the
SmartDebug tools. The re-routed design can then be programmed into the FPGA, where an external logic
analyzer or oscilloscope can be used to view the activity of the probed signal.
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Probe Insertion in the Design Process

The Probe Insertion debug feature is complementary to the Live Probes and Active Probes. In the case of
Live Probes and Active Probes, a special dedicated probe circuitry is used.

Probe Insertion
1. Double-click SmartDebug Design in the Design Flow window to open the SmartDebug window.
Note: FlashPro Programmer must be connected for SmartDebug to open.
2. Select Debug FPGA Array and then select the Probe Insertion tab.

€ Debug FPGA Array

Debug file:  D:\2Work\G4_SmartTime_UG\count16\designer\count16\count 16_debug. bt

FPGA Array debug data

Live Probes | Active Probes | Memory Blocks | Probe Insertion |

Probes I Add Probe... ] ’ Edit Probe... ] I Delete ] [ Delete Al

Net Driver Package Pin Port Name
Qaux_3_1_sum[o]:y ¥ [Probe_Insertd

EENR] - cbe et

Insert probe(s) and program the device

Figure 158 - Probe Insertion Tab
3. Click Add Probe.
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Probe Insertion (Post-Layout) - SmartFusion2, IGLOO2, and RTG4

The Add Probe dialog box displays the nets available to be probed on the right side. Each entry has a
Net and Driver name which identifies that probe point. The left (filter) pane allows filtering of the probe
points by net names or instance names.

To add filtering for Cell Types, enter the Cell Type Name in the Cell Type field. Enter, for example,
SEQ in the Cell Type field and all SEQ (Sequential) cell types will be displayed. If you enter COMB in
the Cell Type field, all COMB (Combinational Cells) will be displayed.

[ 531 Add Probetz) bl ) et |
Fiter raea(s) by: Seect a Netfs) for the Probe

: Frare Irdtanced | Met Dirrves -
I [+ Qim0 Qimi30kQ
2 Quint[26] Q_int]26:Q
Cell Type seq |3 Qing[25) Q irt[ 251
ey intin) R |4 Quingz4] QLint[24):Q
QL ini{10] |5 Quinef23) Qintl22}Q

Qintfl1] 6 Qin[2 Qint] 2210 &
Qint{12] H 7 Q2] Qint21:Q
Eﬂﬂi 5 Quint20] Qimi20}Q
! ink[19] int{13]:
Qs o S S i
QL imtf16] _ o
QL intil7] |11 Quink[17] Qint{171:Q
©int{18] |12 Q int[16] Q im[161Q
Qintf19] 13 Q int[15] QU imt[15EQ
[ | |aomtn) 14 Qintl13) L imi1a}Q
Qint]20] % | 15 Qint[13] QLint[13}Q
I 16 Q int[12] Qint{12}:Q
Seict Al | 17 Quinfin] Qim[10}Q
18 Qint[10] Qint{10}:Q

Match Case L% O intl%] O intf9kG |

Figure 159 - Add Probe(s) Dialog Box

4. Select one or more nets to probe and click OK.
The selected net(s) will appear in the Probes table in the Probe Insertion tab, as shown in the figure
below. SmartDebug automatically generates the Port Name for the probe. You can change the Port
Name from the default if desired.
5. Assign a package pin to the probe using the drop-down list in the Package Pin column. You can assign
the probe to any unused package pin (spare 1/O).
3| Debug FPGA
| DebugFle: C:\actelprj\sF2_preplidesignerishift_reg32ishift_reg32_debug. txt
FPGA Array Debug Data

e I thﬁ| = ,l e s .

Prabes [ Agderobe || Editrobe || Delete Dedete Al

Qint{30] Qint{30):

Net Driver Package Pin Port Name

AlZ x| Probe_Insert1

Q_imt[29] Q_int[29]:Q A19

4

My_probe

Insert Probe(s) and Program the device Run

6.

[ ] e ]

Figure 160 - Debug FPGA Array > Probe Insertion > Add Probe
Click Run.
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This triggers Place and Route in the incremental mode, and the selected probe nets are routed to the
selected package pin. After incremental Place and Route, Libero automatically reprograms the device
(with the added probes).

The log window shows the status of the Probe Insertion run.

Edit Probes
To edit/change a probe, select the probe and click Edit Probe. The Edit Net for Probe dialog box appears.
(1t et foe Probe (B
Fitber netis) by Sebect & Het for S Probe
Mame | [nstances et Diver

Erier beigw a reguis expresson Tt rame should maich

L

Figure 161 - Edit Net for Probe Dialog Box
Click and select a net to replace the original net for the Probe.

Probe Deletion
To delete a probe, select the probe and click Delete. To delete all the probes, click Delete All.

Note: Deleting probes from the probes list without Run does not automatically remove the probes from the
design.

Reverting to the Original Design
To revert to the original design after you have finished debugging:
1. In SmartDebug, click Delete All to delete all probes.
2. Click Run.

3. Wait until the action has completed by monitoring the activity indicator (spinning blue circle). Action is
completed when the activity indicator disappears.

4. Close SmartDebug.

See Also
Debug FPGA Array
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Probe Insertion (Post-Layout) - SmartFusion2, IGLOO2, and RTG4

Active Probes (SmartFusion2, IGLOO2, and RTG4)

On the Active Probes tab a table of Probe Names is shown with the Name, Type (which is the physical
location of the flip-flop) and Value.

Click the Select Active Probes button to open a window that lists all the Available Probe Points and

Selected Probe Points. Both lists can be filtered using the inline Filter box. Between the two lists of Probe
points are buttons for adding and removing probe points from either list.

© Debug FPGA Amay e
Debug fle:  Ex\Asf\RTGA_TCs\AT4G150_ES\serdes\EPCS\poe_epcs_x1_farend'poe_EPCS_yx \designer \serdes serdes_debug. bt
FPGA Array debug data
Lk Probes | Actve Probes | Memery Blodes | Probe bnsertion
Acthve Probe Data
O thee P Active Probed butten to see the dats for selected probes
Hame Type: vkt -
data_0fdata[0]:Q Legic Liwead (=]
: data_0fdatal10]:Q Logc Urread L)
Add Remave Active Probes. .
: g data_0fdaea[11]:Q Legc Urvead O
data_0data[12]:Q Logic Unread O
Resd Actre Probes | data_0fdata[13]:Q Liogc Linreaad L]
data_0fdata[14):Q Legit Wread O
dats_0fdata]15]:Q Log nresad L]
dats_Ofdata[16]:0 e Linread L=
data_fidata[17):Q Logic Unread O
letabn nidataf 1A1:0 1w Lierad £ i
Helg Close

Figure 162 - Active Probes Tab in SmartDebug FPGA Array Dialog Box

Once you have selected the desired probe, points appear in the Active Probe Data chart and you can read
and write multiple probes at the same time (as shown in the figure below).

The Value column fields are editable for each of the probe points. Clicking the circle shaped icon changes
the value, and clicking the back-arrow resets the value. Fields that have been changed are indicated by red
text. After the probes have been written, the values return to black text.

—
49 Select Active Probe Points

Avalable probe points Selected probe points
Flter: | iy Fiter: Seanch
Hame:
CoreaHELite 0/matricax 16 masterstage_0/SDATASELInt{0]:Q [ add o]
CoreAHELite_jmatrixx 16 masterstage_0/SDATASEL Int] 10):Q b )
CoreAHELite_(jmatrix: 16 jmasterstage 0/SDATASELIN11]:Q
(CoreAbBLite_0fmatriscs 16 jmasterstage 0 SOATASELInt[12]:Q
(CoreAbELite_(jmatrixd: 16 masterstage 0/SDATASELInt] 13]:Q

CoreAHBLibe_(yimatrixcd: 16 masterstage 0 SDATASELInt] 14]:G

AR

CoreAMELIbe_Omabrixd 16 masterstage_0/SDATASELIN]15]:Q

Figure 163 - Active Probes Tab - Select Active Probe Points
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Live Probes (SmartFusion2, IGLOO2, and RTG4)

The Live Probes tab shows a table with the probe name and pin type.
Note: SmartFusion2 and IGLOQO2 support two probe channels, and RTG4 supports one probe channel.

SmartFusion2 and IGLOO2

Two Probe Channels (ChannelA and ChannelB) are available. Once a Probe Name is selected, it can be
assigned to either ChannelA or ChannelB.

Note: At least one channel must be set; if you intend to use both probes, they must be set at the same time.
The Active Probes READ/WRITE will overwrite the settings of Live Probe channels (if any).

6 o I ==

Debug file:  D:\2Work\G4_SmartTime_UG \count16\designer\count 16\count16_debug. et

FPGA Array debug data

Live Probes | Active Probes I Memory Blocks I Probe Insertion |

Name Type
%Q_C[U] :Qaux[0]:Q Logic
Q_c[1]:Qaux[1]:Q Logic
Q_c[2]:Qaux[2]:Q Logic
Q_c[3]:Qaux[3]:Q Logic

ChannelA -

Channel -

Set

After the channels have been set, SmartDebug configures the ChannelA and ChannelB 10’s to monitor the
desired probe points. The maximum number of simultaneous probes is two internal signals. There is also a
Filter box to filter through the Probe Names. As you begin typing in the Filter box, the Probe Name table only
shows results for the queried names.

RTGA4

One Probe Channel (Probe Read Data Pin) is available for RTG4 for debug. Once a Probe Name is
selected, it can be assigned to the Probe Channel (Probe Read Data Pin).

The Active Probes READ/WRITE will overwrite the settings of Live Probe channels (if any).
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Probe Insertion (Post-Layout) - SmartFusion2, IGLOO2, and RTG4

9 Debug FPGA Array EELF

Debug file:  D:\RTG4_launch_testcase\DDR2_AHB_PHY16_1_4\DDR2_AHE_PHY16_1_4\designer\TOP\TOP_debug. txt

FPGA Array debug data

Live Probes | Active Probes I Memory Blocks I Probe Insertion |

Name Type =

CoreAHBLite_0/matrix4x 16/masterstage_0/SDATASELINt[0]:Q Logic D
CoreAHELite_0/matrix4x 16/masterstage_0/SDATASELINt[10]:Q Logic
CoreAHBLite_0/matrix4x 16/masterstage_0,/SDATASELINt[11]:Q Logic
CoreAHBLite_0/matrix4x 16/masterstage_0,/SDATASELINt[12]:Q Logic
CoreAHBLite_0/matrix4x 16/masterstage_0/SDATASELINt[13]:Q Logic
CoreAHBLite_0/matrix4x 16/masterstage_0,/SDATASELINt[14]:Q Logic

i; CoreAHBLite_0/matrix4x 16/masterstage_0,/SDATASELINt[15]:Q Logic

=

Probe Read Data Fin | -3  oreAHBLite_0/matrix4x 16/masterstage_0/SDATASELINt[0]:Q Set
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Device Debug User Interface

Inspect Device Dialog Box

Inspect Device is available as a part of the FlashPro programming tool. Refer to Using Device Debug for
information on how to configure the FlashPro to get access to this feature.

The Inspect Device dialog box enables you to access all the Device Debug features, such as the FlashROM,
Embedded Flash Memory (NVM) and Analog Block. If you have multiple devices and programmers
connected, choose your target device/programmer from the dropdown menu and use the ID code to verify
that you are inspecting the correct device.

View Device Status - Displays the Device Status Report. The Device Status Report is a complete summary
of your device state, analog block test values, user information, factory data and security information. Use
this dialog box to save or print your information for future reference.

View Analog Block Configuration - Opens the Analog Block Configuration dialog box. Enables you to view
the channel configuration for your analog block and compare the channel configuration with any other
analog block file.

View Flash Memory Content - Opens the Flash Memory dialog box. This dialog box enables you to view
the details for each flash memory block in your device.

View FlashROM Content - Opens the FlashROM data dialog box, enables you to view a list of the physical
blocks in your FlashROM and the client partitions in FlashROM configuration files.

Y Inspect Device ?)X]

Programmer: |S1538 (usb51538) w

=N A 200MSF (AZF200M3F)

ID code read from device: SA131CF

|'u'iew Device Status i I‘.n'iew Analog Block Cnniiguratinnl [vim Flash Memary Cantaﬂ] \mw FlashROM Cmtent]

Figure 164 - Inspect Device Dialog Box

Device Status Report

This dialog box displays the Device Information report. The Device Information report is a complete
summary of your device state, analog block test values, user information, factory serial number and security
information. Use this dialog box to save or print your information for future reference. See the Interpreting
the Device Status Report topic for information on the report contents.
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Analog Block Configuration Dialog Box (SmartFusion and Fusion Only)

Device: AFSE00 (AFSE00) Programmer: 10865 (usb10368)

[ I save ]

[ ¢ Print ]

Device Skaktus:

IDiCode (HE=):

233261cF

IJser Information:

LIROMY daka (HE®): 23080041020408102045Fd3766303481

Programming Method: PDE

Prograrnmnet: FlashPro3

Programmer Software: FlashPro 3.6

Design Mame: tap

Design Check Sum: 2305

Algorithm Yersion: 19

Array Prog, Cycle Count: 1
Device Stake:

IRiZapture Register (HEX): 55

FPGA frray Status: Programmed and enabled
Analog Block:

QOABTR Regisker (HEX): 1dbe3bhb

3,3 (wdd3an PASS

1.5 {wdd15): PASS

Bandgap: Pass

-3.3Y {vddn33): PASS

ADC Reference: PAs5

FPGA_Good: PASS

Skakus: #nalog Block is operational
Fackory Data:

Factory Serial Mumber (HE=): B0e0904360a0
Securiby;

Device has no security enforced.

Close

Figure 165 - Device Status Report

Analog Block Configuration Dialog Box (SmartFusion and Fusion

Only)

Enables you to:

e View the channel configuration on your analog system, identify iffhow the channels are configured.

e Compare with the design configuration from the Analog System Builder for Fusion and SmartDesign
MSS Configurator for SmartFusion

The values displayed for each channel vary depending on the device family and channel you select; the
Channel configuration register read from the ACM is shown for each analog channel. Individual, decoded bit
fields of the register are listed immediately beneath (as described in Fusion and SmartFusion handbook).
The dialog box may display the following values:

Fusion Device
e Analog MUX select
e Internal chip T monitor
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e Scaling factor control

e Current monitor switch

e Current monitor drive control

e Direct analog input switch

e Pad polarity - G, T, V, C pad polarity, positive or negative

e Select low/high drive

e Prescaler op amp mode
SmartFusion Device

e Gain select

e Channel state

e Direct Input state

e Current Monitor state

e Current monitor strobe state

e Comparator state

e Hysteresis select

e Analog MUX select

e DAC input select

e Temperature monitor state

e Temperature monitor strobe state

e Vref switch state

To use the compare feature, select the Compare with checkbox. If the loaded PDB file contains Analog
Block configuration information the comparison appear automatically.

To use a specific Project File, click Browse and navigate to the Analog System Builder directory for for
Fusion or SmartDesign for SmartFusion. In a typical IDE project, this directory is located at:

e Fusion - <project_root>/smartgen/<analog_block core_name>
e SmartFusion - <project root>/component/work/<SmartDesign project>/MSS_ACE_0

After specifying the compare directory the differences (if any) are indicated in red on a channel by channel
basis, as shown in the figure below.
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Embedded Flash Memory (NVM) Content

¥ Analog Block Configuration ? @
Channel configuration Compare with:  as15
Found 32 mismakched channels
Ladll
Channel Byte ¢ J &Y0
T OxE1 |
AVD Device Content File Content
ACD Ox00 F.'b- | Byte D81 038
Analog MUX select Prescaler Direck input
ACD 000 |4 y
G0 ! Scaling factor control 0.3125 (8v) 0.15625 (16}
ATOD OxE0 .ﬂ. Current monitor switch — Off on
Oxg2 Direct analog input switch OFF on
E

AVl ¥-pad polarity Pasitive Positive
AC1 Ox10 Prescaler op amp mode  Operational Powerdown
AGL Ox00 a
AT1 OxE0 A
AN2 0x92 i‘»
ACP Ox10 ud|

Figure 166 - Analog Block Configuration Dialog Box for a Fusion Device (Differences in Red)

Embedded Flash Memory (NVM) Content

The NVM content dialog is divided into two sections. The top section shows the data that is retrieved from
the PDB that you specified. The bottom section shows the data that is retrieved from the actual device. The
View Flash Memory Content diagnostic enables you to:

e View content of Flash Memory pages (as shown in the figure below)
e Compare device content with original design content (requires a PDB that contains your EFC data)

e Check page status and identify if a page is corrupted or if the write count limit has exceeded the 10-
year retention threshold

Fusion Devices: Choose your block from the From block dropdown list This action populates the Select
dropdown list with the names of the clients in the selected block that is configured in the Flash Memory
System Builder.

SmartFusion Devices: Block selection is unused and unavailable.

Choose a client name from the Select dropdown list and click Read from Device to view the values. You
can also view a specific page range by selecting the <Page Range> option in the Select dropdown list and
then specifying the start page and the end page.

You must click Read from device each time you specify a new page range to update the view.

If you do not have your original design programming database (PDB) file, then you can also examine and
retrieve a range of pages. Specify a page range if you wish to examine a specific set of pages.
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1 Flash Memory
Retrieve Flash Memory Content from Device:
From block |0 - M55_ENWM_0.efc
Select |ACTEL_PPE_MERGE_CONFIG (p)
(page 2044)
| bytes (1 page)

Start address: | 0x3FEOD

Chent size: 48

Latest Content Retrieved from Device:

Retrieved Content:  Client "ACTEL_PPE_MERGE_CONFIG", 48 bytes starting from address Ox3FEQD

@)X

Mon Jun 06 16:16:01 2011

iew Detailed Status| |Compare Client Content

Content

Page Mumber | Address

T

| 2131 «+0sfelz[Jslsfalelclofe]F

2044 3FEQD| 00 a3 oo 0o 10 0a 10 10 an 03 10
2044 JFE10| 01 03 40 oo 10 o0 10 10 o1 03 1o
2044 JFEZ0| 11 an 18 o1 o 0z 20 13 10 00 1
2044 3IFE30| 00 an oo 0o an 0a ao 00 an 00 aa
2044 3FE40| 00 an an a0 oo L1} an 0a an 00 i}
2044 3FESO| 00 ule} oo oo oo oo oo ] an 00 oo
2044 3IFEGD| 00 an 0o 00 o 0o 0o 00 an 00 o0
2044 3IFETO| 00 e} oo 00 an o0 i} 0o an 00 i}

0z
oz
o
an
an
oo
an
o

03

82 8 8 8 8 E

04 10 20
04 10 20
a3 0
an oa
an oo

an

20
o0

an o0 i}
oo
o0 00
oo

an i}

Figure 167 - Flash Memory Dialog Box for a SmartFusion Device (Device Debug)

Embedded Flash Memory: Browse Retrieved Data

The retrieved data table displays the content of the selected client or the page range selection. Corrupted
pages content is displayed in red. Read-only page content, corresponding to clients defined with the Prevent
read option in Flash Memory System Builder, is displayed on gray background. If content cannot be read
(e.g. pages are read-protected, but security has been erased), it is displayed as XX. The mouse tooltip
summarizes abnormal content status (as shown in the figure below).

The corresponding page number and address (relative to the current block) are displayed in the left column.
The client size specified in the Flash Memory System Builder is shown at the top of the content table.

In the Retrieved Data View you can enter an Address value (such as 0010) in the Go to Address field and

click the corresponding button to go directly to that address.

Click View Detailed Status for a detailed report on the page range you have selected.

For example, if you want to view a report on pages 1-3, set the Start Page to 1, End Page to 3 and click
Read from Device, then click View Detailed Status; the figure below is an example of the data for a

specific page range.
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Embedded Flash Memory: Browse Retrieved Data

¥ Flash Memory Details

In Elock 1, from Page 1 to Page 3, 384 bytes starting from address 0x&0 as of Wed Jan 20 15:40:57 2010 ’ H Save ] ’ & Print ]

Flash Memory Content [ Page 1 ko 3 ]
FlashMemary Page #1:
Status Register{HEX): 0O0Sf000
Status ECCZ check:  Pass
Data ECC2 Check:  Pass
W'rite Count: Pass (2288 writes)
FlashMemory Page #2:
Status Register{HEX): 000SFO00
Status ECCZ check:  Pass
Data ECCZ Check:  Pass
W'rite Count: Pass (2258 writes)
FlashMemory Page #3:
Status Register{HEX): 000SF000
Status ECC2 check:  Pass
Data ECCZ Check:  Pass
W'rite Count; Pass (2258 writes)
Total number of pages with status ECCZ errars: 0
Total number of pages with data ECCZ errors: 0
Tatal number of pages with write count ouk of range: 0
FlashMemary Check PASSED for [ Page 1 ka3 ]

s

Figure 168 - Flash Memory Details Dialog Box (Device Debug)

T Flash Memo ry

Retrieve Flash Memory Content from Device:

From black |3 - newiZore.efc &
|2} Read from Device *

{address 0x00000)

Select |<Page Range> %
Stark Page: |0

EndPage: |3 {4 pages, 512 bytes)

Latest Content Retrieved from Device:

Retrieved Content: In Block 3, from Page 0 bo Page 3, 512 bytes starting from address 00

G b deddrass (hee:

Wed Jan 20 103317 2010

Wiew Detaded Status

Conbent
Page Mumber | Address

o |1 J 2z ]3]+ s]s]s]els]alje]c]olel]ler

ojlojojlo|jloljlo|o|o

(11 o0 00 00 00 00

| 0 00
Corrupted; Resd Protected;
. s aca e ol

d

2 E|g 8 8 8 B 8§ 8 B

H

E E|lg 2 2 B E B E E
SE|IFEFE 88 888 =
B B2 8 8 8B E B E| B
2 E|lg 2 2 B E B E E
2 E|g 2 28 BE E B E B
E E|lg 8B E BE E B E B
2 E|lg 2 2 BE E B E B

{8 Bl g 2828 88 8 8
{8 8|l e B8t 88 8 8
{8 EB|ls 8B 8 8 8 8
2 E|l8 BE 8 =B 8
E E|8 B B 8 B
2 E|8 B 8 8 &
2 BE|8 B 8 B B
<

i
i
§
i
i
i
i
i
i
i
i
i

E

Figure 169 - Flash Memory Browse Retrieved Data
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Embedded Flash Memory: Compare Memory Client

After you retrieve the data from the device, the Compare Client Content button enables you to compare the
content of the selected client from the device with the original programming database (PDB) file. The
differences are shown in the Compare Memory Client dialog (as shown in the figure below).

NOTE: This option is not available when you select to retrieve the data based on a page range.

1 Compare Memory Client

In Block 0, Clent "DSBbIL", 256 bytes starting from address 0x0 as of Sun Jan 17 12:12:06 2010 | | save || & it |

Flash Memory Client Compare [DS8bit - Block 0] Al

Difference at byte 0.
Byte Design Device
0 OreFily ]

Difference at bytes 2 ko 4.
Byte Design Device

2 Oee3h, | Ol
3 OxAE | Ox00

4 OxBE | OwOD

Difference at bytes 6 to 255,
Byte |Design |Device
[ OeFF Orxi0eD
7 OpcCh  {ChcaD
& OeAd, | Ol
9 DAl (D00
10 OechRy | OraiiD
11 OecRlE | OrileD)
12 et o vi|

Figure 170 - Compare Memory Client Dialog Box

FlashROM Content Dialog Box

Enables you to view the physical blocks in your FlashROM and the client partitions specified in the original
design content (requires a PDB that contains your UFC data). If the project’'s PDB does not contain UFC
data, only the physical blocks are displayed.

Scroll through the table to view the Words and Pages for your physical blocks.

The Client Partitions section lists the names and configuration details of the clients set up in the FlashROM
Builder. It automatically finds all mismatched client regions. To view the differences between a client and the
device content, select a region row in the Client Partitions table. This action will highlight the corresponding
device content in the Physical Blocks table. The mismatch details are displayed below the Client Partitions
table.

To copy to clipboard the content of the Physical Blocks table, select one or more cells in the table and type
Ctrl+C.
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Device Debug Tcl Commands

1 FlashROM

Phesical Blocks

15 14| 131211 w| 9| 8| 7| 6| s5| 43 2| 1] 0
7FF |7E |70 FC 7B |F& F@ |78 |77 F& |F5 74 F3 72 |71 |FO
62z |22 |2z |2z e |2z |2z |z |22 |2z |2z 22 me z2 |2 |22
5/5F DE Db 5C DB |54 59 D8 D7 56 |55 D4 53 D2 D1 |50
Pages |4 PENNISIIGEIEEES o @ s | EF 0A BC |DE FO A |(D

%/3F |BE |BD 3C BB |34 |39 B8 |BF |3 |35 B4 33 B2 (Bl |30
/00 00 |00 o0 00 |00 |00 OF |BE |FA |FA FA F4 FA |FA |EB
1/00 o0 00 o0 00 00 (OO0 OO 00 (OO0 00 00 00 00 |00 |00
ool 23 (45 (67 89 |01 |23 45 |&F 89 |AA AR BB CC |CD DD

Client Partitions

FlashROM configuration file: D:\templfrom2\From_File_care'\from_File_core.ufc

Found 2 client regions that do not match with dewvice content,

Reqgion Marme Region Type Page Start Ward Size (words)
Region_3_11 Read from file 3 11 5
Reqgion_4_11 Skatic 4 11 =1 ;i\,
Region_5_11 Auto Inc 5 11 1 A

Content dekails For selected region

From dewice: AECDEFOAEC
Shown as: HEXADECIMAL
From config file: 0000000000

& Mismatch between configuration file content and device content,

Figure 171 - FlashROM Content Dialog Box

Device Debug Tcl Commands

The following table lists the Tcl commands related to Device Debug. Click the command to view more

information.
Table 43 - Device Debug Tcl Commands
Command Action Type
check_flash_memory Performs diagnostics of the page status and | Embedded
data information Flash

Memory
(NVM)

compare_analog_config Compares the content of the analog block Analog Block
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Command Action Type
configurations in your design against the
actual values in the device.
compare_flashrom_client | Compares the content of the FlashROM FlashROM
configurations in your design against the
actual values in the selected device.
compare_memory_client Compares the memory Embedded
client in a specific device | Flash
and block Memory
(NVM)
read analog_block_config Reads each channel Analog Block
configuration on your
analog system, enabling
you to identify iffhow each
channel is configured.
read_device_status Displays a summary of the selected device
read_flashrom Reads the content of the FlashROM from FlashROM
the selected device
read_flash_memory Reads information from the NVM modules Embedded
(page status and page data) Flash
Memory
(NVM)
read_id_code Reads IDCode from the device without
masking any IDCode fields
recover_flash_memory Removes ECC2 errors due to memory Embedded
corruption by reprogramming specified flash | Flash
memory (NVM) pages and initializing all Memory
pages to zeros. (NVM)

sample _analog_channel

Samples analog channel; enables you to
debug ADC conversion of the preconfigured
analog channel (you must provide ADC
conversion parameters )

set_debug_device

Identifies the device you intend to debug.

set_debug_programmer

Identifies the programmer you want to use
for debugging (if you have more than one).

SmartDebug for SmartFusion2, IGLOOZ2, and RTG4

SmartDebug for SmartFusion2, IGLOO2, and RTG4 supports probe capabilities in the device architecture
and device debug features for memory.

To open SmartDebug, in the Design Flow window expand Debug Design and double-click SmartDebug
Design (as shown in the figure below).
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SmartDebug for SmartFusion2, IGLOO2, and RTG4

| Debug FPGA Array Lo

Debug File:  N\dmS'soatest4i\smartDebug 25050 Live_Probe_FB\Live_Probe_FB'desigreritest | Browse...
FPGA Array Debug Data

Live Probes | Active Probes | Memory Blocks | Probe Insertion |

Hame Type =
A D_0_c:D_0_ibuffudfu_TOmN:Y:gf<2> East IO B
D 0 oD 0_ibuffUopU_TOIN:Y:qr<2> East IO
D_1_cD_1_ibufUDA_TOIN:Y:gf<D > East IO
D_1 c:D_1 ibuffudfU_TOIN:Y:gr<0> East IO =
[ProbeReadDataPin| -> D_0_c:D_0_ibufUO/U_IOMN:¥:qf<2> [ set |
|
I
R ——
Figure 172 - Debug FPGA Array Dialog Box
The SmartDebug application appears and lists your Device, the ID Code read from your device, and your
Programmer.
[ & smanDebug b | D

File View Help

Devioe: | M25050T (MZS050T . Programmer: | 94472 {isbi 7T -
I code read from  dewice FR021CF
|
]l Wiew Dewice Stahus... [ Diebug FPGA Amay... ] H
| Vierwr Flash Memory Content. . l Dietrug SERDES. .. |
(s -~
Leg B x

([T temmages ] @ rors iy Wornngs @10

Selecting device HIS0S0T for imapectica.

Figure 173 - SmartDebug Dialog Box
SmartDebug enables you to:

View Device Status — Displays the Device Summary Report. It is a summary of your device state, user

information, factory serial number and security information. Use this dialog box to save or print your
information for future reference.

View Flash Memory Content - Use this information to view, save or print the flash memory content in your
design.
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Debug FPGA Array — SmartFusion2, IGLOO2, and RTG4 devices have built in probe points that greatly
enhance the ability to debug logic elements within the device. The enhanced debug features implemented
into the devices give access to any logic element and enable designers to check the state of inputs and

outputs in real time. Live Probe and Active Probe are only available for the SmartFusion2, IGLOO2, and
RTG4 families.

e With Live Probe, dedicated probes (two for SmartFusion2/IGLOO2 and one for RTG4) can be
configured to observe a Probe Point (any input or output of a logic element). The probe data can then

be sent to an oscilloscope or even redirected back to the FPGA Fabric to drive a software logic
analyzer.

e Active Probe allows dynamic asynchronous read and write to a flip-flop or probe point. This enables

you to quickly observe the output of the logic internally or to quickly experiment on how the logic will be
affected by writing to a probe point.

e Memory debug lets you perform dynamic asynchronous reads and writes to a micro SRAM or large
SRAM block so you can quickly verify if the content of the memory is changing as expected.

e Probe Insertion lets you route certain nodes (or debug points) in the FPGA design to the external world
through unused 1/0s. You can attach an oscilloscope/logic analyzer to monitor them as live signals.

Debug SERDES - Enables you to examine and debug the SERDES blocks in your design. You can
configure your SERDES debug, and run PRBS and Loopback tests.

File Menu

The File Menu lets you execute SmartDebug-specific Tcl scripts (File > Execute Script) and export
SmartDebug-specific commands to a script file (File > Export Script File). You may pass the Tcl script to

SmartDebug for batch-mode execution from Libero. Refer to run_tool (SmartFusion2, IGLOO2 and RTG4)
for details.

View Log

SmartDebug displays the Log Window by default when it is invoked. To suppress the Log window display,
select the View menu and toggle View Log.

The Log Windows contains four tabs:
¢ Message window — displays standard output messages
e Errors window — displays error messages
e Warnings windows — displays warning messages
¢ Info window — displays general information

Using SmartDebug with SmartFusion2 and IGLOO2
The most common flow for Device Debug is:

1. Create your design. You must have a FlashPro programmer connected in order to use SmartDebug.

2. Expand Debug Design and double-click Smart Debug Design in the Design Flow window.
SmartDebug opens for your target device.

Click View Device Status to view the device status report and check for issues.
4. Examine individual silicon features, such as FPGA debug.

Device Status Report - SmartFusion2 and IGLOO2

This dialog box displays the Device Information report. The Device Information report is a summary of your
device state, user information, factory serial number and security information. Use this dialog box to save or
print your information for future reference.
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Device Status Report - SmartFusion2 and IGLOO2

Debug SERDES

The Debug SERDES dialog box (as shown in the figure below) enables you to examine and debug the
SERDES blocks in your design.

To Debug SERDES, expand SmartDebug in the Design Flow window and double-click Debug SERDES.

Debug SERDES Configuration is explained below. See the PRBS Test and Loopback Test topics for
information specific to those procedures.

SERDES Block identifies which SERDES block you are configuring. Use the dropdown menu to select from
the list of SERDES blocks in you design.

Debug SERDES - Configuration

Configuration Report
The Configuration Report output depends on the options you selected in your PRBS Test and Loopback
Tests. The default report lists the following for each Lane in your SERDES block:
Lane mode - Indicates the programmed mode on a SERDES lane as defined by the SERDES system
register.
PMA Ready - Indicates whether PMA has completed its internal calibration sequence for the specific lane

and the PMA is operational. See the SmartFusion2 or IGLOO2 High Speed Serial Interfaces User's Guide
on the Microsemi website for details.

TxPII status - Indicates the loss-of-lock status for the TXPLL is asserted and remains asserted until the PLL
reacquires lock.

RxCDR status - Indicates the RxCDR loss-of-lock for the channel when asserted and locking to the
incoming data stream.

Click Refresh Report to update the contents of your SERDES Configuration Report. Any changes to the
specified SERDES register programming can be read back to the report.

SERDES Register Read or Write

Script - Runs your MSS Read/Write using a script. Enter the full pathname for the script location or click the
Browse button to navigate to your script file. Click Execute to run the script.
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SERDES Block |SERDESIF_1 =
Configuration Report:

Debug SERDES

Cenfiguration * | | Refresh Report
4 Tests SE[dES E[i)lm:k SERDESIF_1:
ane 0 :
PRES Test Lane mode : EPCS (1.25 GHz) ]
Loopback Test PMA Ready : True |=
TuPLL status : Locked
RxCDR status : Unlocked
Lane 1:
Lane mode : EPCS (1.25 GHz)
PMA Ready : True
THPLL status : Locked
RxCDR status : Unlocked
Lane 2:
Lane mode : EPCS (1.25 GHz) o

SERDES Register Read or Write:

Script: E] Execute

Figure 174 - Debug SERDES - Configuration

Debug SERDES- PRBS Test

PRBS data stream patterns are generated and checked by the internal SERDES block. These are used to
self-test signal integrity of the device. You can switch the device through several predefined patterns.

View Loopback Test settings in the Debug SERDES - Loopback Test topic.

SERDES Block identifies which SERDES block you are configuring. Use the dropdown menu to select from
the list of SERDES blocks in you design.

SERDES Lanes

Select the Lane and Lane Status on which you wish to run the PRBS test. Lane mode indicates the
programmed mode on a SERDES lane as defined by the SERDES system register.

Test Type
Near End Serial Loopback (On-Die) enables a self test of the device. The serial data stream is sent from
the SERDES TX output and folded back onto the SERDES RX input.
Serial Data (Off-Die) is the normal system operation where the data stream is sent off chip from the TX
output and must be connected to the RX input via a cable or other type of electrical interconnection
Pattern

The SERDESIF includes an embedded test pattern generator and checker used to perform serial
diagnostics on the serial channel, as shown in the table below.
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Pattern Type
PRBS7 Pseudo-Random data stream of 227 polynomial sequences
PRBS11 Pseudo-Random data stream of 2711 polynomial sequences
PRBS23 Pseudo-Random data stream of 2723 polynomial sequences
PRBS31 Pseudo-Random data stream of 2231 polynomial sequences

Error Count

& Microsemi
Debug SERDES - Loopback Test

Lists the number of errors after running your PRBS test. Click Reset to reset to zero.

49 Debug SERDES

E)

SERDES Block: |SERDES_PCIE O -

Debug SERDES SERDES Lanes: (@) Lane 0 Lane 1 Lane 2 () Lane 3
Configuration Lane 0 status: RxCDR TuPLL
4 Tests
PRES Test Test Type:
Loopback Test @ Mear End Serial Loopback (On-Die) (71 Serial Data (OFF-Die)
Pattern:
@ PRBEST
{T) PRBS11
| ~) PRBS 23
) PRBS 31
Error Count:
:

Close

Figure 175 - Debug SERDES - PRBS Test

Debug SERDES - Loopback Test

Loopback data stream patterns are generated and checked by the internal SERDES block. These are used
to self-test signal integrity of the device. You can switch the device through predefined tests.

See the PRBS Test topic for more information on the PRBS test options.

SERDES Block identifies which SERDES block you are configuring. Use the dropdown menu to select from

the list of SERDES blocks in you design.

SERDES Lanes

Select the Lane and Lane Status on which you wish to run the Loopback test. Lane mode indicates the
programmed mode on a SERDES lane as defined by the SERDES system register.
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Test Type

PCS Far End PMA RX to TX Loopback- See the SmartFusion2 or IGLOO2 High Speed Serial Interfaces
User's Guide on the Microsemi website for details.

€D Debug SERDES S L2 oS

SERDES Blodk: |SERDES_PCIE 0 -

Debug SERDES SERDES Lanes: (@) Lanz 0 Lane 1 Lane 2 ) Lane 3
Configuration Lane 0 status: RxCDR. TxPLL
4 Tests
PRES Test Test Type:
Loopback Test @ PCS Far End PMA Rx to Tx Loopback

Figure 176 - Debug SERDES - Loopback Test

Debug FPGA Array

The Debug FPGA Array dialog box enables you to view your Live Probes, Active Probes and Memory
Blocks and allows you to Insert Probes (Probe Insertion).

Debug File - Shows a path to your Debug File. The Debug file contains information used by SmartDebug
mainly for mapping user design names to their respective physical addresses. It also contains other
information used during debug process.

The Debug file is generated by Libero SoC during Place and Route and is stored in the design folder.
The Debug FPGA Array dialog box includes the following four tabs:

e Live Probes

e Active Probes

e Memory Blocks
e Probe Insertion
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Debug FPGA Array

Live Probes (SmartFusion2, IGLOO2, and RTG4)

The Live Probes tab shows a table with the probe name and pin type.
Note: SmartFusion2 and IGLOQO2 support two probe channels, and RTG4 supports one probe channel.

SmartFusion2 and IGLOO2

Two Probe Channels (ChannelA and ChannelB) are available. Once a Probe Name is selected, it can be
assigned to either ChannelA or ChannelB.

Note: At least one channel must be set; if you intend to use both probes, they must be set at the same time.
The Active Probes READ/WRITE will overwrite the settings of Live Probe channels (if any).

(s o

Debug file:  D:\2Work\G4_SmartTime_UG\count16\designer\count 16\count 16_debug, txt

FPGA Array debug data

Live Probes | Active Probes | Memory Blocks I Probe Insertion |

Filter:
Name Type
éQJ[OJ :Qaux([0]:Q Logic
Q_c[1]:Qaux[1]:Q Logic
Q_c[2]:Qaux[2]:Q Logic
Q_c[3]:Qaux[3]:Q Logic

Channela -

Set
ChannelB -

Figure 177 - Live Probes Tab (SmartFusion2 and IGLOQO2) in SmartDebug FPGA Array Dialog Box

After the channels have been set, SmartDebug configures the ChannelA and ChannelB 10’s to monitor the
desired probe points. The maximum number of simultaneous probes is two internal signals. There is also a
Filter box to filter through the Probe Names. As you begin typing in the Filter box, the Probe Name table only
shows results for the queried names.

RTG4

One Probe Channel (Probe Read Data Pin) is available for RTG4 for debug. Once a Probe Name is
selected, it can be assigned to the Probe Channel (Probe Read Data Pin).

The Active Probes READ/WRITE will overwrite the settings of Live Probe channels (if any).
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Debug FPGA Array [ e

Debug file:  D:\RTG4_launch_testcase\DDR2_AHB_PHY16_1_4\DDR2_AHE_PHY16_1_4\designer\TOP\TOP_debug. txt

| FPGA Array debug data

Live Probes | Active Probes I Memory Blocks I Probe Insertion |

Name Type =

| CoreAHELite_0/matrix4x 16 /masterstage_0/SDATASELINt[0]:Q Logic |:|

CoreAHELite_0/matrix4x 16/masterstage_0/SDATASELINt[10]:Q Logic

CoreAHBLite_0/matrix4x 16/masterstage_0,/SDATASELINt[11]:Q Logic

CoreAHBLite_0/matrix4x 16/masterstage_0,/SDATASELINt[12]:Q Logic

CoreAHBLite_0/matrix4x 16/masterstage_0/SDATASELINt[13]:Q Logic

CoreAHBLite_0/matrix4x 16/masterstage_0,/SDATASELINt[14]:Q Logic

CoreAHBLite_0/matrix4x 16/masterstage_0,/SDATASELINt[15]:Q Logic

=

Probe Read Data Fin | -3  oreAHBLite_0/matrix4x 16/masterstage_0/SDATASELINt[0]:Q Set

Figure 178 - Live Probes Tab (RTG4) in SmartDebug FPGA Array Dialog Box
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Debug FPGA Array

Active Probes (SmartFusion2, IGLOO2, and RTG4)

On the Active Probes tab a table of Probe Names is shown with the Name, Type (which is the physical
location of the flip-flop) and Value.

Click the Select Active Probes button to open a window that lists all the Available Probe Points and

Selected Probe Points. Both lists can be filtered using the inline Filter box. Between the two lists of Probe
points are buttons for adding and removing probe points from either list.

& Debug FPGA Amay ol
Debug fle:  Ex\Asf\RTGA_TCs\AT4G150_ES\serdes\EPCS\poe_epcs_x1_farend'poe_EPCS_yx \designer \serdes serdes_debug. bt
FPGA Array debug data
Lk Probes | Actve Probes | Memery Blodes | Probe bnsertion
Acthve Probe Data
O thee P Active Probed butten to see the dats for selected probes
Hame Type: vkt -
data_0fdata[0]:Q Legic Urread (=)
: data_0fdatal10]:Q Logc Urread L)
Add Remave Active Probes. .
: g data_0fdaea[11]:Q Legc Urvead O
data_0data[12]:Q Logic Unread O
Resd Actre Probes | data_0fdata[13]:Q Liogc Linreaad L]
data_0fdata[14):Q Legit Wread O
dats_0fdata]15]:Q Log nresad L]
dats_Ofdata[16]:0 e Linread L=
data_fidata[17):Q Logic Unread O
letabn nidataf 1A1:0 1w Lierad £ i
Helg Close

Figure 179 - Active Probes Tab in SmartDebug FPGA Array Dialog Box

Once you have selected the desired probe, points appear in the Active Probe Data chart and you can read
and write multiple probes at the same time (as shown in the figure below).

The Value column fields are editable for each of the probe points. Clicking the circle shaped icon changes
the value, and clicking the back-arrow resets the value. Fields that have been changed are indicated by red
text. After the probes have been written, the values return to black text.

—
49 Select Active Probe Points

Avalable probe points Selected probe points
Flter: | iy Fiter: Seanch
Hame:
CoreaHELite 0/matricax 16 masterstage_0/SDATASELInt{0]:Q [ add o]
CoreAHELite_jmatrixx 16 masterstage_0/SDATASEL Int] 10):Q b )
CoreAHELite_(jmatrix: 16 jmasterstage 0/SDATASELIN11]:Q
(CoreAbBLite_0fmatriscs 16 jmasterstage 0 SOATASELInt[12]:Q
(CoreAbELite_(jmatrixd: 16 masterstage 0/SDATASELInt] 13]:Q

CoreAHBLibe_(yimatrixcd: 16 masterstage 0 SDATASELInt] 14]:G

AR

CoreAMELIbe_Omabrixd 16 masterstage_0/SDATASELIN]15]:Q

Figure 180 - Active Probes Tab - Select Active Probe Points
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Memory Blocks Tab

The Memory Blocks tab shows a dropdown menu of defined memory blocks that are specified in your design
and generate a debug file. Once you select a memory block you can click Read Block to show the current
contents of the memory or write to individual memory locations. Each field is editable and multiple memory
locations can be written at the same time.

Each field is a 9 bit memory word so valid inputs are hexadecimal values between 0x0 and Ox1FF (as shown
in the figure below).

€ Debug FPGA Array [

Debug file:  D:\2Work\G4_SmartTime_UG\count16\designer \count16\count16_debug. tet

FPGA Array debug data

| Live Probes I Active Probes | Memory Blocks | Probe Insertion |

l hd Read Block Write Block
Memory block data
0000 000 000 000 000 OO0 000 00D 00O 000 000 000
0010 000 000 00C 000 OO0 000 000 000 000 000 000
0020 000 000 000 000 OO0 000 000 000 000 000 000
0030 000 000 000 000 00O 000 000 000 000 000 000
0040 000 000 000 000 00O 000 000 000 000 000 000
0050 000 000 000 000 OO0 000 000 000 000 000 000
0060 000 00D 000 000 00O 000 000 000 000 000 000
0070 000 000 0OC 000 OO0 000 000 000 00O 000 000
0080 000 000 000 000 OO0 000 000 000 000 000 000

Figure 181 - Debug FPGA Array - Memory Blocks Tab

Fields that have changed but have not yet been written appear in red text until you click the Write Block
button to initiate a memory write (as shown in the figure below).
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Probe Insertion (Post-Layout) - SmartFusion2, IGLOO2, and RTG4

i Debug FPGA Array ? =
DebugFie:  C:/Microsemi/SmartDebug/debugFile_combined_names. txt
FPGA Array Debug Data

[ LiveProbes | Active Probes | Memory Blocks |

[MysiBiock ~ ] [ ReadBlock | [ write Block |

Memory Block Data

0230 000 000 000 000 000 000 000 000 00O 000 00O 000 000 000 000 000 °

0240 000 000 000 000 000 000 000 000 00O 000 00O 000 000 000 000 000

0250 000 000 000 000 000 000 000 000 00O 000 00O 000 000 000 000 000

0260 001 002 003 004 005 005 006 007 00Z 009 00O 000 000 000 000 000

0270 000 000 000 00O 000 000 000 000 00O 000 00O 000 000 000 000 000

0280 000 0AA 000 000 000 000 000 000 00O 000 00O 000 000 000 000 000 |-

0290 000 000 000 000 OAA 000 000 000 00O 000 000 000 000 000 000 000 |

0240 000 000 000 000 000 000 000 0S5 000 000 000 000 000 000 000 000

0280 000 055 000 000 000 000 000 000 OAA 000 000 000 000 000 000 000

02C0 000 000 000 000 000 000 000 000 00O 000 00O 000 000 000 000 000

0200 000 000 000 000 000 000 055 000 000 000 000 000 000 000 000 000

02E0 000 000 000 000 000 000 000 000 000 000 OAA 000 000 000 000 000

02F0 000 000 000 000 000 000 000 000 00O 000 00O 000 000 000 000 000

0300 000 000 000 000 OAA 000 000 000 000 055 000 000 000 000 000 000

0310 000 000 000 000 000 000 000 000 00O 000 00O 000 000 000 000 000

0320 000 000 000 000 000 000 000 000 00O 000 00O 000 000 000 000 000

Figure 182 -

Memory Blocks with Updated Values

Probe Insertion (Post-Layout) - SmartFusion2, IGLOO2, and RTG4

Introduction

Probe insertion is a post-layout debug process that enables internal nets in the FPGA design to be routed to
unused I/Os, as shown. Nets are selected and assigned to probes using the Probe Insertion window in the
SmartDebug tools. The re-routed design can then be programmed into the FPGA, where an external logic
analyzer or oscilloscope can be used to view the activity of the probed signal.
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Pra-Synthesis
Simulation
|
Design Implementation ik i
Simulation
Insert probes into design !
Oniginal o \{E (o}
Do [] Incrementally
1GLOO

Figure 183 - Probe Insertion in the Design Process

The Probe Insertion debug feature is complementary to the Live Probes and Active Probes. In the case of
Live Probes and Active Probes, a special dedicated probe circuitry is used.

Probe Insertion
1. Double-click SmartDebug Design in the Design Flow window to open the SmartDebug window.
Note: FlashPro Programmer must be connected for SmartDebug to open.
2. Select Debug FPGA Array and then select the Probe Insertion tab.

€ Debug FPGA Array

Debug file:  D:\2Work\G4_SmartTime_UG\count16\designer\count16\count 16_debug. bt

FPGA Array debug data

Live Probes | Active Probes | Memory Blocks | Probe Insertion |

Probes I Add Probe... ] ’ Edit Probe... ] I Delete ] [ Delete Al

Net Driver Package Pin Port Name
Qaux_3_1_sum[o]:y ¥ [Probe_Insertd

EENR] - cbe et

Insert probe(s) and program the device

Figure 184 - Probe Insertion Tab
3. Click Add Probe.
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Probe Insertion (Post-Layout) - SmartFusion2, IGLOO2, and RTG4

The Add Probe dialog box displays the nets available to be probed on the right side. Each entry has a
Net and Driver name which identifies that probe point. The left (filter) pane allows filtering of the probe
points by net names or instance names.

To add filtering for Cell Types, enter the Cell Type Name in the Cell Type field. Enter, for example,
SEQ in the Cell Type field and all SEQ (Sequential) cell types will be displayed. If you enter COMB in
the Cell Type field, all COMB (Combinational Cells) will be displayed.

[ 531 Add Probetz) bl ) et |
Fiter raea(s) by: Seect a Netfs) for the Probe

: Frare Irdtanced | Met Dirrves -
I [+ Qim0 Qimi30kQ
2 Quint[26] Q_int]26:Q
Cell Type seq |3 Qing[25) Q irt[ 251
ey intin) R |4 Quingz4] QLint[24):Q
QL ini{10] |5 Quinef23) Qintl22}Q

Qintfl1] 6 Qin[2 Qint] 2210 &
Qint{12] H 7 Q2] Qint21:Q
Eﬂﬂi 5 Quint20] Qimi20}Q
! ink[19] int{13]:
Qs o S S i
QL imtf16] _ o
QL intil7] |11 Quink[17] Qint{171:Q
©int{18] |12 Q int[16] Q im[161Q
Qintf19] 13 Q int[15] QU imt[15EQ
[ | |aomtn) 14 Qintl13) L imi1a}Q
Qint]20] % | 15 Qint[13] QLint[13}Q
I 16 Q int[12] Qint{12}:Q
Seict Al | 17 Quinfin] Qim[10}Q
18 Qint[10] Qint{10}:Q

Match Case L% O intl%] O intf9kG |

Figure 185 - Add Probe(s) Dialog Box

4. Select one or more nets to probe and click OK.
The selected net(s) will appear in the Probes table in the Probe Insertion tab, as shown in the figure
below. SmartDebug automatically generates the Port Name for the probe. You can change the Port
Name from the default if desired.
5. Assign a package pin to the probe using the drop-down list in the Package Pin column. You can assign
the probe to any unused package pin (spare 1/O).
3| Debug FPGA
| DebugFle: C:\actelprj\sF2_preplidesignerishift_reg32ishift_reg32_debug. txt
FPGA Array Debug Data

e I thﬁ| = ,l e s .

Prabes [ Agderobe || Editrobe || Delete Dedete Al

Qint{30] Qint{30):

Net Driver Package Pin Port Name

AlZ x| Probe_Insert1

Q_imt[29] Q_int[29]:Q A19

4

My_probe

Insert Probe(s) and Program the device Run

6.

[ ] e ]

Figure 186 - Debug FPGA Array > Probe Insertion > Add Probe
Click Run.
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This triggers Place and Route in the incremental mode, and the selected probe nets are routed to the
selected package pin. After incremental Place and Route, Libero automatically reprograms the device
(with the added probes).

The log window shows the status of the Probe Insertion run.

Edit Probes
To edit/change a probe, select the probe and click Edit Probe. The Edit Net for Probe dialog box appears.
] Bt Mot for Probe [ ) |
Fitber net{s) by Select & Het o e Probe
Mame | lnstances et Dirbver

Crter beiow 5 reguils expresson ot rame shoukd masch

L

Figure 187 - Edit Net for Probe Dialog Box
Click and select a net to replace the original net for the Probe.

Probe Deletion
To delete a probe, select the probe and click Delete. To delete all the probes, click Delete All.

Note: Deleting probes from the probes list without Run does not automatically remove the probes from the
design.

Reverting to the Original Design
To revert to the original design after you have finished debugging:
1. In SmartDebug, click Delete All to delete all probes.
2. Click Run.

3. Wait until the action has completed by monitoring the activity indicator (spinning blue circle). Action is
completed when the activity indicator disappears.

4. Close SmartDebug.

See Also
Debug FPGA Array

SmartDebug Tcl Commands

The following table lists the Tcl commands related to Device Debug for SmartFusion2 and IGLOO2. Click
the command to view more information.
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Table 44 - Device Debug Tcl Commands

Command

Action

Debug File

set_debug_data_file

Sets the debug file

Probe

set_live_probe

Set Live probe channels A and/or B to the specified probe point
(or points)

select_active probe

Manages the current selection of active probe points to be used
by active probe READ operations

read_active probe

Reads active probe values from the device

write_active_probe

Sets the target probe point on the device to the specified value

LSRAM
read_Isram Reads a specified block of large SRAM from the device
write_lsram Writes a seven bit word into the specified large
SRAM location
USRAM
read_usram Reads a uSRAM block from the device.
write_usram Writes a seven bit word into the specified

uUSRAM location.

Customizing the Toolbar

Display the tools and commands you frequently use in the toolbar by customizing it.

To customize the toolbar:

1.
2.

& Microsemi

Customizing the Toolbar

From the Customize menu, choose Toolbars. The Customize dialog appears.
Click the Toolbar tab and check the tools you want to display by checking their respective boxes, (see

figure below).

Note: You can remove tools from your toolbar by deselecting tools from the Toolbar field.
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Toolbarz | Egmmandgl

T oalbars:

[ Show Taltips

(v| T ol v Cool Lok
[w] Programmers 0 Bzl Reszet

=
o
b3

Toolbar rame;
File

| ] I Cancel Help

Figure 188 - Customize Dialog Box

3. Click inside the Show Tooltips checkbox for assistance in identifying icons on your toolbar when you
scroll across them with your mouse.

Click inside the Cool Look checkbox to change the look of your toolbar.
5. Click OK.

You can create multiple toolbars and assigh names to them. Click the New button and type in a name
in the New toolbar dialog box to create a new toolbar. The name of your toolbar will display in the
Toolbar field. Reset your toolbar to the default settings by clicking the Reset button.

To customize commands:

1. From the Customize menu, choose Toolbars. The Customize dialog appears.
2. Click the Commands tab.
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Customizing the Programming Window

X

Toolbars  Commands |

Categaries: — Buttans

DS | ?
Toolz

Frogrammers

Select a category, then click a button to zee ite description. Drag the buttan
to any toolbar

Deszcription

| ] I Cancel Help

Figure 189 - Customize Dialog Box

3. Select a category by clicking one of three options (File, Tools, or Programmers). As you click an
option, the buttons to the right of the category area change accordingly.

4. Click and drag a button to your toolbar.
5. Click OK after you have customized your toolbar.

You can also remove commands from your toolbar by reversing the click and drag method described in the
steps above. Click and drag tools from your toolbar to the Buttons field in the Customize dialog box.

Customizing the Programming Window

The FlashPro software also enables you to customize the programmer window by right-clicking on the
programmer window's header (see figure below).

Programmer Programmer

Programmer
Status Enabled

10

Programmer ‘ Programmer

Hame Type ‘ [Pl ‘

Figure 190 - Programming Window Header
The following right-click menu displays (see figure below).
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Set 'Programmer Mame' Default Column Size
Set Al Default Sizes

Sort ‘Programmer Mame' Ascending
Sort ‘Programmer Name' Descending

Programmer ID
v Programmer Name
v Programmer Type
v Port
v Programmer Skatus
v Programmer Enabled

Cuskarize Columns. ..

Figure 191 - Right-click Menu

The Customize right-click menu (as shown above) is divided into three sections. Click an item in the first
section to set default sizes. Click an item in the second/middle section to add that item to the programmer
window, and click the Advanced or last section to customize the columns in the Programmer window from
the Customize Columns dialog box (see figure below).

Customize Columns

Check the colurmns that wou waould like visible in Ehis
view, s the Up and Down butkons to reorder the
columns however you like.

WPt oorammer (e} 4+

[w|Programmer Marme

[w]Programmer Type Dawn ‘ |

[w]Park

[w]Programmer Status Hide |

[w|Programmer Enabled

[wliCurrent Serial Data Shaw |
Default |

(a4 I Cancel |

Figure 192 - Customize Columns Dialog Box

Note: Follow the instructions in the Customize Columns dialog box to customize the programming window. Use
the Up and Down buttons to move through the list. Use the Show and Hide buttons to hide or show columns in
the programmer window.

FlashPro Preferences

The Preferences dialog box includes three tabs: Log Window, Display Mode, and Updates (see figure
below). You can access the Preferences dialog box by choosing File > Preferences.
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FlashPro Preferences

Preferences x|

Log'window | Display Mode I Updates I

— Color Settings

Chooze the color uzed to dizplay a meszage type by
clicking the color rectangle.

Errorz Infos I -
Warnings [ |"| Lirks -

Festore Defaultz |

[ Clear log window automatically

k. I Canicel | Help |

Figure 193 - Preferences Dialog Box

Log Window

The Log Window tab includes options for you to choose color settings for the various messages (Errors,
Warnings, Information, Links) displayed in the Log window (see figure above).

Display Mode

The Display Mode tab describes the two display modes available in the FlashPro software (as shown in the
figure below). Read each option carefully and choose the mode that will meet your programming needs. As
the Preferences dialog box indicates, the Classic Mode is designed for multiple programming runs when it is
not necessary for you to change your device settings. The Advanced Mode differs from the Classic Mode
because displays both windows (Programmer List and Device Configuration) in the same GUI. Use this
mode when you need to change device settings frequently.
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Preferences x|

Log Window Display Mode I |lpdates I

FlazhPro dizplays two windows:

- Proarammer Lizt Wfindow.

- Device Configuration YWindow,

Select one of the modes below to display the Programmer List
and/or the Device Configuration windowz];

f+ == - | Classic Maode: Only one window view appears it the
j GUI at & tirme. v'ou must switch between the bwo
windowsz, |Jze thiz mode for multiple programming
runz when freguent device zetting changes are not
HECEsEar.

[ E Advanced Maode: The bwa windaw views appear in
the zame GUI. Use thiz mode if you need to change
— device zettingz bebween programming runs.

k. I Canicel Help

Figure 194 - Preferences Dialog Box- Display Mode

Software Updates

The Updates tab lists the FlashPro software setting options. You can choose to have the FlashPro software

automatically check for updates at startup (from the Microsemi website) or remind you to check for updates

at startup (requires you to go to the Microsemi SoC website). If you want to decline both options, choose the
last option: Do not check for updates or remind me at startup.

Preferences x|

Log indow | Dizplay Mode  Updates

Autornatic Software Update:

Settings
" Automatically check for updates at startup
" Remind me to check for updates at startup

* Do not check for updates o remind me at startup

To keep vour software up-to-date, you can automatically
check for available updates at startup. To manually check.
for updates, fram the Help menu, choose Check for
Software Updates.

T hiz feature requirez an Internet connection.

] I Cancel Help

Figure 195 - Preferences Dialog Box- Updates

Software version is up to date

This informational message notifies you that there are no software updates available from Microsemi at this
time. You can set your update preferences to automatically check for software updates.
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FlashPro File Menu

In the Chain Programming mode, the Edit menu and the Configuration menu changes. The table notes

these changes.

NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

Command Icon [ Shortcut Sub-menu Function

New Project Ctrl + N Create a new project

Open Project Ctrl+0 Opens the FlashPro Open Project
dialog box

Restore Restores a ChainBuilder project in

Chainbuilder FlashPro

Project

Close Project Closes the current project

Save Project Ctrl+ S Saves the current project

Save Project As Opens the Save As dialog box;
enables you to save your project
in a different directory or with a
different name

Import Ctrl + 1 Opens the Import Configuration

Configuration File dialog box; enables you to

File import configuration files for your
device(s)

Set Project Log Main Log File Opens the Set Log File dialog

File > box; sets the location of your main
log file

Serialization Opens the Set Serialization Log

Log File File dialog box; sets the location
of your serialization log file

Run Script Opens the Execute Script dialog
box; enables you to run Tcl
Scripts with arguments

Export > Configuration Opens the Export Configuration

File File dialog box; enables you to
export configuration file(s)

Script Opens the Save As dialog box;
enables you to export your
actions as a Tcl script

Chain STAPL | Opens the Export Chain STAPL

File File dialog box; enables you to
export and save your Chain
STAPL file

Chain SVF File | Opens the Export Chain SVF File

dialog box; enables you to export

& Microsemi
FlashPro File Menu
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Command

Icon | Shortcut

Sub-menu

Function

and save your Chain SVF file

Single Device
STAPL File

Opens the Export Single Device
STAPL File dialog box; enables
you to export and save your
single device STAPL file

Single Device
SVF File

Opens the Export Single Device
SVF File dialog box; enables you
to export and save your single
device SVF file

Single 1532
File

Opens the Export Single 1532
File dialog box; enables you to
export and save your single 1532
file

Preferences

Opens the Preferences dialog
box; enables you to set your Log
window, Display Mode and
Update preferences for FlashPro

Exit

Exits FlashPro

FlashPro Edit Menu

Command Shortcut Function

Cut Devices Ctrl + Shift + | Removes (cuts) devices from the project
X

Copy Devices Ctrl + Shift + | Copies the selected device(s) to your Clipboard
C

Paste Devices Ctrl + Shift + | Pastes the devices from your Clipboard into the
\% project

Clear Log Clears the Log window (deletes all Log window

Window content)

FlashPro View Menu

The View menu shows or hides the FlashPro GUI elements.

Command

Sub-menu

Function

Status Bar

Shows/hides the FlashPro Status Bar
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Command Sub-menu Function
Programmer List Window Shows/hides the Programmer List Window
Programmer Details Shows/hides the Programmer Details
Window Window
Single Device Shows/hides the Single Device Configuration
Configuration Window Window
Log Window Shows/hides the Log window
Single Device Basic View | Enables the Basic view for the Single Device
Configuration > Configuration window
Advanced Enables the Advanced view for the Single
View Device Configuration window

FlashPro Tools Menu

Command Icon | Shortcut Sub-menu Function
Mode > | m Single-Device | Sets FlashPro to Single-Device
Programming | Programming mode
= Chain Sets FlashPro to Chain
Programming | Programming mode
Serialization > % | Skip Serial Sets FlashPro to skip serial data
Data during programming
e Reuse Serial Sets FlashPro to reuse serial
ok Data data during programming
Programmer @ Opens the Programmer Settings
Settings : dialog box; enables you to set
options for all FlashPro
programmer types
Import Settings Opens the Import Settings for
for Non- Non-Microsemi Devices dialog
Microsemi box; enables you to import your
Devices settings for non-Microsemi
devices you wish to program
with FlashPro
Connect ‘Eﬂ | Opens the Connect Parallel Port
Parallel Port Cable dialog box; enables you
Cable to connect your parallel port
buffer cable
Run m | Ctrl + Programs your device
! Enter

& Microsemi

FlashPro Tools Menu

FlashPro User's Guide

289



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

& Microsemi

FlashPro Programmers Menu

Command Icon [ Shortcut Function
Ping | m Pings a selected programmer(s)
Self Test ‘ % Runs a self-test on the selected programmer(s)
Scan Chain @ Runs scan chain on the selected programmer(s)
Remove @ Removes the selected programmer(s) from
FlashPro
Refresh/Rescan Ctrl + F5 | Refreshes FlashPro and rescans for programmers

FlashPro Configuration Menu

Command Icon | Shortcut | Sub-menu Function
Select Action # | Ctrl + Shift
2N
Serialization > Ctrl + Shift | Use Enables you to use Serialization in
+S Serialization | FlashPro
Ctrl + Shift | Select Enables you to set your
+R Range Serialization range
Ctrl + Shift | View Status | Enables you to view your
+U Serialization status
Load Ctrl + Shift Opens the Load Programming File
Programming +L dialog box
File
Unload Removes (unloads) your
Programming programming file from FlashPro
File
PDB Ctrl + Shift Opens the PDB Configuration
Configuration +P dialog box; enables you to set
your PDF configuration options
Select Target Ctrl Shift + Opens the Select Target Device
Device D dialog box; enables you to set
your target device for
programming
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FlashPro Customize Menu

Command Icon | Shortcut | Sub-menu Function
Chain Ctrl + Shift Opens the Chain Parameter dialog
Parameter +H box; enables you to set
parameters for your programming
chain

FlashPro Customize Menu

Command Function

Toolbars Opens the Customize dialog box to the Toolbars tab; enables you to
show/hide toolbars and tooltips

Commands | Opens the Customize dialog box to the Commands tab; enables you to
add/remove individual commands to your toolbars

FlashPro Help Menu

Command Icon Sub-menu Function

Help > Help Topics Opens the help

Programmer View | Opens the help to the FlashPro
Programmer List Window topic

Details on Opens the help to the Programmer
Programmer View | Details Window topic
Single Device Opens the Single Device Programming
Programming help topic
Chain Opens the Chain Configuration Window
Programming help topic
Microsemi Web Opens the Microsemi website in your
Site default browser
Check for Checks for software updates (works
Software Updates only if you are connected to the
internet)
About FlashPro Lists the FlashPro release information
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FlashPro Flow Window

The Flow window (located between the toolbar and Log window in the FlashPro GUI)consists of the
following buttons: New Project, Open Project, Configure Device, View Programmers, and Run. See the
table below for a description of these features.

ewF‘rcqeu:t ﬁ Configure Device
‘|> RUN
Open Project =% Yiew Programmers
Figure 196 - Flow Window
Table 45 - Flow Window Button Description
Button Description
New Project Creates a new project. Opens the New Project dialog box.
Open Project Opens a new project. Opens the Open Project dialog box.
Configure Device Opens the Single Device Configuration

window to configure your file.

View Programmers Opens the Programmer List Window for you to view your
programmers.

Refresh/Rescan for Rescans for programmers.

Programmers

Run Executes programming.

FlashPro Log Window

The Log window displays errors, warnings, and basic information about your device. Click the tabs at bottom
of the Log window to toggle between messages or click the All tab to display all of the messages.

You can access the Log window from the View menu.

Setting Log window preferences

From the Preferences dialog box, you can change the text color of the messages that appear in the Log
window.

To set Log window preferences:
1. From the File menu, choose Preferences.
2. Follow the directions in the Color Settings area or click the Restore Defaults button.
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FlashPro Status Bar

Preferences x|

Log'window | Display Mode I Updates I

— Color Settings

Chooze the color uzed to dizplay a meszage type by
clicking the color rectangle.

Errorz Infos I -
Warnings [ |"| Lirks -

Festore Defaultz |

[ Clear log window automatically

k. Canicel | Help |

Figure 197 - Preferences
3. Click OK to apply settings.

Note: You can clear the Log window by choosing Clear Log window from the Edit menu or you can automatically
erase the information by checking the Clear Log Window Automatically checkbox.

FlashPro Status Bar

The Status bar displays the program status, the programmer information (the file name for single device
programming and number of devices for chain programming), and the programming mode (single or chain).

FlashPro Programmer List Window

To activate the Programmer List Window, select View > Programmer List Window. The FlashPro
Programmer List Window consists of a spreadsheet with the programmer name, programmer type, port
number, programmer status, programmer enable check box, and a Refresh/Rescan for New
Programmers button as shown in the figure below.

Note: Double-clicking any of the spreadsheet columns opens the_Programmer Details window.

x

Programmer Programmer Prog Progi . F
Name Type foct Status Enabled Device / Action

Fiefresh/Rescan for Programmers

Programrer List Window

Figure 198 - Programmer List Window

Changing the Name of your Programmer

You can change the name of your programmer by double-clicking in the spreadsheet cell or you can choose
Edit Cell from the right-click menu.

Connecting New Programmers
You can connect new programmers by clicking the Refresh/Rescan for Programmers button.
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Accessing Right-Click Menus

If you have checked the Programmer Enabled checkbox, you can right-click on any of the spreadsheet
fields to access the menu in the figure below.

€ Ping

) Self Test
@ Scan Chain

?& Remove

Disable

Run Selected Programmers

Right-Click Menu

If you have not checked the Programmer Enabled checkbox, you can right-click in the on any of the
spreadsheet fields, to access a menu to remove or enable the programmer (see figure below).

ﬁﬁ Remove

Enable

Figure 199 - Right-Click Menu

Programmer Details Window

The Programmer Details Window displays your programmer ID, port, type, name, and programming status
(see figure below). Use this window to check the status and access common commands (ping, self-test,
scan chain) and to enable/disable or remove the programmer from the chain.

Programmet Details indow x

[v Enable programmer

Programmet I 01236

Pork: usb01236

Tvpe: FlashPro3
Programmer name: 01236

Skatus: SCAN CHAIM PASSED
Action: PROGRAM

Current Senalization D ata:

Mext Seralization 0 ata;

Fing Self-tesk Scan chain | Remove |

Figure 200 - Programmer Details Window
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FlashPro Single Device Configuration Window

You can access this window from the View menu or you can double click any of the fields in the
Programmer List Window (Programmer Name, Programmer Type, Port, Programmer Status, and
Programmer Enabled).

Click the Enable Programmer checkbox to enable your programmer and activate the Programmer Details
Window.

From the Programmer Details Window, you can ping a programmer, perform a self-test, scan a programmer,
Or remove a programmer.

FlashPro Single Device Configuration Window

Single Device Configuration window

To access the Single Device Configuration Window click the Configure Device button in the Flow window.
The Single Device Configuration window displays PDB/STAPL file and serialization information (see figure
below). You can also deactivate serialization by clicking the Serialization checkbox.

Programming File
To continue,

load existing programming file Browse...
of create new POE file

[Saiansean| =

Figure 201 - Single Device Configuration Window

Loading the PDB/STAPL File

You can load your PDB/STAPL file from the Configuration menu by choosing Load Programming File or
by clicking the Browse button in the Single Device Configuration Window.

You can set chain parameter settings by clicking the Chain Parameter button.

Selecting Serialization Indexes

To select the serialization indexes:
1. Check the Serialization checkbox to activate serialization.

2. Click the Select Serialization Indexes button. The Serial Settings dialog box appears (as shown in
the figure below).

FlashPro User's Guide 295



NOTE: Links and cross-references in this PDF file may point to external files and generate an error

CM. f when clicked. View the online help included with software to enable all linked content.
Serial Settings §|
1 - al - =
2
3 .
4
4]
B
?‘ P
B ]
3 o = a |

[v Yiew unused data
[v Wiew used data
v ‘iew skipped data

Filker: | *

v Log serial data: |Regiu:un_6_3 j

Help (] 4 | Cancel |

Figure 202 - Serial Settings Dialog Box

3. Click to select an index in the Indexes column.

4. Click the red arrow button that is pointing toward the Selected Indexes column to move an index to
the Selected Indexes column.

5. If you want to move all the Indexes to the Selected Indexes column, click the All button.
6. Click OK. Information about your serial indexes displays.

You can move indexes from the Selected Indexes column to the Indexes column by clicking the red arrow
buttons pointing toward the Indexes column.

You can set your indexes by choosing the following check boxes: View unused data, View used data, and
View skipped data.

Selecting Action and Procedures
You can select actions from the Basic mode and the Advanced mode. The Basic mode is provided for users
that only require the Program, Verify and Erase actions. In Basic mode, other actions are not visible, and the
Procedures run by an Action cannot be modified.
Mode: & Bazsic { Advanced

Actian

f+ PROGRAM
£ WERIFY
" ERASE

Figure 203 - Basic Mode

The Advanced mode enables you to select an action and modify the procedures for the selected action. In
Advanced mode, actions are determined by the stapl standard used.
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FlashPro Single Device Configuration Window

Mode: © Basic ™ Advanced

Achion

PROGRAM j

Procedures...

Figure 204 - Advanced Mode

To select an action (Advanced Mode):
1. Click the down arrow in the Action menu and select and action (see figure below).

Actian

PROGRAM ARRAT %
PROGRAM_FROM
PROGRAM_SECURITY
READ IDCODE

VERIFY -

Figure 205 - Action Menu
2. Click the Procedures button. The Select Action and Procedures dialog box appears.

Frocedures

INITIALIZE

DO_ERASE

DO_PROGRAM
DO_WERIFY_BOL
DO_PROGRAM_FROM
DO_WERIFY_FROK
DO_PROGRAM_SECURITY
DO_EXIT

EREEEEE R

Festore Defaulk Procedures |

(0] 4 I Cancel | Help |

Figure 206 - Select Action And Procedures Dialog Box

3. Select a procedure or click the Restore Default Procedures button. Gray checkboxes indicate that
the procedure is mandatory.
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Note: The procedures in the Select Action And Procedures dialog box are determined by the STAPL
standard. The Recommended procedures are selected by default and the Optional procedures are
unselected by default.

4. Click OK.
Note: You can also click the Select Action and Procedures dialog box from the toolbar.

Chain Configuration Window
The Chain Configuration Window displays the chain order, the chain editing options, and the chain
configuration grid (see figure below).

The Show Chain Editing checkbox, when checked, displays your chain editing options (Configure device,
Add Microsemi Device, Add Non-Microsemi Device, and organization buttons to move your device within the

grid).
For information on how to add Microsemi and Non-Microsemi devices, see the Chain Editing help topic.

For information on how to use the Organize buttons, see Using the Organize Buttons in the Chain
Programming Grid.

You can enable programming and serialization by checking the Enable Device checkbox and the Enable
Serial checkbox in the Chain Configuration grid.

—-|rn| N wol—-ooo—-lml 2 rool—olml 1 Too;—- | ’—l _I _J _I AddActelDwicem|

Add NoActel Device |
¥ Show Chain Ediing _—

File IR Max TCK  Enable  Enable Serial

Device Name Length | (MHz) | Device | Serial Action Data HIGH-Z

Construct the chain from a Scan Chain operation...

Figure 207 - Chain Configuration Window

Auto-Construction of Chain from Scan Chain

When in chain programming mode, the FlashPro software enables you to automatically construct the chain
by clicking the Construct the chain from a Scan Chain operation link, or by selecting Construct Chain
Automatically from the Configuration menu.

This enables you to scan a chain of devices and automatically construct the chain within FlashPro. If you are
using non-Microsemi devices, you will need to import the device settings into the database by using the
Import Settings for Non-Microsemi Devices dialog box. The software also scans the chain before
constructing it, which reduces the possibilities of having errors in the chain. For more information on how to
automatically construct a chain from scan chain, refer to the Automatic Chain Construction Tutorial.

Chain Editing Options

The FlashPro software enables you to edit your chain by adding Microsemi and Non-Microsemi devices.
You can add devices by clicking the Add Microsemi Device button and the Add Non-Microsemi Device
button or you can select these options from the Configuration menu.

Note: For more information about how to edit the chain, see Chain Editing.

Editing the Chain Configuration Grid

The Chain Configuration Grid enables you to select an Action for your device, Enable Serialization, and
edit the grid using the right-click menu.

To select an Action from the Configuration Grid:
1. Choose the device you would like to program and check the Enable Device checkbox.
2. Inthe Action column, click the down arrow to expose the drop-down menu (see figure below).
3. Select your desired action.
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Chain Configuration Window

Action

FROGRAM =]
DEVICE_INFO
ERASE
ERASE_&LL
ERASE_ARRAY
ERASE_FROM
FROGRAM ARRA
PROGRAM_FROM
READ IDCODE
VERIFY
VERIFY_ARRAY
VERIFY_FROM

Figure 208 - Drop-Down Menu for Select Action

able Serialization:

Check the Enable Serial checkbox. By enabling serialization, the action options change.

Note: Before you can enable serialization, you must check the Enable Device checkbox.

In the Action column, click the down arrow to expose the drop-down menu (see figure below).

Action

_____________

d _
M_FROM

PROGR,

PROGRS
WERIFY
WERIFY _FROM

Figure 209 - Drop-Down Menu for Select Action

Select your desired action.
Choose Select button from the Serial Data column, which is next to the Action column (see figure
below).

Serial
Data

Figure 210 - Serial Data Column

The Serial Settings dialog box appears.
5. Choose your serial settings from the Serial Settings dialog box.

See Serial Settings for more information about this topic.
Note: Uncheck the Enable Serial checkbox to disable serialization.

To edit the Chain Configuration Grid:

1.

2.

Select the device you would like to edit and right click anywhere in the row of the selected device. The
right-click menu below displays.

Select and click an option from the right-click menu.

Note: The Device Configuration menu includes options for configuring your device.
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Product Support

The Microsemi SoC Products Group backs its products with various support services including a Customer
Technical Support Center and Non-Technical Customer Service. This appendix contains information about
contacting the SoC Products Group and using these support services.

Contacting the Customer Technical Support Center

Microsemi staffs its Customer Technical Support Center with highly skilled engineers who can help answer
your hardware, software, and design questions. The Customer Technical Support Center spends a great
deal of time creating application notes and answers to FAQs. So, before you contact us, please visit our
online resources. It is very likely we have already answered your questions.

Technical Support

Microsemi customers can receive technical support on Microsemi SoC products by calling Technical
Support Hotline anytime Monday through Friday. Customers also have the option to interactively submit and
track cases online at My Cases or submit questions through email anytime during the week.

Web: www.actel.com/mycases

Phone (North America): 1.800.262.1060
Phone (International): +1 650.318.4460
Email: soc_tech@microsemi.com

ITAR Technical Support

Microsemi customers can receive ITAR technical support on Microsemi SoC products by calling ITAR
Technical Support Hotline: Monday through Friday, from 9 AM to 6 PM Pacific Time. Customers also have
the option to interactively submit and track cases online at My Cases or submit questions through email
anytime during the week.

Web: www.actel.com/mycases

Phone (North America): 1.888.988.ITAR
Phone (International): +1 650.318.4900
Email: soc_tech_itar@microsemi.com

Non-Technical Customer Service

Contact Customer Service for non-technical product support, such as product pricing, product upgrades,
update information, order status, and authorization.

Microsemi's customer service representatives are available Monday through Friday, from 8 AM to 5 PM
Pacific Time, to answer non-technical questions.

Phone: +1 650.318.2470
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Microsemi Corporate Headquarters
One Enterprise, Aliso Viejo,
CA 92656 USA

Within the USA: +1 (800) 713-4113
Outside the USA: +1 (949) 380-6100
Sales: +1 (949) 380-6136

Fax: +1 (949) 215-4996

E-mail: sales.support@microsemi.com
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Microsemi Corporation (Nasdaq: MSCC) offers a comprehensive portfolio of semiconductor
and system solutions for communications, defense & security, aerospace and industrial
markets. Products include high-performance and radiation-hardened analog mixed-signal
integrated circuits, FPGAs, SoCs and ASICs; power management products; timing and
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